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Copyright and Disclaimer
Product specifications are subject to change without notice and do not represent a commitment on the part of 
Avid Technology, Inc. The software described in this document is furnished under a license agreement. You 
can obtain a copy of that license by visiting Avid's Web site at www.avid.com. The terms of that license are 
also available in the product in the same directory as the software. The software may not be reverse assem-
bled and may be used or copied only in accordance with the terms of the license agreement. It is against the 
law to copy the software on any medium except as specifically allowed in the license agreement. Avid prod-
ucts or portions thereof are protected by one or more of the following United States patents: 4,746,994; 
4,970,663; 5,045,940; 5,063,448; 5,077,604; 5,245,432; 5,267,351; 5,309,528; 5,325,200; 5,355,450; 
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6,215,485; 6,223,211; D352,278; D372,478; D373,778; D392,267; D392,268; D392,269; D395,291; D396,853; 
D398,912. Additional U.S. and foreign patents pending. No part of this document may be reproduced or trans-
mitted in any form or by any means, electronic or mechanical, including photocopying and recording, for any 
purpose without the express written permission of Avid Technology, Inc.

© 2001 Avid Technology, Inc. All rights reserved. Printed in USA.

The following disclaimer is required by Apple Computer, Inc.

APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, 
REGARDING THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR 
ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PER-
MITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PRO-
VIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH 
VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their 
TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation 
for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permis-
sion notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler 
and Silicon Graphics may not be used in any advertising or publicity relating to the software without the spe-
cific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING 
FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, 
AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFOR-
MANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
Portions of this software are based on work of the Independent JPEG Group.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.



The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive 
a source code equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers 
Associates, Inc. shall in no event be liable for any damages resulting from reseller’s failure to perform reseller’s 
obligation; or any damages arising from use or operation of reseller’s products or the software; or any other 
damages, including but not limited to, incidental, direct, indirect, special or consequential Damages including 
lost profits, or damages resulting from loss of use or inability to use reseller’s products or the software for any 
reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been 
advised, knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, includ-
ing warranties with respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products 
developed by Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under 
license from Videomedia, Inc. Use of this software will allow “frame accurate” editing control of applicable vid-
eotape recorder decks, videodisc recorders/players and the like.” 

The following notice is required by Altura Software, Inc. for the use of its Mac2Win software and 
Sample Source Code:
©1993–1998 Altura Software, Inc.

The following notice is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from 
Ultimatte Corporation and are subject to copyright protection.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer 
software” or “commercial computer software documentation.” In the event that such Software or documenta-
tion is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with respect to this 
Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) 
and/or DFARS §227.7202-1(a), as applicable.

Trademarks
AirPlay, AudioVision, Avid, Avid Xpress, CamCutter, Digidesign, Elastic Reality, FieldPak, Film Composer, HIIP, 
Image Independence, Marquee, Media Composer, Media Recorder, NewsCutter, OMF, OMF Interchange, 
Open Media Framework, Pro Tools, and Softimage are registered trademarks and 888 I/O, AirSPACE, Air-
SPACE HD, AniMatte, AudioSuite, AutoSync, AVIDdrive, AVIDdrive Towers, AvidNet, Avid Production Network, 
AvidProNet, AVIDstripe, Avid Unity, AVX, DAE, D-Fi, D-fx, DigiTranslator, D-Verb, ExpertRender, FilmScribe, 
HyperSPACE, HyperSPACE HDCAM, Intraframe, iS9, iS18, iS23, iS36, Lo-Fi, Magic Mask, 
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Media Fusion, Media Illusion, MediaLog, Media Reader, MediaShare, Meridien, NaturalMatch, OMM, 
Open Media Management, QuietDrive, Recti-Fi, rS9, rS18, Sci-Fi, Sound Designer II, SPACE, SPACEnet, 
SPACEShift, Symphony, Vari-Fi, Video Slave Driver, and VideoSPACE are trademarks of Avid Technology, Inc.

Adobe, Adobe Type Manager, Photoshop, and PostScript are either registered trademarks or trademarks of 
Adobe Systems Incorporated in the United States and/or other countries. AppleShare, Mac, Macintosh, 
Power Mac, QuickTime, and TrueType are trademarks of Apple Computer, Inc., registered in the U. S. and 
other countries. IBM is a registered trademark of International Business Machines Corporation. Indy, IRIX, 
OCTANE, and Onyx are registered trademarks, and Indigo2 IMPACT and O2 are trademarks of 
Silicon Graphics, Inc. Jaz and Zip are registered trademarks of Iomega Corporation. K-AShare is a registered 
trademark of Xinet, Inc. MacDrive is a trademark of Mediafour Corporation. MacOpener is a registered trade-
mark of DataViz, Inc. Microsoft, Windows, and Windows NT are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries. Pentium is a registered trademark of Intel 
Corporation. QuickTime and the QuickTime logo are trademarks used under license from Apple Computer, Inc. 
RealMedia is a trademark of Real Networks, Inc. Sorenson Video is a trademark of Sorenson Vision, Inc.



TARGA is a trademark of Pinnacle Systems, Inc., registered in the U. S. and other countries. Tektronix is a reg-
istered trademark of Tektronix, Inc. Ultimatte is a registered trademark of Ultimatte Corporation. UNIX is a regis-
tered trademark of The Open Group in the U. S. and other countries. All other trademarks contained herein are 
the property of their respective owners.
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Using This Guide

Avid Technology is unique. No other company in the world has the 
same breadth and depth of digital solutions for content creation. A key 
component of the solutions that Avid offers is the relationship between 
Avid products. 

The Avid Products Collaboration Guide is designed to assist you as you 
transfer work between various Avid applications. Its purpose is to 
follow the same workflow that you use when:

• Moving projects between editing applications

• Moving audio files between editing applications and audio tools

• Moving graphics and effects between editing and graphics and 
effects applications

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .W h o  S h o u l d  U s e  T h i s  G u i d e

This reference guide is intended for all Avid® product users, from 
beginning to advanced, who want to transfer work between Avid 
applications.
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This guide provides step-by-step instructions for transferring your project 
files, audio files, and graphics and effects files between the following Avid 
products:

• Editing Products: 

- Symphony™ Release 3.5 (Windows® 2000)

- Symphony™ Release 3.1 (Windows NT®)

- Symphony™ Release 3.0 (Windows NT®)

- Symphony™ Release 2.1 (Windows NT®)

- Media Composer® Release 10.5 (Windows® 2000)

- Media Composer® Release 10.1 (Windows NT®)

- Media Composer® Release 10.0 (Windows NT®)

- Media Composer® Release 10.5 (Macintosh®)

- Media Composer® Release 10.1 (Macintosh®)

- Media Composer® Release 10.0 (Macintosh®)

- Media Composer® Release 9.1 (Windows NT®)

- Media Composer® Release 8.1 (Macintosh®)

- Media Composer® Release 7.2 (Macintosh®)

- Film Composer® Release 10.5 (Windows® 2000)

- Film Composer® Release 10.1 (Windows NT®)

- Film Composer® Release 10.0 (Windows NT®)

- Film Composer® Release 10.5 (Macintosh®)

- Film Composer® Release 10.1 (Macintosh®)

- Film Composer® Release 10.0 (Macintosh®)

- Avid Xpress® Release 4.5 (Windows® 2000)

- Avid Xpress® Release 4.1 (Windows NT®)
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- Avid Xpress® Release 4.0 (Windows NT®)

- Avid Xpress® Release 4.5 (Macintosh®)

- Avid Xpress® Release 4.1 (Macintosh®)

- Avid Xpress® Release 4.0 (Macintosh®)

- Avid Xpress® Release 3.1 (Windows NT®)

- Avid Xpress® Release 2.1 (Windows NT®)

- Avid Xpress® Release 2.5 (Macintosh®)

- Avid Xpress® Release 2.1 (Macintosh®)

- Avid Xpress® DV Release 2.0 (Windows® 2000)

- Avid Xpress® DV Release 1.5 (Windows NT®)

- Avid Xpress® DV Release 1.0 (Windows NT®)

- NewsCutter® XP Release 2.0 (Windows® 2000)

- NewsCutter® XP Release 1.5 (Windows NT®)

- NewsCutter® Release 2.5 (Windows® 2000)

- NewsCutter® Release 2.0 (Windows NT®)

- NewsCutter® Release 1.5 (Windows NT®)

- NewsCutter® Release 1.2 (Windows NT®)

- NewsCutter® DV Release 1.1 (Windows NT®)

- Softimage®|DS Release 3.0.1

- Softimage® |DS Release 2.1

- Avid®|DS Release 4.0

• Audio Products: 

- AudioVision® Release 4.1v10 (Macintosh®)

- Pro Tools® Release 4.3.1 (Macintosh®)

- Pro Tools® Release 5.0.1 (Macintosh®)

- Pro Tools® Release 5.1 (Macintosh®)
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• Graphics and Effects Products: 

- Matador™ (SGI IRIX®) 

- Softimage® Media Illusion™ Release 5.1v6 (SGI IRIX®) 

- Elastic Reality® Release 3.1 (Macintosh®)

- Elastic Reality® Release 3.1 (Windows NT® and Windows® 95)

- Elastic Reality® Release 3.1 (SGI IRIX®)

- Softimage® Marquee® Release 1.0 (SGI IRIX®)

- Softimage® Marquee® Release 1.0 (Windows NT®)

This guide is divided into three chapters according to workflow. Each chapter 
begins with a table of contents that lists the topics discussed in that chapter. 
The chapters are then divided into sections for individual products. Within 
each product section, there are step-by-step instructions describing how to 
move your files to and from other Avid applications. Where the instructions 
differ for a particular product, you will see the product name in the left 
margin.

Two appendixes follow the chapters: one adresses file transfers, and one 
addresses AvidLinks and export tempates. Finally, the guide includes an 
index.

The Contents lists all topics included in the guide. The chapters are organized 
according to the flow of your work as follows:

• Chapter 1, “Moving Project Files,” describes how to move a project 
between the Avid family of editing products on both the Macintosh and 
Windows platforms.

• Chapter 2, “Moving Sequences with Audio Media,” describes how to 
move audio files between Avid video and audio editing products.

• Chapter 3, “Moving Graphics and Effects Files,” describes how to move 
graphics and effects files between editing applications and Avid graphics 
and effects products.

• Appendix A, “Transferring Files,” lists methods of transfer between the 
same and different platforms, including Windows systems, Macintosh 
systems, and SGI IRIX systems. It also lists step-by-step procedures for 
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transferring your compositions and bins, using the AvidNet™ Transfer 
Tool and Avid Unity™ TransferManager.

• Appendix B, “AvidLinks and Export Templates,” lists the export 
templates for various product releases. It also describes AvidLinks menu 
options for Symphony Release 3.x (Windows), Media Composer and 
Film Composer Release 10.x (Windows and Macintosh), and Avid Xpress 
Release 4.x (Windows and Macintosh).

• A detailed Index helps you to quickly locate specific topics.

The most recent version of the Avid Products Collaboration Guide is available on 
the Avid Customer Service Knowledge Center. 

To access the Knowledge Center:

1. Go to www.avid.com.

2. Click Support.

3. Click Knowledge Center.

4. Choose your product from the pop-up menu at the upper right of the Web 
page.

5. Click the Documentation tab and select the Avid Products Collaboration 
Guide.

http://www.avid.com
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This guide uses the following symbols and conventions:

1 A numbered list, when the order of the items is important, such as steps in a 
procedure. The line above indicates the start of a numbered list and the line below 

indicates the end of a numbered list.

a Alphabetical lists, when the order of secondary items is important.

• Bulleted lists, when the order of the items is unimportant.

- Indented dashed lists, when the order of secondary items is 
unimportant.

Courier Bold font identifies text that you type.

n A note provides important related information, reminders, recommendations, and 
strong suggestions.

c A caution means that a specific action you take could cause harm to your 
computer or cause you to lose data.

Product Name A product name in the left margin indicates that the information following the 
name is specific to that product. When you use this guide, look in the margin 
for the name of the product you are working with.

This guide also uses the following naming conventions:

• The terms digitize and record have the same meaning when referring to 
methods for converting analog video and audio signals to digital format. 
The term digitize or redigitize in sections applicable to Avid Xpress DV, 
NewsCutter and NewsCutter XP, stands for record or rerecord.

• Windows refers to the Windows NT or Windows 2000 operating system.

• Windows NT refers to the Windows NT operating system.
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• Windows 95 refers to the Windows 95 operating system.

• Macintosh refers to the Macintosh operating system.

• SGI IRIX refers to the SGI IRIX operating system.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .I f  Y o u  N e e d  H e l p

If you are having trouble using any of your Avid applications, you should:

1 Retry the action, carefully following the instructions given for that task in this guide.

2 Check the documentation that came with your hardware for maintenance or 
hardware-related issues.

3 For support services, call Avid Customer Support:

- Broadcast products — call 800-NEWS-DNG (639-7364).

- Postproduction products — call 800-800-AVID (2843). 

Outside of the United States and Canada, contact your local Avid representative.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .I f  Y o u  H a v e  D o c u m e n t a t i o n  C o m m e n t s

Avid Technology, Inc. continuously seeks to improve its documentation. We 
value your comments about this guide and other Avid-supplied 
documentation.

Simply e-mail your documentation comments to Avid Technology at:

TechPubs@avid.com

Please include the title of the document, its part number, revision letter, and 
the specific section you are commenting on in all correspondence. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .H o w  t o  O r d e r  D o c u m e n t a t i o n

To order additional copies of this documentation from within the United 
States, call Avid Telesales at 800-949-AVID (2843). If you are placing an order 
from outside the United States, contact your local Avid representative.



Chapter 1

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Moving Project Files

Introduction ...................................................................................1-2

About Project Files ........................................................................1-3

Before You Move Your Files .........................................................1-4

Moving to Symphony Release 2.1 or 3.x for Windows .................1-6

Moving to Media Composer Release 9.1 or 10.x or Film Composer 
Release 10.x for Windows .......................................................1-22

Moving to Media Composer or Film Composer Release 10.x for 
Macintosh ................................................................................1-38

Moving to Media Composer Release 8.1 for Macintosh .............1-53

Moving to Media Composer or Film Composer Release 7.2 for 
Macintosh ................................................................................1-68

Moving to Avid Xpress Release 3.1 or 4.x for Windows .............1-79

Moving to Avid Xpress Release 4.x for Macintosh ......................1-94

Moving to Avid Xpress Release 2.5 for Macintosh ...................1-108

Moving to Avid Xpress Release 2.1 for Macintosh ...................1-123

Moving to Avid Xpress DV Release 1.5 or 2.0 for Windows .....1-134

Moving to Avid Xpress DV Release 1.0 for Windows NT .........1-144

Moving to NewsCutter XP Release 1.5 or 2.0 for Windows ......1-153

Moving to NewsCutter DV Release 1.1, or NewsCutter 
Release 1.x or 2.x ..................................................................1-162

Moving to Softimage|DS Release 3.0.1 or Avid|DS 4.0 ............1-171



1-2 Collaboration Guide

C h a p t e r  1
I N T R O D U C T I O N

1-2 Collaboration Guide

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .I n t r o d u c t i o n

Avid offers a range of editing applications from Avid Xpress, to 
Media Composer, to NewsCutter, to Symphony, to Softimage|DS and 
Avid|DS. Each of these products has its place in your nonlinear editing 
environment. The beauty of working with the Avid family of editing and 
finishing products is that you can work at the system most appropriate to 
your task and then easily move your work to another system when you are 
ready for the next step in the process. For example, you might start your 
project on an Avid Xpress (Windows) system and then move it to a Symphony 
system when you are ready for finishing.

This chapter is organized by product, and contains step-by-step instructions 
to help you prepare all of your project files for easy transfer between Avid 
editing and finishing products. 

n Make sure that you follow the instructions for the platform and product to which you 
are moving work.
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Project files include bins, settings, and compositions. Some products have 
direct compatibility, meaning that you can move the project files from one 
system to the other and they will work. For example, there is direct 
compatibility moving from Media Composer Release 10.x (Windows) to 
Symphony Release 3.x. 

With other products, the options for moving files include OMFI compositions 
with or without media and QuickTime™. OMFI compositions are the 
representation of a sequence, including the information describing how the 
media is edited together to form a final sequence. Objects used within 
compositions include effect clips, master clips, and subclips. Any program 
that supports OMFI can read OMFI files, regardless of the platform on which 
it is running. QuickTime can be used to bring incompatible clips forward to 
later releases and to move files to graphics stations. 
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Before you begin moving project files between Avid editing applications, 
consider the following:

• If you want to archive your original source sequence, duplicate the 
sequence, put the duplicate in another bin, and prepare the duplicate for 
export. Your original sequence will be preserved.

• If you are exporting a sequence as anything other than an OMFI file, you 
can speed the export process by rendering all effects in advance.

• If you are using OMFI to export your sequence and you only want to 
move one file, you can export it as an OMFI composition with media. If 
you are using a network drive to move your files, you might want to 
include the media in your OMFI composition to simplify moving across 
the network.

• Softimage|DS and Avid|DS can import OMFI compositions but cannot 
export in OMFI format. If you are moving from Media Composer, 
Symphony, or Avid Xpress to Softimage|DS or Avid|DS, export your 
project information as an OMFI composition and redigitize your media. 
However, you cannot move from Softimage|DS or Avid|DS back to 
Media Composer, Symphony, or Avid Xpress.

• If you want to move sequences from Symphony or Avid Xpress 
(Windows) to Media Composer Release 8.1 (Macintosh), you must use 
Symphony Release 2.1 or 3.x, or Avid Xpress Release 3.x, or 4.x 
(Windows) for direct compatibility.

• Do not include video media files from Media Composer Release 7.1 when 
you transfer directly to Media Composer Release 8.1 (Macintosh).

• Do not mix PAL and NTSC media in your sequence.
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• To make it easier to move files between products and across platforms, 
use the following guidelines when naming files: 

- Do not use the following characters in project, bin, or other file names:

/\:*?”<>|

The Windows system does not recognize these characters in file 
names and will substitute other characters, possibly making the file 
name unrecognizable.

- Do not add spaces at the beginning or end of a file name. The 
Windows system will display such files but might be unable to open 
them.

- Do not use a period at the end of a file name. The Windows system 
will display such files but might be unable to open them.

- In Media Composer Releases 7.2, 8.1, and 10.x (Macintosh), and 
Avid Xpress Releases 2.1, 2.5, and 4.x (Macintosh), you can enable a 
new setting that prevents you from using restricted characters in file 
names and automatically adds the correct file name extensions to files 
for your project. The Use Windows Compatible File Names setting in 
the General Settings dialog box is deslected by default. When you 
select the setting, the file name extension .avp is added to project files 
and .avb is added to bin files when they are saved. These file name 
extensions are attached to existing files, also.

• If the project includes titles and you are moving between Macintosh and 
Windows systems, make sure you have the same font with exactly the 
same name (preferably from the same manufacturer) on both the 
Macintosh and Windows systems. Check the font carefully because the 
same font can have slightly different names. For example, Times New 
Roman on the Macintosh system is named Times New Roman Regular on 
the Windows system.

If you open a title that does not have a matching font, a dialog box 
appears that allows you to substitute the font in the title with a font that 
exists on your system. 

For best results, use TrueType® or PostScript® fonts. Bitmap fonts can 
cause scaling problems.
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M o v i n g  t o  S y m p h o n y  R e l e a s e  2 . 1  o r  3 . x  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .f o r  W i n d o w s

Symphony provides high-end finishing capabilities on the Windows platform. 
You might want to compose your work on another system, and then move it 
to the Symphony system for finishing. This section includes instructions for 
moving work to Symphony Release 2.1, 3.0, 3.1, or 3.5.

Compat ib i l i ty  Issues

When you are moving projects to Symphony Release 2.1 or 3.x, some products 
have direct compatibility while others do not, as described in the following 
sections.

C o m p a t i b i l i t y  B e t w e e n  S y m p h o n y  R e l e a s e  2 . 1  
a n d  3 . x

In general, there is compatibility between Symphony Release 2.1 and 3.x; you 
can move audio, video, compositions, and bins from Release 2.1 to 
Release 3.x. However, when you move projects backward from Release 3.x, 
some features, especially new features in Release 3.0 or later, require special 
attention. The following list includes known features in this category:

• Color correction: Color adjustment is backward compatible with 
Release 2.1, but does not appear or becomes corrupted in Release 2.0 or 
earlier. In addition, controls for secondary color correction do not appear 
in releases earlier than Symphony Release 3.0. You can, however, transfer 
a sequence from Release 3.x to Release 2.1, and then back to Release 3.x, 
and the effect will remain in place.
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• Stabilize effect: This effect appears as an unknown effect in the Timeline 
and the data is lost in Release 2.1 or earlier. You can, however, transfer a 
sequence from Symphony Release 3.x to Media Composer or 
Film Composer Release 10.x (Windows and Macintosh) or Avid Xpress 
Release 4.x (Windows and Macintosh) and the effect will remain in place.

• Motion tracking: Effects that are tracking enabled — such as the 
Symphony Warp effect, the Paint effect, the AniMatte™ effect, and the 
Scratch Removal feature — lose their tracking data in Release 2.1 or 
earlier. You can, however, transfer a sequence from Symphony Release 3.x 
to Media Composer or Film Composer Release 10.x or Avid Xpress 
Release 4.x and the tracking information will remain intact.

• Ultimatte® effect: This effect appears as an unknown effect in the 
Timeline in Release 2.1, or becomes corrupted in Release 2.0 and earlier.

• Defocus parameter (3D effect): Sequences containing the 3D Warp effect 
with defocus parameters will open, but the effect will use the parameters 
set under the Internal defocus pane and will ignore all other parameters.

• Reformat effects: These effects appear as unknown effects in the Timeline 
in Releases 2.0 and 2.1, or become corrupted in Release 2.0 or earlier.

• Real-time moving mattes: Real-time moving mattes are converted to non-
real-time Matte Key effects in Release 2.1 or earlier. To use the effect, you 
can batch import the graphics again and render the effect. After batch 
import, however, the effect will no longer work if you return the sequence 
to Release 3.x.

• 25p editing: 25p editing projects do not open in Releases 2.0 and 2.1. To 
maintain compatibility when sharing projects between these systems, try 
to use a 24p project instead.

• MultiCamera editing: MultiCamera resolutions 3:1 m, 4:1 m, 8:1 m, and 
10:1 m are not compatible with Release 2.1 or earlier. The project will 
open, but the Timeline will display the “unsupported resolution” 
message. You can, however, redigitize the clips in another compatible 
resolution.
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• Mixed audio sample rates: Release 3.x supports the mixing of sample 
rates within the Timeline. Therefore, you must convert all clips to one 
sample rate before moving the project files to Release 2.1 or earlier, which 
does not support mixed sample rates. For more information on 
converting sample rates, see “Converting Multiple Audio Sample Rates” 
on page 2-10.

• Simultaneous automation gain and clip gain volume adjustments: 
Release 3.x supports the simultaneous adjustment of volume by using 
both automation gain and clip gain (volume adjustment for the entire 
clip). Release 2.1 maintains the automation gain adjustments but ignores 
the clip gain adjustments.

• Crawling titles: Release 3.5 supports crawling titles. These effects appear 
as unknown effects in the Timeline in earlier releases.

F i l m  P r o j e c t  C o m p a t i b i l i t y  B e t w e e n  S y m p h o n y  
R e l e a s e  2 . 1  o r  3 . x  a n d  F i l m  C o m p o s e r  
R e l e a s e 7 . 2  ( M a c i n t o s h )

Note the following compatibility issues for film projects:

• 25-fps film projects: You can open all 25-fps film projects transferred 
from Film Composer Release 7.2 (Macintosh) as 25p projects in Symphony 
Release 3.x. You can also open any sequence transferred from a 25-fps film 
project in a 25i project with matchback in Symphony Release 3.x.

• PAL Method 1 film projects: When you create a new Film Composer 
Release 7.2 (Macintosh) project for PAL Method 1, choose Film options in 
the Project window and then choose 24-frame editing. These options give 
you compatibility with a 24p PAL project for Symphony Releases 2.1 and 
3.x.

n The default setting for a PAL film project with Film Composer Release 7.2 
(Macintosh) is 25-frame editing. You need to change to 24-frame editing to maintain 
compatibility with Symphony Releases 2.1 and 3.x PAL projects.
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C o m p a t i b i l i t y  w i t h  A v i d  V i d e o - E d i t i n g  
P r o d u c t s

Table 1-1 lists the products from which you can move project files to 
Symphony Release 2.1 or 3.x and their level of compatibility.

Table 1-1 Moving Project Files to Symphony Release 2.1 or 3.x 
(Windows)

Source 
Application

Compatibility with Symphony Release 2.1 or 3.x 
(Windows)

Media Composer 
Release 9.1 or 10.x 
(Windows)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Film Composer 
Release 10.x 
(Windows)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Media Composer 
Release 8.1 
(Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins
Not Compatible: Sound Designer II™ Audio

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: Native Audio (AIFF-C only), 
Compositions, Bins
Not Compatible: Native Video, Sound Designer II 
Audio

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins
Not Compatible: Sound Designer II Audio
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n Before beginning a project that you will be moving to Symphony, set your audio file 
format to AIFF-C, which allows the simplest method of transferring audio files 
between the two applications.

Moving the Project  F i les

To transfer project files to Symphony Release 2.1 or 3.x:

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and redigitize.

4 Import graphics.

5 Transfer or import audio files.

6 Re-create the title media.

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Native Audio (AIFF-C only), 
Compositions, Bins
Not Compatible: Native Video, Sound Designer II 
Audio

Avid Xpress DV 
Release 1.0, 1.5, or 
2.0 (Windows) 

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter XP 
Release 1.5 or 2.0

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

Table 1-1 Moving Project Files to Symphony Release 2.1 or 3.x 
(Windows) (Continued)

Source 
Application

Compatibility with Symphony Release 2.1 or 3.x 
(Windows)
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7 Render non-real-time effects.

The following procedures detail each step in the transfer process. For more 
information, see the Symphony documentation, the Avid Symphony Help, 
and the appropriate documentation for your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Total Conform drastically reduces the amount of time spent conforming an 
offline project on Symphony. Total Conform handles almost all of the settings 
and effects that are used in Symphony, Media Composer, and Avid Xpress, 
but there are exceptions. Follow some or all of these guidelines to prepare 
your project for export:

• AVX™ plug-ins: If your project contains AVX plug-in effects and you are 
moving across platforms, make sure the same plug-ins are available on 
both the Macintosh and Windows systems. If the same AVX plug-in effect 
is not available, the video media can be mixed down and imported as an 
OMFI file. This method allows a maximum resolution of 1:1 from 
Media Composer Release 8.1 (Macintosh), and allows a resolution of 2:1 
from Media Composer or Film Composer Release 7.2 (Macintosh), or 
Avid Xpress Release 2.1 (Macintosh), which is equivalent to AVR 77.

If you do not create a mixdown, you can render the effect. If you do not 
create a mixdown or render the effect, the effect will be identified as an 
unknown effect in Symphony, and you will have to create a new effect.

• Video media: Media compatibility with Symphony Release 2.1 or 3.x 
depends on the product from which you are moving video media:

Media Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility. 

Film Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility. 
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Media Composer 
9.1 (Windows NT)

There is direct video media compatibility. 

Media Composer 
8.1 (Macintosh)

There is direct video media compatibility. 

Media Composer 
7.2

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media. 

The OMFI file can then be imported into Symphony Release 2.1 or 3.x or 
the master clips can be imported directly from the OMFI MediaFiles 
folder. For more information, see the appropriate documentation for your 
product.

Avid Xpress 3.1 or 
4.x (Windows)

There is direct video media compatibility. 

Avid Xpress 4.x 
(Macintosh)

There is direct video media compatibility. 

Avid Xpress 2.5 
(Macintosh)

There is direct video media compatibility. 

Avid Xpress 2.1 
(Macintosh) 

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media. 

The OMFI file can then be imported into Symphony Release 2.1 or the 
master clips can be imported directly from the OMFI MediaFiles folder. 
For more information, see the appropriate documentation for your 
product.

Avid Xpress DV 
1.0 or 1.5
(Windows NT)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media. 
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NewsCutter XP 
1.5 or 2.0

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter DV 
1.1, or 
NewsCutter 1.x or 
2.x

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Step 2:  Transfer  the Project  Informat ion

For the options to move your files from one system to another, see 
Appendix A.

Step 3:  Open the Pro ject  and Redigi t ize

If your media is not compatible, there are four options for redigitizing. You 
can:

• Redigitize existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Redigitize a sequence — provides a quick one-step process, but it limits 
your options during digitizing. You can make revisions using only 
assigned handles.

• Decompose the sequence and redigitize the new clips — digitizes only 
enough media to re-create the sequence, plus short handles for minor 
revisions. This method is more flexible than digitizing from the sequence 
because the new clips that are created can be sorted and selectively 
digitized. This method uses minimal storage and can be one of the fastest 
methods for redigitizing.

• Use the Show Reference Clips option — lets you reveal the source clips 
of a sequence, and then redigitize the clips. This method can be faster than 
the others depending on how the lengths of the original clips compare to 
the clips used in the sequence, and how the lengths of the new audio and 
video clips differ from the original master clips. Because two passes are 
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necessary to digitize audio and video from a single source if the lengths 
are not the same, it is sometimes faster to digitize a slightly longer master 
clip than to digitize the new clips once for audio and once for video. 
However, this method uses more disk space and digitizing can take 
longer. This method also gives you more opportunity for revisions. It is a 
good compromise between digitizing all the original clips and digitizing 
only the clips needed to re-create the source.

For instructions on redigitizing, see your system’s documentation. 

Note the following requirements:

• When you redigitize from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 

• If you redigitize a sequence, Avid recommends that you stop the 
digitizing process by clicking the Trash icon, and then reset the video 
levels.

• When you redigitize uncompressed media, Avid recommends that you 
store video and audio on different media drives. 

n If the incoming media is from the SDI (serial digital I/O) board, Symphony ignores 
the video input settings.
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Step 4:  Import  Graphics

You can use the Batch Import command from the Clip menu if your media 
originated from:

• Symphony Release 2.1 or 3.x (Windows)

• Media Composer Release 9.1 or 10.x, or Film Composer Release 10.x 
(Windows)

• Media Composer or Film Composer Release 10.x (Macintosh)

• Media Composer Release 8.1 (Macintosh)

• Media Composer or Film Composer Release 7.2 (Macintosh)

• Avid Xpress Release 3.1 or 4.x (Windows)

• Avid Xpress Release 4.x (Macintosh)

• Avid Xpress Release 2.5 (Macintosh)

• Avid Xpress Release 2.1 (Macintosh) 

• Avid Xpress DV Release 1.0, 1.5, or 2.0 (Windows)

The Batch Import command allows you to reimport master clips or sequences 
that contain imported material while automatically linking the newly 
imported material with the original master clips and sequences. When you 
play the sequence after batch importing the files, the newly imported material 
plays in it.

c Batch importing requires your original source file. Do not delete the media 
files for imported files if the source files are no longer available, unless you 
will not need the material again.

When you batch import a media file, the entire media file, including all tracks, 
is reimported. For example, the reimport process will import both the video 
and audio from a source file, even if only the video track was used in the 
sequence.
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Here are two tips for making batch importing easier:

• Placing a “graphics” folder inside the project folder of your offline project 
makes the batch import process easier because the path will be the same, 
or at least faster to find.

• It is easy to edit revised graphics into your project by giving them the 
same names as the original graphics and by placing them in the same 
folder. You can also edit new graphics into your project by deleting the 
media for your original graphic, then batch importing your sequence and 
pointing the old graphics clips to the revised graphics files. 

n OMFI files can contain only one master clip when you batch import them.

n OMFI master clips that have been consolidated cannot be batch imported.

Step 5:  Transfer  or  Import  Audio  F i les

For a detailed description of transferring audio files between Avid 
video-editing products, see Chapter 2.
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Step 6:  Re-create  the  T i t le  Media

After you import all the files into your Symphony Release 2.1 or 3.x system, 
re-create the title media as follows:

1 Open the bin or project.

2 For Symphony Release 2.1 or earlier, choose Compression from the Tools menu 

and choose the video resolution you want to use for the re-created title media.

n For Symphony Release 3.x, choosing the video resolution is a later step.

3 Load the sequence containing the titles into the Record monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 

the Alt key, and drag the selected group of titles into the Record monitor. A 
sequence containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s effects guide or Help.

4 Select all video tracks that contain titles.

5 Mark an IN point and an OUT point to include all your titles.

6 Choose Re-create Title Media from the Clip menu.

- If you have the same font on both systems, the new font appears 
automatically.

Because the mapping process changes the exact appearance of the font, 
check your titles carefully. It might be easier to check your titles from the bin 
than from the sequence. See step 8.

- If a title opens and the system does not recognize the font, you will see a 
dialog box that allows you to substitute the font in the title for one that is 

installed on the system. 

This replacement establishes a relationship between the font used in the 
original title and the mapped font. For information on changing the font 
mapping, see “Redefining a Font Replacement” on page 1-19.

If more than one font in the title needs replacement, the dialog box will remain 
open after you click OK, and a new message will identify the next font that 
needs replacement. 
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7 For Symphony Release 3.x, choose a drive and resolution for the re-created title 

media.

8 If necessary, adjust the size of the bounding box, leading values, or kerning 

information. 

Note the following:

• If you are moving across platforms and the transferred title text uses a 
single style (the same font and type size), the title text aligns as closely as 
possible to its original position. The size of the text bounding box adjusts 
to accommodate the differences between the Macintosh and Windows 
versions of the font used. You might see a changed leading value in the 
Title Tool leading field to adjust for multiline text.

Because the Macintosh and Windows systems handle fonts differently, 
you might see variations in the appearance of titles between the two 
systems. 

For example, bounding boxes that were set on a Macintosh system might 
be different sizes on a Windows system. Some clipping of the new text 
might occur and words can be lost. If this clipping occurs, you need to 
open the title, select the text box, and manually change the size of the text 
box or the size of the fonts to display all the text. 

For more information on differences between the Macintosh and 
Windows versions of a font, contact the font manufacturer.

• If the titles are downstream key (DSK) graphics that include position 
changes set with keyframes, see “Turning Off Downstream Keys (DSK)” 
on page 1-20.

• If the original system used any applications to manipulate font display 
(such as Adobe® Type Manager®), the enhancements these applications 
provided on the original system (such as character anti-aliasing or 
character spacing) will not transfer to a system not using the application. 

• For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.
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R e d e f i n i n g  a  F o n t  R e p l a c e m e n t

You can redefine a font replacement at any time. However, your new font 
choice is applied only to a title currently in the Title tool and future 
replacements. It does not affect the font replacement information in titles that 
you have worked with previously.

Font relationships are saved as a “site” setting file named AvidFontSub.avt. 
This file is located in the Settings folder, which is located in the Symphony, 
Media Composer, or Avid Xpress folder on your internal drive. 

Once you have defined a font replacement, the Avid system uses that 
definition across all projects and all users of the system. If you want to switch 
to a different replacement font for a title, you must redefine the font 
replacement. 

n If you replace the font for a title and return that title to an Avid editing application on 
a Macintosh system, the new font information will be associated with the title. You 
must reapply the Macintosh font to restore the title to its original Macintosh style.

To redefine a font replacement:

1 Open a title in the Title tool.

2 Choose Font Replacement from the Object menu.

A dialog box appears. 

3 Choose the original font from the Unknown Fonts pop-up menu on the left.

4 Choose the replacement font you want to use from the Available Fonts pop-up 
menu on the right.

When you choose a font from the Available Fonts pop-up menu, a preview of that 
font appears in the text boxes.

5 Click OK.

The system updates the font in the open title and records the new replacement 
information for future use.
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T u r n i n g  O f f  D o w n s t r e a m  K e y s  ( D S K )

If you transfer a project that includes downstream key (DSK) graphics with 
position changes set with keyframes, position changes are ignored unless you 
turn off DSK. DSK was introduced in Media Composer Release 7.0 and 
Avid Xpress Release 2.0 (Macintosh).

n Turning off DSK is necessary only if you are moving from Media Composer 
Release 7.2 or Avid Xpress Release 2.x (Macintosh).

To turn off DSK for all such graphics in a sequence:

1 Load the sequence into the Record monitor.

2 Choose Console from the Tools menu. 

3 Type the following in the text box of the Console window:

MeridienDSK TRUE 

4 Press Enter.

n The command MeridienDSK False reverses this action and turns on DSK for all 
graphics that include position changes.

This procedure removes DSK from all mattes and keys that include position 
changes marked by keyframes. 

Step 7:  Render  Non-Real -Time Ef fects

You must render a non-real-time effect (an effect whose icon displays a blue 
dot) before it can be played. In addition, you must render some or all effects 
that exceed the real-time playback capabilities of the system to view the 
effects during playback. Occasionally, you might need to render an effect with 
a green dot in the Timeline, depending on the complexity of the sequence. 

n Preview your effects before rendering them to see if the effects imported correctly.
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To render multiple effects:

1 Click the track selector in the Timeline for each track with effects to be rendered.

2 Mark an IN point before the first effect to be rendered in your sequence; mark an 
OUT point after the last effect to be rendered.

3 Choose Render In/Out from the Clip menu.

4 (Optional) Select the quality of the effects. The default quality is Highest Quality. 
The effect quality applies only to effects that change the image size, such as 
Picture-in-Picture, Peel, and Squeeze.

5 If you do not want to render the real-time effects in the selected group of effects, 
select Skip Real-time Effects.

6 Click OK.
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M o v i n g  t o  M e d i a  C o m p o s e r  R e l e a s e  9 . 1  
o r  1 0 . x  o r  F i l m  C o m p o s e r  R e l e a s e 1 0 . x  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .f o r  W i n d o w s

This section includes instructions for moving work to Media Composer 
Release 9.1 or 10.x, or Film Composer Release 10.x (Windows). 

Compat ib i l i ty  Issues

When you are moving projects to Media Composer Release 9.1 or 10.x, or 
Film Composer Release 10.x (Windows), some products have direct 
compatibility while others do not. Review the following sections before 
proceeding.

C o m p a t i b i l i t y  B e t w e e n  M e d i a  C o m p o s e r  
R e l e a s e  9 . 1 ,  a n d  M e d i a  C o m p o s e r  o r  
F i l m Co m p o s e r  R e l e a s e  1 0 . x  f o r  W i n d o w s

In general, there is compatibility going from Media Composer Release 9.1 to 
Media Composer or Film Composer Release 10.x; you can move audio, video, 
compositions and bins from Media Composer Release 9.1 to Release 10.x. 
However, when you move projects backward from Release 10.x to Release 9.1, 
some features, specially new features in Release 10.0 or later, require special 
attention. The following list includes known features in this category:

• Defocus parameter (3D effect): Sequences containing the 3D Warp effect 
with defocus parameters will open, but the effect will use the parameters 
set under the Internal defocus pane and will ignore all other parameters.

• Reformat effects: These effects appear as unknown effects in the Timeline 
in Release 9.1. 
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• Real-time moving mattes: Real-time moving mattes are converted to non-
real-time Matte Key effects in Release 9.1.

• 25p editing: 25p editing projects do not open in Release 9.1.

• MultiCamera editing: MultiCamera resolutions 3:1 m, 4:1 m, 8:1 m, and 
10:1 m are not compatible with Release 9.1. The project will open, but the 
Timeline will display the “unsupported resolution” message. You can, 
however, redigitize the clips in another compatible resolution.

• Mixed audio sample rates: Release 10.x supports the mixing of sample 
rates within the Timeline. Therefore, you must convert all clips to one 
sample rate before moving the project files to Release 9.1, which does not 
support mixed sample rates. For more information on converting sample 
rates, see “Converting Multiple Audio Sample Rates” on page 2-10.

• Simultaneous automation gain and clip gain volume adjustments: 
Release 10.x supports the simultaneous adjustment of volume by using 
both automation gain and clip gain (volume adjustment for the entire 
clip). Release 9.1 maintains the automation gain adjustments but ignores 
the clip gain adjustments.

C o m p a t i b i l i t y  B e t w e e n  M e d i a  C o m p o s e r  
R e l e a s e  9 . 1  o r  1 0 . x ,  o r  F i l m  C o m p o s e r  
R e l e a s e 1 0 . x  a n d  S y m p h o n y  R e l e a s e  3 . x  f o r  
W i n d o w s

In general, Media Composer Release 9.1 or 10.x, or Film Composer 
Release 10.x is compatible with Symphony Release 3.x with a few exceptions. 
In Release 9.1, incompatibilities include all features described in the previous 
section, along with the following features available in Symphony only. In 
Release 10.x, known incompatibilities include:

• Color correction: Color adjustment does not appear in Media Composer 
Release 9.1, or Media Composer or Film Composer Release 10.x. In 
addition, controls for secondary color correction do not appear in 
Release 9.1 or 10.x. You can, however, transfer a sequence from Symphony 
Release 3.x to Media Composer Release 9.1 or 10.x, or Film Composer 
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Release 10.x, and then back to Symphony Release 3.x, and the effect will 
remain in place.

• Stabilize effect: This effect appears as an unknown effect in the Timeline 
and data is lost in Release 9.1. You can, however, transfer a sequence from 
Symphony Release 3.x to Media Composer or Film Composer 
Release 10.x or Avid Xpress Release 4.x, and then back to Symphony 
Release 3.x, and the effect will remain in place.

• Motion tracking: Effects that are tracking enabled — such as the 
Symphony Warp effect, the Paint effect, AniMatte effect, and the Scratch 
Removal feature — lose their tracking data in Release 9.1. You can, 
however, transfer a sequence from Symphony Release 3.x to Media 
Composer or Film Composer Release 10.x or Avid Xpress Release 4.x, and 
then back to Symphony Release 3.x, and the tracking data will remain 
intact.

• Ultimatte effect: This effect appears as an unknown effect in the Timeline 
in Release 9.1 or 10.x. You can, however, transfer a sequence from 
Symphony Release 3.x to Media Composer Release 9.1 or 10.x, or 
Film Composer Release 10.x, and then back to Symphony Release 3.x, and 
the effect will remain in place.

F i l m  P r o j e c t  C o m p a t i b i l i t y  B e t w e e n  
M e d i a C o m p o s e r  R e l e a s e  9 . 1  o r  1 0 . x ,  o r  
F i l m C o m p o s e r  R e l e a s e  1 0 . x  a n d  
F i l m C o m p o s e r  R e l e a s e  7 . 2  ( M a c i n t o s h )

Note the following compatibility issues for film projects:

• 25-fps film projects (Release 10.x only): You can open all 25-fps film 
projects transferred from Release 7.2 (Macintosh) as 25p projects in 
Media Composer or Film Composer Release 10.x. You can also open any 
sequence transferred from a 25-fps film project in a 25i project with 
matchback in Media Composer or Film Composer Release 10.x.

• 24-fps PAL Method 1 film projects (Release 9.1 or 10.x): When you create 
a new Film Composer Release 7.2 (Macintosh) project for PAL Method 1, 
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choose Film options in the Project window and choose 24-frame editing. 
This gives you compatibility with a 24p PAL project for Media Composer 
Release 9.1 or 10.x, or Film Composer Release 10.x.

n The default setting for a PAL film project with Film Composer Release 7.2 
(Macintosh) is 25-frame editing. You need to change to 24-frame editing to maintain 
compatibility with Symphony Release 2.1 and 3.x PAL projects.

C o m p a t i b i l i t y  w i t h  A v i d  V i d e o - E d i t i n g  
P r o d u c t s

Table 1-2 lists the products from which you can move project files to 
Media Composer Release 9.1 or 10.x, or Film Composer Release 10.x 
(Windows) and their level of compatibility.

Table 1-2 Moving Project Files to Media Composer Release 9.1 or 10.x, or 
Film Composer Release 10.x (Windows)

Source 
Application

Compatibility with Media Composer Release 9.1 or 
10.x, or Film Composer Release 10.x (Windows)

Symphony 
Release 2.1 or 3.x

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
or Film Composer 
Release 10.x 
(Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
Release 8.1 
(Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins
Not Compatible: Sound Designer II Audio

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: Native Audio (AIFF-C only), 
Compositions, Bins
Not Compatible: Native Video, Sound Designer II 
Audio
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Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins
Not Compatible: Sound Designer II Audio

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Native Audio (AIFF-C only), 
Compositions, Bins
Not Compatible: Native Video, Sound Designer II 
Audio

Avid Xpress DV 
Release 1.0, 1.5, or 
2.0 (Windows) 

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter XP 
Release 1.5 or 2.0 

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

Table 1-2 Moving Project Files to Media Composer Release 9.1 or 10.x, or 
Film Composer Release 10.x (Windows) (Continued)

Source 
Application

Compatibility with Media Composer Release 9.1 or 
10.x, or Film Composer Release 10.x (Windows)
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Moving the Project  F i les

To transfer project files to Media Composer Release 9.1 or 10.x, or 
Film Composer Release 10.x (Windows):

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and redigitize.

4 Import graphics.

5 Transfer or import audio files.

6 Re-create the title media.

7 Render non-real-time effects.

The following procedures detail each step in the transfer process. For more 
information, see the Media Composer or Film Composer documentation and 
the Avid Media Composer and Film Composer Help, and the appropriate 
documentation for your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for moving to 
Media Composer Release 9.1 or 10.x, or Film Composer Release 10.x 
(Windows):

• AVX plug-ins: If your project contains AVX plug-in effects and you are 
moving across platforms, make sure the same plug-ins are available on 
both the Macintosh and Windows systems. If the same AVX plug-in effect 
is not available, the video media can be mixed down and imported as an 
OMFI file. This method allows a maximum resolution of 1:1 from 
Media Composer Release 8.1 (Macintosh) or Symphony Release 1.1, and a 
resolution of 2:1 from Media Composer or Film Composer Release 7.2 
(Macintosh), or Avid Xpress Release 2.1 (Macintosh), which is equivalent 
to AVR 77.
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If you do not create a mixdown, the effect will be identified as an 
unknown effect in Media Composer Release 9.1 or 10.x, or Film Composer 
Release 10.x (Windows), and you will have to create a new effect.

• Video media: Media compatibility with Media Composer Release 9.1 or 
10.x, or Film Composer Release 10.x (Windows) depends on the product 
from which you are moving video media:

Symphony 2.1 or 
3.x

There is direct video media compatibility. 

Media Composer 
10.x (Macintosh)

There is direct video media compatibility. 

Film Composer 
10.x (Macintosh)

There is direct video media compatibility. 

Media Composer 
8.1 (Macintosh)

There is direct video media compatibility. 

Media Composer 
7.2 (Macintosh)

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media. 

The OMFI file can then be imported into Media Composer Release 9.1 or 
10.x, or Film Composer Release 10.x (Windows), or the master clips can be 
imported directly from the OMFI MediaFiles folder. For more 
information, see the appropriate documentation for your product.

Avid Xpress 3.1 or 
4.x (Windows)

There is direct video media compatibility. 

Avid Xpress 2.5 or 
4.x (Macintosh)

There is direct video media compatibility. 
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Avid Xpress 2.1 
(Macintosh)

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media. 

The OMFI file can then be imported into Media Composer Release 9.1 or 
10.x, or Film Composer Release 10.x (Windows), or the master clips can be 
imported directly from the OMFI MediaFiles folder. For more 
information, see the appropriate documentation for your product.

Avid Xpress DV 
1.0, 1.5, or 2.0
(Windows)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter XP 
1.5 or 2.0

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter DV 
1.1, or 
NewsCutter 1.x or 
2.x

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Step 2:  Transfer  the Project  Informat ion

For the options to move your files from one system to another, see 
Appendix A.
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Step 3:  Open the Pro ject  and Redigi t ize

If your media is not compatible, there are four options for redigitizing. You 
can:

• Redigitize existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Redigitize a sequence — provides a quick one-step process, but it limits 
your options during digitizing. You can make revisions using only 
assigned handles.

• Decompose the sequence and redigitize the new clips — digitizes only 
enough media to re-create the sequence, plus short handles for minor 
revisions. This method is more flexible than digitizing from the sequence 
because the new clips that are created can be sorted and selectively 
digitized. This method uses minimal storage and can be one of the fastest 
methods for redigitizing.

• Use the Show Reference Clips option — lets you reveal the source clips 
of a sequence, and then redigitize the clips. This method can be faster than 
the others depending on how the lengths of the original clips compare to 
the clips used in the sequence, and how the lengths of the new audio and 
video clips differ from the original master clips. Because two passes are 
necessary to digitize audio and video from a single source if the lengths 
are not the same, it is sometimes faster to digitize a slightly longer master 
clip than to digitize the new clips once for audio and once for video. 
However, this method uses more disk space and digitizing can take 
longer. This method also gives you more opportunity for revisions. It is a 
good compromise between digitizing all the original clips and digitizing 
only the clips needed to re-create the source.

For instructions on redigitizing, see your system’s documentation. 

Note the following requirements:

• When you redigitize from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 
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• If you redigitize a sequence, Avid recommends that you stop the 
digitizing process by clicking the Trash icon, and then reset the video 
levels.

• When you redigitize uncompressed media, Avid recommends that you 
store video and audio on different media drives. 

n If the incoming media is from the SDI (serial digital I/O) board, Media Composer or 
Film Composer ignores the video input settings.

Step 4:  Import  Graphics

You can use the Batch Import command from the Clip menu if your media 
originated from:

• Symphony Release 2.1 or 3.x (Windows)

• Media Composer or Film Composer Release 10.x (Macintosh)

• Media Composer Release 8.1 (Macintosh)

• Media Composer or Film Composer Release 7.2 (Macintosh)

• Avid Xpress Release 3.1 or 4.x (Windows)

• Avid Xpress Release 4.x (Macintosh)

• Avid Xpress Release 2.5 (Macintosh)

• Avid Xpress Release 2.1 (Macintosh) 

• Avid Xpress DV Release 1.0, 1.5, or 2.0 (Windows)

The Batch Import command allows you to reimport master clips or sequences 
that contain imported material while automatically linking the newly 
imported material with the original master clips and sequences. When you 
play the sequence after batch importing the files, the newly imported material 
plays in it.
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c Batch importing requires your original source file. Do not delete the media 
files for imported files if the source files are no longer available, unless you 
will not need the material again.

When you batch import a media file, the entire media file, including all tracks, 
is reimported. For example, the reimport process will import both the video 
and audio from a source file, even if only the video track was used in the 
sequence.

Here are two tips for making batch importing easier:

• Placing a “graphics” folder inside the project folder of your offline project 
makes the batch import process easier because the path will be the same, 
or at least faster to find.

• It is easy to edit revised graphics into your project by giving them the 
same names as the original graphics and by placing them in the same 
folder. You can also edit new graphics into your project by deleting the 
media for your original graphic, then batch importing your sequence and 
pointing the old graphics clips to the revised graphics files. 

n OMFI files can contain only one master clip when you batch import them. 

n OMFI master clips that have been consolidated cannot be batch imported.

Step 5:  Transfer  or  Import  Audio  F i les

For a detailed description of transferring audio files between Avid 
video-editing products, see Chapter 2.
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Step 6:  Re-create  the  T i t le  Media

After you import all the files into your Media Composer Release 9.1 or 10.x, or 
Film Composer Release 10.x (Windows) system, re-create the title media as 
follows:

1 Open the bin or project.

2 For Media Composer Release 9.1 and earlier, choose Compression from the Tools 
menu and choose the video resolution you want to use for the re-created title 
media.

n For Media Composer and Film Composer Release 10.x, choosing the video resolution 
is a later step.

3 Load the sequence containing the titles into the Record monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 
the Alt key, and drag the selected group of titles into the Record monitor. A 

sequence containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s effects guide or Help.

4 Select all video tracks that contain titles.

5 Mark an IN point and an OUT point to include all of your titles.

6 Choose Re-create Title Media from the Clip menu.

- If you have the same font on both systems, the new font appears 
automatically.

Because the mapping process changes the exact appearance of the font, 
check your titles carefully. It might be easier to check your titles from the bin 
than from the sequence. See step 8.

- If a title opens and the system does not recognize the font, you will see a 
dialog box that allows you to substitute the font in the title for one that is 
installed on the system. 

This replacement establishes a relationship between the font used in the 
original title and the mapped font. For information on changing the font 
mapping, see “Redefining a Font Replacement” on page 1-35.
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If more than one font in the title needs replacement, the dialog box will remain 
open after you click OK, and a new message will identify the next font that 
needs replacement.

7 For Media Composer Release 10.x or Film Composer Release 10.x, choose a 
drive and resolution for the re-created title media.

8 If necessary, adjust the size of the bounding box, leading values, or kerning 
information. 

Note the following:

• If you are moving across platforms and the transferred title text uses a 
single style (the same font and type size), the title text aligns as closely as 
possible to its original position. The size of the text bounding box adjusts 
to accommodate the differences between the Macintosh and Windows 
versions of the font used. You might see a changed leading value in the 
Title Tool leading field to adjust for multiline text.

Because the Macintosh and Windows systems handle fonts differently, 
you might see variations in the appearance of titles between the two 
systems. 

For example, bounding boxes that were set on a Macintosh system might 
be different sizes on a Windows system. Some clipping of the new text 
might occur and words can be lost. If this clipping occurs, you need to 
open the title, select the text box, and manually change the size of the text 
box or the size of the fonts to display all the text. 

For more information on differences between the Macintosh and 
Windows versions of a font, contact the font manufacturer.

• If the titles are downstream key (DSK) graphics that include position 
changes set with keyframes, see “Turning Off Downstream Keys (DSK)” 
on page 1-36.

• If the original system used any applications to manipulate font display 
(such as Adobe Type Manager), the enhancements these applications 
provided on the original system (such as character anti-aliasing or 
character spacing) will not transfer to a system not using the application. 
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• For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.

R e d e f i n i n g  a  F o n t  R e p l a c e m e n t

You can redefine a font replacement at any time. However, your new font 
choice is applied only to a title currently in the Title tool and future 
replacements. It does not affect the font replacement information in titles that 
you have worked with previously.

Font relationships are saved as a “site” setting file named AvidFontSub.avt. 
This file is located in the Settings folder, which is located in the Symphony, 
Media Composer, Film Composer, or Avid Xpress folder on your internal 
drive. 

Once you have defined a font replacement, the Avid system uses that 
definition across all projects and all users of the system. If you want to switch 
to a different replacement font for a title, you must redefine the font 
replacement. 

n If you replace the font for a title and return that title to an Avid editing application on 
a Macintosh system, the new font information will be associated with the title. You 
must reapply the Macintosh font to restore the title to its original Macintosh style.

To redefine a font replacement:

1 Open a title in the Title tool.

2 Choose Font Replacement from the Object menu.

A dialog box appears. 

3 Choose the original font from the Unknown Fonts pop-up menu on the left.

4 Choose the replacement font you want to use from the Available Fonts pop-up 
menu on the right.

When you choose a font from the Available Fonts pop-up menu, a preview of that 
font appears in the text boxes.
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5 Click OK.

The system updates the font in the open title and records the new replacement 
information for future use.

T u r n i n g  O f f  D o w n s t r e a m  K e y s  ( D S K )

If you transfer a project that includes downstream key (DSK) graphics with 
position changes set with keyframes, position changes are ignored unless you 
turn off DSK. DSK was introduced in Media Composer Release 7.0 and 
Avid Xpress Release 2.0 (Macintosh).

n Turning off DSK is necessary only if you are moving from Media Composer or 
Film Composer Release 7.2 or Avid Xpress Release 2.x (Macintosh).

To turn off DSK for all such graphics in a sequence:

1 Load the sequence into the Record monitor.

2 Choose Console from the Tools menu. 

3 Type the following in the text box of the Console window:

MeridienDSK TRUE 

4 Press Enter.

n The command MeridienDSK False reverses this action and turns on DSK for all 
graphics that include position changes.

This procedure removes DSK from all mattes and keys that include position 
changes marked by keyframes.
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Step 7:  Render  Non-Real -Time Ef fects

You must render a non-real-time effect (an effect whose icon displays a blue 
dot) before it can be played. In addition, you must render some or all effects 
that exceed the real-time playback capabilities of the system to view the 
effects during playback. Occasionally, you might need to render an effect with 
a green dot in the Timeline, depending on the complexity of the sequence. 

n Preview your effects before rendering them to see if an effect did not import correctly.

To render multiple effects:

1 Click the track selector in the Timeline for each track with effects to be rendered.

2 Mark an IN point before the first effect to be rendered in your sequence; mark an 

OUT point after the last effect to be rendered.

3 Choose Render In/Out from the Clip menu.

4 (Optional) Select the quality of the effects. The default quality is Highest Quality. 
The effect quality applies only to effects that change the image size, such as 

Picture-in-Picture, Peel, and Squeeze.

5 If you do not want to render the real-time effects in the selected group of effects, 

select Skip Real-time Effects.

6 Click OK.
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This section includes instructions for moving work to Media Composer or 
Film Composer Release 10.0, 10.1 or 10.5 (Macintosh). 

Compat ib i l i ty  Issues

When you are moving projects to Media Composer or Film Composer 
Release 10.x (Macintosh), some products have direct compatibility while 
others do not, as described in the following sections.

C o m p a t i b i l i t y  w i t h  S y m p h o n y  R e l e a s e  3 . x

The following features (available in Symphony Release 3.x) require special 
attention:

• Color correction: Color adjustment does not appear in Release 10.x. You 
can, however, transfer a sequence from Symphony Release 3.x to 
Media Composer or Film Composer Release 10.x, and then back to 
Symphony Release 3.x, and the effect will remain in place. 

• Stabilize effect: This effect appears as an unknown effect in the Timeline 
in Release 10.x. You can, however, transfer a sequence from Symphony 
Release 3.x to Media Composer or Film Composer Release 10.x, and then 
back to Symphony Release 3.x, and the effect will remain in place.

• Motion tracking: Effects that are tracking enabled — such as the 
Symphony Warp effect, the Paint effect, the AniMatte effect, and the 
Scratch Removal feature — lose their tracking controls in Release 10.x. 
You can, however, transfer a sequence from Symphony Release 3.x to 
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Media Composer or Film Composer Release 10.x, and then back to 
Symphony Release 3.x, and the tracking data will remain intact.

• Ultimatte effect: This effect appears as an unknown effect in the Timeline 
in Release 10.x.

F i l m  P r o j e c t  C o m p a t i b i l i t y  B e t w e e n  
M e d i a C o m p o s e r  R e l e a s e  9 . 1  o r  1 0 . x ,  o r  
F i l m C o m p o s e r  R e l e a s e  1 0 . x  a n d  
F i l m C o m p o s e r  7 . 2  f o r  M a c i n t o s h

Note the following compatibility issues for film projects:

• 25-fps film projects (Release 10.x only): You can open all 25-fps film 
projects transferred from Film Composer Release 7.2 as 25p projects in 
Media Composer or Film Composer Release 10.x. You can also open any 
sequence from a 25-fps film project in a 25i project with matchback in 
Media Composer or Film Composer Release 10.x

• 24-fps PAL Method 1 film projects (Release 9.1 or 10.x): When you create 
a new Film Composer Release 7.2 project for PAL Method 1, choose Film 
options in the Project window and choose 24-frame editing. These options 
give you compatibility with a 24p PAL project for Media Composer or 
Film Composer Release 10.x.

n The default setting for a PAL film project with Film Composer Release 7.2 
(Macintosh) is 25-frame editing. You need to change to 24-frame editing to maintain 
compatibility with Symphony Release 2.1 and 3.x PAL projects.

C o m p a t i b i l i t y  w i t h  A v i d  V i d e o - E d i t i n g  
P r o d u c t s

Table 1-3 lists the products from which you can move project files to 
Media Composer or Film Composer Release 10.x (Macintosh) and their level 
of compatibility.
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Table 1-3 Moving Project Files to Media Composer or Film Composer 
Release 10.x (Macintosh)

Source 
Application

Compatibility with Media Composer or 
Film Composer Release 10.x (Macintosh)

Symphony 
Release 2.1 or 3.x

Compatible: Native Video, Native Audio, 
Compositions, Bins

Media Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
Release 9.1 
(Windows NT)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
Release 8.1 
(Macintosh)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: Native Audio, Compositions, Bins
Not Compatible: Native Video

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: Native Video, Native Audio, 
Compositions, Bins
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n Before beginning a project that you will be moving to Media Composer or 
Film Composer Release 10.x (Macintosh), set your audio file format to AIFF-C. This 
format allows the simplest method of transferring audio files between the two 
applications.

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Native Audio, Compositions, Bins
Not Compatible: Native Video

Avid Xpress DV 
Release 1.0, 1.5, or 
2.0 (Windows) 

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter XP 
Release 1.5 or 2.0

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

Table 1-3 Moving Project Files to Media Composer or Film Composer 
Release 10.x (Macintosh) (Continued)

Source 
Application

Compatibility with Media Composer or 
Film Composer Release 10.x (Macintosh)
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Moving the Project  F i les

To transfer project files to Media Composer or Film Composer Release 10.0, 
10.1, or 10.5 (Macintosh):

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and redigitize.

4 Import graphics.

5 Transfer or import audio files.

6 Re-create the title media.

7 Render non-real-time effects.

The following procedures detail each step in the transfer process. For more 
information, see the Media Composer and Film Composer documentation, 
the Avid Media Composer and Film Composer Help, and the appropriate 
documentation for your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for moving to 
Media Composer or Film Composer Release 10.0, 10.1, or 10.5 (Macintosh):

• AVX plug-ins: If your project contains AVX plug-in effects and you are 
moving across platforms, make sure the same plug-ins are available on 
both the Macintosh and Windows systems. If the same AVX plug-in effect 
is not available, the video media can be mixed down and imported as an 
OMFI file. 

If you do not create a mixdown, the effect will be identified as an 
unknown effect in Media Composer or Film Composer, and you will have 
to create a new effect.
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• Video media: Media compatibility with Media Composer or 
Film Composer Release 10.x (Macintosh) depends on the product from 
which you are moving video media:

Symphony 2.1 or 
3.x

There is direct video media compatibility.

Media Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility.

Film Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility.

Media Composer 
9.1 (Windows NT)

There is direct video media compatibility.

Media Composer 
8.1 (Macintosh)

There is direct video media compatibility.

Media Composer 
7.2

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media.

The OMFI file can then be imported into Media Composer or 
Film Composer Release 10.x (Macintosh) or the master clips can be 
imported directly from the OMFI MediaFiles folder. For more 
information, see the appropriate documentation for your product.

n Be aware that the import process might be slow and your media will lose some quality.

Avid Xpress 3.1 or 
4.x (Windows)

There is direct video media compatibility.
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Avid Xpress 4.0 
(Macintosh)

There is direct video media compatibility.

Avid Xpress 2.5
(Macintosh)

There is direct video media compatibility.

Avid Xpress 2.1 
(Macintosh)

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media.

The OMFI file can then be imported into Media Composer or 
Film Composer Release 10.x (Macintosh). Master clips can be imported 
directly from the OMFI MediaFiles folder. For more information, see the 
appropriate documentation for your product.

Avid Xpress DV 
1.0, 1.5, or 2.0 
(Windows)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter XP 
1.5 or 2.0

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter DV 
1.1, or 
NewsCutter 1.x or 
2.x

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Step 2:  Transfer  the Project  Informat ion

For the options to move your files from one system to another, see 
Appendix A.
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Step 3:  Open the Pro ject  and Redigi t ize 

If your media is not compatible, there are four options for redigitizing. You 
can:

• Redigitize existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Redigitize a sequence — provides a quick one-step process, but it limits 
your options during digitizing. You can make revisions using only 
assigned handles.

• Decompose the sequence and redigitize the new clips — digitizes only 
enough media to re-create the sequence, plus short handles for minor 
revisions. This method is more flexible than digitizing from the sequence 
because the new clips that are created can be sorted and selectively 
digitized. This method uses minimal storage and can be one of the fastest 
methods for redigitizing.

• Use the Show Reference Clips option — lets you reveal the source clips 
of a sequence, and then redigitize the clips. This method can be faster than 
the others depending on how the lengths of the original clips compare to 
the clips used in the sequence, and how the lengths of the new audio and 
video clips differ from the original master clips. Because two passes are 
necessary to digitize audio and video from a single source if the lengths 
are not the same, it is sometimes faster to digitize a slightly longer master 
clip than to digitize the new clips once for audio and once for video. 
However, this method uses more disk space and digitizing can take 
longer. This method also gives you more opportunity for revisions. It is a 
good compromise between digitizing all the original clips and digitizing 
only the clips needed to re-create the source.

For instructions on redigitizing, see your system’s documentation. 

Note the following requirements:

• When you redigitize from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 
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• If you redigitize a sequence, Avid recommends that you stop the 
digitizing process by clicking the Trash icon, and then reset the video 
levels.

• When you redigitize uncompressed media, Avid recommends that you 
store video and audio on different media drives. 

n If the incoming media is from the SDI (serial digital I/O) board, Media Composer or 
Film Composer ignores the video input settings.

Step 4:  Import  Graphics

You can use the Batch Import command from the Clip menu if your media 
originated from:

• Symphony Release 2.1 or 3.x (Windows)

• Media Composer Release 9.1 or 10.x, or Film Composer Release 10.x 
(Windows)

• Media Composer Release 8.1 (Macintosh)

• Media Composer or Film Composer Release 7.2 (Macintosh)

• Avid Xpress Release 3.1 or 4.x (Windows)

• Avid Xpress Release 4.x (Macintosh)

• Avid Xpress Release 2.5 (Macintosh)

• Avid Xpress Release 2.1 (Macintosh) 

• Avid Xpress DV Release 1.0, 1.5, or 2.0 (Windows)

The Batch Import command allows you to reimport master clips or sequences 
that contain imported material while automatically linking the newly 
imported material with the original master clips and sequences. When you 
play the sequence after batch importing the files, the newly imported material 
plays in it.
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c Batch importing requires your original source file. Do not delete the media 
files for imported files if the source files are no longer available, unless you 
will not need the material again.

When you batch import a media file, the entire media file, including all tracks, 
is reimported. For example, the reimport process will import both the video 
and audio from a source file, even if only the video track was imported into 
the sequence.

Here are two tips for making batch importing easier:

• Placing a “graphics” folder inside the project folder of your offline project 
makes the batch import process easier because the path will be the same, 
or at least faster to find.

• It is easy to edit revised graphics into your project by giving them the 
same names as the original graphics and by placing them in the same 
folder. You can also edit new graphics into your project by deleting the 
media for your original graphic, then batch importing your sequence and 
pointing the old graphics clips to the revised graphics files. 

n OMFI files can contain only one master clip when you batch import them.

Step 5:  Transfer  or  Import  Audio  F i les

For a detailed description of transferring audio files between Avid 
video-editing products, see Chapter 2.

Step 6:  Re-create  the  T i t le  Media

After you import all the files into your Media Composer or Film Composer 
Release 10.x (Macintosh) system, re-create the title media as follows:

1 Load the sequence containing the titles into the Record monitor.
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If the titles are not part of a sequence, select the titles in the bin, press and hold 

the Option key, and drag the selected group of titles into the Record or Composer 
monitor. A sequence containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s effects guide or Help.

2 Select all video tracks that contain titles.

3 Mark an IN point and an OUT point to include all of your titles.

4 Choose Recreate Title Media from the Clip menu.

- If you have the same font on both systems, the new font appears 
automatically.

Because the mapping process changes the exact appearance of the font, 
check your titles carefully. It might be easier to check your titles from the bin 
than from the sequence. See step 6.

- If a title opens and the system does not recognize the font, you will see a 
dialog box that allows you to substitute the font in the title for one that is 

installed on the system. 

This replacement establishes a relationship between the font used in the 
original title and the mapped font. For information on changing the font 
mapping, see “Redefining a Font Replacement” on page 1-49.

If more than one font in the title needs replacement, the dialog box will remain 
open after you click OK, and a new message will identify the next font that 
needs replacement. 

5 Choose a drive and resolution for the re-created title media.

6 If necessary, adjust the size of the bounding box, leading values, or kerning 
information. 

Note the following:

• If you are moving across platforms and the transferred title text uses a 
single style (the same font and type size), the title text aligns as closely as 
possible to its original position. The size of the text bounding box adjusts 
to accommodate the differences between Macintosh and Windows 
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versions of the font used. You might see a changed leading value in the 
Title Tool leading field to adjust for multiline text.

Because the Macintosh and Windows systems handle fonts differently, 
you might see variations in the appearance of titles between the two 
systems. 

For example, bounding boxes that were set on a Macintosh system might 
be different sizes on a Windows system. Some clipping of the new text 
might occur and words can be lost. If this clipping occurs, you need to 
open the title, select the text box, and manually change the size of the text 
box or the size of the fonts to display all the text. 

For more information on differences between the Macintosh and 
Windows versions of a font, contact the font manufacturer.

• If the original system used any applications to manipulate font display 
(such as Adobe Type Manager), the enhancements these applications 
provided on the original system (such as character anti-aliasing or 
character spacing) will not transfer to a system not using the application. 

• For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.

R e d e f i n i n g  a  F o n t  R e p l a c e m e n t

You can redefine a font replacement at any time. However, your new font 
choice is applied only to a title currently in the Title tool and future 
replacements. It does not affect the font replacement information in titles that 
you have worked with previously.

Font relationships are saved as a “site” setting file named AvidFontSub.avt. 
This file is located in the Settings folder, which is located in the Symphony, 
Media Composer, Film Composer, or Avid Xpress folder on your internal 
drive. 

Once you have defined a font replacement, the Avid system uses that 
definition across all projects and all users of the system. If you want to switch 
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to a different replacement font for a title, you must redefine the font 
replacement. 

n If you replace the font for a title on a Windows system and return that title to an Avid 
editing application on a Macintosh system, the new font information will be 
associated with the title. You must reapply the Macintosh font to restore the title to its 
original Macintosh style.

To redefine a font replacement:

1 Open a title in the Title tool.

2 Choose Font Replacement from the Object menu.

A dialog box appears. 

3 Choose the original font from the Unknown Fonts pop-up menu on the left.

4 Choose the replacement font you want to use from the Available Fonts pop-up 

menu on the right.

When you choose a font in the Available Fonts pop-up menu, a preview of that font 

appears in the text boxes.

5 Click OK.

The system updates the font in the open title and records the new replacement 
information for future use.

T u r n i n g  O f f  D o w n s t r e a m  K e y s  ( D S K )

If you transfer a project that includes downstream key (DSK) graphics with 
position changes set with keyframes, position changes are ignored unless you 
turn off DSK. DSK was introduced in Media Composer Release 7.0 and 
Avid Xpress Release 2.0 (Macintosh).

n Turning off DSK is necessary only if you are moving from Media Composer or 
Film Composer Release 7.2 or Avid Xpress Release 2.x (Macintosh).
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To turn off DSK for all such graphics in a sequence:

1 Load the sequence into the Record monitor.

2 Choose Console from the Tools menu. 

3 Type the following in the text box of the Console window:

MeridienDSK TRUE 

4 Press Enter.

n The command MeridienDSK False reverses this action and turns on DSK for all 
graphics that include position changes.

This procedure removes DSK from all mattes and keys that include position 
changes marked by keyframes.

Step 7:  Render  Non-Real -Time Ef fects

You must render a non-real-time effect (an effect whose icon displays a blue 
dot) before it can be played. In addition, you must render some or all effects 
that exceed the real-time playback capabilities of the system to view the 
effects during playback. Occasionally, you might also need to render an effect 
that displays a green dot in the Timeline, depending on the complexity of the 
sequence. For more information on render options, see the Avid 
Media Composer and Film Composer Effects Guide.

n Preview your effects before rendering them to see if the effects imported correctly.

To render multiple effects:

1 Click the track selector in the Timeline for each track with effects to be rendered.

2 Mark an IN point before the first effect to be rendered in your sequence; mark an 
OUT point after the last effect to be rendered.

3 Choose Render In/Out from the Clip menu.



1-52 Collaboration Guide

C h a p t e r  1
M O V I N G  T O  M E D I A  C O M P O S E R  O R  F I L M C O M P O S E R  R E L E A S E  1 0 . X  
F O R  M A C I N T O S H

1-52 Collaboration Guide

4 (Optional) Select the quality of the effects. The default quality is Highest Quality. 

The effect quality applies only to effects that change the image size, such as 
Picture-in-Picture, Peel, and Squeeze.

5 If you do not want to render the real-time effects in the selected group of effects, 
select Skip Real-time Effects.

6 Click OK.
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M o v i n g  t o  M e d i a  C o m p o s e r  R e l e a s e  8 . 1  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .f o r  M a c i n t o s h

This section includes instructions for moving work to Media Composer 
Release 8.1 (Macintosh). 

Compat ib i l i ty  Issues

When you are moving projects to Media Composer Release 8.1 (Macintosh), 
some products have direct compatibility while others do not, as described in 
the following sections.

C o m p a t i b i l i t y  w i t h  L a t e r  R e l e a s e s

If there are Intraframe effects (Paint and AniMatte) included in your 
Symphony Release 2.1 or 3.x, or Media Composer Release 9.1 or 10.x 
(Windows) sequence, the project will not open in Media Composer 
Release 8.1 (Macintosh). 

In addition, the following features (available in the following releases: 
Symphony Release 3.x, Media Composer and Film Composer Release 10.x, 
and Avid Xpress Release 4.x on both Windows and Macintosh) require special 
attention:

• Color correction (Symphony only): Color adjustment does not appear or 
becomes corrupted in Release 8.1. 

• Stabilize effect (Symphony only): This effect appears as an unknown 
effect in the Timeline and all data is lost in Release 8.1. 

• Motion tracking (Symphony only): Effects that are tracking enabled — 
such as the Symphony Warp effect, the Paint effect, the AniMatte effect, 
and the Scratch Removal feature — lose their tracking data in Release 8.1. 
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• Ultimatte effect (Symphony only): This effect appears as an unknown 
effect in the Timeline in Release 8.1.

• Defocus parameter in 3D effect (Symphony, Media Composer, 
Film Composer, Avid Xpress): Sequences containing the 3D Warp effect 
with defocus parameters will open, but the effect will use the parameters 
set under the Internal defocus pane and will ignore all other parameters.

• Reformat effects (Symphony, Media Composer, Film Composer): These 
effects appear as unknown effects in the Timeline in Release 8.1. 

• Real-time moving mattes (Symphony, Media Composer, 
Film Composer, Avid Xpress): Real-time moving mattes are converted to 
non-real-time Matte Key effects in Release 8.1.

• 25p editing (Symphony, Media Composer, Film Composer): 25p editing 
projects do not open in Release 8.1.

• MultiCamera editing (Symphony, Media Composer, Film Composer): 
MultiCamera resolutions 3:1 m, 4:1 m, 8:1 m, and 10:1 m are not 
compatible. The project will open, but the Timeline will display the 
“unsupported resolution” message. You can, however, redigitize the clips 
in another compatible resolution.

• Mixed audio sample rates (Symphony, Media Composer, 
Film Composer, Avid Xpress): Symphony Release 3.x, Media Composer 
and Film Composer Release 10.x, and Avid Xpress Release 4.x support the 
mixing of sample rates within the Timeline. Therefore, you must convert 
all clips to one sample rate before moving the project files to Release 8.1, 
which does not support mixed sample rates. For more information on 
converting sample rates, see “Converting Multiple Audio Sample Rates” 
on page 2-10.

• Simultaneous automation gain and clip gain volume adjustments 
(Symphony, Media Composer, Film Composer, Avid Xpress): Symphony 
Release 3.x, Media Composer and Film Composer Release 10.x, and 
Avid Xpress Release 4.x support simultaneous adjustment of volume by 
using both automation gain and clip gain (volume adjustment for the 
entire clip). Release 8.1 maintains the automation gain adjustments but 
ignores the clip gain adjustments.
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• AVX Version 1.5 plug-ins (Symphony, Media Composer, 
Film Composer, Avid Xpress): Release 8.1 supports AVX Version 1.0 
plug-ins, but does not support Version 1.5 of the AVX plug-ins. AVX 
Version 1.5 plug-in effects appear as unknown effects in Release 8.1.

C o m p a t i b i l i t y  w i t h  A v i d  V i d e o - E d i t i n g  
P r o d u c t s

Table 1-4 lists the products from which you can move project files to 
Media Composer Release 8.1 (Macintosh) and their level of compatibility.

Table 1-4 Moving Project Files to Media Composer Release 8.1 
(Macintosh)

Source 
Application

Compatibility with Media Composer Release 8.1 
(Macintosh)

Symphony 
Release 2.1 or 3.x

Compatible: Native Video, Native Audio, 
Compositions, Bins

Media Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
Release 9.1 
(Windows NT)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: Native Audio, Compositions, Bins
Not Compatible: Native Video
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n Before beginning a project that you will be moving to Media Composer Release 8.1 
(Macintosh), set your audio file format to AIFF-C. This format allows the simplest 
method of transferring audio files between the two applications.

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Native Audio, Compositions, Bins
Not Compatible: Native Video

Avid Xpress DV 
Release 1.0, 1.5, or 
2.0 (Windows)

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter XP 
Release 1.5 or 2.0

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

Table 1-4 Moving Project Files to Media Composer Release 8.1 
(Macintosh) (Continued)

Source 
Application

Compatibility with Media Composer Release 8.1 
(Macintosh)
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Moving the Project  F i les

To transfer project files to Media Composer 8.1 (Macintosh):

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and redigitize.

4 Import graphics.

5 Transfer or import audio files.

6 Re-create the title media.

7 Render non-real-time effects.

The following procedures detail each step in the transfer process. For more 
information, see the Media Composer documentation, the Avid 
Media Composer and Film Composer Help, and the appropriate 
documentation for your product.
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Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for moving to 
Media Composer Release 8.1 (Macintosh):

• AVX plug-ins: If your project contains AVX plug-in effects and you are 
moving across platforms, make sure the same plug-ins are available on 
both the Macintosh and Windows systems. If the same AVX plug-in effect 
is not available, the video media can be mixed down and imported as an 
OMFI file. This method only allows a maximum resolution equivalent to 
AVR 77. 

If you do not create a mixdown, the effect will be identified as an 
unknown effect in Media Composer, and you will have to create a new 
effect.

• Video media: Media compatibility with Media Composer Release 8.1 
(Macintosh) depends on the product from which you are moving video 
media:

Symphony 2.1 or 
3.x

There is direct video media compatibility.

Media Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility.

Film Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility.

Media Composer 
9.1 (Windows NT)

There is direct video media compatibility.

Media Composer 
7.2 (Macintosh)

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media.



. .
 . 

. .

Collaboration Guide 1-59

M O V I N G  T O  M E D I A  C O M P O S E R  R E L E A S E  8 . 1  F O R  M A C I N T O S H

The OMFI file can then be imported into Media Composer Release 8.1 
(Macintosh) or the master clips can be imported directly from the OMFI 
MediaFiles folder. For more information, see the appropriate 
documentation for your product.

n Be aware that the import process might be slow and your media will lose some quality.

Avid Xpress 3.1 or 
4.x (Windows)

There is direct video media compatibility.

Avid Xpress 4.x 
(Macintosh)

There is direct video media compatibility.

Avid Xpress 2.5
(Macintosh)

There is direct video media compatibility.

Avid Xpress 2.1 
(Macintosh)

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media.

The OMFI file can then be imported into Media Composer Release 8.1 
(Macintosh). Master clips can be imported directly from the OMFI 
MediaFiles folder. For more information, see the appropriate 
documentation for your product.

Avid Xpress DV 
1.0, 1.5, or 2.0 
(Windows)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter XP 
1.5 or 2.0

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter DV 
1.1, or 
NewsCutter 1.x or 
2.x

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.
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Step 2:  Transfer  the Project  Informat ion

For the options to move your files from one system to another, see 
Appendix A.

Step 3:  Open the Pro ject  and Redigi t ize 

If your media is not compatible, there are four options for redigitizing. You 
can:

• Redigitize existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Redigitize a sequence — provides a quick one-step process, but it limits 
your options during digitizing. You can make revisions using only 
assigned handles.

• Decompose the sequence and redigitize the new clips — digitizes only 
enough media to re-create the sequence, plus short handles for minor 
revisions. This method is more flexible than digitizing from the sequence 
because the new clips that are created can be sorted and selectively 
digitized. This method uses minimal storage and can be one of the fastest 
methods for redigitizing.

• Use the Show Reference Clips option — lets you reveal the source clips 
of a sequence, and then redigitize the clips. This method can be faster than 
the others depending on how the lengths of the original clips compare to 
the clips used in the sequence, and how the lengths of the new audio and 
video clips differ from the original master clips. Because two passes are 
necessary to digitize audio and video from a single source if the lengths 
are not the same, it is sometimes faster to digitize a slightly longer master 
clip than to digitize the new clips once for audio and once for video. 
However, this method uses more disk space and digitizing can take 
longer. This method also gives you more opportunity for revisions. It is a 
good compromise between digitizing all the original clips and digitizing 
only the clips needed to re-create the source.

For instructions on redigitizing, see your system’s documentation. 
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Note the following requirements:

• When you redigitize from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 

• If you redigitize a sequence, Avid recommends that you stop the 
digitizing process by clicking the Trash icon, and then reset the video 
levels.

• When you redigitize uncompressed media, Avid recommends that you 
store video and audio on different media drives. 

n If the incoming media is from the SDI (serial digital I/O) board, Media Composer 
ignores the video input settings.

Step 4:  Import  Graphics

You can use the Batch Import command from the Clip menu if your media 
originated from:

• Symphony Release 2.1 or 3.x (Windows)

• Media Composer Release 9.1 or 10.x, or Film Composer Release 10.x 
(Windows)

• Media Composer or Film Composer Release 10.x (Macintosh)

• Media Composer or Film Composer Release 7.2 (Macintosh)

• Avid Xpress Release 3.1 or 4.x (Windows)

• Avid Xpress Release 4.x (Macintosh)

• Avid Xpress Release 2.5 (Macintosh)

• Avid Xpress Release 2.1 (Macintosh) 

• Avid Xpress DV Release 1.0, 1.5, or 2.0 (Windows)
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The Batch Import command allows you to reimport master clips or sequences 
that contain imported material while automatically linking the newly 
imported material with the original master clips and sequences. When you 
play the sequence after batch importing the files, the newly imported material 
plays in it.

c Batch importing requires your original source file. Do not delete the media 
files for imported files if the source files are no longer available, unless you 
will not need the material again.

When you batch import a media file, the entire media file, including all tracks, 
is reimported. For example, the reimport process will import both the video 
and audio from a source file, even if only the video track was imported into 
the sequence.

Here are two tips for making batch importing easier:

• Placing a “graphics” folder inside the project folder of your offline project 
makes the batch import process easier because the path will be the same, 
or at least faster to find.

• It is easy to edit revised graphics into your project by giving them the 
same names as the original graphics and by placing them in the same 
folder. You can also edit new graphics into your project by deleting the 
media for your original graphic, then batch importing your sequence and 
pointing the old graphics clips to the revised graphics files. 

n OMFI files can contain only one master clip when you batch import them.
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Step 5:  Transfer  or  Import  Audio  F i les

For a detailed description of transferring audio files between Avid 
video-editing products, see Chapter 2.

Step 6:  Re-create  the  T i t le  Media

After you import all the files into your Media Composer Release 8.1 
(Macintosh) system, re-create the title media as follows:

1 Choose Compression from the Tools menu and choose the video resolution you 
want to use for the re-created title media.

2 Open the bin or project. 

3 Load the sequence containing the titles into the Record monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 
the Option key, and drag the selected group of titles into the Record or Composer 

monitor. A sequence containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s effects guide or Help.

4 Select all video tracks that contain titles.

5 Mark an IN point and an OUT point to include all of your titles.

6 Choose Recreate Title Media from the Clip menu.

- If you have the same font on both systems, the new font appears 
automatically.

Because the mapping process changes the exact appearance of the font, 
check your titles carefully. It might be easier to check your titles from the bin 
than from the sequence. See step 7.

- If a title opens and the system does not recognize the font, you will see a 
dialog box that allows you to substitute the font in the title for one that is 
installed on the system. 
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This replacement establishes a relationship between the font used in the 
original title and the mapped font. For information on changing the font 
mapping, see “Redefining a Font Replacement” on page 1-65.

If more than one font in the title needs replacement, the dialog box will remain 
open after you click OK, and a new message will identify the next font that 
needs replacement. The dialog box closes when you have defined a font for 
each font that needs replacement.

7 If necessary, adjust the size of the bounding box, leading values, or kerning 
information. 

Note the following:

• If you are moving across platforms and the transferred title text uses a 
single style (the same font and type size), the title text aligns as closely as 
possible to its original position. The size of the text bounding box adjusts 
to accommodate the differences between Macintosh and Windows 
versions of the font used. You might see a changed leading value in the 
Title Tool leading field to adjust for multiline text.

Because the Macintosh and Windows systems handle fonts differently, 
you might see variations in the appearance of titles between the two 
systems. 

For example, bounding boxes that were set on a Macintosh system might 
be different sizes on a Windows system. Some clipping of the new text 
might occur and words can be lost. If this clipping occurs, you need to 
open the title, select the text box, and manually change the size of the text 
box or the size of the fonts to display all the text. 

For more information on differences between the Macintosh and 
Windows versions of a font, contact the font manufacturer.

• If the original system used any applications to manipulate font display 
(such as Adobe Type Manager), the enhancements these applications 
provided on the original system (such as character anti-aliasing or 
character spacing) will not transfer to a system not using the application. 

• For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.



. .
 . 

. .

Collaboration Guide 1-65

M O V I N G  T O  M E D I A  C O M P O S E R  R E L E A S E  8 . 1  F O R  M A C I N T O S H

R e d e f i n i n g  a  F o n t  R e p l a c e m e n t

You can redefine a font replacement at any time. However, your new font 
choice is applied only to a title currently in the Title tool and future 
replacements. It does not affect the font replacement information in titles that 
you have worked with previously.

Font relationships are saved as a “site” setting file named AvidFontSub.avt. 
This file is located in the Settings folder, which is located in the Symphony, 
Media Composer, or Avid Xpress folder on your internal drive. 

Once you have defined a font replacement, the Avid system uses that 
definition across all projects and all users of the system. If you want to switch 
to a different replacement font for a title, you must redefine the font 
replacement. 

n If you replace the font for a title on a Windows system and return that title to an Avid 
editing application on a Macintosh system, the new font information will be 
associated with the title. You must reapply the Macintosh font to restore the title to its 
original Macintosh style.

To redefine a font replacement:

1 Open a title in the Title tool.

2 Choose Font Replacement from the Object menu.

A dialog box appears. 

3 Choose the original font from the Unknown Fonts pop-up menu on the left.

4 Choose the replacement font you want to use from the Available Fonts pop-up 
menu on the right.

When you choose a font in the Available Fonts pop-up menu, a preview of that font 
appears in the text boxes.

5 Click OK.

The system updates the font in the open title and records the new replacement 
information for future use.
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T u r n i n g  O f f  D o w n s t r e a m  K e y s  ( D S K )

If you transfer a project that includes downstream key (DSK) graphics with 
position changes set with keyframes, position changes are ignored unless you 
turn off DSK. DSK was introduced in Media Composer Release 7.0 and 
Avid Xpress Release 2.0 (Macintosh).

n Turning off DSK is necessary only if you are moving from Media Composer or 
Film Composer Release 7.2 or Avid Xpress Release 2.x (Macintosh).

To turn off DSK for all such graphics in a sequence:

1 Load the sequence into the Record monitor.

2 Choose Console from the Tools menu. 

3 Type the following in the text box of the Console window:

MeridienDSK TRUE 

4 Press Return.

n The command MeridienDSK False reverses this action and turns on DSK for all 
graphics that include position changes.

This procedure removes DSK from all mattes and keys that include position 
changes marked by keyframes.
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Step 7:  Render  Non-Real -Time Ef fects

You must render a non-real-time effect (an effect whose icon displays a blue 
dot) before it can be played. In addition, you must render some or all effects 
that exceed the real-time playback capabilities of the system to view the 
effects during playback. Occasionally, you might also need to render an effect 
that displays a green dot in the Timeline, depending on the complexity of the 
sequence. For more information on render options, see the Avid 
Media Composer and Film Composer Effects Guide.

n Preview your effects before rendering them to see if the effects imported correctly.

To render multiple effects:

1 Click the track selector in the Timeline for each track with effects to be rendered.

2 Mark an IN point before the first effect to be rendered in your sequence; mark an 
OUT point after the last effect to be rendered.

3 Choose Render In/Out from the Clip menu.

4 (Optional) Select the quality of the effects. The default quality is Highest Quality. 
The effect quality applies only to effects that change the image size, such as 
Picture-in-Picture, Peel, and Squeeze.

5 If you do not want to render the real-time effects in the selected group of effects, 
select Skip Real-time Effects.

6 Click OK.
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This section includes instructions for moving work to Media Composer or 
Film Composer Release 7.2 (Macintosh). 

n In general, the same issues apply to Media Station Release 7.2 (Macintosh).

Compat ib i l i ty  Issues

When you are moving projects to Media Composer or Film Composer Release 
7.2 (Macintosh), some products have direct compatibility while others do not, 
as described in the following sections.

C o m p a t i b i l i t y  w i t h  L a t e r  R e l e a s e s

If there are Intraframe effects (Paint and AniMatte) included in your 
Symphony Release 2.1 or 3.x, or Media Composer Release 9.1 or 10.x 
(Windows) sequence, the project will not open in Media Composer or 
Film Composer Release 7.2 (Macintosh). 

In addition, the following features (available in the following releases: 
Symphony Release 3.x, Media Composer and Film Composer Release 10.x, 
and Avid Xpress Release 4.x on both Windows and Macintosh) require special 
attention:

• Color correction (Symphony only): Color adjustment does not appear or 
becomes corrupted in Release 7.2. 

• Stabilize effect (Symphony only): This effect appears as an unknown 
effect in the Timeline and all data is lost in Release 7.2. 
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• Motion tracking (Symphony only): Effects that are tracking enabled — 
such as the Symphony Warp effect, the Paint effect, the AniMatte effect, 
and the Scratch Removal feature — lose their tracking data in Release 7.2. 

• Ultimatte effect (Symphony only): This effect appears as an unknown 
effect in the Timeline in Release 7.2. 

• Defocus parameter in 3D effect (Symphony, Media Composer, 
Film Composer, Avid Xpress): Sequences containing the 3D Warp effect 
with defocus parameters will open, but the effect will use the parameters 
set under the Internal defocus pane and will ignore all other parameters.

• Reformat effects (Symphony, Media Composer, Film Composer): These 
effects appear as unknown effects in the Timeline in Release 7.2. 

• Pan and Scan effects (Symphony, Media Composer, Film Composer): 
These effects appear as unknown effects in the Timeline in Release 7.2. 

• Real-time moving mattes (Symphony, Media Composer, 
Film Composer, Avid Xpress): Real-time moving mattes are converted to 
non-real-time Matte Key effects in Release 7.2.

• 25p editing (Symphony, Media Composer, Film Composer): 25p editing 
projects do not open in Release 7.2.

• MultiCamera editing (Symphony, Media Composer, Film Composer): 
MultiCamera resolutions 3:1 m, 4:1 m, 8:1 m, and 10:1 m are not 
compatible. The project will open, but the Timeline will display the 
“unsupported resolution” message. You can, however, redigitize the clips 
in another compatible resolution.

• Mixed audio sample rates (Symphony, Media Composer, 
Film Composer, Avid Xpress): Symphony Release 3.x, Media Composer 
and Film Composer Release 10.x, and Avid Xpress Release 4.x support the 
mixing of sample rates within the Timeline. Therefore, you must convert 
all clips to one sample rate before moving the project files to Release 7.2, 
which does not support mixed sample rates. For more information on 
converting sample rates, see “Converting Multiple Audio Sample Rates” 
on page 2-10.
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• Simultaneous automation gain and clip gain volume adjustments 
(Symphony, Media Composer, Film Composer, Avid Xpress): Symphony 
Release 3.x, Media Composer and Film Composer Release 10.x, and 
Avid Xpress Release 4.x support simultaneous adjustment of volume by 
using both automation gain and clip gain (volume adjustment for the 
entire clip). Release 7.2 maintains the automation gain adjustments but 
ignores the clip gain adjustments.

• AVX Version 1.5 plug-ins (Symphony, Media Composer, 
Film Composer, Avid Xpress): Release 7.2 supports AVX Version 1.0 
plug-ins, but does not support Version 1.5 of the AVX plug-ins. AVX 
Version 1.5 plug-in effects appear as unknown effects in Release 7.2.

F i l m  P r o j e c t  C o m p a t i b i l i t y  B e t w e e n  
M e d i a C o m p o s e r 9 . 1  o r  1 0 . x ,  o r  
F i l m C o m p o s e r  R e l e a s e  1 0 . x  a n d  
F i l m C o m p o s e r  7 . 2

Note the following compatibility issues for film projects:

• 25-fps film projects (Release 10.x only): You can open all 25-fps film 
projects from Release 7.2 as 25p projects in Media Composer or 
Film Composer Release 10.x. You can also open any sequence from a 
25-fps film project in a 25i project with matchback in Media Composer or 
Film Composer Release 10.x.

• 24-fps PAL Method 1 film projects (Release 9.1 or 10.x): When you create 
a new Film Composer Release 7.2 project for PAL Method 1, choose Film 
options in the Project window and be sure to choose 24-frame editing. 
This will give you compatibility with a 24p PAL project for 
Media Composer Release 9.1 and 10.x, or Film Composer Release 10.x.

n The default setting for a PAL film project with Film Composer Release 7.2 is 25-frame 
editing. You need to change to 24-frame editing to maintain compatibility with 
Symphony Release 2.1 and 3.x PAL projects.
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P r o d u c t s

Table 1-5 lists the products from which you can move project files to 
Media Composer or Film Composer Release 7.2 (Macintosh) and their level of 
compatibility.

Table 1-5 Moving Project Files to Media Composer or Film Composer 
Release 7.2 (Macintosh)

Source 
Application

Compatibility with Media Composer or 
Film Composer Release 7.2 (Macintosh)

Symphony 
Release 2.1 or 3.x

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video

Media Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Audio (AIFF-C and WAVE), 
Compositions, Bins
Not Compatible: Native Video

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Audio (AIFF-C and WAVE), 
Compositions, Bins
Not Compatible: Native Video

Media Composer 
Release 9.1 
(Windows NT)

Compatible: Native Audio (AIFF-C and WAVE), 
Compositions, Bins
Not Compatible: Native Video

Media Composer 
Release 8.1 
(Macintosh)

Compatible: Bins, Compositions, Native Audio 
(AIFF-C and Sound Designer II)
Not Compatible: Native Video

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video
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Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Bins, Compositions, Native Audio 
(AIFF-C and Sound Designer II)
Not Compatible: Native Video

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Bins, Compositions, Native Video, 
Native Audio

Avid Xpress DV 
Release 1.0, 1.5, or 
2.0 (Windows) 

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video

NewsCutter XP 
Release 1.5 or 2.0

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video

Table 1-5 Moving Project Files to Media Composer or Film Composer 
Release 7.2 (Macintosh) (Continued)

Source 
Application

Compatibility with Media Composer or 
Film Composer Release 7.2 (Macintosh)
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Moving the Project  F i les

To transfer project files to Media Composer or Film Composer Release 7.2 
(Macintosh):

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and redigitize.

4 Import graphics.

5 Transfer or import audio files.

6 Re-create the title media.

7 Render non-real-time effects.

The following procedures detail each step in the transfer process. For more 
information, see the Media Composer or Film Composer documentation, the 
Avid Media Composer and Film Composer Help, and the appropriate 
documentation for your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for export to 
Media Composer or Film Composer Release 7.2 (Macintosh):

• AVX plug-ins: If your project contains AVX plug-in effects and you are 
moving across platforms, make sure the same plug-ins are available on 
both the Macintosh and Windows systems. If the same AVX plug-in effect 
is not available, the video media can be mixed down and imported as an 
OMFI file. This method only allows a maximum resolution equivalent to 
AVR 77. 

If you do not create a mixdown, the effect will be identified as an 
unknown effect in Media Composer or Film Composer, and you will have 
to create a new effect.
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• Video media: Media compatibility with Media Composer or 
Film Composer Release 7.2 depends on the product from which you are 
moving video media:

Symphony 2.1 or 
3.x

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Media Composer 
10.x (Windows 
and Macintosh)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Film Composer 
10.x (Windows 
and Macintosh)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Media Composer 
9.1 (Windows NT)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Media Composer 
8.1 (Macintosh)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Avid Xpress 3.1 or 
4.x (Windows)

There is no direct video media compatibility. The bins are compatible, but
you must redigitize your media.

Avid Xpress 4.x 
(Macintosh)

There is no direct video media compatibility. The bins are compatible, but
you must redigitize your media.

Avid Xpress 2.5 
(Macintosh)

There is no direct video media compatibility. The bins are compatible, but
you must redigitize your media.

Avid Xpress 2.1 
(Macintosh)

There is direct video media compatibility.

Avid Xpress DV 
1.0, 1.5, or 2.0 
(Windows)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.
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NewsCutter XP 
1.5 or 2.0

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter DV 
1.1, or 
NewsCutter 1.x or 
2.x

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Step 2:  Transfer  the Project  Informat ion

For the options to move your files from one system to another, see 
Appendix A.

Step 3:  Open the Pro ject  and Redigi t ize 

If your media is not compatible, there are four options for redigitizing. You 
can:

• Redigitize existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Redigitize a sequence — provides a quick one-step process, but it limits 
your options during digitizing. You can make revisions using only 
assigned handles.

• Decompose the sequence and redigitize the new clips — digitizes only 
enough media to re-create the sequence, plus short handles for minor 
revisions. This method is more flexible than digitizing from the sequence 
because the new clips that are created can be sorted and selectively 
digitized. This method uses minimal storage and can be one of the fastest 
methods for redigitizing.

• Use the Show Reference Clips option — lets you reveal the source clips 
of a sequence, and then redigitize the clips. This method can be faster than 
the others depending on how the lengths of the original clips compare to 
the clips used in the sequence, and how the lengths of the new audio and 
video clips differ from the original master clips. Because two passes are 
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necessary to digitize audio and video from a single source if the lengths 
are not the same, it is sometimes faster to digitize a slightly longer master 
clip than to digitize the new clips once for audio and once for video. 
However, this method uses more disk space and digitizing can take 
longer. This method also gives you more opportunity for revisions. It is a 
good compromise between digitizing all the original clips and digitizing 
only the clips needed to re-create the source.

For instructions on redigitizing, see your system’s documentation. 

Note the following requirements:

• When you redigitize from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 

• If you redigitize a sequence, Avid recommends that you stop the 
digitizing process by clicking the Trash icon, and then reset the video 
levels.

• When you redigitize uncompressed media, Avid recommends that you 
store video and audio on different media drives. 

n If the incoming media is from the SDI (serial digital I/O) board, Media Composer and 
Film Composer ignore the video input settings.

Step 4:  Import  Graphics

For a detailed description of importing graphics and effects files into Avid 
video-editing products, see Chapter 3.

Step 5:  Transfer  or  Import  Audio  F i les

For a detailed description of transferring audio files between Avid 
video-editing products, see Chapter 2.
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Step 6:  Re-create  the  T i t le  Media

After you import all the files into your Media Composer or Film Composer 
Release 7.2 (Macintosh) system, re-create the title media as follows:

1 Choose Compression from the Tools menu and choose the video resolution you 
want to use for the re-created title media.

2 Open the bin or project. 

3 Load the sequence containing the titles into the Record monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 
the Option key, and drag the selected group of titles into the Record monitor. A 

sequence containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s effects guide or Help.

4 Select all video tracks that contain titles.

5 Mark an IN point and an OUT point to include all of your titles.

6 Choose Recreate Title Media from the Clip menu.

7 If necessary, adjust the size of the bounding box, leading values, or kerning 
information. 

Note the following:

• If the original system used any applications to manipulate font display 
(such as Adobe Type Manager), the enhancements these applications 
provided on the original system (such as character anti-aliasing or 
character spacing) will not transfer to a system not using the application.

• For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.
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Step 7:  Render  Non-Real -Time Ef fects

You must render a non-real-time effect (an effect whose icon displays a blue 
dot) before it can be played. In addition, you must render some or all effects 
that exceed the real-time playback capabilities of the system to view the 
effects during playback. Occasionally, you might also need to render an effect 
that displays a green dot in the Timeline, depending on the complexity of the 
sequence. 

n Preview your effects before rendering them to see if the effects imported correctly.

To render multiple effects:

1 Click the track selector in the Timeline for each track with effects to be rendered.

2 Mark an IN point before the first effect to be rendered in your sequence; mark an 
OUT point after the last effect to be rendered.

3 Choose Render In/Out from the Clip menu.

4 (Optional) Select the quality of the effects. The default quality is Highest Quality. 

The effect quality applies only to effects that change the image size, such as 
Picture-in-Picture, Peel, and Squeeze.

5 If you do not want to render the real-time effects in the selected group of effects, 
select Skip Real-time Effects.

6 Click OK.



. .
 . 

. .

Collaboration Guide 1-79

M O V I N G  T O  AV I D X P R E S S  R E L E A S E  3 . 1  O R  4 . X  F O R  W I N D O W S

M o v i n g  t o  A v i d X p r e s s  R e l e a s e  3 . 1  o r  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4 . x  f o r  W i n d o w s

This section includes instructions for moving work to Avid Xpress Release 3.1, 
4.0, 4.1, or 4.5 (Windows). 

Compat ib i l i ty  Issues

When you are moving projects to Avid Xpress Release 3.1 or 4.x (Windows), 
some products have direct compatibility while others do not, as described in 
the following sections.

C o m p a t i b i l i t y  B e t w e e n  A v i d  X p r e s s  
R e l e a s e 3 . 1  a n d  R e l e a s e  4 . x  f o r  W i n d o w s

In general, there is compatibility going from Avid Xpress Release 3.1 to 
Release 4.x; you can move audio, video, compositions, and bins from 
Release 3.1 to Release 4.x. However, when you move projects backward from 
Release 4.x to Release 3.1, some features, especially new features in Release 4.0 
or later, require special attention. The following list includes known features 
in this category:

• Real-time moving mattes: Real-time moving mattes are converted to non-
real-time Matte Key effects in Release 3.1.

• Mixed audio sample rates: Release 3.1 supports the mixing of sample 
rates within the Timeline. Therefore, you must convert all clips to one 
sample rate before moving the project files to Release 3.1, which does not 
support mixed sample rates. For more information on converting sample 
rates, see “Converting Multiple Audio Sample Rates” on page 2-10.
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• Simultaneous automation gain and clip gain volume adjustments: 
Release 4.0 supports the simultaneous adjustment of volume by using 
both automation gain and clip gain (volume adjustment for the entire 
clip). Release 3.1 maintains the automation gain adjustments but ignores 
the clip gain adjustments.

C o m p a t i b i l i t y  w i t h  L a t e r  R e l e a s e s  o f  
S y m p h o n y ,  M e d i a  C o m p o s e r ,  o r  
F i l m C o m p o s e r

The following features (available in Symphony Release 3.x and 
Media Composer or Film Composer Release 10.x on both Windows and 
Macintosh) require special attention when moving to Avid Xpress Release 3.1 
or 4.x (Windows):

• Color correction (Symphony only): Color adjustment does not appear in 
Avid Xpress Release 3.1 or 4.x. In addition, controls for secondary color 
correction do not appear. You can, however, transfer a sequence from 
Symphony Release 3.x to Avid Xpress Release 3.1 or 4.x, and then back to 
Symphony Release 3.x, and the effect will remain in place.

• Stabilize effect (Symphony only): This effect appears as an unknown 
effect in the Timeline and all data is lost in Avid Xpress Release 3.1. You 
can, however, transfer a sequence from Symphony Release 3.x to 
Avid Xpress Release 4.x, and then back to Symphony Release 3.x, and the 
effect will remain in place.

• Motion tracking (Symphony only): Effects that are tracking enabled — 
such as the Symphony Warp effect, the Paint effect, the AniMatte effect, 
and the Scratch Removal feature — lose their tracking data in Avid Xpress 
Release 3.1. You can, however, transfer a sequence from Symphony 
Release 3.x to Avid Xpress Release 4.x, and then back to Symphony 
Release 3.x, and the tracking data will remain in place.
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• Ultimatte effect (Symphony only): This effect appears as an unknown 
effect in the Timeline in Avid Xpress Release 3.1 or 4.x. You can, however, 
transfer a sequence from Symphony Release 3.x to Avid Xpress 
Release 3.1 or 4.x, and then back to Symphony Release 3.x, and the effect 
will remain in place.

• Defocus parameter in 3D effect (Symphony, Media Composer, 
Film Composer): Sequences containing the 3D Warp effect with defocus 
parameters will open, but the effect will use the parameters set under the 
Internal defocus pane and will ignore all other parameters.

• Reformat effects (Symphony, Media Composer, Film Composer): These 
effects appear as unknown effects in the Timeline in Release 2.0. 

• Pan and Scan effects (Symphony, Media Composer, Film Composer): 
These effects appear as unknown effects in the Timeline in Release 2.0. 

• 25p editing (Symphony, Media Composer, Film Composer): 25p editing 
projects do not open in Avid Xpress.

• MultiCamera editing (Symphony, Media Composer, Film Composer): 
MultiCamera resolutions 3:1 m, 4:1 m, 8:1 m, and 10:1 m are not 
compatible. The project will open, but the Timeline will display the 
“unsupported resolution” message. You can, however, redigitize the clips 
in another compatible resolution.
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C o m p a t i b i l i t y  w i t h  A v i d  V i d e o - E d i t i n g  
P r o d u c t s

Table 1-6 lists the products from which you can move project files to 
Avid Xpress Release 3.1 or 4.x (Windows) and their level of compatibility.

Table 1-6 Moving Project Files to Avid Xpress Release 3.1 or 4.x 
(Windows)

Source 
Application

Compatibility with Avid Xpress Release 3.1 or 4.x 
(Windows)

Symphony 
Release 2.1 or 3.x

Compatible: Native Video, Native Audio, 
Compositions, Bins

Media Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
Release 9.1 
(Windows NT)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
Release 8.1 
(Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins
Not Compatible: Sound Designer II Audio

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: Native Audio (AIFF-C only), 
Compositions, Bins
Not Compatible: Native Video

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins
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To transfer project files to Avid Xpress Release 3.1 or 4.x (Windows):

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and redigitize.

4 Import graphics.

5 Transfer or import audio files.

6 Re-create the title media.

7 Render non-real-time effects.

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins
Not Compatible: Sound Designer II Audio

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Native Audio (AIFF-C only), 
Compositions, Bins
Not Compatible: Native Video

Avid Xpress DV 
Release 1.0, 1.5, or 
2.0 (Windows) 

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter XP 
Release 1.5 or 2.0

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

Table 1-6 Moving Project Files to Avid Xpress Release 3.1 or 4.x 
(Windows) (Continued)

Source 
Application

Compatibility with Avid Xpress Release 3.1 or 4.x 
(Windows)
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The following procedures detail each step in the transfer process. For more 
information, see the Avid Xpress User’s Guide, the Avid Xpress Help, and the 
appropriate documentation for your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for moving to 
Avid Xpress Release 3.1 or 4.x (Windows):

• AVX plug-ins: If your project contains AVX plug-in effects and you are 
moving across platforms, make sure the same plug-ins are available on 
both the Macintosh and Windows systems. If the same AVX plug-in effect 
is not available, the video media can be mixed down and imported as an 
OMFI file. This method allows a maximum resolution of 1:1 from 
Media Composer Release 8.1 (Macintosh) or Symphony Release 1.1, and 
allows a maximum resolution of 2:1 from Media Composer or Film 
Composer Release 7.2 (Macintosh), or Avid Xpress Release 2.1 
(Macintosh), which is equivalent to AVR 77. 

If you do not create a mixdown, the effect will be identified as an 
unknown effect in Avid Xpress Release 3.1 or 4.x (Windows), and you will 
have to create a new effect.

• Video media: Media compatibility with Avid Xpress Release 3.1 or 4.x 
(Windows) depends on the product from which you are moving video 
media:

Symphony 2.1 or 
3.x

There is direct video media compatibility. 

Media Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility.

Film Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility.
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Media Composer 
9.1 (Windows NT)

There is direct video media compatibility.

Media Composer 
8.1 (Macintosh)

There is direct video media compatibility. 

Media Composer 
or Film Composer 
7.2 (Macintosh)

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media. 

The OMFI file can then be imported into Avid Xpress Release 3.1 or 4.x 
(Windows) or the master clips can be imported directly from the OMFI 
MediaFiles folder. For more information, see the appropriate 
documentation for your product.

Avid Xpress 4.x 
(Macintosh)

There is direct video media compatibility.

Avid Xpress 2.5 
(Macintosh)

There is direct video media compatibility. 

Avid Xpress 2.1 
(Macintosh)

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only,
OMFI 1.0, With Media. 

The OMFI file can then be imported into Avid Xpress Release 3.1 or 4.x 
(Windows) or the master clips can be imported directly from the OMFI 
MediaFiles folder. For more information, see the appropriate 
documentation for your product.

Avid Xpress DV 
1.0, 1.5, or 2.0
(Windows)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter XP 
1.5 or 2.0

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.
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NewsCutter DV 
1.1, or 
NewsCutter 1.x or 
2.x

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Step 2:  Transfer  the Project  Informat ion

For the options to move your files from one system to another, see
Appendix A.

Step 3:  Open the Pro ject  and Redigi t ize

If your media is not compatible, there are three options for redigitizing. You 
can:

• Redigitize existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Redigitize a sequence — provides a quick one-step process, but it limits 
your options during digitizing. You can make revisions using only 
assigned handles.

• Use the Show Reference Clips option — lets you reveal the source clips 
of a sequence, and then redigitize the clips. This method can be faster than 
the others depending on how the lengths of the original clips compare to 
the clips used in the sequence, and how the lengths of the new audio and 
video clips differ from the original master clips. Because two passes are 
necessary to digitize audio and video from a single source if the lengths 
are not the same, it is sometimes faster to digitize a slightly longer master 
clip than to digitize the new clips once for audio and once for video. 
However, this method uses more disk space and digitizing can take 
longer. This method also gives you more opportunity for revisions. It is a 
good compromise between digitizing all the original clips and digitizing 
only the clips needed to re-create the source.

For instructions on redigitizing, see your system’s documentation. 
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Note the following requirements:

• When you redigitize from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 

• If you redigitize a sequence, Avid recommends that you stop the 
digitizing process by clicking the Trash icon, and then reset the video 
levels.

• When you redigitize uncompressed media, Avid recommends that you 
store video and audio on different media drives. 

n If the incoming media is from the SDI (serial digital I/O) board, Avid Xpress ignores 
the video input settings.

Step 4:  Import  Graphics

You can use the Batch Import command from the Clip menu if your media 
originated from:

• Symphony Release 2.1 or 3.x (Windows)

• Media Composer Release 9.1 or 10.x, or Film Composer Release 10.x 
(Windows)

• Media Composer or Film Composer Release 10.x (Macintosh)

• Media Composer Release 8.1 (Macintosh)

• Media Composer or Film Composer Release 7.2 (Macintosh)

• Avid Xpress Release 4.x (Macintosh)

• Avid Xpress Release 2.5 (Macintosh)

• Avid Xpress Release 2.1 (Macintosh) 

• Avid Xpress DV Release 1.0, 1.5, or 2.0 (Windows)
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The Batch Import command allows you to reimport master clips or sequences 
that contain imported material while automatically linking the newly 
imported material with the original master clips and sequences. When you 
play the sequence after batch importing the files, the newly imported material 
plays in it.

c Batch importing requires your original source file. Do not delete the media 
files for imported files if the source files are no longer available, unless you 
will not need the material again.

When you batch import a media file, the entire media file, including all tracks, 
is reimported. For example, the reimport process will import both the video 
and audio from a source file, even if only the video track was used in the 
sequence.

Here are two tips for making batch importing easier:

• Placing a “graphics” folder inside the project folder of your offline project 
makes the batch import process easier because the path will be the same, 
or at least faster to find.

• It is easy to edit revised graphics into your project by giving them the 
same names as the original graphics and by placing them in the same 
folder. You can also edit new graphics into your project by deleting the 
media for your original graphic, then batch importing your sequence and 
pointing the old graphics clips to the revised graphics files. 

n OMFI files can contain only one master clip when you batch import them.

n OMFI master clips that have been consolidated cannot be batch imported.
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Step 5:  Transfer  or  Import  Audio  F i les

For a detailed description of transferring audio files between Avid 
video-editing products, see Chapter 2.

Step 6:  Re-create  the  T i t le  Media

After you import all the files into your Avid Xpress Release 3.1 or 4.x 
(Windows) system, re-create the title media as follows:

1 Open the bin or project.

2 For Avid Xpress Release 3.1 or earlier, choose Compression from the Tools menu 

and choose the video resolution you want to use for the re-created title media.

n For Avid Xpress Release 4.x, choosing the video resolution is a later step.

3 Load the sequence containing the titles into the Composer monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 

the Alt key, and drag the selected group of titles into the Composer monitor. A 
sequence containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s effects guide or Help.

4 Select all video tracks that contain titles.

5 Mark an IN point and an OUT point to include all of your titles.

6 Choose Re-create Title Media from the Clip menu.

- If you have the same font on both systems, the new font appears 
automatically.

Because the mapping process changes the exact appearance of the font, 
check your titles carefully. It might be easier to check your titles from the bin 
than from the sequence. See step 8.

- If a title opens and the system does not recognize the font, you will see a 
dialog box that allows you to substitute the font in the title for one that is 

installed on the system. 
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This replacement establishes a relationship between the font used in the 
original title and the mapped font. For information on changing the font 
mapping, see “Redefining a Font Replacement” on page 1-91.

If more than one font in the title needs replacement, the dialog box will remain 
open after you click OK, and a new message will identify the next font that 
needs replacement. 

7 For Avid Xpress Release 4.x, choose a drive and resolution for the re-created title 
media.

8 If necessary, adjust the size of the bounding box, leading values, or kerning 
information. 

Note the following:

• If you are moving across platforms and the transferred title text uses a 
single style (the same font and type size), the title text aligns as closely as 
possible to its original position. The size of the text bounding box adjusts 
to accommodate the differences between the Macintosh and Windows 
versions of the font used. You might see a changed leading value in the 
Title Tool leading field to adjust for multiline text.

Because the Macintosh and Windows systems handle fonts differently, 
you might see variations in the appearance of titles between the two 
systems. 

For example, bounding boxes that were set on a Macintosh system might 
be different sizes on a Windows system. Some clipping of the new text 
might occur and words can be lost. If this clipping occurs, you need to 
open the title, select the text box, and manually change the size of the text 
box or the size of the fonts to display all the text. 

For more information on differences between the Macintosh and 
Windows versions of a font, contact the font manufacturer.

• If the titles are downstream key (DSK) graphics that include position 
changes set with keyframes, see “Redefining a Font Replacement” on 
page 1-91.

• If the original system used any applications to manipulate font display 
(such as Adobe Type Manager), the enhancements these applications 
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provided on the original system (such as character anti-aliasing or 
character spacing) will not transfer to a system not using the application. 

• For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.

R e d e f i n i n g  a  F o n t  R e p l a c e m e n t

You can redefine a font replacement at any time. However, your new font 
choice is applied only to a title currently in the Title tool and future 
replacements. It does not affect the font replacement information in titles that 
you have worked with previously.

Font relationships are saved as a “site” setting file named AvidFontSub.avt. 
This file is located in the Settings folder, which is located in the Symphony, 
Media Composer, or Avid Xpress folder on your internal drive. 

Once you have defined a font replacement, the Avid system uses that 
definition across all projects and all users of the system. If you want to switch 
to a different replacement font for a title, you must redefine the font 
replacement. 

n If you replace the font for a title and return that title to an Avid editing application on 
a Macintosh system, the new font information will be associated with the title. You 
must reapply the Macintosh font to restore the title to its original Macintosh style.

To redefine a font replacement:

1 Open a title in the Title tool.

2 Choose Font Replacement from the Object menu.

A dialog box appears. 

3 Choose the original font from the Unknown Fonts pop-up menu on the left.

4 Choose the replacement font you want to use from the Available Fonts pop-up 

menu on the right.

When you choose a font from the Available Fonts pop-up menu, a preview of that 

font appears in the text boxes.
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5 Click OK.

The system updates the font in the open title and records the new replacement 
information for future use.

T u r n i n g  O f f  D o w n s t r e a m  K e y s  ( D S K )

If you transfer a project that includes downstream key (DSK) graphics with 
position changes set with keyframes, position changes are ignored unless you 
turn off DSK. DSK was introduced in Media Composer Release 7.0 
(Macintosh) and Avid Xpress Release 2.0 (Macintosh).

n Turning off DSK is necessary only if you are moving from Media Composer or 
Film Composer Release 7.2 (Macintosh) or Avid Xpress Release 2.x (Macintosh).

To turn off DSK for all such graphics in a sequence:

1 Load the sequence into the Composer monitor.

2 Choose Console from the Tools menu. 

3 Type the following in the text box of the Console window:

MeridienDSK TRUE 

4 Press Enter.

n The command MeridienDSK False reverses this action and turns on DSK for all 
graphics that include position changes.

This procedure removes DSK from all mattes and keys that include position 
changes marked by keyframes.
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Step 7:  Render  Non-Real -Time Ef fects

You must render a non-real-time effect (an effect whose icon displays a blue 
dot) before it can be played. In addition, you must render some or all effects 
that exceed the real-time playback capabilities of the system to view the 
effects during playback. Occasionally, you might need to render an effect that 
displays a green dot in the Timeline, depending on the complexity of the 
sequence. 

n Preview your effects before rendering them to see if the effects imported correctly.

To render multiple effects:

1 Click the track selector in the Timeline for each track with effects to be rendered.

2 Mark an IN point before the first effect to be rendered in your sequence; mark an 
OUT point after the last effect to be rendered.

3 Choose Render In/Out from the Clip menu.

4 (Optional) Select the quality of the effects. The default quality is Highest Quality. 

The effect quality applies only to effects that change the image size, such as 
Picture-in-Picture, Peel, and Squeeze.

5 If you do not want to render the real-time effects in the selected group of effects, 
select Skip Real-time Effects.

6 Click OK.
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This section includes instructions for moving work to Avid Xpress Release 4.0, 
4.1, or 4.5 (Macintosh). 

Compat ib i l i ty  Issues

When you are moving projects to Avid Xpress Release 4.x (Macintosh), some 
products have direct compatibility while others do not, as described in the 
following sections.

C o m p a t i b i l i t y  w i t h  S y m p h o n y ,  
M e d i a C o m p o s e r ,  o r  F i l m  C o m p o s e r

The following features and effects that are available in later releases of 
Symphony, Media Composer, and Film Composer are not compatible with 
Avid Xpress Release 4.x (Macintosh):

• Intraframe Paint and AniMatte effects (Symphony, Media Composer, 
Film Composer): Sequences containing these effects will not open in 
Avid Xpress Release 4.x.

• Color correction (Symphony only): Color adjustment does not appear in 
Avid Xpress Release 4.x. You can, however, transfer a sequence from 
Symphony Release 3.x to Avid Xpress Release 4.x, and then back to 
Symphony Release 3.x, and the effect will remain in place.

• Stabilize effect (Symphony only): This effect appears as an unknown 
effect in the Timeline in Avid Xpress Release 4.x. You can, however, 
transfer a sequence from Symphony Release 3.x to Avid Xpress 
Release 4.x, and then back to Symphony Release 3.x, and the effect will 
remain in place.
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• Motion tracking (Symphony only): Effects that are tracking enabled — 
such as the Symphony Warp effect, the Paint effect, the AniMatte effect, 
and the Scratch Removal feature — lose their tracking controls in 
Avid Xpress Release 4.x. You can, however, transfer a sequence from 
Symphony Release 3.x to Avid Xpress Release 4.x, and then back to 
Symphony Release 3.x, and the tracking data will remain in place.

• Ultimatte effect (Symphony only): This effect appears as an unknown 
effect in the Timeline in Release 4.x. You can, however, transfer a sequence 
from Symphony Release 3.x to Avid Xpress Release 4.x, and then back to 
Symphony Release 3.x, and the effect will remain in place.

• Reformat effects (Symphony, Media Composer, Film Composer): These 
effects appear as unknown effects in the Timeline in Release 4.x. 

• Pan and Scan effects (Symphony, Media Composer, Film Composer): 
These effects appear as unknown effects in the Timeline in Release 4.0. 

• 25p editing (Symphony, Media Composer, Film Composer): 25p editing 
projects do not open in Avid Xpress.
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C o m p a t i b i l i t y  w i t h  A v i d  V i d e o - E d i t i n g  
P r o d u c t s

Table 1-7 lists the products from which you can move project files to 
Avid Xpress Release 4.x (Macintosh) and their level of compatibility.

Table 1-7 Moving Project Files to Avid Xpress Release 4.x 
(Macintosh)

Source 
Application

Compatibility with Avid Xpress Release 4.x 
(Macintosh)

Symphony 
Release 2.1 or 3.x

Compatible: Native Video, Native Audio, 
Compositions, Bins

Media Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
Release 9.1 
(Windows NT)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
Release 8.1 
(Macintosh)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: Native Audio, Compositions, Bins
Not Compatible: Native Video

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: Native Video, Native Audio, 
Compositions, Bins
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n Before beginning a project that you will be moving to Avid Xpress Release 4.x 
(Macintosh), set your audio file format to AIFF-C. This format allows the simplest 
method of transferring audio files between the two applications.

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Native Audio, Compositions, Bins
Not Compatible: Native Video

Avid Xpress DV 
Release 1.0, 1.5, or 
2.0 (Windows) 

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter XP 
Release 1.5 or 2.0

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

Table 1-7 Moving Project Files to Avid Xpress Release 4.x 
(Macintosh) (Continued)

Source 
Application

Compatibility with Avid Xpress Release 4.x 
(Macintosh)
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Moving the Project  F i les

To transfer project files to Avid Xpress Release 4.x (Macintosh):

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and redigitize.

4 Import graphics.

5 Transfer or import audio files.

6 Re-create the title media.

7 Render non-real-time effects.

The following procedures detail each step in the transfer process. For more 
information, see the Avid Xpress documentation, the Avid Xpress Help, and 
the appropriate documentation for your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for moving to 
Avid Xpress Release 4.x (Macintosh):

• AVX plug-ins: If your project contains AVX plug-in effects and you are 
moving across platforms, make sure the same plug-ins are available on 
both the Macintosh and Windows systems. If the same AVX plug-in effect 
is not available, the video media can be mixed down and imported as an 
OMFI file. 

If you do not create a mixdown, the effect will be identified as an 
unknown effect in Avid Xpress, and you will have to create a new effect.

• Video media: Media compatibility with Avid Xpress Release 4.x 
(Macintosh) depends on the product from which you are moving video 
media:
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Symphony 2.1 or 
3.x

There is direct video media compatibility.

Media Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility.

Film Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility.

Media Composer 
9.1 (Windows NT)

There is direct video media compatibility.

Media Composer 
8.1 (Macintosh)

There is direct video media compatibility.

Media Composer 
7.2 (Macintosh)

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media.

The OMFI file can then be imported into Avid Xpress Release 4.x 
(Macintosh) or the master clips can be imported directly from the OMFI 
MediaFiles folder. For more information, see the appropriate 
documentation for your product.

n Be aware that the import process might be slow and your media will lose some quality.

Avid Xpress 3.1 or 
4.x (Windows)

There is direct video media compatibility.

Avid Xpress 2.5
(Macintosh)

There is direct video media compatibility.
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Avid Xpress 2.1 
(Macintosh)

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media.

The OMFI file can then be imported into Avid Xpress Release 4.x. Master 
clips can be imported directly from the OMFI MediaFiles folder. For more 
information, see the appropriate documentation for your product.

Avid Xpress DV 
1.0, 1.5, or 2.0 
(Windows)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter XP 
1.5 or 2.0

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter DV 
1.1, or 
NewsCutter 1.x or 
2.x

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Step 2:  Transfer  the Project  Informat ion

For the options to move your files from one system to another, see 
Appendix A.

Step 3:  Open the Pro ject  and Redigi t ize 

If your media is not compatible, there are four options for redigitizing. You 
can:

• Redigitize existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Redigitize a sequence — provides a quick one-step process, but it limits 
your options during digitizing. You can make revisions using only 
assigned handles.
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• Decompose the sequence and redigitize the new clips — digitizes only 
enough media to re-create the sequence, plus short handles for minor 
revisions. This method is more flexible than digitizing from the sequence 
because the new clips that are created can be sorted and selectively 
digitized. This method uses minimal storage and can be one of the fastest 
methods for redigitizing.

• Use the Show Reference Clips option — lets you reveal the source clips 
of a sequence, and then redigitize the clips. This method can be faster than 
the others depending on how the lengths of the original clips compare to 
the clips used in the sequence, and how the lengths of the new audio and 
video clips differ from the original master clips. Because two passes are 
necessary to digitize audio and video from a single source if the lengths 
are not the same, it is sometimes faster to digitize a slightly longer master 
clip than to digitize the new clips once for audio and once for video. 
However, this method uses more disk space and digitizing can take 
longer. This method also gives you more opportunity for revisions. It is a 
good compromise between digitizing all the original clips and digitizing 
only the clips needed to re-create the source.

For instructions on redigitizing, see your system’s documentation. 

Note the following requirements:

• When you redigitize from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 

• If you redigitize a sequence, Avid recommends that you stop the 
digitizing process by clicking the Trash icon, and then reset the video 
levels.

• When you redigitize uncompressed media, Avid recommends that you 
store video and audio on different media drives. 

n If the incoming media is from the SDI (serial digital I/O) board, Avid Xpress ignores 
the video input settings.
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Step 4:  Import  Graphics

You can use the Batch Import command from the Clip menu if your media 
originated from:

• Symphony Release 2.1 or 3.x (Windows)

• Media Composer Release 9.1 or 10.x, or Film Composer Release 10.x 
(Windows)

• Media Composer or Film Composer Releases 10.x (Macintosh)

• Media Composer Release 8.1 (Macintosh)

• Media Composer or Film Composer Release 7.2 (Macintosh)

• Avid Xpress Release 3.1 or 4.x (Windows)

• Avid Xpress Release 2.5 (Macintosh)

• Avid Xpress Release 2.1 (Macintosh) 

• Avid Xpress DV Release 1.0, 1.5, or 2.0 (Windows)

The Batch Import command allows you to reimport master clips or sequences 
that contain imported material while automatically linking the newly 
imported material with the original master clips and sequences. When you 
play the sequence after batch importing the files, the newly imported material 
plays in it.

c Batch importing requires your original source file. Do not delete the media 
files for imported files if the source files are no longer available, unless you 
will not need the material again.

When you batch import a media file, the entire media file, including all tracks, 
is reimported. For example, the reimport process will import both the video 
and audio from a source file, even if only the video track was imported into 
the sequence.
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Here are two tips for making batch importing easier:

• Placing a “graphics” folder inside the project folder of your offline project 
makes the batch import process easier because the path will be the same, 
or at least faster to find.

• It is easy to edit revised graphics into your project by giving them the 
same names as the original graphics and by placing them in the same 
folder. You can also edit new graphics into your project by deleting the 
media for your original graphic, then batch importing your sequence and 
pointing the old graphics clips to the revised graphics files. 

n OMFI files can contain only one master clip when you batch import them.

Step 5:  Transfer  or  Import  Audio  F i les

For a detailed description of transferring audio files between Avid 
video-editing products, see Chapter 2.

Step 6:  Re-create  the  T i t le  Media

After you import all the files into your Avid Xpress Release 4.x (Macintosh) 
system, re-create the title media as follows:

1 Load the sequence containing the titles into the Composer monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 

the Option key, and drag the selected group of titles into the Composer monitor. A 
sequence containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s effects guide or Help.

2 Select all video tracks that contain titles.

3 Mark an IN point and an OUT point to include all of your titles.
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4 Choose Recreate Title Media from the Clip menu.

- If you have the same font on both systems, the new font appears 
automatically.

Because the mapping process changes the exact appearance of the font, 
check your titles carefully. It might be easier to check your titles from the bin 
than from the sequence. See 6.

- If a title opens and the system does not recognize the font, you will see a 
dialog box that allows you to substitute the font in the title for one that is 

installed on the system. 

This replacement establishes a relationship between the font used in the 
original title and the mapped font. For information on changing the font 
mapping, see “Redefining a Font Replacement” on page 1-105.

If more than one font in the title needs replacement, the dialog box will remain 
open after you click OK, and a new message will identify the next font that 
needs replacement. 

5 Choose a drive and resolution for the re-created title media.

6 If necessary, adjust the size of the bounding box, leading values, or kerning 
information. 

Note the following:

• If you are moving across platforms and the transferred title text uses a 
single style (the same font and type size), the title text aligns as closely as 
possible to its original position. The size of the text bounding box adjusts 
to accommodate the differences between Macintosh and Windows 
versions of the font used. You might see a changed leading value in the 
Title Tool leading field to adjust for multiline text.

Because the Macintosh and Windows systems handle fonts differently, 
you might see variations in the appearance of titles between the two 
systems. 

For example, bounding boxes that were set on a Macintosh system might 
be different sizes on a Windows system. Some clipping of the new text 
might occur and words can be lost. If this clipping occurs, you need to 
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open the title, select the text box, and manually change the size of the text 
box or the size of the fonts to display all the text. 

For more information on differences between the Macintosh and 
Windows versions of a font, contact the font manufacturer.

• If the original system used any applications to manipulate font display 
(such as Adobe Type Manager), the enhancements these applications 
provided on the original system (such as character anti-aliasing or 
character spacing) will not transfer to a system not using the application. 

• For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.

R e d e f i n i n g  a  F o n t  R e p l a c e m e n t

You can redefine a font replacement at any time. However, your new font 
choice is applied only to a title currently in the Title tool and future 
replacements. It does not affect the font replacement information in titles that 
you have worked with previously.

Font relationships are saved as a “site” setting file named AvidFontSub.avt. 
This file is located in the Settings folder, which is located in the Symphony, 
Media Composer, or Avid Xpress folder on your internal drive. 

Once you have defined a font replacement, the Avid system uses that 
definition across all projects and all users of the system. If you want to switch 
to a different replacement font for a title, you must redefine the font 
replacement. 

n If you replace the font for a title on a Windows system and return that title to an Avid 
editing application on a Macintosh system, the new font information will be 
associated with the title. You must reapply the Macintosh font to restore the title to its 
original Macintosh style.
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To redefine a font replacement:

1 Open a title in the Title tool.

2 Choose Font Replacement from the Object menu.

A dialog box appears. 

3 Choose the original font from the Unknown Fonts pop-up menu on the left.

4 Choose the replacement font you want to use from the Available Fonts pop-up 
menu on the right.

When you choose a font in the Available Fonts pop-up menu, a preview of that font 
appears in the text boxes.

5 Click OK.

The system updates the font in the open title and records the new replacement 
information for future use.

T u r n i n g  O f f  D o w n s t r e a m  K e y s  ( D S K )

If you transfer a project that includes downstream key (DSK) graphics with 
position changes set with keyframes, position changes are ignored unless you 
turn off DSK. DSK was introduced in Media Composer Release 7.0 and 
Avid Xpress Release 2.0 (Macintosh).

n Turning off DSK is necessary only if you are moving from Media Composer or 
Film Composer Release 7.2 (Macintosh) or Avid Xpress Release 2.x (Macintosh).

To turn off DSK for all such graphics in a sequence:

1 Load the sequence into the Composer monitor.

2 Choose Console from the Tools menu. 

3 Type the following in the text box of the Console window:

MeridienDSK TRUE 
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4 Press Return.

n The command MeridienDSK False reverses this action and turns on DSK for all 
graphics that include position changes.

This procedure removes DSK from all mattes and keys that include position 
changes marked by keyframes.

Step 7:  Render  Non-Real -Time Ef fects

You must render a non-real-time effect (an effect whose icon displays a blue 
dot) before it can be played. In addition, you must render some or all effects 
that exceed the real-time playback capabilities of the system to view the 
effects during playback. Occasionally, you might also need to render an effect 
that displays a green dot in the Timeline, depending on the complexity of the 
sequence. For more information on render options, see the Avid Xpress Effects 
Guide.

n Preview your effects before rendering them to see if the effects imported correctly.

To render multiple effects:

1 Click the track selector in the Timeline for each track with effects to be rendered.

2 Mark an IN point before the first effect to be rendered in your sequence; mark an 

OUT point after the last effect to be rendered.

3 Choose Render In/Out from the Clip menu.

4 (Optional) Select the quality of the effects. The default quality is Highest Quality. 
The effect quality applies only to effects that change the image size, such as 

Picture-in-Picture, Peel, and Squeeze.

5 If you do not want to render the real-time effects in the selected group of effects, 

select Skip Real-time Effects.

6 Click OK.
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This section includes instructions for moving work to Avid Xpress Release 2.5 
(Macintosh). 

Compat ib i l i ty  Issues

When you are moving projects to Avid Xpress Release 2.5 (Macintosh), some 
products have direct compatibility while others do not, as described in the 
following sections. 

C o m p a t i b i l i t y  w i t h  A v i d  X p r e s s  R e l e a s e  4 . x  
f o r  W i n d o w s

When you move projects backward from Avid Xpress Release 4.x, some 
features, especially new features in Release 4.0 or later, require special 
attention. The following list includes known features in this category:

• Real-time moving mattes: Real-time moving mattes are converted to non-
real-time Matte Key effects in Avid Xpress Release 2.5 (Macintosh).

• Mixed audio sample rates: Avid Xpress Release 4.x supports the mixing 
of sample rates within the Timeline. Therefore, you must convert all clips 
to one sample rate before moving the project files to Avid Xpress 
Release 2.5 (Macintosh), which does not support mixed sample rates. For 
more information on converting sample rates, see “Converting Multiple 
Audio Sample Rates” on page 2-10.

• Simultaneous automation gain and clip gain volume adjustments: 
Release 4.0 supports the simultaneous adjustment of volume by using 
both automation gain and clip gain (volume adjustment for the entire 
clip). Avid Xpress Release 2.5 (Macintosh) maintains the automation gain 
adjustments but ignores the clip gain adjustments.
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• AVX Version 1.5 plug-ins (Symphony, Media Composer, 
Film Composer, Avid Xpress): Avid Xpress Release 2.5 (Macintosh) 
supports AVX Version 1.0 plug-ins, but does not support Version 1.5 of the 
AVX plug-ins. AVX Version 1.5 plug-in effects appear as unknown effects 
in Avid Xpress Release 2.5 (Macintosh).

C o m p a t i b i l i t y  w i t h  L a t e r  R e l e a s e s  o f  
S y m p h o n y ,  M e d i a  C o m p o s e r ,  o r  
F i l m C o m p o s e r

All the features listed in the previous section also apply when you move from 
later releases of Symphony, Media Composer, or Film Composer to 
Avid Xpress Release 2.5 (Macintosh).

In addition, if there are Intraframe effects (Paint and AniMatte) included in 
your Symphony Release 2.1 or 3.x, or Media Composer Release 9.1 or 10.x 
sequence, the project will not open in Avid Xpress Release 2.5 (Macintosh). 

The following features (available in Symphony Release 3.x, Media Composer 
and Film Composer Release 10.x) also require special attention when moving 
to Avid Xpress Release 2.5 (Macintosh):

• Color correction (Symphony only): Color adjustment does not appear or 
becomes corrupted in Avid Xpress Release 2.5 (Macintosh). 

• Stabilize effect (Symphony only): This effect appears as an unknown 
effect in the Timeline and all data is lost in Avid Xpress Release 2.5 
(Macintosh). 

• Motion tracking (Symphony only): Effects that are tracking enabled — 
such as the Symphony Warp effect, the Paint effect, the AniMatte effect, 
and the Scratch Removal feature — lose their tracking data in Avid Xpress 
Release 2.5 (Macintosh).

• Ultimatte effect (Symphony only): This effect appears as an unknown 
effect in the Timeline in Avid Xpress Release 2.5 (Macintosh). 
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• Defocus parameter in 3D effect (Symphony, Media Composer, 
Film Composer): Sequences containing the 3D Warp effect with defocus 
parameters will open, but the effect will use the parameters set under the 
Internal defocus pane and will ignore all other parameters.

• Reformat effects (Symphony, Media Composer, Film Composer): These 
effects appear as unknown effects in the Timeline in Avid Xpress 
Release 2.5 (Macintosh). 

• Pan and Scan effects (Symphony, Media Composer, Film Composer): 
These effects appear as unknown effects in the Timeline in Avid Xpress 
Release 2.5 (Macintosh). 

• 25p editing (Symphony, Media Composer, Film Composer): 25p editing 
projects do not open in Avid Xpress.

• MultiCamera editing (Symphony, Media Composer, Film Composer): 
MultiCamera resolutions 3:1 m, 4:1 m, 8:1 m, and 10:1 m are not 
compatible. The project will open, but the Timeline will display the 
“unsupported resolution” message. You can, however, redigitize the clips 
in another compatible resolution.

C o m p a t i b i l i t y  w i t h  A v i d  V i d e o - E d i t i n g  
P r o d u c t s

Table 1-8 lists the products from which you can move project files to 
Avid Xpress Release 2.5 (Macintosh) and their level of compatibility.

Table 1-8 Moving Project Files to Avid Xpress Release 2.5 
(Macintosh)

Source 
Application

Compatibility with Avid Xpress Release 2.5 
(Macintosh)

Symphony 
Release 2.1 or 3.x

Compatible: Native Video, Native Audio, 
Compositions, Bins
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Media Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
Release 9.1 
(Windows NT)

Compatible: Native Video, Native Audio (AIFF-C 
and WAVE), Compositions, Bins

Media Composer 
Release 8.1 
(Macintosh)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: Native Audio, Compositions, Bins
Not Compatible: Native Video

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: Native Video, Native Audio, 
Compositions, Bins

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Native Audio, Compositions, Bins
Not Compatible: Native Video

Table 1-8 Moving Project Files to Avid Xpress Release 2.5 
(Macintosh) (Continued)

Source 
Application

Compatibility with Avid Xpress Release 2.5 
(Macintosh)
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n Before beginning a project that you will be moving to Avid Xpress Release 2.5 
(Macintosh), set your audio file format to AIFF-C. This format allows the simplest 
method of transferring audio files between the two applications.

Moving the Project  F i les

To transfer project files to Avid Xpress Release 2.5 (Macintosh):

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and redigitize.

4 Import graphics.

5 Transfer or import audio files.

6 Re-create the title media.

7 Render non-real-time effects.

Avid Xpress DV 
Release 1.0, 1.5, or 
2.0 (Windows)

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter XP 
Release 1.5 or 2.0

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: Native Audio, Bins, Compositions
Not Compatible: Native Video

Table 1-8 Moving Project Files to Avid Xpress Release 2.5 
(Macintosh) (Continued)

Source 
Application

Compatibility with Avid Xpress Release 2.5 
(Macintosh)
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The following procedures detail each step in the transfer process. For more 
information, see the Avid Xpress Help and the appropriate documentation for 
your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for moving to 
Avid Xpress Release 2.5 (Macintosh):

• AVX plug-ins: If your project contains AVX plug-in effects and you are 
moving across platforms, make sure the same plug-ins are available on 
both the Macintosh and Windows systems, and that the versions are 
compatible. If the same AVX plug-in effect is not available, the video 
media can be mixed down and imported as an OMFI file. However, this 
method only allows a maximum resolution equivalent to AVR 77. 

If you do not create a mixdown, the effect will be identified as an 
unknown effect in Avid Xpress, and you will have to create a new effect.

• Video media: Media compatibility with Avid Xpress Release 2.5 
(Macintosh) depends on the product from which you are moving video 
media:

Symphony 2.1 or 
3.x

There is direct video media compatibility.

Media Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility.

Film Composer 
10.x (Windows 
and Macintosh)

There is direct video media compatibility.

Media Composer 
9.1 (Windows NT)

There is direct video media compatibility.
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Media Composer 
8.1 (Macintosh)

There is direct video media compatibility.

Media Composer 
7.2 (Macintosh)

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only,
OMFI 1.0, With Media.

The OMFI file can then be imported into Avid Xpress Release 2.5 
(Macintosh) or the master clips can be imported directly from the OMFI 
MediaFiles folder. For more information, see the appropriate 
documentation for your product.

n Be aware that the import process might be slow and your media will lose some quality.

Avid Xpress 3.1 or 
4.x (Windows)

There is direct video media compatibility.

Avid Xpress 4.x 
(Macintosh)

There is direct video media compatibility.

Avid Xpress 2.1 
(Macintosh)

You must export video media as an OMFI file. In the Export Format 
dialog box, select OMFI Composition Standard-AIFC, Video Only, 
OMFI 1.0, With Media.

The OMFI file can then be imported into Avid Xpress Release 2.5 
(Macintosh) or the master clips can be imported directly from the OMFI 
MediaFiles folder. For more information, see the appropriate 
documentation for your product.

Avid Xpress DV 
1.0, 1.5, or 2.0
(Windows)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter XP 
1.5 or 2.0

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.
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NewsCutter DV 
1.1, or 
NewsCutter 1.x or 
2.x

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Step 2:  Transfer  the Project  Informat ion

For the options to move your files from one system to another, see 
Appendix A.

Step 3:  Open the Pro ject  and Redigi t ize 

If your media is not compatible, there are three options for redigitizing. You 
can:

• Redigitize existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Redigitize a sequence — provides a quick one-step process, but it limits 
your options during digitizing. You can make revisions using only 
assigned handles.

• Use the Show Reference Clips option — lets you reveal the source clips 
of a sequence, and then redigitize the clips. This method can be faster than 
the others, depending on how the lengths of the original clips compare to 
the clips used in the sequence, and how the lengths of the new audio and 
video clips differ from the original master clips. Because two passes are 
necessary to digitize audio and video from a single source if the lengths 
are not the same, it is sometimes faster to digitize a slightly longer master 
clip than to digitize the new clips once for audio and once for video. 
However, this method uses more disk space and digitizing can take 
longer. This method also gives you more opportunity for revisions. It is a 
good compromise between digitizing all the original clips and digitizing 
only the clips needed to re-create the source.

For instructions on redigitizing, see your system’s documentation. 
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Note the following requirements:

• When you redigitize from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 

• If you redigitize a sequence, Avid recommends that you stop the 
digitizing process by clicking the Trash icon, and then reset the video 
levels.

• When you redigitize uncompressed media, Avid recommends that you 
store video and audio on different media drives. 

n If the incoming media is from the SDI (serial digital I/O) board, Avid Xpress ignores 
the video input settings.

Step 4:  Import  Graphics

You can use the Batch Import command from the Clip menu if your media 
originated from:

• Symphony Release 2.1 or 3.x (Windows)

• Media Composer Release 9.1 or 10.x, or Film Composer Release 10.x 
(Windows)

• Media Composer or Film Composer Release 10.x (Macintosh)

• Media Composer Release 8.1 (Macintosh)

• Media Composer or Film Composer Release 7.2 (Macintosh)

• Avid Xpress Release 3.1 or 4.x (Windows)

• Avid Xpress Release 4.x (Macintosh)

• Avid Xpress Release 2.1 (Macintosh) 

• Avid Xpress DV Release 1.0, 1.5, or 2.0 (Windows)
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The Batch Import command allows you to reimport master clips or sequences 
that contain imported material while automatically linking the newly 
imported material with the original master clips and sequences. When you 
play the sequence after batch importing the files, the newly imported material 
plays in it.

c Batch importing requires your original source file. Do not delete the media 
files for imported files if the source files are no longer available, unless you 
will not need the material again.

When you batch import a media file, the entire media file, including all tracks, 
is reimported. For example, the reimport process will import both the video 
and audio from a source file, even if only the video track was imported into 
the sequence.

Here are two tips for making batch importing easier:

• Placing a “graphics” folder inside the project folder of your offline project 
makes the batch import process easier because the path will be the same, 
or at least faster to find.

• It is easy to edit revised graphics into your project by giving them the 
same names as the original graphics and by placing them in the same 
folder. You can also edit new graphics into your project by deleting the 
media for your original graphic, then batch importing your sequence and 
pointing the old graphics clips to the revised graphics files. 

n OMFI files can contain only one master clip when you batch import them.

Step 5:  Transfer  or  Import  Audio  F i les

For a detailed description of transferring audio files between Avid 
video-editing products, see Chapter 2.
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Step 6:  Re-create  the  T i t le  Media

After you import all the files into your Avid Xpress Release 2.5 (Macintosh) 
system, re-create the title media as follows:

1 Set the Title Tool compression before re-creating your titles. To set the 
compression, create a new title, choose Save As, and save it at the video 
resolution you want to use for the re-created title media.

2 Open the bin or project. 

3 Load the sequence containing the titles into the Composer monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 

the Option key, and drag the selected group of titles to the Timeline. A sequence 
containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s effects guide or Help.

4 Select all video tracks that contain titles.

5 Mark an IN point and an OUT point to include all of your titles.

6 Choose Recreate Title Media from the Clip menu.

- If you have the same font on both systems, the new font appears 
automatically.

Because the mapping process changes the exact appearance of the font, you 
should check your titles carefully. It might be easier to check your titles from 
the bin than from the sequence. See Step 7.

- If a title opens and the system does not recognize the font, you will see a 
dialog box that allows you to substitute the font in the title for one that is 

installed on the system. 

This replacement establishes a relationship between the font used in the 
original title and the mapped font. For information on changing the font 
mapping, see “Redefining a Font Replacement” on page 1-120.

If more than one font in the title needs replacement, the dialog box will remain 
open after you click OK, and a new message will identify the next font that 
needs replacement. The dialog box closes when you have defined a font for 
each font that needs replacement.
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7 If necessary, adjust the size of the bounding box, leading values, or kerning 

information. 

Note the following:

• If you are moving across platforms and the transferred title text uses a 
single style (the same font and type size), the title text aligns as closely as 
possible to its original position. The size of the text bounding box adjusts 
to accommodate the differences between the Macintosh and Windows 
versions of the font used. You might see a changed leading value in the 
Title Tool leading field to adjust for multiline text.

Because the Macintosh and Windows systems handle fonts differently, 
you might see variations in the appearance of titles between the two 
systems. 

For example, bounding boxes that were set on a Macintosh system might 
be different sizes on a Windows system. Some clipping of the new text 
might occur and words can be lost. If this clipping occurs, you need to 
open the title, select the text box, and manually change the size of the text 
box or the size of the fonts to display all the text. 

For more information on differences between the Macintosh and 
Windows versions of a font, contact the font manufacturer.

• If the original system used any applications to manipulate font display 
(such as Adobe Type Manager), the enhancements these applications 
provided on the original system (such as character anti-aliasing or 
character spacing) will not transfer to a system not using the application.

• For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.
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R e d e f i n i n g  a  F o n t  R e p l a c e m e n t

You can redefine a font replacement at any time. However, your new font 
choice is applied only to a title currently in the Title tool and future 
replacements. It does not affect the font replacement information in titles that 
you have worked with previously.

Font relationships are saved as a “site” setting file named AvidFontSub.avt. 
This file is located in the Settings folder, which is located in the Symphony, 
Media Composer, or Avid Xpress folder on your internal drive. 

Once you have defined a font replacement, the Avid system uses that 
definition across all projects and all users of the system. If you want to switch 
to a different replacement font for a title, you must redefine the font 
replacement. 

n If you replace the font for a title on a Windows system and return that title to an Avid 
editing application on a Macintosh system, the new font information will be 
associated with the title. You must reapply the Macintosh font to restore the title to its 
original Macintosh style.

To redefine a font replacement:

1 Open a title in the Title tool.

2 Choose Font Replacement from the Object menu.

A dialog box appears. 

3 Choose the original font from the Unknown Fonts pop-up menu on the left.

4 Choose the replacement font you want to use from the Available Fonts pop-up 
menu on the right.

When you choose a font from the Available Fonts pop-up menu, a preview of that 
font appears in the text boxes.

5 Click OK.

The system updates the font in the open title and records the new replacement 
information for future use.
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T u r n i n g  O f f  D o w n s t r e a m  K e y s  ( D S K )

If you transfer a project that includes downstream key (DSK) graphics with 
position changes set with keyframes, position changes are ignored unless you 
turn off DSK. DSK was introduced in Media Composer Release 7.0 and 
Avid Xpress Release 2.0 (Macintosh).

n Turning off DSK is necessary only if you are moving from Media Composer or 
Film Composer Release 7.2 or Avid Xpress Release 2.x (Macintosh).

To turn off DSK for all such graphics in a sequence:

1 Load the sequence into the Composer monitor.

2 Choose Console from the Tools menu. 

3 Type the following in the text box of the Console window:

MeridienDSK TRUE 

4 Press Return.

n The command MeridienDSK False reverses this action and turns on DSK for all 
graphics that include position changes.

This procedure removes DSK from all mattes and keys that include position 
changes marked by keyframes.
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Step 7:  Render  Non-Real -Time Ef fects

You must render a non-real-time effect (an effect whose icon displays a blue 
dot) before it can be played. In addition, you must render some or all effects 
that exceed the real-time playback capabilities of the system to view the 
effects during playback. Occasionally, you might need to render an effect that 
displays a green dot in the Timeline, depending on the complexity of the 
sequence. For more information on render options, see your effects guide.

n Preview your effects before rendering them to see if the effects imported correctly.

To render multiple effects:

1 Click the track selector in the Timeline for each track with effects to be rendered.

2 Mark an IN point before the first effect to be rendered in your sequence; mark an 
OUT point after the last effect to be rendered.

3 Choose Render In/Out from the Clip menu.

4 (Optional) Select the quality of the effects. The default quality is Highest Quality. 

The effect quality applies only to effects that change the image size, such as 
Picture-in-Picture, Peel, and Squeeze.

5 If you do not want to render the real-time effects in the selected group of effects, 
select Skip Real-time Effects.

6 Click OK.
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M o v i n g  t o  A v i d  X p r e s s  R e l e a s e  2 . 1  f o r  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .M a c i n t o s h

This section includes instructions for moving work to Avid Xpress Release 2.1 
(Macintosh). 

Compat ib i l i ty  Issues

When you are moving projects to Avid Xpress Release 2.1 (Macintosh), some 
products have direct compatibility while others do not, as described in the 
following sections. 

C o m p a t i b i l i t y  w i t h  A v i d  X p r e s s  R e l e a s e  4 . x  
f o r  W i n d o w s

When you move projects backward from Avid Xpress Release 4.x, some 
features, especially new features in Release 4.0 or later, require special 
attention. The following list includes known features in this category:

• Real-time moving mattes: Real-time moving mattes are converted to non-
real-time Matte Key effects in Release 2.1 (Macintosh).

• Mixed audio sample rates: Avid Xpress Release 4.x supports the mixing 
of sample rates within the Timeline. Therefore, you must convert all clips 
to one sample rate before moving the project files to Avid Xpress 
Release 2.1 (Macintosh), which do not support mixed sample rates. For 
more information on converting sample rates, see “Converting Multiple 
Audio Sample Rates” on page 2-10.

• Simultaneous automation gain and clip gain volume adjustments: 
Avid Xpress Release 4.0 supports the simultaneous adjustment of volume 
by using both automation gain and clip gain (volume adjustment for the 
entire clip). Avid Xpress Release 2.1 (Macintosh) maintains the 
automation gain adjustments but ignore the clip gain adjustments.
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• AVX Version 1.5 plug-ins (Symphony, Media Composer, 
Film Composer, Avid Xpress): Avid Xpress Release 2.1 (Macintosh) 
supports AVX Version 1.0 plug-ins, but does not support Version 1.5 of the 
AVX plug-ins. AVX Version 1.5 plug-in effects appear as unknown effects 
in Avid Xpress Release 2.1 (Macintosh).

C o m p a t i b i l i t y  w i t h  L a t e r  R e l e a s e s  o f  
S y m p h o n y ,  M e d i a  C o m p o s e r ,  o r  
F i l m C o m p o s e r

All the features listed in the previous section also apply when you move from 
Symphony Release 3.x, Media Composer or Film Composer Release 10.x, or 
Avid Xpress Releases 4.x (Windows and Macintosh) to Avid Xpress 
Release 2.1 (Macintosh).

In addition, if there are Intraframe effects (Paint and AniMatte) included in 
your Symphony Release 2.1 or 3.x, or Media Composer Release 9.1 or 10.x 
sequence, the project will not open in Avid Xpress Release 2.1 (Macintosh). 

The following features (available in Symphony Release 3.x, Media Composer 
and Film Composer Release 10.x) also require special attention when moving 
to Avid Xpress Release 2.1 (Macintosh):

• Color correction (Symphony only): Color adjustment does not appear or 
becomes corrupted in Avid Xpress Release 2.1 (Macintosh). 

• Stabilize effect (Symphony only): This effect appears as an unknown 
effect in the Timeline and all data is lost in Avid Xpress Release 2.1 
(Macintosh). 

• Motion tracking (Symphony only): Effects that are tracking enabled — 
such as the Symphony Warp effect, the Paint effect, the AniMatte effect, 
and the Scratch Removal feature — lose their tracking data in Avid Xpress 
Release 2.1 (Macintosh). 

• Ultimatte effect (Symphony only): This effect appears as an unknown 
effect in the Timeline in Avid Xpress Release 2.1 (Macintosh). 
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• Defocus parameter in 3D effect (Symphony, Media Composer, 
Film Composer): Sequences containing the 3D Warp effect with defocus 
parameters will open, but the effect will use the parameters set under the 
Internal defocus pane and will ignore all other parameters.

• Reformat effects (Symphony, Media Composer, Film Composer): These 
effects appear as unknown effects in the Timeline in Avid Xpress 
Release 2.1 (Macintosh). 

• Pan and Scan effects (Symphony, Media Composer, Film Composer): 
These effects appear as unknown effects in the Timeline in Avid Xpress 
Release 2.1 (Macintosh). 

• 25p editing (Symphony, Media Composer, Film Composer): 25p editing 
projects do not open in Avid Xpress.

• MultiCamera editing (Symphony, Media Composer, Film Composer): 
MultiCamera resolutions 3:1 m, 4:1 m, 8:1 m, and 10:1 m are not 
compatible. The project will open, but the Timeline will display the 
“unsupported resolution” message. You can, however, redigitize the clips 
in another compatible resolution.
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C o m p a t i b i l i t y  w i t h  A v i d  V i d e o - E d i t i n g  
P r o d u c t s

Table 1-9 lists the other products from which you can move project files to 
Avid Xpress Release 2.1 (Macintosh) and their level of compatibility.

Table 1-9 Moving Project Files to Avid Xpress Release 2.1 
(Macintosh)

Source 
Application

Compatibility with Avid Xpress Release 2.1 
(Macintosh)

Symphony 
Release 2.1 or 3.x

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video

Media Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Audio (AIFF-C and WAVE), 
Compositions, Bins
Not Compatible: Native Video

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Native Audio (AIFF-C and WAVE), 
Compositions, Bins
Not Compatible: Native Video

Media Composer 
Release 9.1 
(Windows NT)

Compatible: Native Audio (AIFF-C and WAVE), 
Compositions, Bins
Not Compatible: Native Video

Media Composer 
Release 8.1 
(Macintosh)

Compatible: Bins, Compositions, Native Audio 
(AIFF-C and Sound Designer II)
Not Compatible: Native Video

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: Native Video, Native Audio, Bins, 
Compositions
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n Before beginning a project that you will be moving to Avid Xpress Release 2.1 
(Macintosh), set your audio file format to AIFF-C. This format allows the simplest 
method of transferring audio files between the two applications.

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Bins, Compositions, Native Audio 
(AIFF-C and Sound Designer II)
Not Compatible: Native Video

MCXpress™ 
Release 1.5 
(Macintosh)

Compatible: Bins, Compositions
Not Compatible: Native Video, Native Audio 

Avid Xpress DV 
Release 1.0, 1.5, or 
2.0 (Windows) 

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video

NewsCutter XP 
Release 1.5 or 2.0

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: Bins, Compositions, Native Audio 
(AIFF-C only)
Not Compatible: Native Video

Table 1-9 Moving Project Files to Avid Xpress Release 2.1 
(Macintosh) (Continued)

Source 
Application

Compatibility with Avid Xpress Release 2.1 
(Macintosh)
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Moving the Project  F i les

To transfer project files to Avid Xpress Release 2.1 (Macintosh):

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and redigitize.

4 Import graphics.

5 Transfer or import audio files.

6 Re-create the title media.

7 Render non-real-time effects.

The following procedures detail each step in the transfer process. For more 
information, see the Avid Xpress Help and the appropriate documentation for 
your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for moving to 
Avid Xpress Release 2.1 (Macintosh):

• AVX plug-ins: If your project contains AVX plug-in effects and you are 
moving across platforms, make sure the same plug-ins are available on 
both the Macintosh and Windows systems. If the same AVX plug-in effect 
is not available, the video media can be mixed down and imported as an 
OMFI file. This method only allows a maximum resolution equivalent to 
AVR 77. 

If you do not create a mixdown, the effect will be identified as an 
unknown effect in Avid Xpress, and you will have to create a new effect.

• Video media: Media compatibility with Avid Xpress Release 2.1 
(Macintosh) depends on the product from which you are moving video 
media:
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Symphony 2.1 or 
3.x

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Media Composer 
10.x (Windows 
and Macintosh)

There is no direct video media compatibility. The bins are compatible, but
you must redigitize your media.

Film Composer 
10.x (Windows 
and Macintosh)

There is no direct video media compatibility. The bins are compatible, but
you must redigitize your media.

Media Composer 
9.1 (Windows NT)

There is no direct video media compatibility. The bins are compatible, but
you must redigitize your media.

Media Composer 
8.1 (Macintosh)

There is no direct video media compatibility. The bins are compatible, but
you must redigitize your media.

Media Composer 
or Film Composer 
7.2 (Macintosh)

There is direct video media compatibility.

Avid Xpress 3.1 or 
4.x (Windows)

There is no direct video media compatibility. The bins are compatible, but
you must redigitize your media.

Avid Xpress 4.x 
(Macintosh)

There is no direct video media compatibility. The bins are compatible, but
you must redigitize your media.

Avid Xpress 2.5 
(Macintosh)

There is no direct video media compatibility. The bins are compatible, but
you must redigitize your media.

MCXpress 1.5 
(Macintosh)

Media digitized in MCXpress Release 1.5 and earlier cannot be used with 
Avid Xpress Release 2.1 or later without first converting the media. Earlier 
releases use Media File Manager (MFM), and releases starting with 
Release 2.0 use Media Stream Manager (MSM). Media must be converted 
by using the Conversion tool in the Utilities folder. This utility works on a 
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per-folder basis for bringing MCXpress Release 1.x MediaFiles media into 
OMFI MediaFiles media.

Avid Xpress DV 
1.0, 1.5, or 2.0
(Windows)

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter XP 
1.5 or 2.0

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

NewsCutter DV 
1.1, or 
NewsCutter 1.x or 
2.0

There is no direct video media compatibility. The bins are compatible, but 
you must redigitize your media.

Step 2:  Transfer  the Project  Informat ion

For the options to move your files from one system to another, see 
Appendix A.

Step 3:  Open the Pro ject  and Redigi t ize 

If your media is not compatible, there are three options for redigitizing. You 
can:

• Redigitize existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Redigitize a sequence — provides a quick one-step process, but it limits 
your options during digitizing. You can make revisions using only 
assigned handles.

• Use the Show Reference Clips option — lets you reveal the source clips 
of a sequence, and then redigitize the clips. This method can be faster than 
the others depending on how the lengths of the original clips compare to 
the clips used in the sequence, and how the lengths of the new audio and 
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video clips differ from the original master clips. Because two passes are 
necessary to digitize audio and video from a single source if the lengths 
are not the same, it is sometimes faster to digitize a slightly longer master 
clip than to digitize the new clips once for audio and once for video. 
However, this method uses more disk space and digitizing can take 
longer. This method also gives you more opportunity for revisions. It is a 
good compromise between digitizing all the original clips and digitizing 
only the clips needed to re-create the source.

For instructions on redigitizing, see your system’s documentation. 

Note the following requirements:

• When you redigitize from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 

• If you redigitize a sequence, Avid recommends that you stop the 
digitizing process by clicking the Trash icon, and then reset the video 
levels.

• When you redigitize uncompressed media, Avid recommends that you 
store video and audio on different media drives. 

n If the incoming media is from the SDI (serial digital I/O) board, Avid Xpress ignores 
the video input settings.

Step 4:  Import  Graphics

For a detailed description of importing graphics and effects files into Avid 
video-editing products, see Chapter 3.

Step 5:  Transfer  or  Import  Audio  F i les

For a detailed description of transferring audio files between Avid 
video-editing products, see Chapter 2.
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Step 6:  Re-create  the  T i t le  Media

After you import all the files into your Avid Xpress Release 2.1 (Macintosh) 
system, re-create the title media as follows:

1 Set the Title Tool compression before re-creating your titles. To set the 
compression, create a new title, choose Save As, and save it at the video 
resolution you want to use for the re-created title media.

2 Open the bin or project. 

3 Load the sequence containing the titles into the Composer monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 

the Option key, and drag the selected group of titles into the Composer monitor. A 
sequence containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s effects guide or Help.

4 Select all video tracks that contain titles.

5 Mark an IN point and an OUT point to include all of your titles.

6 Choose Recreate Title Media from the Clip menu.

7 If necessary, adjust the size of the bounding box, leading values, or kerning 
information. 

Note the following:

• If the original system used any applications to manipulate font display 
(such as Adobe Type Manager), the enhancements these applications 
provided on the original system (such as character anti-aliasing or 
character spacing) will not transfer to a system not using the application. 

• For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.
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Step 7:  Render  Non-Real -Time Ef fects

You must render a non-real-time effect (an effect whose icon displays a blue 
dot) before it can be played. In addition, you must render some or all effects 
that exceed the real-time playback capabilities of the system to view the 
effects during playback. Occasionally, you might also need to render an effect 
that displays a green dot in the Timeline, depending on the complexity of the 
sequence. 

n Preview your effects before rendering them to see if the effects imported correctly.

To render multiple effects:

1 Click the track selector in the Timeline for each track with effects to be rendered.

2 Mark an IN point before the first effect to be rendered in your sequence; mark an 
OUT point after the last effect to be rendered.

3 Choose Render In/Out from the Clip menu.

4 (Optional) Select the quality of the effects. The default quality is Highest Quality. 

The effect quality applies only to effects that change the image size, such as 
Picture-in-Picture, Peel, and Squeeze.

5 If you do not want to render the real-time effects in the selected group of effects, 
select Skip Real-time Effects.

6 Click OK.
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M o v i n g  t o  A v i d  X p r e s s  D V  R e l e a s e  1 . 5  
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This section includes instructions for moving work to Avid Xpress DV 
Release 1.5 or 2.0 (Windows). 

Compat ib i l i ty  Issues

When you are moving projects to Avid Xpress DV Release 1.5 or 2.0, some 
products have direct compatibility while others do not, as described in the 
following sections. 

C o m p a t i b i l i t y  w i t h  S y m p h o n y ,  
M e d i a C o m p o s e r ,  a n d  F i l m  C o m p o s e r

If there are Intraframe effects (Paint and AniMatte) included in your 
Symphony Release 2.1 or 3.x, or Media Composer Release 9.1 or 10.x 
sequence, the project will not open in Avid Xpress DV Release 1.5 or 2.0 
(Windows). 

In addition, when moving projects from later releases of Symphony, 
Media Composer, and Film Composer, the following features and effects are 
not compatible:

• Defocus parameter (3D effect): Sequences containing the 3D Warp effect 
with defocus parameters will open, but the effect will use the parameters 
set under the Internal defocus pane and will ignore all other parameters.

• Reformat effects (Symphony, Media Composer, Film Composer): These 
effects appear as unknown effects in the Timeline in Avid Xpress DV 
Release 1.5 (Windows NT). 
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• Pan and Scan effects (Symphony, Media Composer, Film Composer): 
These effects appear as unknown effects in the Timeline in Avid Xpress 
DV Release 1.5 (Windows NT). 

• Real-time moving mattes (Symphony, Media Composer, 
Film Composer): Real-time moving mattes are converted to non-real-time 
Matte Key effects in Avid Xpress DV Release 1.5 (Windows NT).

• Color correction (Symphony only): Color adjustment does not appear or 
becomes corrupted in Avid Xpress DV Release 1.5 (Windows NT). 

• Stabilize effect (Symphony only): This effect appears as an unknown 
effect in the Timeline and all data is lost in Release 1.5 (Windows NT). 

• Motion tracking (Symphony only): Effects that are tracking enabled — 
such as the Symphony Warp effect, the Paint effect, the AniMatte effect, 
and the Scratch Removal feature — lose their tracking data in Avid Xpress 
DV Release 1.5 (Windows NT). 

• Ultimatte effect (Symphony only): This effect appears as an unknown 
effect in the Timeline in Avid Xpress DV Release 1.5 (Windows NT). 

• 25p editing (Symphony, Media Composer, Film Composer): 25p editing 
projects do not open in Avid Xpress DV.

• MultiCamera editing (Symphony, Media Composer, Film Composer): 
MultiCamera resolutions 3:1 m, 4:1 m, 8:1 m, and 10:1 m are not 
compatible. The project will open, but the Timeline will display the 
“unsupported resolution” message. You can, however, redigitize the clips 
in another compatible resolution.
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C o m p a t i b i l i t y  w i t h  A v i d  V i d e o - E d i t i n g  
P r o d u c t s

Table 1-10 lists the products from which you can move project files to 
Avid Xpress DV Release 1.5 or 2.0 (Windows) and their level of compatibility.

Table 1-10 Moving Project Files to Avid Xpress DV Release 1.5 or 2.0
(Windows)

Source 
Application

Compatibility with Avid Xpress DV Release 1.5 
or 2.0 (Windows)

Avid Symphony 
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Media Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Media Composer 
Release 9.1 
(Windows NT)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Media Composer 
Release 8.1 
(Macintosh)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: AIFF-C Audio, Compositions, Bins

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins
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n Before beginning a project that you will be moving to Avid Xpress DV Release 1.5 or 
2.0 (Windows), set your audio file format to AIFF-C. This format allows the simplest 
method of transferring audio files between the two applications. To set the audio file 
format, click General Settings.

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: AIFF-C Audio, 
Compositions, Bins

Avid Xpress 
Release DV 
Release 1.0 
(Windows NT) 

Compatible: AIFF-C and WAVE Audio, DV 
Video, Compositions, Bins

NewsCutter XP 
Release 1.5 or 2.0

Compatible: AIFF-C and WAVE Audio, DV 
Video, Compositions, Bins

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: AIFF-C and WAVE Audio, DV 
Video, Compositions, Bins

Table 1-10 Moving Project Files to Avid Xpress DV Release 1.5 or 2.0
(Windows) (Continued)

Source 
Application

Compatibility with Avid Xpress DV Release 1.5 
or 2.0 (Windows)
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Moving the Project  F i les

To transfer project files to Avid Xpress DV Release 1.5 or 2.0 (Windows):

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and rerecord.

4 Import graphics.

5 Import audio files.

6 Re-create the title media.

7 Render effects.

The following procedures detail each step in the transfer process. For more 
information, see the Avid Xpress DV Help and the appropriate 
documentation for your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for moving to 
Avid Xpress DV Release 1.5 or 2.0 (Windows):

• Editing products compatibility: The Avid editing products most 
compatible with Avid Xpress DV Release 1.5 or 2.0 are NewsCutter DV 
Release 1.1 and NewsCutter Release 1.x or 2.x. Film projects are not 
compatible with Avid Xpress DV.

• Audio files: The audio files you can play back in Avid Xpress DV have 
audio sample rates of 32 kHz, 44.1 kHz, and 48 kHz.

• Video media: There is no direct video media compatibility between 
Avid Xpress DV Release 1.5 or 2.0 (Windows) and other Avid products 
(except NewsCutter DV Release 1.1, NewsCutter Release 1.x or 2.x, 
NewsCutter XP Release 1.5 or 2.0, and Avid Xpress DV Release 1.5 or 2.0). 
The bins are compatible, but you must redigitize your media.
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• AVX plug-ins: If your project contains AVX plug-in effects and you are 
moving across platforms, make sure the same plug-ins are available on 
both the Windows and Macintosh systems, and that the versions are 
compatible. If the same AVX plug-in effect is not available, the video 
media can be mixed down and imported as an OMFI file. 

If you do not create a mixdown, the effect will be identified as an 
unknown effect on Avid Xpress DV, and you will have to create a new 
effect.

Step 2:  Transfer  the Project  Informat ion

Depending on the application, you can transfer files to Avid Xpress DV 
Release 1.5 (Windows NT) or Release 2.0 (Windows 2000) in several ways:

• Avid Unity TransferManager (Windows to Windows; Macintosh to 
Macintosh; Windows to Macintosh; or Macintosh to Windows on 
Avid Unity)

• Compatible external drive storage (Macintosh to Windows, with the 
MacDrive CrossStripe Edition for Avid Systems installed on the Windows 
system)

n If you are already using the MacOpener application on a Windows NT system for 
transferring files, you can continue using it for Avid Xpress DV Release 1.0. For 
Avid Xpress DV Release 2.0, use the MacDrive CrossStripe Edition for Avid 
Systems.

• Network connection (Windows to Windows; Macintosh to Macintosh; or 
Macintosh to Windows)

• Fetch (Macintosh to Macintosh; Macintosh to Windows, with Fetch 
installed on the Macintosh system; or Macintosh to SGI IRIX) 

For detailed information on each of these transfer options, see Appendix A.
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Step 3:  Open the Pro ject  and Rerecord 

If your media is not compatible, there are two options for rerecording. You 
can:

• Rerecord existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Rerecord a sequence — provides a quick one-step process, but it limits 
your options during recording. You can make revisions using only 
assigned handles.

For instructions on rerecording, see your system’s documentation. 

Note the following requirements:

• When you rerecord from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 

• If you rerecord a sequence, Avid recommends that you stop the recording 
process by clicking the Trash icon, and then reset the video levels.

Step 4:  Import  Graphics

Information about importing graphic files is listed below.

• Resizing the DV frame size

With a digital video (DV) format, the frame size of an NTSC DV graphic is 
720 x 480. The NTSC D1 standard frame size is 720 x 486. When importing 
graphics into Avid Xpress DV, you can crop the 486 graphic file by 
removing six lines from the 486 frame size.

n To change the digital video frame size, see “Padding the DV Frame Size” on page 3-52 
or “Cropping the DV Frame Size” on page 3-54.
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• OMFI

DV media embedded in OMFI files can be read only by other 
DV-compatible applications. Non-DV-based applications might not be 
able to uncompress digital video.

• AVI

AVI format can be used for products that do not support QuickTime, and 
could normally use OMFI. Marquee and Elastic Reality (Windows) are 
examples of these products. Because there is no native resolution export 
of the AVI codec, you need to use a generic AVI file, which is slow on both 
export and import.

• QuickTime 4.0

QuickTime “Same as Source” (QuickTime DV) is the quickest method for 
exporting with Avid Xpress DV Release 1.5 or 2.0. Due to the 480 frame 
size of Avid Xpress DV, a Fast export to a D1-based product does not 
work.

Step 5:  Import  Audio  F i les

There are no issues with importing audio files.
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Step 6:  Re-create  the  T i t le  Media

After you import all the files into your Avid Xpress DV Release 1.5 or 2.0
(Windows) system, re-create the title media as follows. 

1 Open the bin or project.

2 Load the sequence containing the titles into the Composer monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 
the Alt key, and drag the selected group of titles into the Composer monitor. A 

sequence containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s effects guide or Help.

3 Select all video tracks that contain titles.

4 Mark an IN point and an OUT point to include all your titles.

5 Choose Re-create Title Media from the Clip menu.

- If you have the same font on both systems, the new font appears 
automatically.

Because the mapping process changes the exact appearance of the font, 
check your titles carefully. It might be easier to check your titles from the bin 
than from the sequence.

- If a title opens and the system does not recognize the font, you will see a 
dialog box that allows you to substitute the font in the title for one that is 
installed on the system. 

This replacement establishes a relationship between the font used in the 
original title and the mapped font. For information on changing the font 
mapping, see “Redefining a Font Replacement” on page 1-19.

If more than one font in the title needs replacement, the dialog box will remain 
open after you click OK, and a new message will identify the next font that 
needs replacement. 
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6 For Avid Xpress DV Release 2.0, choose a drive for the re-created title media.

7 If necessary, adjust the size of the bounding box, leading values, or kerning 
information. 

Step 7:  Render  Ef fects

You must render all effects. For more information on render options, see the 
Avid Xpress DV Effects Guide.

n Preview your effects before rendering them to see if the effects imported correctly.
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This section includes instructions for moving work to Avid Xpress DV 
Release 1.0 (Windows NT). 

Compat ib i l i ty  Issues

When you are moving projects to Avid Xpress DV Release 1.0, some products 
have direct compatibility while others do not, as described in the following 
sections. 

C o m p a t i b i l i t y  w i t h  A v i d  X p r e s s  D V  R e l e a s e  1 . 5  
o r  2 . 0 ,  a n d  A v i d  X p r e s s  R e l e a s e  4 . x  ( W i n d o w s  
a n d  M a c i n t o s h )

When moving projects backward from Avid Xpress DV Release 1.5 or 2.0, and 
Avid Xpress Release 4.x (Windows and Macintosh), one feature requires 
special attention: real-time moving mattes. Real-time moving mattes are 
converted to non-real-time Matte Key effects in Avid Xpress DV Release 1.0 
(Windows NT).

C o m p a t i b i l i t y  w i t h  L a t e r  R e l e a s e s  o f  
S y m p h o n y ,  M e d i a  C o m p o s e r ,  o r  
F i l m C o m p o s e r

All the features listed in the previous section also apply when you move from 
Symphony Release 3.x and Media Composer or Film Composer Release 10.x 
to Avid Xpress DV Release 1.0 (Windows NT).
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In addition, if there are Intraframe effects (Paint and AniMatte) included in 
your Symphony Release 2.1 or 3.x, or Media Composer Release 9.1 or 10.x 
sequence, the project will not open in Avid Xpress DV Release 1.0 
(Windows NT). 

The following features (available in Symphony Release 3.x, and 
Media Composer and Film Composer Release 10.x) also require special 
attention when moving to Avid Xpress DV Release 1.0 (Windows NT):

• Color correction (Symphony only): Color adjustment does not appear or 
becomes corrupted in Avid Xpress DV Release 1.0 (Windows NT). 

• Stabilize effect (Symphony only): This effect appears as an unknown 
effect in the Timeline and all data is lost in Avid Xpress DV Release 1.0 
(Windows NT). 

• Motion tracking (Symphony only): Effects that are tracking enabled — 
such as the Symphony Warp effect, the Paint effect, the AniMatte effect, 
and the Scratch Removal feature — lose their tracking data in Avid Xpress 
DV Release 1.0 (Windows NT). 

• Ultimatte effect (Symphony only): This effect appears as an unknown 
effect in the Timeline in Avid Xpress DV Release 1.0 (Windows NT). 

• Defocus parameter in 3D effect (Symphony, Media Composer, 
Film Composer): Sequences containing the 3D Warp effect with defocus 
parameters will open, but the effect will use the parameters set under the 
Internal defocus pane and will ignore all other parameters.

• Reformat effects (Symphony, Media Composer, Film Composer): These 
effects appear as unknown effects in the Timeline in Avid Xpress DV 
Release 1.0 (Windows NT). 

• Pan and Scan effects (Symphony, Media Composer, Film Composer): 
These effects appear as unknown effects in the Timeline in Avid Xpress 
DV Release 1.0 (Windows NT). 

• 25p editing (Symphony, Media Composer, Film Composer): 25p editing 
projects do not open in Avid Xpress DV.

• MultiCamera editing (Symphony, Media Composer, Film Composer): 
MultiCamera resolutions 3:1 m, 4:1 m, 8:1 m, and 10:1 m are not 
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compatible. The project will open, but the Timeline will display the 
“unsupported resolution” message. You can, however, redigitize the clips 
in another compatible resolution.

C o m p a t i b i l i t y  w i t h  A v i d  V i d e o - E d i t i n g  
P r o d u c t s

Table 1-11 lists the products from which you can move project files to 
Avid Xpress DV Release 1.0 (Windows NT) and their level of compatibility.

Table 1-11 Moving Project Files to Avid Xpress DV Release 1.0 
(Windows NT)

Source 
Application

Compatibility with Avid Xpress DV Release 1.0 
(Windows NT)

Avid Symphony 
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Media Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Media Composer 
Release 9.1 
(Windows NT)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Media Composer 
Release 8.1 
(Macintosh)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins
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n Before beginning a project that you will be moving to Avid Xpress DV Release 1.0 
(Windows NT), set your audio file format to AIFF-C. This format allows the simplest 

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: AIFF-C audio only, Compositions, 
Bins

Avid Xpress 
Release 3.1 or 4x 
(Windows)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: AIFF-C and WAVE Audio, 
Compositions, Bins

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: AIFF-C Audio, 
Compositions, Bins

Avid Xpress DV 
Release 1.5 or 2.0 
(Windows) 

Compatible: AIFF-C and WAVE Audio, DV 
Video, Compositions, Bins

NewsCutter XP 
Release 1.5 or 2.0

Compatible: AIFF-C and WAVE Audio, DV 
Video, Compositions, Bins

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: AIFF-C and WAVE Audio, DV 
Video, Compositions, Bins

Table 1-11 Moving Project Files to Avid Xpress DV Release 1.0 
(Windows NT) (Continued)

Source 
Application

Compatibility with Avid Xpress DV Release 1.0 
(Windows NT)
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method of transferring audio files between the two applications. To set the audio file 
format, click General Settings.

Moving the Project  F i les

To transfer project files to Avid Xpress DV Release 1.0 (Windows NT):

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and rerecord.

4 Import graphics.

5 Import audio files.

6 Re-create the title media.

7 Render effects.

The following procedures detail each step in the transfer process. For more 
information, see the Avid Xpress DV Help and the appropriate 
documentation for your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for moving to 
Avid Xpress DV Release 1.0 (Windows NT):

• Editing products compatibility: The Avid editing products most 
compatible with Avid Xpress DV Release 1.0 are NewsCutter DV 
Release 1.1, and NewsCutter Release 1.x or 2.x. Film projects are not 
compatible with Avid Xpress DV.

• Audio files: The audio files you can play back in Avid Xpress DV have 
audio sample rates of 32 kHz, 44.1 kHz, and 48 kHz.
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• Video media: There is no direct video media compatibility between 
Avid Xpress DV Release 1.0 (Windows NT) and other Avid products 
(except NewsCutter DV Release 1.1, NewsCutter Release 1.x or 2.x, 
NewsCutter XP Release 1.5 or 2.0, and Avid Xpress DV Release 1.5 or 2.0). 
The bins are compatible, but you must redigitize your media.

• AVX plug-ins: If your project contains AVX plug-in effects and you are 
moving across platforms, make sure the same plug-ins are available on 
both the Windows and Macintosh systems, and that the versions are 
compatible. If the same AVX plug-in effect is not available, the video 
media can be mixed down and imported as an OMFI file. 

If you do not create a mixdown, the effect will be identified as an 
unknown effect on Avid Xpress DV and you will have to create a new 
effect.

Step 2:  Transfer  the Project  Informat ion

Depending on the application, you can transfer files to Avid Xpress DV 
Release 1.0 (Windows NT) in several ways:

• AvidNet Transfer Tool (Windows to Windows; Macintosh to Macintosh; 
Windows to Macintosh; or Macintosh to Windows)

• Compatible external drive storage (Macintosh to Windows, with the 
MacDrive CrossStripe Edition for Avid Systems installed on the Windows 
system)

n If you are already using the MacOpener application on a Windows NT system you 
can continue using it for Avid Xpress DV Release 1.0.

• Network connection (Windows to Windows; Macintosh to Macintosh; or 
Macintosh to Windows)

• Fetch (Macintosh to Macintosh; Macintosh to Windows, with Fetch 
installed on the Macintosh system; or Macintosh to SGI IRIX) 

For detailed information on each of these transfer options, see Appendix A.
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Step 3:  Open the Pro ject  and Rerecord 

If your media is not compatible, there are two options for rerecording. You 
can:

• Rerecord existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Rerecord a sequence — provides a quick one-step process, but it limits 
your options during recording. You can make revisions using only 
assigned handles.

For instructions on rerecording, see your system’s documentation. 

Note the following requirements:

• When you rerecord from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 

• If you rerecord a sequence, Avid recommends that you stop the recording 
process by clicking the Trash icon, and then reset the video levels.

Step 4:  Import  Graphics

Information about importing graphic files is listed below.

• Resizing the DV frame size

With a digital video (DV) format, the frame size of an NTSC DV graphic is 
720 x 480. The NTSC D1 standard frame size is 720 x 486. When importing 
graphics into Avid Xpress DV, you can crop the 486 graphic file by 
removing six lines from the 486 frame size.

n To change the digital video frame size, see “Padding the DV Frame Size” on page 3-52 
or “Cropping the DV Frame Size” on page 3-54.
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• OMFI

DV media embedded in OMFI files can be read only by other 
DV-compatible applications. Non-DV-based applications might not be 
able to uncompress digital video.

• AVI

AVI format can be used for products that do not support QuickTime, and 
could normally use OMFI. Marquee and Elastic Reality (Windows) are 
examples of these products. Because there is no native resolution export 
of the AVI codec, you need to use a generic AVI file, which is slow on both 
export and import.

• QuickTime 4.0

QuickTime “Same as Source” (QuickTime DV) is the quickest method for 
exporting with Avid Xpress DV Release 1.0. Due to the 480-frame size of 
DV, a Fast export to a D1-based product does not work.

Step 5:  Import  Audio  F i les

There are no issues with importing audio files.

Step 6:  Re-create  the  T i t le  Media

After you import all the files into your Avid Xpress DV Release 1.0 
(Windows NT) system, re-create the title media as follows.

1 Open the bin or project.

2 Load the sequence containing the titles into the Composer monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 
the Alt key, and drag the selected group of titles into the Composer monitor. A 

sequence containing all the titles will appear. 
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n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s effects guide or Help.

3 Select all video tracks that contain titles.

4 Mark an IN point and an OUT point to include all your titles.

5 Choose Re-create Title Media from the Clip menu.

- If you have the same font on both systems, the new font appears 
automatically.

Because the mapping process changes the exact appearance of the font, 
check your titles carefully. It might be easier to check your titles from the bin 
than from the sequence.

- If a title opens and the system does not recognize the font, you will see a 
dialog box that allows you to substitute the font in the title for one that is 
installed on the system. 

This replacement establishes a relationship between the font used in the 
original title and the mapped font. For information on changing the font 
mapping, see “Redefining a Font Replacement” on page 1-19.

If more than one font in the title needs replacement, the dialog box will remain 
open after you click OK, and a new message will identify the next font that 
needs replacement. 

6 If necessary, adjust the size of the bounding box, leading values, or kerning 
information. 

Step 7:  Render  Ef fects

You must render all effects. For more information on render options, see the 
Avid Xpress DV Effects Guide.

n Preview your effects before rendering them to see if the effects imported correctly.
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This section includes instructions for moving work to NewsCutter XP 
Release 1.5 (Windows NT) and Release 2.0 (Windows 2000).

Compat ib i l i ty  Issues

When you are moving projects to NewsCutter XP Release 1.5 or 2.0, some 
products have direct compatibility while others do not, as described in the 
following sections. 

C o m p a t i b i l i t y  w i t h  S y m p h o n y ,  
M e d i a C o m p o s e r ,  a n d  F i l m  C o m p o s e r

If there are Intraframe effects (Paint and AniMatte) included in your 
Symphony Release 2.1 or 3.x, or Media Composer Release 9.1 or 10.x 
sequence, the project will not open in NewsCutter XP Release 1.5 or 2.0. 

In addition, when moving projects from later releases of Symphony, 
Media Composer, and Film Composer, the following features and effects are 
not compatible:

• Defocus parameter in 3D effect (Symphony, Media Composer, 
Film Composer): Sequences containing the 3D Warp effect with defocus 
parameters will open, but the effect will use the parameters set under the 
Internal defocus pane and will ignore all other parameters.

• Reformat effects (Symphony, Media Composer, Film Composer): These 
effects appear as unknown effects in the Timeline in NewsCutter XP 
Release 1.5 or 2.0. 
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• Pan and Scan effects (Symphony, Media Composer, Film Composer): 
These effects appear as unknown effects in the Timeline in 
NewsCutter XP Release 1.5 or 2.0. 

• Real-time moving mattes (Symphony, Media Composer, 
Film Composer): Real-time moving mattes are converted to non-real-time 
Matte Key effects in NewsCutter XP Release 1.5 or 2.0.

• Simultaneous automation gain and clip gain volume adjustments 
(Symphony, Media Composer, Film Composer, Avid Xpress): Symphony 
Release 3.x, Media Composer and Film Composer Release 10.x, and 
Avid Xpress Release 4.x support the simultaneous adjustment of volume 
by using both automation gain and clip gain (volume adjustment for the 
entire clip). NewsCutter XP Release 1.5 or 2.0 maintains the automation 
gain adjustments but ignores the clip gain adjustments.

• Color correction (Symphony only): Color adjustment does not appear or 
becomes corrupted in NewsCutter XP Release 1.5 or 2.0. 

• Stabilize effect (Symphony only): This effect appears as an unknown 
effect in the Timeline and in NewsCutter XP Release 1.5 or 2.0. 

• Motion tracking (Symphony only): Effects that are tracking enabled — 
such as the Symphony Warp effect, the Paint effect, the AniMatte effect, 
and the Scratch Removal feature — lose their tracking data in 
NewsCutter XP Release 1.5 or 2.0. 

• Ultimatte effect (Symphony only): This effect appears as an unknown 
effect in the Timeline in NewsCutter XP Release 1.5 or 2.0. 

• 25p editing (Symphony, Media Composer, Film Composer): 25p editing 
projects do not open in NewsCutter XP Release 1.5 or 2.0.

• MultiCamera editing (Symphony, Media Composer, Film Composer): 
MultiCamera resolutions 3:1 m, 4:1 m, 8:1 m, and 10:1 m are not 
compatible. The project will open, but the Timeline will display the 
“unsupported resolution” message. You can, however, redigitize the clips 
in another compatible resolution.
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Table 1-12 lists the products from which you can move project files to 
NewsCutter XP Release 1.5 or 2.0 and their level of compatibility.

Table 1-12 Moving Project Files to NewsCutter XP 
Release 1.5 or 2.0 

Source 
Application Compatibility with NewsCutter XP

Symphony 
Release  2.1 or 3.x

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Media Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Media Composer 
Release 9.1 
(Windows NT)

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Media Composer 
Release 8.1 
(Macintosh)

Compatible: Audio (AIFF-C and WAVE), Bins
Not Compatible: Native Video, Audio 
(Sound Designer II), Compositions

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: Audio (AIFF-C only), Bins
Not Compatible: Native Video, Audio 
(Sound Designer II), Compositions
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n Before beginning a project that you will be moving to NewsCutter XP Release 1.5 or 
2.0, set your audio file format to AIFF-C. This format allows the simplest method of 
transferring audio files between the two applications.

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Audio (AIFF-C and WAVE), Bins
Not Compatible: Native Video, Audio 
(Sound Designer II), Compositions

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Audio (AIFF-C only), Bins
Not Compatible: Native Video, Audio (Sound 
Designer II), Compositions

Avid Xpress DV 
Release 1.0, 1.5, or 
2.0 (Windows)

Compatible: AIFF-C and WAVE Audio, DV 
Video, Compositions, Bins

NewsCutter DV 
Release 1.1, or 
NewsCutter 
Release 1.x or 2.x

Compatible: AIFF-C and WAVE Audio, DV 
Video, Compositions, Bin

Table 1-12 Moving Project Files to NewsCutter XP 
Release 1.5 or 2.0  (Continued)

Source 
Application Compatibility with NewsCutter XP
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Moving the Project  F i les

To transfer project files to NewsCutter XP Release 1.5 or 2.0:

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and redigitize.

4 Import graphics.

5 Transfer or import audio files.

6 Re-create the title media.

7 Render non-real-time effects.

The following procedures detail each step in the transfer process. For more 
information, see the Avid NewsCutter XP Help and the appropriate 
documentation for your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for moving to 
NewsCutter XP Release 1.5 or 2.0:

• Suggestions for AudioSuite users: If your project includes AudioSuite 
plug-in effects, the effects will transfer but cannot be manipulated further. 
However, you can use one of the following options to import media 
effects generated in AudioSuite:

- Render the audio clips or sequences and export them as OMFI files. 
You can perform an audio mixdown first, and then import the files 
into NewsCutter XP Release 1.5 or 2.0. For more information, see the 
Avid NewsCutter XP Help.
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- Render the audio clips or sequences and export them as AIFF-C files. 
In the Export Format dialog box, select the Sound and AIFF-C 
options, and then import the files into NewsCutter XP Release 1.5 or 
2.0.

• Video media: To transfer a composition to NewsCutter XP Release 1.5 or 
2.0, you must export it as an OMFI file. There are some limitations to be 
aware of when you are moving project files to NewsCutter XP Release 1.5 
or 2.0:

- If you import an OMFI composition with media, there will be some 
degradation of the media.

- Clips with groups of effects can cause problems.

- Single-field resolutions can cause problems.

- OMFI 2.0 compositions with audio media can cause problems.

n You will be most successful if you export a two-field OMFI 1.0 composition without 
group clips or an OMFI composition with AIFF-C audio media only.

For more information on exporting OMFI compositions, see the Avid 
NewsCutter XP Help. 

Step 2:  Transfer  the Project  Informat ion

For the options to move your files from one system to another, see 
Appendix A.

Step 3:  Open the Pro ject  and Redigi t ize 

If your media is not compatible, there are three options for redigitizing. You 
can:

• Redigitize existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.
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• Redigitize a sequence — provides a quick one-step process, but it limits 
your options during digitizing. You can make revisions using only 
assigned handles.

• Use the Show Reference Clips option — lets you reveal the source clips 
of a sequence, and then redigitize the clips. This method can be faster than 
the others depending on how the lengths of the original clips compare to 
the clips used in the sequence, and how the lengths of the new audio and 
video clips differ from the original master clips. Because two passes are 
necessary to digitize audio and video from a single source if the lengths 
are not the same, it is sometimes faster to digitize a slightly longer master 
clip than to digitize the new clips once for audio and once for video. 
However, this method uses more disk space and digitizing can take 
longer. This method also gives you more opportunity for revisions. It is a 
good compromise between digitizing all the original clips and digitizing 
only the clips needed to re-create the source.

For instructions on redigitizing, see your system’s documentation. 

Note the following requirements:

• When you redigitize from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 

• If you redigitize a sequence, Avid recommends that you stop the 
digitizing process by clicking the Trash icon, and then reset the video 
levels.

• When you redigitize uncompressed media, Avid recommends that you 
store video and audio on different media drives. 

n If the incoming media is from the SDI (serial digital I/O) board, NewsCutter XP 
Release 1.5 or 2.0 ignores the video input settings.
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Step 4:  Import  Graphics

For a detailed description of importing graphics and effects files into Avid 
video-editing products, see Chapter 3.

Step 5:  Transfer  or  Import  Audio  F i les

For a detailed description of transferring audio files between Avid 
video-editing products, see Chapter 2.

Step 6:  Re-create  the  T i t le  Media

After you import all the files into your NewsCutter XP Release 1.5 or 2.0 
system, re-create the title media as follows:

1 Open the bin or project. 

2 Load the sequence containing the titles into the Record monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 
the Alt key, and drag the selected group of titles into the Record monitor. A 

sequence containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s Help.

3 Select all video tracks that contain titles.

4 Mark an IN point and an OUT point to include all of your titles.

5 Choose Recreate Title Media from the Clip menu.

6 If necessary, adjust the size of the bounding box, leading values, or kerning 
information. 
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Note the following:

• If the original system used any applications to manipulate font display 
(such as Adobe Type Manager), the enhancements these applications 
provided on the original system (such as character anti-aliasing or 
character spacing) will not transfer to a system not using the application. 

• For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.

Step 7:  Render  Non-Real -Time Ef fects

You must render a non-real-time effect (an effect whose icon displays a blue 
dot) before it can be played. In addition, you must render some or all effects 
that exceed the real-time playback capabilities of the system to view the 
effects during playback. Occasionally, you might also need to render an effect 
that displays a green dot in the Timeline, depending on the complexity of the 
sequence. 

n Preview your effects before rendering them to see if the effects imported correctly.

To render multiple effects:

1 Click the track selector in the Timeline for each track with effects to be rendered.

2 Mark an IN point before the first effect to be rendered in your sequence; mark an 
OUT point after the last effect to be rendered.

3 Click Render on the Tool palette.

4 (Optional) Select the quality of the effects. The default quality is Highest Quality. 
The effect quality applies only to effects that change the image size, such as 
Picture-in-Picture, Peel, and Squeeze.

5 If you do not want to render the real-time effects in the selected group of effects, 
select Skip Real-time Effects.

6 Click OK.
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This section includes instructions for moving work to NewsCutter DV 
Release 1.1, or NewsCutter Release 1.2, 1.5, 2.0, or 2.5.

Compat ib i l i ty  Issues

When you are moving projects to NewsCutter DV Release 1.1, or NewsCutter 
Release 1.x or 2.x, some products have direct compatibility while others do 
not, as described in the following sections. 

C o m p a t i b i l i t y  w i t h  L a t e r  R e l e a s e s  o f  
S y m p h o n y ,  M e d i a  C o m p o s e r ,  F i l m  C o m p o s e r ,  
o r  A v i d  X p r e s s

If there are Intraframe effects (Paint and AniMatte) included in your 
Symphony Release 2.1 or 3.x, or Media Composer Release 9.1 or 10.x 
sequence, the project will not open in NewsCutter DV Release 1.1, or 
NewsCutter Release 1.x or 2.x (Windows). 

The following features (available in the following releases: Symphony 
Release 3.x, Media Composer and Film Composer Release 10.x, and 
Avid Xpress Release 4.x) also require special attention when moving to 
NewsCutter DV Release 1.1, or NewsCutter Release 1.x or 2.x (Windows):

• Color correction (Symphony only): Color adjustment does not appear or 
becomes corrupted.

• Stabilize effect (Symphony only): This effect appears as an unknown 
effect in the Timeline. 
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• Motion tracking (Symphony only): Effects that are tracking enabled — 
such as the Symphony Warp effect, the Paint effect, the AniMatte effect, 
and the Scratch Removal feature — lose their tracking data.

• Ultimatte effect (Symphony only): This effect appears as an unknown 
effect in the Timeline. 

• 25p editing (Symphony, Media Composer, Film Composer): 25p editing 
projects do not open.

• MultiCamera editing (Symphony, Media Composer, Film Composer): 
MultiCamera resolutions 3:1 m, 4:1 m, 8:1 m, and 10:1 m are not 
compatible. The project will open, but the Timeline will display the 
“unsupported resolution” message. You can, however, redigitize the clips 
in another compatible resolution.

• Defocus parameter in 3D effect (Symphony, Media Composer, 
Film Composer, Avid Xpress): Sequences containing the 3D Warp effect 
with defocus parameters will open, but the effect will use the parameters 
set under the Internal defocus pane and will ignore all other parameters.

• Reformat effects (Symphony, Media Composer, Film Composer, 
Avid Xpress): These effects appear as unknown effects in the Timeline in 
Release 1.1. 

• Pan and Scan effects (Symphony, Media Composer, Film Composer): 
These effects appear as unknown effects in the Timeline in Release 1.1. 

• Real-time moving mattes (Symphony, Media Composer, 
Film Composer, Avid Xpress): Real-time moving mattes are converted to 
non-real-time Matte Key effects in Release 1.1.

• Simultaneous automation gain and clip gain volume adjustments 
(Symphony, Media Composer, Film Composer, Avid Xpress): Symphony 
Release 3.x, Media Composer and Film Composer Release 10.x, and 
Avid Xpress Release 4.x support the simultaneous adjustment of volume 
by using both automation gain and clip gain (volume adjustment for the 
entire clip). Release 1.1 maintains the automation gain adjustments but 
ignores the clip gain adjustments.
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Table 1-13 lists the products from which you can move project files to 
NewsCutter DV Release 1.1 or NewsCutter Release 1.x or 2.x, and their level 
of compatibility.

Table 1-13 Moving Project Files to NewsCutter DV Release 1.1, or 
NewsCutter Release 1.x or 2.x

Source 
Application

Compatibility with NewsCutter Release DV 
Release 1.1 or NewsCutter Release 1.x or 2.x

Symphony 
Release  2.1 or 3.x

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Media Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Media Composer 
Release 9.1 
(Windows NT)

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Media Composer 
Release 8.1 
(Macintosh)

Compatible: Audio (AIFF-C and WAVE), Bins
Not Compatible: Native Video, Audio 
(Sound Designer II), Compositions

Media Composer 
or Film Composer 
Release 7.2 
(Macintosh)

Compatible: Audio (AIFF-C only), Bins
Not Compatible: Native Video, Audio 
(Sound Designer II), Compositions
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n Before beginning a project that you will be moving to NewsCutter Release 1.x or 2.x, 
set your audio file format to AIFF-C. This format allows the simplest method of 
transferring audio files between the two applications.

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: Audio, Bins
Not Compatible: Native Video, Compositions

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Audio (AIFF-C and WAVE), Bins
Not Compatible: Native Video, Audio 
(Sound Designer II), Compositions

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Audio (AIFF-C only), Bins
Not Compatible: Native Video, Audio 
(Sound Designer II), Compositions

Avid Xpress DV 
Release 1.0, 1.5, or 
2.0 (Windows) 

Compatible: AIFF-C and WAVE audio, DV Video, 
Compositions, Bins

NewsCutter XP 
Release 1.5 or 2.0

Compatible: AIFF-C and WAVE audio, DV Video, 
Compositions, Bins

Table 1-13 Moving Project Files to NewsCutter DV Release 1.1, or 
NewsCutter Release 1.x or 2.x (Continued)

Source 
Application

Compatibility with NewsCutter Release DV 
Release 1.1 or NewsCutter Release 1.x or 2.x
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Moving the Project  F i les

To transfer project files to NewsCutter DV Release 1.1 or NewsCutter 
Release 1.x or 2.x:

1 Prepare the project files for export. 

2 Transfer the project information.

3 Open the project and redigitize.

4 Import graphics.

5 Transfer or import audio files.

6 Re-create the title media.

7 Render non-real-time effects.

The following procedures detail each step in the transfer process. For more 
information, see the Avid NewsCutter Help and the appropriate 
documentation for your product.

Step 1:  Prepare  the  Pro ject  Fi les for  Export

Follow some or all of these guidelines to prepare your project for moving to 
NewsCutter DV Release 1.1 or NewsCutter Release 1.x or 2.x:

• Suggestions for AudioSuite users: If your project includes AudioSuite 
plug-in effects, the effects will transfer but cannot be manipulated further. 
However, you can use one of the following options to import media 
effects generated in AudioSuite:

- Render the audio clips or sequences and export them as OMFI files. 
You can perform an audio mixdown first, and then import the files 
into NewsCutter. For more information, see the Avid NewsCutter 
Help.



. .
 . 

. .

Collaboration Guide 1-167

M O V I N G  T O  N E W S C U T T E R  D V  R E L E A S E  1 . 1 ,  O R  N E W S C U T T E R  R E L E A S E  1 . X  O R  2 . X

- Render the audio clips or sequences and export them as AIFF-C files. 
In the Export Format dialog box, select the Sound and AIFF-C 
options, and then import the files into NewsCutter.

• Video media: To transfer a composition to NewsCutter, you must export 
it as an OMFI file. There are some limitations to be aware of when you are 
moving project files to NewsCutter:

- If you import an OMFI composition with media, there will be some 
degradation of the media.

- Clips with groups of effects can cause problems.

- Single-field resolutions can cause problems.

- OMFI 2.0 compositions with audio media can cause problems.

n You will be most successful if you export a two-field OMFI 1.0 composition without 
group clips or an OMFI composition with AIFF-C audio media only.

For more information on exporting OMFI compositions, see the Avid 
NewsCutter Help. 

Step 2:  Transfer  the Project  Informat ion

For the options to move your files from one system to another, see 
Appendix A.

Step 3:  Open the Pro ject  and Redigi t ize 

If your media is not compatible, there are three options for redigitizing. You 
can:

• Redigitize existing clips — offers complete flexibility to make revisions, 
but takes the most time and disk space.

• Redigitize a sequence — provides a quick one-step process, but it limits 
your options during digitizing. You can make revisions using only 
assigned handles.



1-168 Collaboration Guide

C h a p t e r  1
M O V I N G  T O  N E W S C U T T E R  D V  R E L E A S E  1 .1 ,  O R  N E W S C U T T E R  
R E L E A S E  1 . X  O R  2 . X

1-168 Collaboration Guide

• Use the Show Reference Clips option — lets you reveal the source clips 
of a sequence, and then redigitize the clips. This method can be faster than 
the others depending on how the lengths of the original clips compare to 
the clips used in the sequence, and how the lengths of the new audio and 
video clips differ from the original master clips. Because two passes are 
necessary to digitize audio and video from a single source if the lengths 
are not the same, it is sometimes faster to digitize a slightly longer master 
clip than to digitize the new clips once for audio and once for video. 
However, this method uses more disk space and digitizing can take 
longer. This method also gives you more opportunity for revisions. It is a 
good compromise between digitizing all the original clips and digitizing 
only the clips needed to re-create the source.

For instructions on redigitizing, see your system’s documentation. 

Note the following requirements:

• When you redigitize from source tapes, Avid recommends that you 
readjust the video levels. You can reuse video settings from another 
system, but the existing settings have been calibrated to a different set of 
hardware and might not operate properly. 

• If you redigitize a sequence, Avid recommends that you stop the 
digitizing process by clicking the Trash icon, and then reset the video 
levels.

• When you redigitize uncompressed media, Avid recommends that you 
store video and audio on different media drives. 

n If the incoming media is from the SDI (serial digital I/O) board, NewsCutter ignores 
the video input settings.

Step 4:  Import  Graphics

For a detailed description of importing graphics and effects files into Avid 
video-editing products, see Chapter 3.
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Step 5:  Transfer  or  Import  Audio  F i les

For a detailed description of transferring audio files between Avid 
video-editing products, see Chapter 2.

Step 6:  Re-create  the  T i t le  Media

After you import all the files into your NewsCutter DV Release 1.1, or 
NewsCutter Release 1.x or 2.x system, re-create the title media as follows:

1 Open the bin or project. 

2 Load the sequence containing the titles into the Record monitor.

If the titles are not part of a sequence, select the titles in the bin, press and hold 
the Alt key, and drag the selected group of titles into the Record monitor. A 

sequence containing all the titles will appear. 

n You can also open titles in other ways, such as double-clicking a title in a bin. For 
more information on opening and editing titles, including full instructions for 
re-creating title media, see your product’s Help.

3 Select all video tracks that contain titles.

4 Mark an IN point and an OUT point to include all of your titles.

5 Choose Recreate Title Media from the Clip menu.

6 If necessary, adjust the size of the bounding box, leading values, or kerning 
information. 

Note the following:

• If the original system used any applications to manipulate font display 
(such as Adobe Type Manager), the enhancements these applications 
provided on the original system (such as character anti-aliasing or 
character spacing) will not transfer to a system not using the application. 

• For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.
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Step 7:  Render  Non-Real -Time Ef fects

You must render a non-real-time effect (an effect whose icon displays a blue 
dot) before it can be played. In addition, you must render some or all effects 
that exceed the real-time playback capabilities of the system to view the 
effects during playback. Occasionally, you might also need to render an effect 
that displays a green dot in the Timeline, depending on the complexity of the 
sequence. 

n Preview your effects before rendering them to see if the effects imported correctly.

To render multiple effects:

1 Click the track selector in the Timeline for each track with effects to be rendered.

2 Mark an IN point before the first effect to be rendered in your sequence; mark an 
OUT point after the last effect to be rendered.

3 Click Render on the Tool palette.

4 (Optional) Select the quality of the effects. The default quality is Highest Quality. 

The effect quality applies only to effects that change the image size, such as 
Picture-in-Picture, Peel, and Squeeze.

5 If you do not want to render the real-time effects in the selected group of effects, 
select Skip Real-time Effects.

6 Click OK.
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Softimage|DS and Avid|DS are nonlinear systems for creating, editing, and 
finishing effects-intensive videos such as commercials, music videos, and TV 
programs. Avid|DS is the latest version of the DS product line and reflects a 
name change from Softimage|DS to Avid|DS. Using uncompressed and 
compressed quality images, Softimage|DS and Avid|DS each contain a 
complete set of customizable tools that provide professional nonlinear 
editing, compositing, paint, digital audio editing, character generation, 
special effects, image treatment, and project management. 

When you are moving projects to Softimage|DS Release 3.0.1 or Avid|DS 
Release 4.0, you must export your sequence as an OMFI composition and 
redigitize your media.

To transfer project files to Softimage|DS Release 3.0.1 or Avid|DS Release 4.0, 
see the “Conforming” chapter of your Softimage|DS Release 3.0.1 or 
Avid|DS Release 4.0 user’s guide.

n Softimage|DS and Avid|DS do not support OMFI 1.0. Softimage|DS and 
Avid|DS support the import of OMFI 2.0 files.
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The three file formats that you will be working with when you move audio 
media are:

• Audio Interchange File Format (AIFF): This format for audio files was 
developed by Apple Computer, Inc.

Avid uses the AIFF-C file format. Although the data is not compressed, 
the file headers still use the “-C” extension of the AIFF file format. This 
prevents you from editing AIFF-C audio media files in programs that 
understand only the uncompressed AIFF file format because they do not 
recognize the -C header extensions.

n In Media Composer Release 8.1 or later (Macintosh) and Avid Xpress Release 3.1 or 
later (Windows), the AIFF format is now designated as AIFF-C. Broadcast Extension 
(bext) information and a universal media identifier are also included. 

• Wave Format (WAVE): This format for audio files was developed jointly 
by Microsoft® and IBM®. WAVE files can be played by most Windows 
applications that support sound.

• Sound Designer II (SD2): This format for audio files was developed by 
Digidesign®. It is a format for Macintosh applications only.

In addition, there are three sample rates you can use with Symphony 
Release 3.x, Media Composer or Film Composer Release 10.x, Avid Xpress 
Release 4.x, and Avid Xpress DV Release 1.0, 1.5, or 2.0:

• 32-kHz (Avid Xpress DV only): A 32-kHz file cannot be exported to an 
application that does not support 32 kHz. You must convert the 32-kHz 
audio sample rate.

• 44.1-kHz and 48-kHz: You can now mix these sample rates in the 
Timeline in Symphony Release 3.x, Media Composer or Film Composer 
Release 10.x, and Avid Xpress Release 4.x. You can also mix 32-, 44.1-, and 
48-kHz audio files in the Timeline in Avid Xpress DV Release 1.0, 1.5, or 
2.0. You must convert these sample rates to a single sample rate before 
exporting the audio to applications that do not support mixed rates.
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As you move sequences with audio media between Avid applications, it is 
important that you verify your audio formats to ensure compatibility. 
Table 2-1 lists Avid video-editing applications and the audio formats they 
support.

c If you are moving between applications that support incompatible audio 
formats, you must use OMFI.

c When you work in an Avid Unity workgroup environment, use the AIFF-C 
audio format for the most complete compatibility among clients. Avoid 
using Sound Designer II, which is a format for Macintosh systems.

n If you use the AvidNet Transfer Tool to move your sequence from Media Composer 
Release 7.2 or 8.1 (Macintosh) or Avid Xpress Release 2.1, 2.5, or 3.1 (Macintosh), 
AvidNet will convert some audio formats for you. It will convert AIFF-C to Sound 
Designer II if you are moving to AudioVision, and Sound Designer II to AIFF-C if 
you are moving to Media Composer, Film Composer, Symphony, or Avid Xpress 
(Windows).

Table 2-1 Supported Audio Formats in Avid Video-Editing 
Products

Avid Video-Editing 
Application Supported Audio Formats

Symphony 2.1 or 3.x AIFF-C and WAVE

Media Composer Release 9.1 
or 10.x (Windows)

AIFF-C and WAVE

Film Composer Release 10.x 
(Windows)

AIFF-C and WAVE
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Table 2-2 lists Avid’s audio-editing applications and the audio formats they 
support.

Media Composer or 
Film Composer Release 10.x 
(Macintosh)

AIFF-C and WAVE

Media Composer Release 8.1 
(Macintosh)

Sound Designer II, WAVE, and AIFF-C

Media Composer Release 7.2 Sound Designer II and AIFF-C

Avid Xpress Release 3.1 or 4.x 
(Windows)

AIFF-C and WAVE

Avid Xpress Release 2.5 or 4.x 
(Macintosh)

Sound Designer II, WAVE, and AIFF-C

Avid Xpress Release 2.1 
(Macintosh)

Sound Designer II and AIFF-C

Softimage|DS Release 3.0.1 
and Avid|DS Release 4.0

WAVE

Table 2-1 Supported Audio Formats in Avid Video-Editing 
Products (Continued)

Avid Video-Editing 
Application Supported Audio Formats

Table 2-2 Supported Audio Formats in Avid Audio-Editing Products

Avid Audio-Editing 
Application Supported Audio Formats

AudioVision Release 4.1v10 Sound Designer II

Pro Tools Release 4.3.1 
(Macintosh)

Sound Designer II and AIFF-C
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n If your video-editing application supports AIFF-C, set your audio file format to 
AIFF-C before beginning a project. This ensures the simplest method of transferring 
audio files between two applications.

When you are moving your sequence to an audio-editing application, you 
need to export the sequence as OMFI. If the audio-editing application to 
which you are moving supports the audio format used to create your 
sequence, you can export the sequence as an OMFI composition without 
media and move the original media files to the audio-editing workstation. If 
the audio-editing application to which you are moving your sequence does not 
support the audio format in your video-editing application, you must export 
the sequence as an OMFI composition with audio media. 

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move your files, you might want to include the audio media 
in your OMFI composition to simplify moving across the network.
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This section describes how to transfer sequences with audio media from 
Symphony Release 3.0, 3.1, or 3.5 to AudioVision or Pro Tools for audio 
sweetening. It also describes how to move your audio media to a 
Media Composer or Film Composer, Avid Xpress, or another Symphony 
system.

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. For example, if you created your 
sequence in Symphony by using the AIFF-C audio format and you are 
moving to Pro Tools on the Macintosh, you can export your sequence as an 
OMFI composition only and move your original audio media from the 
Symphony system to the Pro Tools workstation. However, if you wanted to 
move the same sequence to AudioVision, you would need to export the 
sequence as an OMFI composition with audio media before you could move it 
to the AudioVision workstation. 

If there is bin compatibility between your applications, such as between 
Symphony Release 3.x and Media Composer Release 10.x (Windows), and 
you use compatible audio formats, you can move your bin and media without 
creating an OMFI file.

Table 2-3 lists the editing applications and their compatibility with Symphony 
Release 3.x.
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Table 2-3 Moving Sequences from Symphony Release 3.x (Windows) to 
an Editing Application

Destination 
Application

Compatibility with Symphony Release 3.x 
(Windows)

AudioVision 
Release 4.1v10

Compatible: None 
Export your sequence as an OMFI 1.0 composition 
with embedded audio media.

Pro Tools 
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
with embedded audio media if you used the WAVE 
format.
Export your sequence as an OMFI 2.0 composition 
only, if you used the AIFF-C format.

Symphony 
Release 2.1

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 9.1 or 10.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Film Composer 
Release 10.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 8.1 or 10.x, 
or Avid Xpress 
Release 2.5 or 4.x 
(Macintosh)

Compatible: AIFF-C, and WAVE
Bin compatibility; see Appendix A.
Export your sequence as an OMFI 1.0 composition 
with embedded audio media if you used the 
Sound Designer II format.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

To move sequences with audio media between applications with different 
audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from Symphony to an 
editing system, review the following list to ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the application to which 
you are moving. To set the audio file format, select General Settings from 
the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

Media Composer 
Release 7.2 or 
Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: AIFF-C 
Export your sequence as an OMFI composition with 
embedded audio media if you used the WAVE 
format.
Bin compatibility if you used AIFF-C; see 
Appendix A.

Table 2-3 Moving Sequences from Symphony Release 3.x (Windows) to 
an Editing Application (Continued)

Destination 
Application

Compatibility with Symphony Release 3.x 
(Windows)
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If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
with Audio Media” on page 2-10. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Media Composer or Film Composer, 
Avid Xpress, or Symphony. For options and instructions for transferring 
files, see Appendix A.

C o n v e r t i n g  M u l t i p l e  A u d i o  S a m p l e  R a t e s

If you have a sequence with multiple audio sample rates (for example, one 
clip at 48 kHz and other clips at 44.1 kHz), you must convert the clips to a 
single sample rate for transfer to Symphony Release 2.1 or earlier, 
Media Composer Release 9.1 or earlier, or Avid Xpress Release 3.1 or earlier. 

To convert a sequence to a single audio sample rate:

1 Make a duplicate of your sequence and name it to indicate the conversion to one 

sample rate; for example, “Sequence44.”

2 Select the new sequence, and then choose Change Sample Rate from the Bin 

menu.

3 Choose a quality level for the conversion.

4 Choose a sample rate from the submenu, and then click OK.

Step 2:  Export  the Sequence wi th Audio Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.
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There are two methods for exporting the sequence: you can use AvidLinks for 
quick export to AudioVision or Pro Tools, or you can use the Export Format 
dialog box to manually determine settings for export to a variety of 
applications.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

To export a sequence with audio media, using AvidLinks:

1 In a Symphony bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HSF nonstriped drive if you are moving these files to a Macintosh 
digital audio workstation.

4 Choose Export from the File menu and point to AvidLinks.

5 Select the appropriate AvidLink for the application to which you are moving media.

For a list of the available AvidLinks, see Appendix B.

AudioVision AudioVision AvidLink choice:

- AudioVision — Exports an OMFI composition with embedded AIFF-C audio 

media 

Pro Tools Pro Tools AvidLink choice:

- Digidesign Pro Tools — Exports an OMFI composition with embedded AIFF-C 
audio media
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To export a sequence with audio media, using the Export Format dialog box:

1 In a Symphony bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Macintosh 
workstation.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select Customize.

The Export Settings dialog box appears.

6 (Optional) Enter a name if this is a template you want to keep.

7 Choose the format options based on the application to which you are moving 
media.

AudioVision Moving AIFF-C or WAVE files to AudioVision:

- Click the AudioVision Compatibility check box.

Pro Tools — 
AIFF-C

Moving AIFF-C files to Pro Tools (Macintosh):

a Choose OMFI.

b Select Version 2.0.

Pro Tools — 
WAVE

Moving WAVE files to Pro Tools (Macintosh):

a Choose OMFI.

b Select Version 2.0.

c Select Embed Audio Media.

d Select AIFF-C.
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Media Composer 
7.2

Moving WAVE files to Media Composer Release 7.2:

a Choose OMFI.

b Select Version 1.0.

c Select Embed Audio Media.

d Select AIFF-C.

Avid Xpress 2.1 
(Macintosh)

Moving WAVE files to Avid Xpress Release 2.1 (Macintosh):

a Choose OMFI.

b Select Version 1.0.

c Select Embed Audio Media.

d Select AIFF-C.

8 Click OK.

9 In the Export As dialog box, check the file name, select a drive formatted for 
Windows (NTFS) or a network drive, and click Save.

Step 3:  Transfer  the F i les  to  the Dest inat ion System

For the options to move your files from one system to another, see 
Appendix A.

Step 4:  Import  the OMFI  F i le

This final step varies, depending on both the file type and the receiving 
system. The following sections describe how to import the audio file into 
AudioVision, Pro Tools, and Media Composer or Film Composer.

AudioVision To import OMFI files after transferring the files to the AudioVision system, 
start AudioVision and import the files into a bin.
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Pro Tools To import OMFI files into Pro Tools:

1 Start the Macintosh system.

2 Open the DigiTranslator™.

3 Create a Session File from the OMFI file you exported from Symphony.

4 Start Pro Tools and open the Session File. All audio should now be online.

Media Composer 
or Film Composer

When you import OMFI files into Media Composer or Film Composer, the 
system converts them to objects in a bin. You can manipulate and edit these 
objects as you would any other clip or sequence. 

To import an OMFI file into Media Composer or Film Composer for 
Macintosh:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click the bin to select it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the File Type pop-up menu.

5 Choose a destination drive from the Media Drive pop-up menu.

6 Use the Directory pop-up menu to locate the folder containing the source files.

7 Add files to or remove files from the import file list on the right, using one of the 

following methods:

- To add a single file, select a file name in the source file list and click the Add 

button, or double-click the file name.

- To add all the files in the source file list, click the Add All button.

- To remove a single file from the import file list, select a file name and click the 
Remove button.

- To remove all the files from the import file list, click the Remove All button.
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8 Click Done.

To import an OMFI file into Media Composer or Film Composer for 
Windows:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Import File(s) into Bin dialog box appears.

4 Choose OMFI from the Files of Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Look In pop-up menu to locate the folder containing the source files.

7 Add files to the import file list on the right, using one of the following methods:

- To add a single file, select the file name in the source file list.

- To add multiple files, press and hold the Ctrl key while selecting the file name 

for each file you want to include.

- To add all the files in the source file list, press Ctrl+A.

8 Click Done.
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This section describes how to transfer sequences with audio media from 
Symphony Release 2.1 to AudioVision or Pro Tools for audio sweetening. It 
also describes how to move your audio media to a Media Composer or 
Film Composer, Avid Xpress, or another Symphony system.

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. For example, if you created your 
sequence in Symphony by using the AIFF-C audio format and you are 
moving to Pro Tools on the Macintosh, you can export your sequence as an 
OMFI composition only and move your original audio media from the 
Symphony system to the Pro Tools workstation. However, if you wanted to 
move the same sequence to AudioVision, you would need to export the 
sequence as an OMFI composition with audio media before you could move it 
to the AudioVision workstation. 

If there is bin compatibility between your applications, such as between 
Symphony Release 2.1 and Media Composer Release 9.1 (Windows), and you 
use compatible audio formats, you can move your bin and media without 
creating an OMFI file.

Table 2-4 lists the editing applications and their compatibility with Symphony 
Release 2.1.
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Table 2-4 Moving Sequences from Symphony Release 2.1 (Windows) to 
an Editing Application

Destination 
Application

Compatibility with Symphony Release 2.1 
(Windows)

AudioVision 
Release 4.1v10

Compatible: Sound Designer II 
Export your sequence as an OMFI 1.0 composition 
with embedded audio media.

Pro Tools 
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
with embedded audio media if you used the WAVE 
format.
Export your sequence as an OMFI 2.0 composition 
only, if you used the AIFF-C format.

Symphony 
Release 3.x

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 9.1 or 10.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Film Composer 
Release 10.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 8.1 or 10.x 
or Avid Xpress 
Release 2.5 or 4.x 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and WAVE
Bin compatibility; see Appendix A.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

To move sequences with audio media between applications with different 
audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from Symphony to an 
editing system, review the following list to ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the application to which 
you are moving. To set the audio file format, select General Settings from 
the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

Media Composer 
Release 7.2 or 
Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Sound Designer II and AIFF-C 
Export your sequence as an OMFI composition with 
audio media if you used the WAVE format.
Bin compatibility if you used AIFF-C; see 
Appendix A.

Table 2-4 Moving Sequences from Symphony Release 2.1 (Windows) to 
an Editing Application (Continued)

Destination 
Application

Compatibility with Symphony Release 2.1 
(Windows)
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If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
with Audio Media” on page 2-19. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Media Composer or Film Composer, 
Avid Xpress, or Symphony. For options and instructions for transferring 
files, see Appendix A.

Step 2:  Export  the Sequence wi th Audio Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.

There are two methods for exporting the sequence: you can use templates for 
quick export to AudioVision or Pro Tools, or you can use the Export Format 
dialog box to manually determine settings for export to a variety of 
applications.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

To export a sequence with audio media, using a template:

1 In a Symphony bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.
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n Consolidate to an HSF nonstriped drive if you are moving these files to a Macintosh 
digital audio workstation.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select the appropriate template for the application to which you are moving media.

For a list of the available templates, see Appendix B.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

AudioVision AudioVision template choice:

- AudioVision AIFF-C Embedded — Exports an OMFI composition with 
embedded AIFF-C audio media 

Pro Tools Pro Tools template choices:

- Pro Tools AIFF-C Embedded — Exports an OMFI composition with 

embedded AIFF-C audio media. 

- Pro Tools AIFF-C External — Exports OMFI composition only. Use this 

template if you have AIFF-C audio media in your sequence. This template 
does not re-create any media.

6 Click OK.

7 In the Export As dialog box, check the file name, select a drive, and click Save.

If you are moving a sequence to another Symphony, Media Composer or 
Film Composer, or Avid Xpress system, use the following steps to customize 
your settings.

1 In a Symphony bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 

your original sequence.

3 Consolidate the sequence.
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n Consolidate to an HFS nonstriped drive if you are moving these files to a Macintosh 
digital audio workstation.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select Customize.

The Export Settings dialog box appears.

6 (Optional) Enter a name if this is a template you want to keep.

7 Choose the format options based on the application to which you are moving 
media.

AudioVision Moving AIFF-C or WAVE files to AudioVision:

- Click the AudioVision Compatibility check box.

Pro Tools — 
AIFF-C

Moving AIFF-C files to Pro Tools (Macintosh):

a Click the OMFI Composition button.

b Choose Version 2.0 from the Version pop-up menu.

Pro Tools — 
WAVE

Moving WAVE files to Pro Tools (Macintosh):

a Click the OMFI Composition button.

b Choose Version 2.0 from the Version pop-up menu.

c Click the Use Audio Media check box.

d Choose AIFF-C from the pop-up menu.

Media Composer 
7.2 (Macintosh)

Moving WAVE files to Media Composer Release 7.2:

a Click the OMFI Composition button.

b Choose Version 1.0 from the Version pop-up menu.

c Click the Use Audio Media check box.

d Choose AIFF-C from the pop-up menu.

Avid Xpress 2.1 
(Macintosh)

Moving WAVE files to Avid Xpress Release 2.1 (Macintosh):

a Click the OMFI Composition button.
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b Choose Version 1.0 from the Version pop-up menu.

c Click the Use Audio Media check box.

d Choose AIFF-C from the pop-up menu.

8 Click OK.

9 In the Export As dialog box, check the file name, select a drive formatted for 
Windows (NTFS) or a network drive, and click Save.

Step 3:  Transfer  the F i les  to  the Dest inat ion System

For the options to move your files from one system to another, see 
Appendix A.

Step 4:  Import  the OMFI  F i le

This final step varies, depending on both the file type and the receiving 
system. The following sections describe how to import the audio file into 
AudioVision, Pro Tools, and Media Composer or Film Composer.

AudioVision To import OMFI files after transferring the files to the AudioVision system, 
start AudioVision and import the files into a bin.

Pro Tools To import OMFI files into Pro Tools:

1 Start the Macintosh system.

2 Open the DigiTranslator or OMF Tool 2.0.8.

3 Create a Session File from the OMFI file you exported from Symphony.

4 Start Pro Tools and open the Session File. All audio should now be online.
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Media Composer 
or Film Composer

When you import OMFI files into Media Composer or Film Composer, the 
system converts them to objects in a bin. You can manipulate and edit these 
objects as you would any other clip or sequence. 

To import an OMFI file into Media Composer or Film Composer (Macintosh):

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 

it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the File Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 

menu.

6 Use the Directory pop-up menu to locate the folder containing the source files.

7 Add files to or remove files from the import file list on the right, using one of the 
following methods:

- To add a single file, select a file name in the source file list and click the Add 
button, or double-click the file name.

- To add all the files in the source file list, click the Add All button.

- To remove a single file from the import file list, select a file name and click the 
Remove button.

- To remove all the files from the import file list, click the Remove All button.

8 Click Done.
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To import an OMFI file into Media Composer or Film Composer (Windows):

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Import File(s) into Bin dialog box appears.

4 Choose OMFI from the Files of Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Look In pop-up menu to locate the folder containing the source files.

7 Add files to the import file list on the right, using one of the following methods:

- To add a single file, select the file name in the source file list.

- To add multiple files, press and hold the Ctrl key while selecting the file name 
for each file you want to include.

- To add all the files in the source file list, press Ctrl+A.

8 Click Done.
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This section describes how to transfer sequences with audio media from 
Media Composer or Film Composer Release 10.x (Windows) to AudioVision 
or Pro Tools for audio sweetening. It also describes how to move your audio 
media to Symphony, Avid Xpress, or another Media Composer or 
Film Composer system.

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. For example, if you created your 
sequence in Media Composer Release 10.0 (Windows) by using the AIFF-C 
audio format and you are moving to Pro Tools on the Macintosh, you can 
export your sequence as an OMFI composition only and move your original 
audio media from the Media Composer system to the Pro Tools workstation. 
However, if you wanted to move the same sequence to AudioVision, you 
would need to export the sequence as an OMFI composition with audio 
media before you could move it to the AudioVision workstation. 

If there is bin compatibility between your applications, such as between 
Media Composer Release 10.x (Windows) and Media Composer Release 9.1 
(Windows), and you use compatible audio formats, you can move your bin 
and media without creating an OMFI file.

Table 2-5 lists the editing applications and their compatibility with 
Media Composer or Film Composer Release 10.x (Windows).
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Table 2-5 Moving Sequences from Media Composer or Film Composer 
Release 10.x (Windows) to an Editing Application

Destination 
Application

Compatibility with Media Composer or 
Film Composer Release 10.x (Windows)

AudioVision 
Release 4.1v10

Compatible: Sound Designer II 
Export your sequence as an OMFI 1.0 composition 
with audio media.

Pro Tools 
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
with audio media if you used the WAVE format.
Export your sequence as an OMFI 2.0 composition 
only, if you used the AIFF-C format.

Symphony 
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 9.1 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 8.1 or 10.x, 
or Avid Xpress 
Release 2.5 or 4.x 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 7.2 or 
Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Sound Designer II and AIFF-C 
Export your sequence as an OMFI composition 
with audio media if you used the WAVE format.
Bin compatibility if you used AIFF-C; see 
Appendix A.

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

To move sequences with audio media between applications with different 
audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from 
Media Composer or Film Composer Release 10.x (Windows) to an editing 
system, review the following list to ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the application to which 
you are moving. To set the audio file format, select General Settings from 
the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

Avid Xpress 
Release 2.1 or 2.5 
(Macintosh)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Table 2-5 Moving Sequences from Media Composer or Film Composer 
Release 10.x (Windows) to an Editing Application (Continued)

Destination 
Application

Compatibility with Media Composer or 
Film Composer Release 10.x (Windows)
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If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
with Audio Media” on page 2-29. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Symphony, Media Composer or Film Composer, 
or Avid Xpress. For options and instructions for transferring files, see 
Appendix A.

C o n v e r t i n g  M u l t i p l e  A u d i o  S a m p l e  R a t e s

If you have a sequence with multiple audio sample rates (for example, one 
clip at 48 kHz and other clips at 44.1 kHz), you must convert the clips to a 
single sample rate for transfer to Symphony Release 2.1 or earlier, 
Media Composer Release 9.1 or earlier, or Avid Xpress Release 3.1 or earlier. 

To convert a sequence to a single audio sample rate:

1 Make a duplicate of your sequence and name it to indicate the conversion to one 

sample rate; for example, “Sequence44.”

2 Select the new sequence, and then choose Change Sample Rate from the Bin 

menu.

3 Choose a quality level for the conversion.

4 Choose a sample rate from the submenu, and then click OK.
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Step 2:  Export  the Sequence wi th Audio Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.

There are two methods for exporting the sequence: you can use AvidLinks for 
quick export to AudioVision or Pro Tools, or you can use the Export Format 
dialog box to manually determine settings for export to a variety of 
applications.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

To export a sequence with audio media, using AvidLinks:

1 In a Media Composer or Film Composer bin, select the sequence or master clip 

you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Macintosh 
digital audio workstation.

4 Open the File menu and point to AvidLinks. 

5 Select the appropriate AvidLink for the application to which you are moving media.

For a list of the available AvidLinks, see Appendix B.



2-30 Collaboration Guide

C h a p t e r  2
M O V I N G  S E Q U E N C E S  W I T H  A U D I O  M E D I A  F R O M  M E D I A  C O M P O S E R  
O R  F I L M  C O M P O S E R  R E L E A S E  1 0 . X  F O R  W I N D O W S

2-30 Collaboration Guide

AudioVision AudioVision AvidLink choice:

- AudioVision — Exports an OMFI composition with embedded AIFF-C audio 

media 

Pro Tools Pro Tools AvidLink choice:

- Digidesign Pro Tools Embedded — Exports an OMFI composition with 
embedded AIFF-C audio media. 

To export a sequence with audio media, using the Export Format dialog box:

1 In a Media Composer or Film Composer bin, select the sequence or master clip 
you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Macintosh 
digital audio workstation.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select Customize.

The Export Settings dialog box appears.

6 (Optional) Enter a name if this is a template you want to keep.

7 Choose the format options based on the application to which you are moving 
media.

AudioVision Moving AIFF-C or WAVE files to AudioVision:

- Click the AudioVision Compatibility check box.
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Pro Tools — 
AIFF-C

Moving AIFF-C files to Pro Tools (Macintosh):

a Choose OMFI.

b Select Version 2.0.

Pro Tools — 
WAVE

Moving WAVE files to Pro Tools (Macintosh):

a Choose OMFI.

b Select Version 2.0.

c Select Embed Audio Media.

d Select AIFF-C.

Media Composer 
7.2 (Macintosh)

Moving WAVE files to Media Composer Release 7.2:

a Choose OMFI.

b Select Version 1.0.

c Select Embed Audio Media.

d Select AIFF-C.

Avid Xpress 2.1 
(Macintosh)

Moving WAVE files to Avid Xpress Release 2.1 (Macintosh):

a Choose OMFI.

b Select Version 1.0.

c Select Embed Audio Media.

d Select AIFF-C.

8 Click OK.

9 In the Export As dialog box, check the file name, select a drive formatted for 

Windows (NTFS) or a network drive, and click Save.

Step 3:  Transfer  the F i les  to  the Dest inat ion System

For the options to move your files from one system to another, see 
Appendix A.
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Step 4:  Import  the OMFI  F i le  

This final step varies, depending on both the file type and the receiving 
system. The following sections describe how to import the audio file into 
AudioVision, Pro Tools, and Media Composer or Film Composer.

AudioVision To import OMFI files after transferring the files to the AudioVision system, 
start AudioVision and import the files into a bin.

Pro Tools To import OMFI files into Pro Tools:

1 Start the Macintosh system.

2 Open the DigiTranslator.

3 Create a Session File from the OMFI file you exported from Media Composer or 
Film Composer Release 10.x (Windows).

4 Start Pro Tools and open the Session File. All audio should now be online.

Media Composer 
or Film Composer

When you import OMFI files into Media Composer or Film Composer, the 
system converts them to objects in a bin. You can manipulate and edit these 
objects as you would any other clip or sequence. 

To import an OMFI file into Media Composer or Film Composer for 
Macintosh:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the File Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.
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6 Use the Directory pop-up menu to locate the folder containing the source files.

7 Add files to or remove files from the import file list on the right, using one of the 
following methods:

- To add a single file, select a file name in the source file list and click the Add 
button, or double-click the file name.

- To add all the files in the source file list, click the Add All button.

- To remove a single file from the import file list, select a file name and click the 
Remove button.

- To remove all the files from the import file list, click the Remove All button.

8 Click Done.

To import an OMFI file into Media Composer or Film Composer for 
Windows:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 

it. 

3 Choose Import from the File menu. 

The Import File(s) into Bin dialog box appears.

4 Choose OMFI from the Files of Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 

menu.

6 Use the Look In pop-up menu to locate the folder containing the source files.

7 Add files to the import file list on the right, using one of the following methods:

- To add a single file, select the file name in the source file list.

- To add multiple files, press and hold the Ctrl key while selecting the file name 

for each file you want to include.

- To add all the files in the source file list, press Ctrl+A.

8 Click Done.
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This section describes how to transfer sequences with audio media from 
Media Composer or Film Composer Release 10.0, 10.1, or 10.5 (Macintosh) to 
AudioVision or Pro Tools for audio sweetening. It also describes how to move 
your audio media to Symphony, Avid Xpress, Film Composer, or another 
Media Composer system.

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. The formats available in 
Media Composer or Film Composer Release 10.x (Macintosh) are compatible 
with formats in both AudioVision and Pro Tools. Therefore, you can export 
your sequence as an OMFI composition only and move your original audio 
media from the Media Composer or Film Composer Release 10.x (Macintosh) 
system to the Pro Tools or AudioVision workstation. 

If there is bin compatibility between your applications, such as between 
Media Composer or Film Composer Release 10.0 (Windows) and 
Media Composer Release 8.1 (Macintosh), and you use compatible audio 
formats, you can move your bin and media without creating an OMFI file.

Table 2-6 lists the editing applications and their compatibility with 
Media Composer or Film Composer Release 10.x (Macintosh).
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Table 2-6 Moving Sequences from Media Composer or Film Composer 
Release 10.x (Macintosh) to an Editing Application

Destination 
Application

Compatibility with Media Composer or 
Film Composer Release 10.x (Macintosh)

AudioVision 
Release 4.1v10

Compatible: Sound Designer II 
Export your sequence as an OMFI 1.0 composition 
only, if you used the Sound Designer II format.
Export your sequence as OMFI 1.0 composition 
with audio media if you used the AIFF-C or WAVE 
format. 

Pro Tools 
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
with audio media if you used the WAVE format.
Export your sequence as an OMFI 2.0 composition 
only, if you used the AIFF-C or Sound Designer II 
format.

Symphony 
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Media Composer 
Release 9.1 or 10.x, 
or Film Composer 
Release 10.x, or 
Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Media Composer 
Release 8.1 or 10.x, 
or Avid Xpress 
Release 2.5 or 4.x 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE
Bin compatibility; see Appendix A.



2-36 Collaboration Guide

C h a p t e r  2
M O V I N G  S E Q U E N C E S  W I T H  A U D I O  M E D I A  F R O M  M E D I A  C O M P O S E R  
O R  F I L M  C O M P O S E R  R E L E A S E  1 0 . X  F O R  M A C I N T O S H

2-36 Collaboration Guide

If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

To move sequences between applications with different audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with or without audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from 
Media Composer or Film Composer Release 10.x (Macintosh) to an editing 
system, review the following list to ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the application to which 
you are moving. To set the audio file format, select General Settings from 
the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

Media Composer 
Release 7.2 or 
Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Sound Designer II and AIFF-C 
Export your sequence as an OMFI composition 
with audio media if you used the WAVE format.
Bin compatibility if you used AIFF-C or 
Sound Designer II; see Appendix A.

Table 2-6 Moving Sequences from Media Composer or Film Composer 
Release 10.x (Macintosh) to an Editing Application (Continued)

Destination 
Application

Compatibility with Media Composer or 
Film Composer Release 10.x (Macintosh)
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If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
With or Without Audio Media” on page 2-38. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Media Composer or Film Composer, Symphony, 
or Avid Xpress. For options and instructions for transferring files, see 
Appendix A.

C o n v e r t i n g  M u l t i p l e  A u d i o  S a m p l e  R a t e s

If you have a sequence with multiple audio sample rates (for example, one 
clip at 48 kHz and other clips at 44.1 kHz), you must convert the clips to a 
single sample rate for transfer to Symphony Release 2.1 or earlier, 
Media Composer Release 9.1 or earlier, and Avid Xpress Release 3.1 or earlier. 

To convert a sequence to a single audio sample rate:

1 Make a duplicate of your sequence and name it to indicate the conversion to one 

sample rate; for example, “Sequence44.”

2 Select the new sequence, and then choose Change Sample Rate from the Bin 

menu.

3 Choose a quality level for the conversion.

4 Choose a sample rate from the submenu, and then click OK.
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Step 2:  Export  the Sequence With  or  Wi thout  Audio  Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.

There are two methods for exporting the sequence: you can use AvidLinks for 
quick export to AudioVision or Pro Tools, or you can use the Export Format 
dialog box to manually determine settings for export to a variety of 
applications.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

In Media Composer or Film Composer Release 10.x (Macintosh), there are 
AvidLinks set up for export options. If you are moving media to AudioVision 
or Pro Tools, perform the following steps to use the existing templates. 

To export a sequence with audio media, using AvidLinks:

1 In a Media Composer or Film Composer bin, select the sequence or master clip 
you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 

your original sequence.

3 Consolidate the sequence.

n Consolidate to an HSF nonstriped drive if you are moving these files to a digital audio 
workstation.

4 Open the File menu and point to AvidLinks. 

5 Select the appropriate AvidLink for the application to which you are moving media.

For a list of the available AvidLinks, see Appendix B.
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AudioVision AudioVision AvidLink choice:

- AudioVision Embedded — Exports an OMFI composition with embedded 
AIFF-C audio media. 

Pro Tools Digidesign Pro Tools AvidLink choice:

- Digidesign Pro Tools — Exports an OMFI composition with embedded AIFF-C 
audio media

To export a sequence with audio media, using the Export Format dialog box:

1 In a Media Composer or Film Composer bin, select the sequence or master clip 

you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Windows 
editing system.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select Customize.

The Export Settings dialog box appears.

6 (Optional) Enter a name if this is a template you want to keep.

7 Choose the format options based on the application to which you are moving 

media:

Pro Tools — 
AIFF-C

Moving AIFF-C files to Pro Tools (Macintosh):

a Choose OMFI.

b Select Version 2.0.
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Pro Tools — 
WAVE

Moving WAVE files to Pro Tools (Macintosh):

a Choose OMFI.

b Select Version 2.0.

c Select Embed Audio Media.

d Select AIFF-C.

Media Composer 
7.2

Moving WAVE files to Media Composer Release 7.2:

a Choose OMFI.

b Select Version 1.0.

c Select Embed Audio Media.

d Select AIFF-C.

Avid Xpress 2.1 
(Macintosh)

Moving WAVE files to Avid Xpress Release 2.1 (Macintosh):

a Choose OMFI.

b Select Version 1.0.

c Select Embed Audio Media.

d Select AIFF-C.

8 Click OK.

9 In the Export As dialog box, check the file name, select a drive formatted for 
Windows (NTFS) or a network drive, and click Save.

Step 3:  Transfer  the F i les  to  the Dest inat ion System

For the options to move your files from one system to another, see 
Appendix A.
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Step 4:  Import  the OMFI  F i le  

This final step varies, depending on both the file type and the receiving 
system. The following sections describe how to import the audio file into 
AudioVision, Pro Tools, and Media Composer or Film Composer.

AudioVision To import OMFI files after transferring the files to the AudioVision system, 
start AudioVision and import the files into a bin.

Pro Tools To import OMFI files into Pro Tools:

1 Start the Macintosh system.

2 Open the DigiTranslator.

3 Create a Session File from the OMFI file you exported from Media Composer or 
Film Composer Release 10.x (Macintosh).

4 Start Pro Tools and open the Session File. All audio should now be online.

Media Composer 
or Film Composer

When you import OMFI files into Media Composer or Film Composer, the 
system converts them to objects in a bin. You can manipulate and edit these 
objects as you would any other clip or sequence. 

To import an OMFI file into Media Composer or Film Composer for 
Macintosh:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the File Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.
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6 Use the Directory pop-up menu to locate the folder containing the source files.

7 Add files to or remove files from the import file list on the right, using one of the 
following methods:

- To add a single file, select a file name in the source file list and click the Add 
button, or double-click the file name.

- To add all the files in the source file list, click the Add All button.

- To remove a single file from the import file list, select a file name and click the 
Remove button.

- To remove all the files from the import file list, click the Remove All button.

8 Click Done.

To import an OMFI file into Media Composer or Film Composer (Windows):

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Import File(s) into Bin dialog box appears.

4 Choose OMFI from the Files of Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Look In pop-up menu to locate the folder containing the source files.

7 Add files to the import file list on the right, using one of the following methods:

- To add a single file, select the file name in the source file list.

- To add multiple files, press and hold the Ctrl key while selecting the file name 
for each file you want to include.

- To add all the files in the source file list, press Ctrl+A.

8 Click Done.
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This section describes how to transfer sequences with audio media from 
Media Composer Release 9.1 (Windows) to AudioVision or Pro Tools for 
audio sweetening. It also describes how to move your audio media to 
Symphony, Avid Xpress, or another Media Composer or Film Composer 
system.

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. For example, if you created your 
sequence in Media Composer Release 9.1 (Windows) by using the AIFF-C 
audio format and you are moving to Pro Tools on the Macintosh, you can 
export your sequence as an OMFI composition only and move your original 
audio media from the Media Composer system to the Pro Tools workstation. 
However, if you wanted to move the same sequence to AudioVision, you 
would need to export the sequence as an OMFI composition with audio 
media before you could move it to the AudioVision workstation. 

If there is bin compatibility between your applications, such as between 
Media Composer Release 9.1 (Windows) and Media Composer Release 8.1 
(Macintosh), and you use compatible audio formats, you can move your bin 
and media without creating an OMFI file.

Table 2-7 lists the editing applications and their compatibility with 
Media Composer Release 9.1 (Windows).
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Table 2-7 Moving Sequences from Media Composer Release 9.1 
(Windows) to an Editing Application

Destination 
Application

Compatibility with Media Composer Release 9.1 
(Windows)

AudioVision 
Release 4.1v10

Compatible: Sound Designer II 
Export your sequence as an OMFI 1.0 composition 
with audio media.

Pro Tools 
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
with audio media if you used the WAVE format.
Export your sequence as an OMFI 2.0 composition 
only, if you used the AIFF-C format.

Symphony 
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 10.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Film Composer 
Release 10.x 
(Windows and 
Macintosh)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 8.1 or 10.x, 
or Avid Xpress 
Release 2.5 or 4.x 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 7.2 or 
Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Sound Designer II and AIFF-C 
Export your sequence as an OMFI composition 
with audio media if you used the WAVE format.
Bin compatibility if you used AIFF-C; see 
Appendix A.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

To move sequences with audio media between applications with different 
audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Table 2-7 Moving Sequences from Media Composer Release 9.1 
(Windows) to an Editing Application (Continued)

Destination 
Application

Compatibility with Media Composer Release 9.1 
(Windows)
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Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from 
Media Composer Release 9.1 (Windows) to an editing system, review the 
following list to ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the application to which 
you are moving. To set the audio file format, select General Settings from 
the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
with Audio Media” on page 2-46. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Symphony, Media Composer or Film Composer, 
or Avid Xpress. For options and instructions for transferring files, see 
Appendix A.

Step 2:  Export  the Sequence wi th Audio Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.



. .
 . 

. .

Collaboration Guide 2-47

M O V I N G  S E Q U E N C E S  W I T H  A U D I O  M E D I A  F R O M  M E D I A  C O M P O S E R  R E L E A S E  9 . 1  F O R
W I N D O W S

To export a sequence with audio media, using a template:

1 In a Media Composer or Film Composer bin, select the sequence or master clip 

you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Macintosh 
digital audio workstation.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select the appropriate template for the application to which you are moving media.

For a list of the available templates, see Appendix B.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

AudioVision AudioVision template choice:

- AudioVision AIFF-C Embedded — Exports an OMFI composition with 

embedded AIFF-C audio media 

Pro Tools Pro Tools template choice:

- Digidesign Pro Tools— Exports an OMFI composition with embedded AIFF-C 
audio media

6 Click OK.

7 In the Export As dialog box, check the file name, select a drive, and click Save.
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To export a sequence with audio media, using the Export Format dialog box:

1 In a Media Composer or Film Composer bin, select the sequence or master clip 

you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Macintosh 
digital audio workstation.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select Customize.

The Export Settings dialog box appears.

6 (Optional) Enter a name if this is a template you want to keep.

7 Choose the format options based on the application to which you are moving 

media.

AudioVision Moving AIFF-C or WAVE files to AudioVision:

- Click the AudioVision Compatibility check box.

Pro Tools — 
AIFF-C

Moving AIFF-C files to Pro Tools (Macintosh):

a Click the OMFI Composition button.

b Choose Version 2.0 from the Version pop-up menu.

Pro Tools — 
WAVE

Moving WAVE files to Pro Tools (Macintosh):

a Click the OMFI Composition button.

b Choose Version 2.0 from the Version pop-up menu.

c Click the Use Audio Media check box.

d Choose AIFF-C from the pop-up menu.
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Media Composer 
7.2

Moving WAVE files to Media Composer Release 7.2:

a Click the OMFI Composition button.

b Choose Version 1.0 from the Version pop-up menu.

c Click the Use Audio Media check box.

d Choose AIFF-C from the pop-up menu.

Avid Xpress 2.1 
(Macintosh)

Moving WAVE files to Avid Xpress Release 2.1 (Macintosh)

a Click the OMFI Composition button.

b Choose Version 1.0 from the Version pop-up menu.

c Click the Use Audio Media check box.

d Choose AIFF-C from the pop-up menu.

8 Click OK.

9 In the Export As dialog box, check the file name, select a drive formatted for 
Windows (NTFS) or a network drive, and click Save.

Step 3:  Transfer  the F i les  to  the Dest inat ion System

For the options to move your files from one system to another, see 
Appendix A.

Step 4:  Import  the OMFI  F i le  

This final step varies, depending on both the file type and the receiving 
system. The following sections describe how to import the audio file into 
AudioVision, Pro Tools, and Media Composer or Film Composer.

AudioVision To import OMFI files after transferring the files to the AudioVision system, 
start AudioVision and import the files into a bin.
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Pro Tools To import OMFI files into Pro Tools:

1 Start the Macintosh system.

2 Open the DigiTranslator or OMF Tool 2.0.8.

3 Create a Session File from the OMFI file you exported from Media Composer or 
Film Composer.

4 Start Pro Tools and open the Session File. All audio should now be online.

Media Composer 
or Film Composer

When you import OMFI files into Media Composer or Film Composer, the 
system converts them to objects in a bin. You can manipulate and edit these 
objects as you would any other clip or sequence. 

To import an OMFI file into Media Composer or Film Composer for 
Macintosh:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the File Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Directory pop-up menu to locate the folder containing the source files.

7 Add files to or remove files from the import file list on the right, using one of the 

following methods:

- To add a single file, select a file name in the source file list and click the Add 

button, or double-click the file name.

- To add all the files in the source file list, click the Add All button.

- To remove a single file from the import file list, select a file name and click the 
Remove button.
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- To remove all the files from the import file list, click the Remove All button.

8 Click Done.

To import an OMFI file into Media Composer or Film Composer for 
Windows:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Import File(s) into Bin dialog box appears.

4 Choose OMFI from the Files of Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Look In pop-up menu to locate the folder containing the source files.

7 Add files to the import file list on the right, using one of the following methods:

- To add a single file, select the file name in the source file list.

- To add multiple files, press and hold the Ctrl key while selecting the file name 
for each file you want to include.

- To add all the files in the source file list, press Ctrl+A.

8 Click Done.
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This section describes how to transfer sequences with audio media from 
Media Composer Release 8.1 (Macintosh) to AudioVision or Pro Tools for 
audio sweetening. It also describes how to move your audio media to 
Symphony, Avid Xpress, or another Media Composer or Film Composer 
system.

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. The formats available in 
Media Composer Release 8.1 (Macintosh) are compatible with formats in both 
AudioVision and Pro Tools. Therefore, you can export your sequence as an 
OMFI composition only and move your original audio media from the 
Media Composer Release 8.1 (Macintosh) system to the Pro Tools or 
AudioVision workstation. 

If there is bin compatibility between your Avid applications for Windows and 
Media Composer Release 8.1 (Macintosh), and you use compatible audio 
formats, you can move your bin and media without creating an OMFI file.

Table 2-8 lists the editing applications and their compatibility with 
Media Composer Release 8.1 (Macintosh).
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Table 2-8 Moving Sequences from Media Composer Release 8.1 
(Macintosh) to an Editing Application

Destination 
Application

Compatibility with Media Composer Release 8.1 
(Macintosh)

AudioVision 
Release 4.1v10

Compatible: Sound Designer II 
Export your sequence as an OMFI 1.0 composition 
only, if you used the Sound Designer II format.
Export your sequence as OMFI 1.0 composition 
with audio media if you used the AIFF-C or WAVE 
format. 

Pro Tools 
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
with audio media if you used the WAVE format.
Export your sequence as an OMFI 2.0 composition 
only, if you used the AIFF-C or Sound Designer II 
format.

Symphony 
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Media Composer 
Release 9.1 or 10.x, 
or Film Composer 
Release 10.x, or 
Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Film Composer 
Release 10.x 
(Macintosh)

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

Media Composer 
Release 10.x 
Avid Xpress 
Release 2.5 or 4.x 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 7.2 
(Macintosh)

Compatible: Sound Designer II and AIFF-C 
Export your sequence as an OMFI composition 
with audio media if you used the WAVE format.
Bin compatibility if you used AIFF-C or 
Sound Designer II; see Appendix A.

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Table 2-8 Moving Sequences from Media Composer Release 8.1 
(Macintosh) to an Editing Application (Continued)

Destination 
Application

Compatibility with Media Composer Release 8.1 
(Macintosh)
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To move sequences between applications with different audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with or without audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from 
Media Composer Release 8.1 (Macintosh) to an editing system, review the 
following list to ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the application to which 
you are moving. To set the audio file format, select General Settings from 
the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
With or Without Audio Media” on page 2-56. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Media Composer or Film Composer, Symphony, 
or Avid Xpress. For options and instructions for transferring files, see 
Appendix A.

• Prepare AudioSuite plug-ins: If your project includes AudioSuite plug-in 
effects, the effects will transfer but cannot be manipulated further. You 
have the following options:

- Render the audio clips in the sequence, and perform an audio 
mixdown, if necessary. Export the clips as OMFI files and import 
them into your editing application. 
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- Render the audio clips in the sequence and export them as AIFF-C 
files. In the Export Format dialog box, select the Sound and AIFF-C 
options, and then import the files into your editing application.

- Render the audio clips in the sequence and export the sequence as 
OMFI 1.0 or OMFI 2.0 with or without media.

Step 2:  Export  the Sequence With  or  Wi thout  Audio  Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.

There are two methods for exporting the sequence: you can use templates for 
quick export to AudioVision or Pro Tools, or you can use the Export Format 
dialog box to manually determine settings for export to a variety of 
applications.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

In Media Composer Release 8.1 (Macintosh), there are templates set up for 
many export options. If you are moving media to AudioVision or Pro Tools, 
perform the following steps to use the existing templates. 

To export a sequence with audio media, using a template:

1 In a Media Composer bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 

your original sequence.

3 Consolidate the sequence.
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n Consolidate to an HSF nonstriped drive if you are moving these files to a digital audio 
workstation.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select the appropriate template for the application to which you are moving media.

For a list of the available templates, see Appendix B.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

AudioVision AudioVision template choices:

- AudioVision AIFF-C Embedded — Exports an OMFI composition with 
embedded AIFF-C audio media. 

- AudioVision SD2 External — Exports OMFI composition only, and creates 
Sound Designer II files for any audio media not created with Sound Designer 

II in the sequence. The re-created Sound Designer II media is put in a folder 
labeled “Exported Audio Media” at the top level of the drive where the original 
media was located. The template won’t re-create any original Sound Designer 

II media that was in the sequence.

Pro Tools Pro Tools template choices:

- Pro Tools AIFF-C Embedded — Exports an OMFI composition with 
embedded AIFF-C audio media. 

- Pro Tools SD2 External — Exports OMFI composition only, and creates 
Sound Designer II files for any audio media not created with Sound Designer 
II in the sequence. The re-created Sound Designer II media is put in a folder 

labeled “Exported Audio Media” at the top level of the drive where the original 
media was located.

6 Click OK.

7 In the Export As dialog box, check the file name, select a drive, and click Save.
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To export a sequence with audio media, using the Export Format dialog box:

1 In a Media Composer bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Windows 
editing system.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select Customize.

The Export Settings dialog box appears.

6 (Optional) Enter a name if this is a template you want to keep.

7 Choose the format options based on the application to which you are moving 
media:

Symphony 
2.1 or 3.x

Moving Sound Designer II files to Symphony Release 2.1 or 3.x:

a Click OMFI Composition.

b Click the Use Audio Media check box.

c Choose AIFF-C or WAVE from the Format pop-up menu.

d Choose Version 1.0 from the Version pop-up menu.

Media Composer 
9.1 or 10.x, or 
Film Composer 
10.x (Windows)

Moving Sound Designer II files to Media Composer Release 9.1 or 10.x, or 

Film Composer Release 10.x (Windows):

a Click OMFI Composition.

b Click the Use Audio Media check box.

c Choose AIFF-C or WAVE from the Format pop-up menu.

d Choose Version 1.0 from the Version pop-up menu.
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Media Composer 
or Film Composer 
10.x (Macintosh)

Moving Sound Designer II files to Media Composer or Film Composer 

Release 10.x (Macintosh):

a Click OMFI Composition.

b Click the Use Audio Media check box.

c Choose AIFF-C or WAVE from the Format pop-up menu.

d Choose Version 1.0 from the Version pop-up menu.

Media Composer 
7.2 (Macintosh)

Moving WAVE files to Media Composer Release 7.2:

a Click OMFI Composition.

b Click the Use Audio Media check box.

c Choose AIFF-C from the Format pop-up menu.

d Choose Version 1.0 from the Version pop-up menu.

Avid Xpress 3.1 or 
4.x (Windows)

Moving Sound Designer II files to Avid Xpress Release 3.1 or 4.x (Windows):

a Click OMFI Composition.

b Click the Use Audio Media check box.

c Choose AIFF-C or WAVE from the Format pop-up menu.

d Choose Version 1.0 from the Version pop-up menu.

Avid Xpress 2.5 or 
4.x (Macintosh)

Moving Sound Designer II files to Avid Xpress Release 2.5 or 4.x (Macintosh):

a Click OMFI Composition.

b Click the Use Audio Media check box.

c Choose AIFF-C or WAVE from the Format pop-up menu.

d Choose Version 1.0 from the Version pop-up menu.

Avid Xpress 2.1 
(Macintosh)

Moving WAVE files to Avid Xpress Release 2.1 (Macintosh):

a Click OMFI Composition.

b Click the Use Audio Media check box.

c Choose AIFF-C from the Format pop-up menu.

d Choose Version 1.0 from the Version pop-up menu.

8 Click OK in the Export Settings dialog box.
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9 Click OK in the Export dialog box.

10 In the Export As dialog box, check the file name, select a drive, and click Save.

Step 3:  Transfer  the F i les  to  the Dest inat ion System

For the options to move your files from one system to another, see 
Appendix A.

Step 4:  Import  the OMFI  F i le  

This final step varies, depending on both the file type and the receiving 
system. The following sections describe how to import the audio file into 
AudioVision, Pro Tools, and Media Composer or Film Composer.

AudioVision To import OMFI files after transferring the files to the AudioVision system, 
start AudioVision and import the files into a bin.

Pro Tools To import OMFI files into Pro Tools:

1 Start the Macintosh system.

2 Open the DigiTranslator or OMF Tool 2.0.8.

3 Create a Session File from the OMFI file you exported from Media Composer 
Release 8.1 (Macintosh).

4 Start Pro Tools and open the Session File. All audio should now be online.

Media Composer 
or Film Composer

When you import OMFI files into Media Composer or Film Composer, the 
system converts them to objects in a bin. You can manipulate and edit these 
objects as you would any other clip or sequence. 
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To import an OMFI file into Media Composer or Film Composer for 
Macintosh:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 

it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the File Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 

menu.

6 Use the Directory pop-up menu to locate the folder containing the source files.

7 Add files to or remove files from the import file list on the right, using one of the 
following methods:

- To add a single file, select a file name in the source file list and click the Add 
button, or double-click the file name.

- To add all the files in the source file list, click the Add All button.

- To remove a single file from the import file list, select a file name and click the 
Remove button.

- To remove all the files from the import file list, click the Remove All button.

8 Click Done.

To import an OMFI file into Media Composer or Film Composer (Windows):

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Import File(s) into Bin dialog box appears.

4 Choose OMFI from the Files of Type pop-up menu.
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5 Choose a destination drive for the imported file from the Media Drive pop-up 

menu.

6 Use the Look In pop-up menu to locate the folder containing the source files.

7 Add files to the import file list on the right, using one of the following methods:

- To add a single file, select the file name in the source file list.

- To add multiple files, press and hold the Ctrl key while selecting the file name 

for each file you want to include.

- To add all the files in the source file list, press Ctrl+A.

8 Click Done.
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This section describes how to transfer sequences with audio media from 
Media Composer Release 7.2 to AudioVision or Pro Tools for audio 
sweetening. It also describes how to move your audio media to Symphony, 
Avid Xpress, Film Composer, or another Media Composer system.

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. If your audio formats are compatible, 
you can export your sequence as an OMFI composition only and move your 
original audio media to the destination system. If your audio formats are not 
compatible, you can export an OMFI composition with audio media. 

If there is bin compatibility between your applications, such as between 
Media Composer Release 7.2 (Macintosh) and Media Composer Release 8.1 
(Macintosh), and you use compatible audio formats, you can move your bin 
and media without creating an OMFI file.

Table 2-9 lists the editing applications and their compatibility with 
Media Composer Release 7.2 (Macintosh).
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Table 2-9 Moving Sequences from Media Composer Release 7.2 
(Macintosh) to an Editing Application

Destination 
Application

Compatibility with Media Composer Release 7.2 
(Macintosh)

AudioVision 
Release 4.1v10

Compatible: Sound Designer II 
Export your sequence as an OMFI 1.0 composition 
only, if you used the Sound Designer II format.
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the AIFF-C format.

Pro Tools 
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
only.

Symphony 
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Media Composer 
Release 9.1 or 10.x, 
or Film Composer
Release 10.x, or 
Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Media Composer 
Release 8.1 or 10.x or 
Avid Xpress 
Release 2.5 or 4.x 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE 
Bin compatibility; see Appendix A.

Film Composer 
Release 10.x 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE 
Bin compatibility; see Appendix A.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files.

To move sequences between applications with different audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with or without audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Sound Designer II and AIFF-C 
Bin compatibility; see Appendix A.

Table 2-9 Moving Sequences from Media Composer Release 7.2 
(Macintosh) to an Editing Application (Continued)

Destination 
Application

Compatibility with Media Composer Release 7.2 
(Macintosh)
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Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from 
Media Composer Release 7.2 (Macintosh) to an editing system, review the 
following list to ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the application to which 
you are moving. To set the audio file format, select General Settings from 
the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
With or Without Audio Media” on page 2-67. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Symphony, Media Composer or Film Composer, 
or Avid Xpress. For options and instructions for transferring files, see 
Appendix A.

• Prepare AudioSuite plug-ins: If your project includes AudioSuite plug-in 
effects, the effects will transfer but cannot be manipulated further. You 
have the following options:

- Render the audio clips in the sequence, and perform an audio 
mixdown, if necessary. Export the clips as OMFI files and import 
them into your editing application. 

- Render the audio clips in the sequence and export them as AIFF-C 
files. In the Export Format dialog box, select the Sound and AIFF-C 
options, and then import the files into your editing application.

- Render the audio clips in the sequence and export the sequence as 
OMFI 1.0 or OMFI 2.0 with or without media.
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Step 2:  Export  the Sequence With  or  Wi thout  Audio  Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

To export a sequence with or without audio media:

1 In a Media Composer bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a digital audio 
workstation or to a Media Composer on a Windows system.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select OMFI Composition as the Export Format and choose the options based on 

the application to which you are moving media:

AudioVision–
AIFF-C

Moving AIFF-C files to AudioVision:

a Choose AudioVision.

b Choose OMFI 1.0 from the Version pop-up menu.

c Click the With Media check box.



2-68 Collaboration Guide

C h a p t e r  2
M O V I N G  S E Q U E N C E S  W I T H  A U D I O  M E D I A  F R O M  M E D I A  C O M P O S E R  
R E L E A S E  7 . 2  F O R  M A C I N T O S H

2-68 Collaboration Guide

AudioVision–
SD2

Moving Sound Designer II files to AudioVision:

a Choose AudioVision.

b Choose OMFI 1.0 from the Version pop-up menu.

c Do not click the With Media check box.

Pro Tools Moving AIFF-C or Sound Designer II files to Pro Tools:

a Choose Standard - AIFF-C from the first pop-up menu.

b Choose Audio Only from the second pop-up menu.

c Choose OMFI 2.0 from the Version pop-up menu.

d Click the With Media check box if you want to embed the audio media.

Symphony 2.1 or 
3.x

Moving Sound Designer II files to Symphony Release 2.1 or 3.x:

a Choose Standard - AIFF-C from the first pop-up menu.

b Choose Audio Only from the second pop-up menu.

c Choose OMFI 1.0 from the Version pop-up menu.

d Click the With Media check box.

Media Composer 
9.1 or 10.x, or 
Film Composer 
10.x (Windows)

Moving Sound Designer II files to Media Composer Release 9.1 or 10.x, or 
Film Composer Release 10.x (Windows):

a Choose Standard - AIFF-C from the first pop-up menu.

b Choose Audio Only from the second pop-up menu.

c Choose OMFI 1.0 from the Version pop-up menu.

d Click the With Media check box.

Avid Xpress 3.1 or 
4.x (Windows)

Moving Sound Designer II files to Avid Xpress Release 3.1 or 4.x (Windows):

a Choose Standard - AIFF-C from the first pop-up menu.

b Choose Audio Only from the second pop-up menu.

c Choose OMFI 1.0 from the Version pop-up menu.

d Click the With Media check box.

6 Click OK.
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7 In the Export As dialog box, check the file name, select a location for the exported 

files, and click Save.

Step 3:  Transfer  the F i les  to  the Dest inat ion System

For the options to move your files from one system to another, see 
Appendix A.

Step 4:  Import  the OMFI  F i le

This final step varies, depending on both the file type and the receiving 
system. The following sections describe how to import the audio file into 
AudioVision, Pro Tools, and Media Composer or Film Composer.

AudioVision To import OMFI files, after transferring the files to the AudioVision system, 
start AudioVision and import the file into a bin.

Pro Tools To import OMFI files into Pro Tools:

1 Start the Macintosh system.

2 Open the DigiTranslator or OMF Tool 2.0.8.

3 Create a Session File from the OMFI file you exported from Media Composer or 

Film Composer.

4 Start Pro Tools and open the Session File. All audio should now be online.

Media Composer 
or Film Composer

When you import OMFI files into Media Composer or Film Composer, the 
system converts them to objects in a bin. You can manipulate and edit these 
objects as you would any other clip or sequence. 
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To import an OMFI file into Media Composer or Film Composer for 
Macintosh:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 

it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the File Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 

menu.

6 Use the Directory pop-up menu to locate the folder containing the source files.

7 Add files to or remove files from the import file list on the right, using one of the 
following methods:

- To add a single file, select a file name in the source file list and click the Add 
button, or double-click the file name.

- To add all the files in the source file list, click the Add All button.

- To remove a single file from the import file list, select a file name and click the 
Remove button.

- To remove all the files from the import file list, click the Remove All button.

8 Click Done.

To import an OMFI file into Media Composer or Film Composer for 
Windows:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Import File(s) into Bin dialog box appears.
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4 Choose OMFI from the Files of Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Look In pop-up menu to locate the folder containing the source files.

7 Add files to the import file list on the right, using one of the following methods:

- To add a single file, select the file name in the source file list.

- To add multiple files, press and hold the Ctrl key while selecting the file name 
for each file you want to include.

- To add all the files in the source file list, press Ctrl+A.

8 Click Done.
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M o v i n g  S e q u e n c e s  w i t h  A u d i o  M e d i a  
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This section describes how to transfer sequences with audio media from 
Avid Xpress Release 4.0, 4.1, or 4.5 (Windows) to AudioVision or Pro Tools for 
audio sweetening. It also describes how to move your audio media to 
Symphony, Media Composer or Film Composer, or another Avid Xpress 
system.

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. For example, if you created your 
sequence in Avid Xpress Release 4.0 (Windows) by using the AIFF-C audio 
format and you are moving to Pro Tools on the Macintosh, you can export 
your sequence as an OMFI composition only, and move your original audio 
media from the Avid Xpress system to the Pro Tools workstation. However, if 
you were to move the same sequence to AudioVision, you would need to 
export the sequence as an OMFI composition with audio media before you 
could move it to the AudioVision workstation. 

If there is bin compatibility between your applications, such as between 
Avid Xpress Release 4.0 (Windows) and Media Composer Release 9.1 
(Windows), and you use compatible audio formats, you can move your bin 
and media without creating an OMFI file.

Table 2-10 lists the editing applications and their compatibility with 
Avid Xpress Release 4.x (Windows).
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Table 2-10 Moving Sequences from Avid Xpress Release 4.x (Windows) 
to an Editing Application

Destination 
Application

Compatibility with Avid Xpress Release 4.x 
(Windows)

AudioVision 
Release 4.1v10

Compatible: Sound Designer II 
Export your sequence as an OMFI 1.0 composition 
with audio media.

Pro Tools 
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
with audio media if you used the WAVE format.
Export your sequence as an OMFI 2.0 composition 
only, if you used the AIFF-C format.

Symphony 
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE
Bin compatibility, see Appendix A.

Media Composer 
Release 9.1 or 10.x, 
or Film Composer 
Release 10.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility, see Appendix A.

Media Composer 
Release 8.1 or 10.x, 
or Avid Xpress 
Release 2.5 or 4.x 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE
Bin compatibility; see Appendix A.

Film Composer 
Release 10.x 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE
Bin compatibility; see Appendix A.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

To move sequences with audio media between applications with different 
audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Media Composer 
Release 7.2 
(Macintosh)

Compatible: Sound Designer II and AIFF-C 
Export your sequence as an OMFI composition 
with audio media if you used the WAVE format.
Bin compatibility if you used AIFF-C; see 
Appendix A.

Avid Xpress 
Release 3.1 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility, see Appendix A.

Avid Xpress 
Release 2.1 or 2.5 
(Macintosh)

Compatible: AIFF-C and WAVE
Bin compatibility, see Appendix A.

Table 2-10 Moving Sequences from Avid Xpress Release 4.x (Windows) 
to an Editing Application (Continued)

Destination 
Application

Compatibility with Avid Xpress Release 4.x 
(Windows)
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Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from Avid Xpress 
Release 4.x (Windows) to an editing system, review the following list to 
ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the application to which 
you are moving. To set the audio file format, select General Settings from 
the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
with Audio Media” on page 2-76. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Symphony, Media Composer or Film Composer, 
or Avid Xpress. For options and instructions for transferring files, see 
Appendix A.

C o n v e r t i n g  M u l t i p l e  A u d i o  S a m p l e  R a t e s

If you have a sequence with multiple audio sample rates (for example, one 
clip at 48 kHz and other clips at 44.1 kHz), you must convert the clips to a 
single sample rate for transfer to Symphony Release 2.1 or earlier, 
Media Composer Release 9.1 or earlier, and Avid Xpress Release 3.1 or earlier. 

To convert a sequence to a single audio sample rate:

1 Make a duplicate of your sequence and name it to indicate the conversion to one 
sample rate; for example, “Sequence44.”

2 Select the new sequence, and then choose Change Sample Rate from the Bin 
menu.
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3 Choose a quality level for the conversion.

4 Choose a sample rate from the submenu, and then click OK.

Step 2:  Export  the Sequence wi th Audio Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.

There are two methods for exporting the sequence: you can use AvidLinks for 
quick export to AudioVision or Pro Tools, or you can use the Export Format 
dialog box to manually determine settings for export to a variety of 
applications.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

To export a sequence with audio media, using AvidLinks:

1 In an Avid Xpress bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Macintosh 
digital audio workstation.

4 Open the File menu and point to AvidLinks. 

5 Select the appropriate AvidLink for the application to which you are moving media.

For a list of the available AvidLinks, see Appendix B.
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AudioVision AudioVision AvidLink choice:

- AudioVision — Exports an OMFI composition with embedded AIFF-C audio 

media 

Pro Tools Pro Tools AvidLink choice:

- Digidesign Pro Tools — Exports an OMFI composition with embedded AIFF-C 
audio media

To export a sequence with audio media, using a template:

1 In an Avid Xpress bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 

your original sequence.

3 Consolidate the sequence.

n Consolidate to an HSF nonstriped drive if you are moving these files to a digital audio 
workstation.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select the appropriate template for the application to which you are moving media.

For a list of the available templates, see Appendix B.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

AudioVision AudioVision template choices:

- AudioVision AIFF-C Embedded — Exports an OMFI composition with 
embedded AIFF-C audio media. 

- AudioVision SD2 External — Exports OMFI composition only, and creates 
Sound Designer II files for any audio media not created with Sound Designer 
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II in the sequence. The re-created Sound Designer II media is put in a folder 

labeled “Exported Audio Media” at the top level of the drive where the original 
media was located. The template won’t re-create any original Sound Designer 
II media that was in the sequence.

Pro Tools Pro Tools template choices:

- Pro Tools AIFF-C Embedded — Exports an OMFI composition with 
embedded AIFF-C audio media. 

- Pro Tools SD2 External — Exports OMFI composition only, and creates 
Sound Designer II files for any audio media not created with Sound Designer 
II in the sequence. The re-created Sound Designer II media is put in a folder 

labeled “Exported Audio Media” at the top level of the drive where the original 
media was located.

6 Click OK.

7 In the Export As dialog box, check the file name, select a drive, and click Save.

To export a sequence with audio media, using the Export Format dialog box:

1 In an Avid Xpress bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 

your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Macintosh 
editing system.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select Customize.

The Export Settings dialog box appears.

6 (Optional) Enter a name if this is a template you want to keep.
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7 Choose the format options based on the application to which you are moving 

media.

AudioVision Moving AIFF-C or WAVE files to AudioVision:

- Click the AudioVision Compatibility check box.

Pro Tools — 
AIFF-C

Moving AIFF-C files to Pro Tools (Macintosh):

a Choose OMFI.

b Select Version 2.0.

Pro Tools — 
WAVE

Moving WAVE files to Pro Tools (Macintosh):

a Choose OMFI.

b Select Version 2.0.

c Select Embed Audio Media.

d Select AIFF-C.

Media Composer 
7.2

Moving WAVE files to Media Composer Release 7.2:

a Choose OMFI.

b Select Version 1.0.

c Select Embed Audio Media.

d Select AIFF-C.

Avid Xpress 2.1 
(Macintosh)

Moving WAVE files to Avid Xpress Release 2.1 (Macintosh):

a Choose OMFI.

b Select Version 1.0.

c Select Embed Audio Media.

d Select AIFF-C.

8 Click OK.

9 In the Export As dialog box, check the file name, select a drive formatted for 
Windows (NTFS) or a network drive, and click Save.
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Step 3:  Transfer  the F i les  to  the Dest inat ion System

For the options to move your files from one system to another, see 
Appendix A.

Step 4:  Import  the OMFI  F i le  

This final step varies, depending on both the file type and the receiving 
system. The following sections describe how to import the audio file into 
AudioVision, Pro Tools, and Media Composer or Film Composer.

AudioVision To import OMFI files after transferring the files to the AudioVision system, 
start AudioVision and import the files into a bin.

Pro Tools To import OMFI files into Pro Tools:

1 Start the Macintosh system.

2 Open the DigiTranslator.

3 Create a Session File from the OMFI file you exported from Avid Xpress.

4 Start Pro Tools and open the Session File. All audio should now be online.

Media Composer 
or Film Composer

When you import OMFI files into Media Composer or Film Composer, the 
system converts them to objects in a bin. You can manipulate and edit these 
objects as you would any other clip or sequence. 

To import an OMFI file into Media Composer or Film Composer for 
Macintosh:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 
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The Select Files to Import dialog box appears.

4 Choose OMFI from the File Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Directory pop-up menu to locate the folder containing the source files.

7 Add files to or remove files from the import file list on the right, using one of the 

following methods:

- To add a single file, select a file name in the source file list and click the Add 

button, or double-click the file name.

- To add all the files in the source file list, click the Add All button.

- To remove a single file from the import file list, select a file name and click the 
Remove button.

- To remove all the files from the import file list, click the Remove All button.

8 Click Done.

To import an OMFI file into Media Composer or Film Composer for 
Windows:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the Files of Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Look In pop-up menu to locate the folder containing the source files.

7 Add files to the import file list on the right, using one of the following methods:

- To add a single file, select the file name in the source file list.
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- To add multiple files, press and hold the Ctrl key while selecting the file name 

for each file you want to include.

- To add all the files in the source file list, press Ctrl+A.

8 Click Done.
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This section describes how to transfer sequences with audio media from 
Avid Xpress Release 4.x (Macintosh) to AudioVision, Pro Tools, or 
Media Composer for audio sweetening. It also describes how to move your 
audio media to Symphony, Media Composer or Film Composer, or another 
Avid Xpress system.

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. The formats available in Avid Xpress 
Release 4.x (Macintosh) are compatible with formats in both AudioVision and 
Pro Tools. Therefore, you can export your sequence as an OMFI composition 
only and move your original audio media from the Avid Xpress Release 4.x 
(Macintosh) system to the Pro Tools or AudioVision workstation. 

If there is bin compatibility between your applications, such as between 
Avid Xpress Release 4.x (Macintosh) and Media Composer Release 8.1 
(Macintosh), and you use compatible audio formats, you can move your bin 
and media without creating an OMFI file.

Table 2-11 lists the editing applications and their compatibility with 
Avid Xpress Release 4.x (Macintosh).
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Table 2-11 Moving Sequences from Avid Xpress Release 4.x (Macintosh) 
to an Editing Application

Destination 
Application

Compatibility with Avid Xpress Release 4.x 
(Macintosh)

AudioVision 
Release 4.1v10

Compatible: Sound Designer II 
Export your sequence as an OMFI 1.0 composition 
only, if you used the Sound Designer II format.
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the AIFF-C or WAVE 
format.

Pro Tools
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
with audio media if you used the WAVE format.
Export your sequence as an OMFI 2.0 composition 
only, if you used the AIFF-C or Sound Designer II 
format.

Symphony
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Media Composer 
Release 9.1 or 10.x, 
or Film Composer 
Release 10.x 
(Windows) 

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Film Composer 
Release 10.x 
(Macintosh) 

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

To move sequences between applications with different audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with or without audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Media Composer 
Release 8.1 or 10.x 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE
Bin compatibility; see Appendix A.

Avid Xpress 
Release 3.1 or 4.x 
(Windows) 

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 7.2 or 
Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Sound Designer II and AIFF-C 
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the WAVE format.
Bin compatibility if you used AIFF-C or 
Sound Designer II; see Appendix A.

Table 2-11 Moving Sequences from Avid Xpress Release 4.x (Macintosh) 
to an Editing Application (Continued)

Destination 
Application

Compatibility with Avid Xpress Release 4.x 
(Macintosh)
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Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from Avid Xpress 
Release 4.x (Macintosh) to an audio-editing system, review the following list 
to ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the audio application to 
which you are moving. To set the audio file format, select General Settings 
from the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
With or Without Audio Media” on page 2-87. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Media Composer or Film Composer, Symphony, 
or Avid Xpress. For options and instructions for transferring files, see 
Appendix A.

C o n v e r t i n g  M u l t i p l e  A u d i o  S a m p l e  R a t e s

If you have a sequence with multiple audio sample rates (for example, one 
clip at 48 kHz and other clips at 44.1 kHz), you must convert the clips to a 
single sample rate for transfer to Symphony Release 2.1 or earlier, 
Media Composer Release 9.1 or earlier, and Avid Xpress Release 3.1 or earlier. 
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To convert a sequence to a single audio sample rate:

1 Make a duplicate of your sequence and name it to indicate the conversion to one 

sample rate; for example, “Sequence44.”

2 Select the new sequence, and then choose Change Sample Rate from the Bin 

menu.

3 Choose a quality level for the conversion.

4 Choose a sample rate from the submenu, and then click OK.

Step 2:  Export  the Sequence With  or  Wi thout  Audio  Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

In Avid Xpress Release 4.x (Macintosh), there are AvidLinks set up for many 
export options. If you are moving media to AudioVision or Pro Tools, perform 
the following steps to use the existing AvidLinks. 

To export a sequence with audio media, using AvidLinks:

1 In an Avid Xpress bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 

your original sequence.

3 Consolidate the sequence.



2-88 Collaboration Guide

C h a p t e r  2
M O V I N G  S E Q U E N C E S  W I T H  A U D I O  M E D I A  F R O M  AV I D  X P R E S S  
R E L E A S E  4 . X  F O R  M A C I N T O S H

2-88 Collaboration Guide

n Consolidate to an HFS nonstriped drive if you are moving these files to a digital audio 
workstation.

4 Open the File menu and point to AvidLinks. 

5 Select the appropriate AvidLink for the application to which you are moving media.

For a list of the available AvidLinks, see Appendix B.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

AudioVision AudioVision AvidLink choice:

- AudioVision — Exports an OMFI composition with embedded AIFF-C audio 

media

Pro Tools Pro Tools AvidLink choice:

- Digidesign Pro Tools — Exports an OMFI composition with embedded AIFF-C 
audio media

To export a sequence with audio media, using a template:

1 In an Avid Xpress bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 

your original sequence.

3 Consolidate the sequence.

n Consolidate to an HSF nonstriped drive if you are moving these files to a digital audio 
workstation.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select the appropriate template for the application to which you are moving media.

For a list of the available templates, see Appendix B.
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n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

AudioVision AudioVision template choices:

- AudioVision AIFF-C Embedded — Exports an OMFI composition with 
embedded AIFF-C audio media. 

- AudioVision SD2 External — Exports OMFI composition only, and creates 
Sound Designer II files for any audio media not created with Sound Designer 

II in the sequence. The re-created Sound Designer II media is put in a folder 
labeled “Exported Audio Media” at the top level of the drive where the original 
media was located. The template won’t re-create any original Sound Designer 

II media that was in the sequence.

Pro Tools Pro Tools template choices:

- Pro Tools AIFF-C Embedded — Exports an OMFI composition with 
embedded AIFF-C audio media. 

- Pro Tools SD2 External — Exports OMFI composition only, and creates 
Sound Designer II files for any audio media not created with Sound Designer 
II in the sequence. The re-created Sound Designer II media is put in a folder 

labeled “Exported Audio Media” at the top level of the drive where the original 
media was located.

6 Click OK.

7 In the Export As dialog box, check the file name, select a drive, and click Save.

To export a sequence with audio media, using the Export Format dialog box:

1 In an Avid Xpress bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.
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n Consolidate to an HFS nonstriped drive if you are moving these files to a Windows 
editing system.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select Customize.

The Export Settings dialog box appears.

6 (Optional) Enter a name if this is a template you want to keep.

7 Choose the format options based on the application to which you are moving 
media files:

Pro Tools — 
AIFF-C

Moving AIFF-C files to Pro Tools (Macintosh):

a Choose OMFI.

b Select Version 2.0.

Pro Tools — 
WAVE

Moving WAVE files to Pro Tools (Macintosh):

a Choose OMFI.

b Select Version 2.0.

c Select Embed Audio Media.

d Select AIFF-C.

Media Composer 
7.2

Moving WAVE files to Media Composer Release 7.2:

a Choose OMFI.

b Select Version 1.0.

c Select Embed Audio Media.

d Select AIFF-C.

Avid Xpress 2.1 
(Macintosh)

Moving WAVE files to Avid Xpress Release 2.1 (Macintosh):

a Choose OMFI.

b Select Version 1.0.

c Select Embed Audio Media.

d Select AIFF-C.
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8 Click OK.

9 In the Export As dialog box, check the file name, select a drive formatted for 
Windows (NTFS) or a network drive, and click Save.
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This section describes how to transfer sequences with audio media from 
Avid Xpress Release 3.1 (Windows) to AudioVision or Pro Tools for audio 
sweetening. It also describes how to move your audio media to Symphony, 
Media Composer or Film Composer, or another Avid Xpress system.

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. For example, if you created your 
sequence in Avid Xpress Release 3.1 (Windows) by using the AIFF-C audio 
format and you are moving to Pro Tools on the Macintosh, you can export 
your sequence as an OMFI composition only, and move your original audio 
media from the Avid Xpress system to the Pro Tools workstation. However, if 
you were to move the same sequence to AudioVision, you would need to 
export the sequence as an OMFI composition with audio media before you 
could move it to the AudioVision workstation. 

If there is bin compatibility between your applications, such as between 
Avid Xpress Release 3.1 (Windows) and Media Composer Release 9.1 
(Windows), and you use compatible audio formats, you can move your bin 
and media without creating an OMFI file.

Table 2-12 lists the editing applications and their compatibility with 
Avid Xpress Release 3.1 (Windows).
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Table 2-12 Moving Sequences from Avid Xpress Release 3.1 (Windows) 
to an Editing Application

Destination 
Application

Compatibility with Avid Xpress Release 3.1 
(Windows)

AudioVision 
Release 4.1v10

Compatible: Sound Designer II 
Export your sequence as an OMFI 1.0 composition 
with audio media.

Pro Tools 
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
with audio media if you used the WAVE format.
Export your sequence as an OMFI 2.0 composition 
only, if you used the AIFF-C format.

Symphony 
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE
Bin compatibility, see Appendix A.

Media Composer 
Release 9.1 or 10.x, 
or Film Composer 
Release 10.x, or 
Avid Xpress 
Release 4.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility, see Appendix A.

Media Composer 
Release 8.1 or 10.0, 
or Avid Xpress 
Release 2.5 or 4.x 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 7.2 or 
Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Sound Designer II and AIFF-C 
Export your sequence as an OMFI composition 
with audio media if you used the WAVE format.
Bin compatibility if you used AIFF-C; see 
Appendix A.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

To move sequences with audio media between applications with different 
audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from Avid Xpress 
Release 3.1 (Windows) to an editing system, review the following list to 
ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the application to which 
you are moving. To set the audio file format, select General Settings from 
the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
with Audio Media” on page 2-95. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Symphony, Media Composer or Film Composer, 
or Avid Xpress. For options and instructions for transferring files, see 
Appendix A.
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Step 2:  Export  the Sequence wi th Audio Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.

There are two methods for exporting the sequence: you can use templates for 
quick export to AudioVision or Pro Tools, or you can use the Export Format 
dialog box to manually determine settings for export to a variety of 
applications.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

To export a sequence with audio media:

1 In an Avid Xpress bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Macintosh 
digital audio workstation.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select the appropriate template for the application to which you are moving media.

For a list of the available templates, see Appendix B.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.
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AudioVision AudioVision template choice:

- AudioVision AIFF-C Embedded — Exports an OMFI composition with 

embedded AIFF-C audio media 

Pro Tools Pro Tools template choices:

- Pro Tools AIFF-C Embedded — Exports an OMFI composition with 
embedded AIFF-C audio media. 

- Pro Tools AIFF-C External — Exports OMFI composition only. Use this 
template if you have AIFF-C audio media in your sequence. This template 

does not re-create any media.

6 Click OK.

7 In the Export As dialog box, check the file name, select a drive, and click Save.

If you are moving a sequence to another Avid Xpress, Media Composer or 
Film Composer, or Symphony system, perform the following steps to 
customize your settings.

1 In an Avid Xpress bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Macintosh 
editing system.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select Customize.

The Export Settings dialog box appears.

6 (Optional) Enter a name if this is a template you want to keep.

7 Choose the format options based on the application to which you are moving 

media.
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AudioVision Moving AIFF-C or WAVE files to AudioVision:

- Click the AudioVision Compatibility check box.

Pro Tools — 
AIFF-C

Moving AIFF-C files to Pro Tools:

a Click the OMFI Composition button.

b Choose Version 2.0 from the Version pop-up menu.

Pro Tools — 
WAVE

Moving WAVE files to Pro Tools:

a Click the OMFI Composition button.

b Choose Version 2.0 from the Version pop-up menu.

c Click the Use Audio Media check box.

d Choose AIFF-C from the pop-up menu.

Media Composer 
7.2

Moving WAVE files to Media Composer Release 7.2:

a Click the OMFI Composition button.

b Choose Version 1.0 from the Version pop-up menu.

c Click the Use Audio Media check box.

d Choose AIFF-C from the pop-up menu.

Avid Xpress 2.1 
(Macintosh)

Moving WAVE files to Avid Xpress Release 2.1 (Macintosh):

a Click the OMFI Composition button.

b Choose Version 1.0 from the Version pop-up menu.

c Click the Use Audio Media check box.

d Choose AIFF-C from the pop-up menu.

8 Click OK.

9 In the Export As dialog box, check the file name, select a drive formatted for 
Windows (NTFS) or a network drive, and click Save.
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Step 3:  Transfer  the F i les  to  the Dest inat ion System

For the options to move your files from one system to another, see 
Appendix A.

Step 4:  Import  the OMFI  F i le  

This final step varies, depending on both the file type and the receiving 
system. The following sections describe how to import the audio file into 
AudioVision, Pro Tools, and Media Composer or Film Composer.

AudioVision To import OMFI files after transferring the files to the AudioVision system, 
start AudioVision and import the files into a bin.

Pro Tools To import OMFI files into Pro Tools:

1 Start the Macintosh system.

2 Open the DigiTranslator or OMF Tool 2.0.8.

3 Create a Session File from the OMFI file you exported from Avid Xpress.

4 Start Pro Tools and open the Session File. All audio should now be online.

Media Composer 
or Film Composer

When you import OMFI files into Media Composer or Film Composer, the 
system converts them to objects in a bin. You can manipulate and edit these 
objects as you would any other clip or sequence. 

To import an OMFI file into Media Composer or Film Composer (Macintosh):

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 

it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.
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4 Choose OMFI from the File Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Directory pop-up menu to locate the folder containing the source files.

7 Add files to or remove files from the import file list on the right, using one of the 
following methods:

- To add a single file, select a file name in the source file list and click the Add 
button, or double-click the file name.

- To add all the files in the source file list, click the Add All button.

- To remove a single file from the import file list, select a file name and click the 

Remove button.

- To remove all the files from the import file list, click the Remove All button.

8 Click Done.

To import an OMFI file into Media Composer or Film Composer for 
Windows:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the Files of Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Look In pop-up menu to locate the folder containing the source files.
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7 Add files to the import file list on the right, using one of the following methods:

- To add a single file, select the file name in the source file list.

- To add multiple files, press and hold the Ctrl key while selecting the file name 
for each file you want to include.

- To add all the files in the source file list, press Ctrl+A.

8 Click Done.
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This section describes how to transfer sequences with audio media from 
Avid Xpress Release 2.5 (Macintosh) to AudioVision, Pro Tools, or 
Media Composer for audio sweetening. It also describes how to move your 
audio media to Symphony, Media Composer or Film Composer, or another 
Avid Xpress system.

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. The formats available in Avid Xpress 
Release 2.5 (Macintosh) are compatible with formats in both AudioVision and 
Pro Tools. Therefore, you can export your sequence as an OMFI composition 
only and move your original audio media from the Avid Xpress Release 2.5 
(Macintosh) system to the Pro Tools or AudioVision workstation. 

If there is bin compatibility between your applications, such as between 
Avid Xpress Release 2.5 (Macintosh) and Media Composer Release 8.1 
(Macintosh), and you use compatible audio formats, you can move your bin 
and media without creating an OMFI file.

Table 2-13 lists the editing applications and their compatibility with 
Avid Xpress Release 2.5 (Macintosh).
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Table 2-13 Moving Sequences from Avid Xpress Release 2.5 (Macintosh) 
to an Editing Application

Destination 
Application

Compatibility with Avid Xpress Release 2.5 
(Macintosh)

AudioVision 
Release 4.1v10

Compatible: Sound Designer II 
Export your sequence as an OMFI 1.0 composition 
only, if you used the Sound Designer II format.
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the AIFF-C or WAVE 
format.

Pro Tools
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
with audio media if you used the WAVE format.
Export your sequence as an OMFI 2.0 composition 
only, if you used the AIFF-C or Sound Designer II 
format.

Symphony
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Avid Xpress 
Release 3.1 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 8.1 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

To move sequences between applications with different audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with or without audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Media Composer or 
Film Composer 
Release 10.x 
(Windows or 
Macintosh)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 7.2 or 
Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: Sound Designer II and AIFF-C 
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the WAVE format.
Bin compatibility if you used AIFF-C or 
Sound Designer II; see Appendix A.

Avid Xpress 
Release 4.x 
(Macintosh)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Table 2-13 Moving Sequences from Avid Xpress Release 2.5 (Macintosh) 
to an Editing Application (Continued)

Destination 
Application

Compatibility with Avid Xpress Release 2.5 
(Macintosh)
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Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from Avid Xpress 
Release 2.5 (Macintosh) to an audio-editing system, review the following list 
to ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the audio application to 
which you are moving. To set the audio file format, select General Settings 
from the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
With or Without Audio Media” on page 2-105. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Media Composer or Film Composer, Symphony, 
or Avid Xpress. For options and instructions for transferring files, see 
Appendix A.

• Prepare AudioSuite plug-ins: If your project includes AudioSuite plug-in 
effects, the effects will transfer but cannot be manipulated further. You 
have the following options:

- Render the audio clips in the sequence, and perform an audio 
mixdown, if necessary. Export the clips as OMFI files and import 
them into your editing application. 

- Render the audio clips in the sequence and export them as AIFF-C 
files. In the Export Format dialog box, select the Sound and AIFF-C 
options, and then import the files into your editing application.

- Render the audio clips in the sequence and export the sequence as 
OMFI 1.0 or OMFI 2.0 with or without media.
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Step 2:  Export  the Sequence With  or  Wi thout  Audio  Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

In Avid Xpress Release 2.5 (Macintosh), there are templates set up for many 
export options. If you are moving media to AudioVision or Pro Tools, perform 
the following steps to use the existing templates. 

To export a sequence with or without audio media:

1 In an Avid Xpress bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 

your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a digital audio 
workstation.

4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select the appropriate template for the application to which you are moving media.

For a list of the available templates, see Appendix B.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.
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AudioVision AudioVision template choices:

- AudioVision AIFF-C Embedded — Exports an OMFI composition with 
embedded AIFF-C audio media. 

- AudioVision SD2 External — Exports OMFI composition only, and creates 
Sound Designer II files for any audio media not created with Sound Designer 

II in the sequence. The re-created Sound Designer II media is put in a folder 
labeled “Exported Audio Media” at the top level of the drive where the original 
media was located. The template won’t re-create any original Sound Designer 

II media that was in the sequence.

Pro Tools Pro Tools template choices:

- Pro Tools AIFF-C Embedded — Exports an OMFI composition with 
embedded AIFF-C audio media. 

- Pro Tools SD2 External — Exports OMFI composition only, and creates 
Sound Designer II files for any audio media not created with Sound Designer 

II in the sequence. The re-created Sound Designer II media is put in a folder 
labeled “Exported Audio Media” at the top level of the drive where the original 
media was located.

6 Click OK.

7 In the Export As dialog box, check the file name, select a drive, and click Save.

If you are moving a sequence to a Media Composer or Film Composer system, 
perform the following steps to customize your settings.

1 In an Avid Xpress bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 

your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a Windows 
editing system.
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4 Choose Export from the File menu. 

The Export Format dialog box appears.

5 Select Customize.

The Export Settings dialog box appears.

6 (Optional) Enter a name if this is a template you want to keep.

7 Choose the format options based on the application to which you are moving 
media files:

Media Composer 
7.2

Moving WAVE files to Media Composer Release 7.2:

a Click OMFI Composition.

b Click the Use Audio Media check box.

c Choose AIFF-C from the Format pop-up menu.

d Choose Version 1.0 from the Version pop-up menu.

Avid Xpress 2.1 
(Macintosh)

Moving WAVE files to Avid Xpress Release 2.1 (Macintosh):

a Click OMFI Composition.

b Click the Use Audio Media check box.

c Choose AIFF-C from the Format pop-up menu.

d Choose Version 1.0 from the Version pop-up menu.

8 Click OK in the Export Settings dialog box.

9 Click OK in the Export dialog box.

10 In the Export As dialog box, check the file name, select a drive, and click Save.

Step 3:  Transfer  the F i les  to  the Dest inat ion System

For the options to move your files from one system to another, see 
Appendix A.
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Step 4:  Import  the OMFI  F i le  

This final step varies, depending on both the file type and the receiving 
system. The following sections describe how to import the audio file into 
AudioVision, Pro Tools, and Media Composer or Film Composer.

AudioVision To import OMFI files after transferring the files to the AudioVision system, 
start AudioVision and import the files into a bin.

Pro Tools To import OMFI files into Pro Tools:

1 Start the Macintosh system.

2 Open the DigiTranslator or OMF Tool 2.0.8.

3 Create a Session File from the OMFI file you exported from Avid Xpress.

4 Start Pro Tools and open the Session File. All audio should now be online.

Media Composer 
or Film Composer

When you import OMFI files into Media Composer or Film Composer, the 
system converts them to objects in a bin. You can manipulate and edit these 
objects as you would any other clip or sequence. 

To import an OMFI file into Media Composer or Film Composer for 
Macintosh:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the File Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Directory pop-up menu to locate the folder containing the source files.
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7 Add files to or remove files from the import file list on the right, using one of the 

following methods:

- To add a single file, select a file name in the source file list and click the Add 

button, or double-click the file name.

- To add all the files in the source file list, click the Add All button.

- To remove a single file from the import file list, select a file name and click the 
Remove button.

- To remove all the files from the import file list, click the Remove All button.

8 Click Done.

To import an OMFI file into Media Composer or Film Composer for 
Windows:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the Files of Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

6 Use the Look in pop-up menu to locate the folder containing the source files.

7 Add files to the import file list on the right, using one of the following methods:

- To add a single file, select the file name in the source file list.

- To add multiple files, press and hold the Ctrl key while selecting the file name 
for each file you want to include.

- To add all the files in the source file list, press Ctrl+A.

8 Click Done.
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This section describes how to transfer sequences with audio media from 
Avid Xpress Release 2.1 (Macintosh) to AudioVision or Pro Tools for audio 
sweetening. It also describes how to move your audio media to Symphony, 
Media Composer or Film Composer, or Avid Xpress (Windows).

It is important to make sure your audio formats are compatible so that you 
know how to move your audio files. The formats available in Avid Xpress 
Release 2.1 (Macintosh) are compatible with formats in both AudioVision and 
Pro Tools. Therefore, you can export your sequence as an OMFI composition 
only and move your original audio media from the Avid Xpress Release 2.1 
(Macintosh) system to the Pro Tools or AudioVision workstation. 

If there is bin compatibility between your applications, such as between 
Avid Xpress Release 2.1 (Macintosh) and Media Composer Release 7.2, and 
you use compatible audio formats, you can move your bin and media without 
creating an OMFI file.

Table 2-14 lists the editing applications and their compatibility with 
Avid Xpress Release 2.1 (Macintosh).
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Table 2-14 Moving Sequences from Avid Xpress Release 2.1 (Macintosh) 
to an Editing Application

Destination 
Application

Compatibility with Avid Xpress Release 2.1 
(Macintosh)

AudioVision 
Release 4.1v10

Compatible: Sound Designer II
Export your sequence as an OMFI 1.0 composition 
only, if you used the Sound Designer II format.
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the AIFF-C format.

Pro Tools 
Release 4.3.1 
(Macintosh) 

Compatible: Sound Designer II and AIFF-C
Export your sequence as an OMFI 2.0 composition 
only.

Symphony
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Media Composer 
Release 9.1 or 10.x, 
or Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: AIFF-C and WAVE
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Film Composer 
Release 10.x 
(Windows or 
Macintosh)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer or 
Film Composer 
Release 10.x 
(Macintosh)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

To move sequences between applications with different audio formats:

1 Prepare the audio files for transfer.

2 Export the sequence with or without audio media.

3 Transfer the files to the destination system.

4 Import the OMFI file.

Media Composer 
Release 8.1, or 
Avid Xpress 
Release 2.5 
(Macintosh)

Compatible: Sound Designer II, AIFF-C, and 
WAVE 
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the Sound Designer II 
format.
Bin compatibility; see Appendix A.

Media Composer 
Release 7.2 or 
Avid Xpress 
Release 2.1 
(Macintosh)

Compatible: AIFF-C and Sound Designer II
Bin compatibility; see Appendix A.

Table 2-14 Moving Sequences from Avid Xpress Release 2.1 (Macintosh) 
to an Editing Application (Continued)

Destination 
Application

Compatibility with Avid Xpress Release 2.1 
(Macintosh)
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Step 1:  Prepare  the  Audio  F i les for  Transfer

To prepare your sequence with audio media for transfer from Avid Xpress 
Release 2.1 (Macintosh) to an editing system, review the following list to 
ensure a successful transfer:

• Set the audio file format: If possible, when you start a project, set the 
audio format to match a format supported on the application to which 
you are moving. To set the audio file format, select General Settings from 
the Settings scroll list in the Project window. Choose the appropriate 
audio format from the Audio File Format menu.

If your audio formats don’t match, you can export the audio media as an 
OMFI composition with audio media. See “Step 2: Export the Sequence 
With or Without Audio Media” on page 2-114. 

• Choose a transfer method: Determine how you will transfer the files to 
AudioVision, Pro Tools, Symphony, Media Composer or Film Composer 
or Avid Xpress (Windows). For options and instructions for transferring 
files, see Appendix A.

• Prepare AudioSuite plug-ins: If your project includes AudioSuite plug-in 
effects, the effects will transfer but cannot be manipulated further. You 
have the following options:

- Render the audio clips in the sequence, and perform an audio 
mixdown, if necessary. Export the clips as OMFI files and import 
them into your editing application. 

- Render the audio clips in the sequence and export them as AIFF-C 
files. In the Export Format dialog box, select the Sound and AIFF-C 
options, and then import the files into your editing application.

- Render the audio clips in the sequence and export the sequence as 
OMFI 1.0 or OMFI 2.0 with or without media.
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Step 2:  Export  the Sequence With  or  Wi thout  Audio  Media

If you are moving between systems that have compatible bins and audio 
formats, and the media files are available to both systems, you can move 
audio simply by exchanging bins. If the audio formats are incompatible, or 
you want to embed audio in an OMFI file for convenience during transfer, use 
the procedures described in this section.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

To export a sequence with or without audio media:

1 In an Avid Xpress bin, select the sequence or master clip you want to transfer.

2 Duplicate the sequence.

Duplicating the sequence ensures that you have a copy if you need to go back to 
your original sequence.

3 Consolidate the sequence.

n Consolidate to an HFS nonstriped drive if you are moving these files to a digital audio 
workstation or to a Media Composer on a Windows system.

4 Choose Export from the File menu.

The Export Format dialog box appears.

5 Select OMFI Composition as the Export Format and choose the options based on 

the application to which you are moving media:

AudioVision Moving AIFF-C files to AudioVision:

a Choose AudioVision.

b Choose OMFI 1.0 from the Version pop-up menu.

c Click the With Media check box.
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Pro Tools Moving AIFF-C or Sound Designer II files to Pro Tools:

a Choose Standard - AIFF-C from the first pop-up menu.

b Choose Audio Only from the second pop-up menu.

c Choose OMFI 2.0 from the Version pop-up menu.

d Click the With Media check box if you want to embed the audio media.

Symphony 2.1 or 
3.x

Moving Sound Designer II files to Symphony Release 2.1 or 3.x:

a Choose Standard - AIFF-C from the first pop-up menu.

b Choose Audio Only from the second pop-up menu.

c Choose OMFI 1.0 from the Version pop-up menu.

d Click the With Media check box.

Media Composer 
9.1 or 10.x, or 
Film Composer 
10.x (Windows)

Moving Sound Designer II files to Media Composer Release 9.1 or 10.x, or 
Film Composer Release 10.x (Windows):

a Choose Standard - AIFF-C from the first pop-up menu.

b Choose Audio Only from the second pop-up menu.

c Choose OMFI 1.0 from the Version pop-up menu.

d Click the With Media check box.

Avid Xpress 3.1 or 
4.x (Windows)

Moving Sound Designer II files to Avid Xpress Release 3.1 or 4.x (Windows):

a Choose Standard - AIFF-C from the first pop-up menu.

b Choose Audio Only from the second pop-up menu.

c Choose OMFI 1.0 from the Version pop-up menu.

d Click the With Media check box.

6 Click OK.

7 In the Export As dialog box, check the file name, select a location for the exported 

files, and click Save.
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Step 3:  Transfer  the F i les  to  the Dest inat ion System

For the options to move your files from one system to another, see 
Appendix A.

Step 4:  Import  the OMFI  F i le  

This final step varies, depending on both the file type and the receiving 
system. The following sections describe how to import the audio file into 
AudioVision, Pro Tools, and Media Composer or Film Composer.

AudioVision To import OMFI files after transferring the files to the AudioVision system, 
start AudioVision and import the files into a bin.

Pro Tools To import OMFI files into Pro Tools:

1 Start the Macintosh system.

2 Open the DigiTranslator or OMF Tool 2.0.8.

3 Create a Session File from the OMFI file you exported from Avid Xpress.

4 Start Pro Tools and open the Session File. All audio should now be online.

Media Composer 
or Film Composer

When you import OMFI files into Media Composer or Film Composer, the 
system converts them to objects in a bin. You can manipulate and edit these 
objects as you would any other clip or sequence. 

To import an OMFI file into Media Composer or Film Composer for 
Macintosh:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 
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The Select Files to Import dialog box appears.

4 Choose OMFI from the File Type pop-up menu.

5 Choose a destination drive for the imported file from the Media Disk pop-up menu.

6 Use the Directory pop-up menu to locate the folder containing the source files.

7 Add files to or remove files from the import file list, using one of these methods:

- To add a single file, select a file name in the source file list and click the Add 
button, or double-click the file name.

- To add all the files in the source file list, click the Add All button.

- To remove a single file from the import file list, select a file name and click the 

Remove button.

- To remove all the files from the import file list, click the Remove All button.

8 Click Done.

To import an OMFI file into Media Composer or Film Composer for 
Windows:

1 Start Media Composer or Film Composer.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it. 

3 Choose Import from the File menu. 

The Select Files to Import dialog box appears.

4 Choose OMFI from the Files of Type pop-up menu.

5 Choose a destination drive from the Media Drive pop-up menu.

6 Use the Look In pop-up menu to locate the folder containing the source files.

7 Add files to the import file list on the right, using one of the following methods:

- To add a single file, select the file name in the source file list.

- To add multiple files, press and hold the Ctrl key while selecting the file name 
for each file you want to include.
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- To add all the files in the source file list, press Ctrl+A.

8 Click Done.
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This section describes how to transfer sequences with audio media from 
Avid Xpress DV Release 1.0, 1.5, or 2.0 (Windows) to AudioVision or Pro Tools 
for audio sweetening. It also describes how to move your audio media to a 
Symphony, Media Composer or Film Composer, or Avid Xpress system.

It is important to make sure your audio formats are compatible with the 
destination application so that you know how to move your audio files. Files 
being exported from Avid Xpress DV to an application that does not support 
mixed audio sample rates need to be converted to one sample rate. In 
addition, you will not be able to export a 32-kHz audio file from an 
Avid Xpress DV system to another Avid product; therefore, you should 
convert the 32-kHz audio sample rate.

If the sample rates are compatible, you can export your sequence as an OMFI 
composition only and move your original audio media from the 
Avid Xpress DV Release 1.0, 1.5, or 2.0 (Windows) system to the Pro Tools 
workstation.

n If you want to move only one file, you can export the sequence as an OMFI 
composition with audio media even if your audio formats are compatible. If you are 
using a network drive to move files, you might want to include the audio media in 
your OMFI composition to simplify moving across the network.

Table 2-15 lists the editing applications and their compatibility with 
Avid Xpress DV Release 1.0, 1.5, or 2.0 (Windows).
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Table 2-15 Moving Sequences from Avid Xpress DV Release 1.0, 1.5, or 
2.0 (Windows) to an Editing Application

Destination 
Application

Compatibility with Avid Xpress DV Release 1.0, 
1.5, or 2.0 (Windows)

AudioVision 
Release 4.1v9

Compatible: Audio not compatible
Export your sequence as an OMFI 1.0 composition 
with audio media. The AudioVision Compatibility 
check box must be selected in the OMFI Export 
Settings dialog box.

Pro Tools
Release 4.3.1.1 
(Macintosh) 

Compatible: AIFF-C
Export your sequence as OMFI 2.0 composition 
with embedded AIFF-C audio media if you used 
WAVE audio media in your sequence.
DigiTranslator or OMF Tool is needed to convert 
OMFI to a session file.

Symphony
Release 2.1 or 3.x

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 9.1 or 10.x, 
or Film Composer 
Release 10.x, or 
Avid Xpress 
Release 3.1 or 4.x 
(Windows)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.

Media Composer 
Release 8.1 or 10.x or 
Avid Xpress 4.x 
(Macintosh)

Compatible: AIFF-C and WAVE
Bin compatibility; see Appendix A.
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If you are moving between applications that use the same audio formats, see 
Appendix A for options on moving your files to the audio-editing 
workstation.

Prepar ing the Audio Fi les  for  Transfer

To transfer a sequence with audio media from Avid Xpress DV Release 1.0, 
1.5, or 2.0 (Windows) to an audio-editing system, see “Exporting Audio Files” 
on page 2-121 and “Converting Multiple Audio Sample Rates” on page 2-122.

E x p o r t i n g  A u d i o  F i l e s

The following list provides information about exporting audio files.

• Multiple audio sample rates

When you export files from Avid Xpress DV to an application that does 
not support multiple audio sample rates, convert the audio sample rates 
to one sample rate. 

• 32-kHz audio files

A 32-kHz file cannot be exported to an application that does not support 
32 kHz. You need to convert the 32-kHz audio sample rate.

Media Composer 
Release 7.2 or 
Avid Xpress 
Release 2.1 or 2.5 
(Macintosh)

Compatible: AIFF-C 
Export your sequence as an OMFI 1.0 composition 
with audio media if you used the WAVE format.
Bin compatibility if you used AIFF-C; see 
Appendix A.

Table 2-15 Moving Sequences from Avid Xpress DV Release 1.0, 1.5, or 
2.0 (Windows) to an Editing Application (Continued)

Destination 
Application

Compatibility with Avid Xpress DV Release 1.0, 
1.5, or 2.0 (Windows)
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If you have a sequence with multiple audio sample rates (for example, one 
clip at 48 kHz and other clips at 44.1 kHz), you must convert the clips to a 
single sample rate for transfer to Symphony Release 2.1 or earlier, 
Media Composer Release 9.1 or earlier, or Avid Xpress Release 3.1 or earlier. 

To convert a sequence to a single audio sample rate in Avid Xpress DV 
Release 1.5 only:

1 Make a duplicate of your sequence and name it to indicate the conversion to one 

sample rate; for example, “Sequence44.”

2 Select the new sequence and choose Change Sample Rate from the Bin menu.

3 Choose a quality level for the conversion.

4 Choose a sample rate from the submenu, and then click OK.

To convert a sequence to a single audio sample rate in Avid Xpress DV 
Release 1.0 or 1.5:

1 If your sequence has multiple audio sample rates, click the Settings button in the 
Project window.

The Setting Scroll list appears.

2 Double-click Audio Project Settings.

The Audio Project Settings window opens.

3 Choose a setting from the Sample Rate pop-up menu: 32 kHz, 44.1 kHz, or 
48 kHz.

This sample rate will be used for converting all other sample rates in your project.

4 Click the Close button to close the Audio Project Settings window.
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5 Make a duplicate of your sequence and name it to indicate the conversion to one 

sample rate; for example, “Sequence44.”

6 Select the new sequence and then choose Change Sample Rate from the Bin 

menu.

7 Choose a quality level for the conversion, and then click OK.
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After you have finished audio editing, you can move the audio files 
(mixdowns of sequences) or OMFI files back to a video-editing application for 
more editing or finishing. Most of the steps for preparing to export from and 
import into a bin are the same regardless of the method you use to transfer the 
files. 

For detailed information on moving files from system to system, see 
Appendix A. 

To transfer files from AudioVision or Pro Tools:

1 Export the audio or OMFI file.

2 Transfer the audio file to your Avid video-editing system.

3 Import the audio or OMFI file into a bin.

The following procedure details each step in the transfer process. For more 
information, see the appropriate documentation for your product.
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Step 1:  Export  the Audio or  OMFI  F i le  

To export from AudioVision or Pro Tools, see the following instructions

AudioVision To export audio files from AudioVision:

1 On the AudioVision system, select the master clip you want to transfer.

2 Export the file.

3 Select OMFI Composition and Frame-accurate Audio Media in the Export dialog 

box.

4 Save the OMFI file.

Pro Tools You can export AIFF-C, WAVE, or Sound Designer II files from Pro Tools. 

To export audio files from Pro Tools:

1 Record a mix of the session back into Pro Tools. 

2 Choose Bounce to Disk from the File menu.

3 Select the following options in the dialog box:

- Split Stereo for the Bounce Type

- Import Into Session After Bounce for the Bounce Options

- 16 bit for the Resolution

4 Click Bounce.

5 Select the new bounced audio regions in the Region list.

6 Choose Export Selected as Files from the Audio menu.
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7 Select the following options in the dialog box:

- Either .AIFF-C, .wav, or Sound Designer II for the File Format

- 16 bit for the Resolution

- Stereo from .L/.R(2) for the Channels

- 44.1 kHz or 48 kHz for the Sample Rate

- Tweak Head for the Conversion Quality

8 Select a Macintosh nonstriped, external drive or a network drive for the 

Destination Directory.

9 Click OK.

Step 2:  Transfer  the Audio F i le  to Your  Avid  Video-Edi t ing  System

For the options to move your files from one system to another, see 
Appendix A.

Step 3:  Import  the Audio  or  OMFI  F i le  in to a  Bin

The final step in moving audio or OMFI files to your Avid video-editing 
application is to import them into a bin. When you import audio or OMFI 
files, the system converts them into objects in the bin (for AudioVision and 
Pro Tools, the audio files import as master clips). You can manipulate and edit 
these objects as you would any other clip or sequence. 

To import the audio or OMFI files into your Avid video-editing application:

1 Start your Avid video-editing application.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it.

3 Choose Import from the File menu. 

The Import dialog box appears.
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4 Choose a destination drive for the imported file from the Media Drive pop-up 

menu.

5 Use the pop-up menu to locate the folder containing the source files.

6 Select files or deselect files from the source file list in the Import dialog box.

7 Click Done.
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You can move specialized effects created in one of Avid’s graphics and effects 
applications to an Avid video-editing application. You can then move your 
graphics and effects files to your editing application. For example, you can 
create your sequence in Media Composer or Avid Xpress and your effects in 
an application that suits your needs, and then move your sequence and effects 
to Symphony for finishing.

For the options to move your files from one system to another, see
Appendix A.

This chapter describes the steps for moving graphics and effects files from 
Media Illusion, Matador, Elastic Reality, or Marquee to Symphony, 
Media Composer, Avid Xpress, or Avid Xpress DV systems. 

n If you are exporting from Symphony Release 2.1 or 3.x, or from Media Composer 
Release 9.1 or 10.x, or from Film Composer Release 10.x, note that OMFI does not 
support 24p.
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Avid’s product line includes applications for creating graphics, effects, and 
titles. These applications include:

• Matador — Paint, special effects, and rotoscoping software running on 
the SGI Indy®, Indigo2 IMPACT™, O2™, OCTANE®, and Onyx® 
platforms

• Media Illusion — Compositing, paint, image manipulation, and special 
effects software running on the SGI OCTANE and O2 platforms

• Elastic Reality — Advanced warping and morphing software running on 
the Windows NT, Windows 95, SGI IRIX, and Macintosh platforms

• Marquee — 3D title animation software running on the Windows NT and 
SGI IRIX platforms

Consider the following guidelines when you are moving graphics and effects 
to an editing application:

• It is a good idea to render both fields rather than a single field per frame. 
This process preserves as much of the original data as possible.

• When you bring graphics with premultiplied alpha images into an editing 
application, the premultiplied alpha images will not appear correctly. 
Make sure that your alpha channels are not premultiplied.

• If you are exporting a sequence of files, name each file in the sequence 
NameN.ext, with Name identifying the sequence, N indicating the file 
order, and .ext indicating the file type (for example, Image1.PIC, 
Image2.PIC, Image3.PIC). The numbering can start at any number except 
zero and use any numbering format (for example, Image010.PIC, 
Image012.PIC or Imagef28.PIC, Imagef29.PIC).
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After you create a project, review the following list before exporting your 
graphics and effects files to other Avid applications:

• File Names: Use the following guidelines when naming files: 

- Use only a combination of letters and numbers when creating file 
names. In addition, a total length of eight characters (not including 
the file name extension) will prevent problems when transferring the 
files.

- Do not add spaces at the beginning or end of a file name. Windows 
will display such files but may be unable to open them.

- Do not use a period at the end of a file name. Windows will display 
such files but may be unable to open them.

- UNIX® file names are case sensitive.

• You do not need to consolidate when using AVI or OMFI media only 
formats. However, to make the transfer process quicker and easier, you 
should export only the media that you will need. When you export a 
master clip OMFI composition, limit the master clip to the amount of time 
you need. Even if you create a subclip, the entire master clip media will be 
exported. 
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Symphony, Media Composer, and Avid Xpress support video export only 
from Media Illusion. The video files will transfer best with an OMFI media 
format. The preferred path for export is the AvidNet Transfer Tool, network 
connection, or shared storage.

To export files from Media Illusion:

Select one of the following export options:

• Uncompressed OMFI media 

• Sequential files: PICT or TARGA file type
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Symphony, Media Composer, and Avid Xpress support video export only 
from Matador. You can transfer Matador files via a network connection.

To export files from Matador:

1 Ensure that the NTSC or PAL export setting is consistent with your project.

2 Select one of the following export options:

- Uncompressed OMFI media

- Sequential files: PICT or TARGA® file type
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You can export files from Elastic Reality as either AVI files (AVI is a Windows 
format) or OMFI media files. If you export AVI files, you must have the Avid 
Codec for AVI installed on the Elastic Reality system. You can install the Avid 
Codec for AVI from the Symphony or Avid Xpress (Windows) CD-ROM.

Export ing E last ic  Real i ty  for  Windows AVI  F i les

To export AVI files from Elastic Reality Release 3.1 for Windows:

1 Choose Output Options from the Render menu.

2 Set the format to Video for Windows.

3 Click the Parameters button.

4 Click Setup.

5 Select Avid Codec for AVI Compression.

6 Select the compression setting based on the project to which you are moving the 
files.

7 Render the project to disk.
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Export ing E last ic  Real i ty  for  Windows OMFI  Media  F i les

To export OMFI media files from Elastic Reality Release 3.1 for Windows:

1 Choose Output Options from the Render menu.

2 Set the format to OMF.

3 Click the Parameters button.

4 Click Setup.

5 Select the compression setting based on the project to which you are moving the 
files.

6 Select NTSC or PAL.

7 Render the project to disk.

This procedure creates an OMFI media only file.

n If you want to include a matte with the image, you need to export the image in a file 
format that supports an alpha channel. Both OMFI and AVI let you export an alpha 
channel, but only external to the graphic channel. You will need to import the two files 
that are created through this process, and merge them using a Matte Key effect within 
your editing application. If you want to export a file that contains an embedded alpha 
channel, export the file as a sequential PICT or TARGA file type.
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To export files from Elastic Reality Release 3.0.9 for SGI IRIX:

1 Choose Output Options from the Render menu.

2 Set the Saver to OMF.

3 Click the Parameters button.

4 Click Setup.

5 Select the compression setting.

If you are exporting to any release except Media Composer Release 7.2, select 
Uncompressed.

6 Select NTSC or PAL.

This procedure creates an OMFI file. 

n If you want to include a matte with the image, you need to export the image in a file 
format that supports an alpha channel. OMFI lets you export an alpha channel, but 
only external to the graphic channel. You can also export the images as a sequence of 
files in PICT or TARGA format. 
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You can transfer QuickTime files from Elastic Reality (Macintosh) to your 
editing application. 

n To use QuickTime format for the transfer, you need QuickTime 3.0 and the latest Avid 
Codec for QuickTime installed on your Macintosh system. If you are moving 
QuickTime files to Avid Xpress Release 3.1 (Windows NT), you also need the 
Mov2OMF converter installed on your Macintosh system.

To create a QuickTime file for export:

1 Choose Output Options from the Render menu.

2 Set the format to QuickTime.

3 Click the Parameters button.

4 Select either:

- Media Composer compressor in Media Composer Release 8.1 or 
Avid Xpress Release 2.1.

- Avid QuickTime in Symphony Release 2.1, Media Composer Release 9.1, or 
Avid Xpress Release 3.1.

5 Select the compression ratio.

The QuickTime file will be compatible with any other Macintosh application 
using QuickTime 3.0 and the latest version of the Avid Codec for QuickTime. 
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You can export files from Marquee via compatible external drive storage or a 
network connection.

You should prepare static title and animation files with or without alpha 
channels before importing them to your editing application. The following 
sections describe the process for creating a static title and an animation file for 
transfer.

Creat ing a Sta t ic  T i t le  for  Export

To create a static title for export:

1 Create a new project whose format matches the intended pixel dimensions, frame 

rate, and field dominance for the animation or sequence.

2 Select the PICT or TARGA file format for rendering.

3 Save the matte as an alpha channel.

4 Choose Render Current Frame from the Render menu. 

The Save Frame dialog box appears.

5 Name the file and save it to a disk.



3-12 Collaboration Guide

C h a p t e r  3
E X P O R T I N G  F R O M  M A R Q U E E  R E L E A S E  1 . 0 . 1  F O R  W I N D O W S

3-12 Collaboration Guide

Export ing an Animat ion as an  OMFI Fi le

To prepare an animation without an embedded alpha channel for export, you 
should export the animation as either an OMFI file or an AVI file.

To export the animation as an OMFI file:

1 Choose Options from the Render menu.

2 Set Format and OMF. 

3 Click the Parameters button.

4 Select NTSC or PAL.

5 Select the compression setting based on the project to which you are moving the 
file.

6 Import the file into your editing application.

Export ing an Animat ion as an  AVI  Fi le

To export the animation as an AVI file:

1 Choose Options from the Render menu.

2 Set the format to Video for Windows.

3 Click the Parameters button.

4 Click Setup.

5 Select the Avid Codec for AVI.

6 Import the file into your editing application.

n None of the OMFI resolutions support embedded alpha channels. To composite the 
animation over a background in your editing application, select the Save Matte option 
and save the matte as an external file.
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Export ing an Animat ion as a  Sequence of  F i les  wi th an Alpha 
Channel

n If you are exporting a sequence of files, name each file in the sequence NameN.ext, 
with Name identifying the sequence, N indicating the file order, and .ext indicating 
the file type (for example, Image1.PIC, Image2.PIC, Image3.PIC). The numbering can 
start at any number except zero or use any numbering format (for example, 
Image010.PIC, Image012.PIC or Imagef28.PIC, Imagef29.PIC).

To export an animation as a sequence of files with an alpha channel:

1 Create a new project whose format matches the intended pixel dimensions, frame 

rate, and field dominance for the animation or sequence.

If you will be using the exported media in an Avid editing system for Macintosh, 

specify field 1 dominance. If you will be using an Avid editing system for Windows, 
Softimage|DS, Avid|DS, or Media Illusion, specify field 2 dominance.

- Select NTSC (720x486@29.97) for the NTSC-based format that uses field 1 
dominance.

- Select NTSC (720x486@29.97), select Custom, and then set the Dominance 
to Field 2 for the NTSC-based format that uses field 2 dominance.

2 Select the PICT or TARGA file format for rendering.

3 Save the matte as an embedded alpha file and specify the directory where you will 

save the file.

4 Choose either Render In to Out or Render All Frames from the Render menu.

5 Import the file into your editing application and apply a Matte Key effect to 
composite.
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Export ing an Animat ion wi th an Alpha Channel

To prepare an animation file with an alpha channel for export, you can export 
the file as an AVI file with an external alpha.

To export as an AVI file with an external alpha channel:

1 Create a new project whose format matches the intended pixel dimensions, frame 

rate, and field dominance for the animation or sequence.

If you will be using the exported media in an ABVB-based Macintosh system, 

specify field 1 dominance. If you will be using a Meridien-based Macintosh or 
Windows system, Softimage|DS, Avid|DS, or Media Illusion, specify field 2 
dominance.

- Select NTSC (720x486@29.97) for the NTSC-based format that uses field 1 
dominance.

- Select NTSC (720x486@29.97), select Custom, and then set the Dominance 
to Field 2 for the NTSC-based format that uses field 2 dominance.

2 Select the AVI with AVI Codec file format for rendering.

3 Save the matte externally and specify the directory where you will save the file.

4 Select the compression setting based on the project.

5 Choose Render All Frames from the Render menu.

6 Import the file into your editing application.

7 (Optional) if you exported as AVI, apply a Matte Key effect to the composite.



. .
 . 

. .

Collaboration Guide 3-15

E X P O R T I N G  F R O M  M A R Q U E E  R E L E A S E  1 . 0 . 1  F O R  S G I  I R I X

E x p o r t i n g  f r o m  M a r q u e e  R e l e a s e  1 . 0 . 1  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .f o r  S G I  I R I X  

You should prepare static title and animation files with or without alpha 
channels before importing them into your editing application. The following 
sections describe the process for creating a static title and an animation file for 
transfer.

Creat ing a Sta t ic  T i t le  for  Export

To create a static title for export:

1 Create an NTSC or PAL project.

2 Select the TIFF or PICT file format for rendering.

3 Save the matte as an alpha channel.

4 Choose Render Current Frame from the Render menu. 

The Save dialog box appears.

5 Name the file and save it to a disk.
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Export ing  an Animat ion as an OMFI  Fi le

To prepare an animation without an alpha channel for export, export the 
animation as an OMFI file:

1 Create a new project whose format matches the intended pixel dimensions, frame 
rate, and field dominance for the animation or sequence.

If you will be using the exported media in an Avid editing system for Macintosh, 
specify field 1 dominance. If you will be using an Avid editing system for Windows, 
Softimage|DS, Avid|DS, or Media Illusion, specify field 2 dominance.

- Select NTSC (720x486@29.97) for the NTSC-based format that uses field 1 
dominance.

- Select NTSC (720x486@29.97), select Custom, and then set the Dominance 
to Field 2 for the NTSC-based format that uses field 2 dominance.

2 Select the OMF file format for rendering and select the resolution required in the 
parameters.

3 Name the file and save it to a disk.

4 Choose either Render In to Out or Render All Frames from the Render menu.

5 Import the file into your Avid editing application.
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Export ing an Animat ion as a  Sequence of  F i les

To export an animation with an alpha channel as a sequence of files:

n If you are exporting a sequence of files, name each file in the sequence NameN.ext, 
with Name identifying the sequence, N indicating the file order, and .ext indicating 
the file type (for example, Image1.PIC, Image2.PIC, Image3.PIC). The numbering can 
start at any number except zero or use any numbering format (for example, 
Image010.PIC, Image012.PIC or Imagef28.PIC, Imagef29.PIC).

1 Create a new project whose format matches the intended pixel dimensions, frame 
rate, and field dominance for the animation or sequence.

If you will be using the exported media in an Avid editing system for Macintosh, 
specify field 1 dominance. If you will be using an Avid editing system for Windows, 
Softimage|DS, Avid|DS, or Media Illusion, specify field 2 dominance.

- Select NTSC (720x486@29.97) for the NTSC-based format that uses field 1 
dominance.

- Select NTSC (720x486@29.97), select Custom, and then set the Dominance 
to Field 2 for the NTSC-based format that uses field 2 dominance.

2 Select the PICT or TARGA file format for rendering.

3 Save the matte as an embedded alpha file and specify the directory where you will 
save the file.

4 Choose either Render In to Out or Render All Frames from the Render menu.

5 Name the file and save it to a disk.

6 Import the file into your editing application and apply a Matte Key effect to the 
composite. 
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To import files into Symphony Release 2.1 or 3.x, Media Composer Release 9.1 
or 10.x, or Film Composer Release 10.x, or Avid Xpress Release 3.1 or 4.x 
(Windows):

n If you are importing a graphic or an effect with an alpha channel, make sure you 
choose the Invert Existing Alpha option when you import into a Media Composer, 
Film Composer, Symphony, or Avid Xpress system.

1 Start Symphony, Media Composer, Film Composer, or Avid Xpress.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it.

3 Choose Import from the File menu. 

The Import File(s) into Bin dialog box appears.

4 Choose All Files from the Files of Type pop-up menu.

5 Click the Options button.

The Import Settings dialog box appears. 

6 Select the appropriate options. 

For more information on Import Settings options, see the appropriate 

documentation for your product.

7 Click OK to close the Import Settings dialog box and return to the Import File(s) 

into Bin dialog box.

8 Choose a destination drive for the imported file from the Media Drive pop-up 

menu.

9 Use the Look In pop-up menu to locate the folder containing the source files.
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10 Select files or deselect files from the source file list in the Import File(s) into Bin 

dialog box by doing one of the following:

- To add a single file, Ctrl+click the file in the source file list.

- To add a group of files, click the first file in a group, and then Shift+click the 
last file in a group.

- To deselect a single file from the source file list, Ctrl+click a highlighted file 
name.

11 Click Open.
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To import files into Media Composer Release 8.1 or 10.x, or Avid Xpress 
Release 2.5 or 4.x (Macintosh):

1 Start Media Composer or Avid Xpress.

2 Open the bin in which you want to store the imported files. Click in the bin to select 
it.

3 Choose Import from the File menu. 

The Import dialog box appears.

4 Click Show All Files to display all file types.

5 Choose the type of file you want to import from the Files Type pop-up menu.

6 Click the Options button.

The Import Settings dialog box appears. 

7 Select the appropriate options. 

For more information on Import Settings options, see the appropriate 
documentation for your product.

8 Click OK to close the Import Settings dialog box and return to the Import dialog 
box.

9 Choose a destination drive for the imported file from the Media Drive pop-up 
menu.

10 Choose a resolution for the imported file from the Resolution pop-up menu.

11 Choose the source destination from the Source pop-up menu to locate the source 

files.
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12 Select files or deselect files from the source file list in the Import dialog box by 

doing one of the following:

- To add a single file, double-click the file name in the source file list.

- To add all of the files, click the Add All button.

- To deselect a single file from the source file list, click file name to select it and 
click the Remove button.

- To remove all the files from the import list, click the Remove All button.

13 Click Done.



3-22 Collaboration Guide

C h a p t e r  3
E X P O R T I N G  T O  M E D I A  I L L U S I O N  R E L E A S E 5 . 1 V 6

3-22 Collaboration Guide

E x p o r t i n g  t o  M e d i a  I l l u s i o n  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .R e l e a s e 5 . 1 v 6

When you prepare a composition, sequence, or clip for transfer, select only the 
media that you need to expedite the transfer process. 

Export ing F i les f rom Symphony Release 3.x ,  Media Composer  or  
Fi lm Composer  Release 10.x  (Windows or  Macintosh) ,  or  
Avid Xpress  Release 4 .x  (Windows or  Macintosh)

You can use the AvidLinks command to quickly transfer compositions from 
Symphony Release 3.x (Windows), Media Composer or Film Composer 
Release 10.x (Windows and Macintosh), or Avid Xpress Release 4.x (Windows 
and Macintosh) to Media Illusion, but you cannot transfer audio files. The 
best path for transfer is a network connection that both Media Illusion and the 
editing application can access. 

To export files from Symphony Release 3.x (Windows), Media Composer or 
Film Composer Release 10.x (Windows and Macintosh), or Avid Xpress 
Release 4.x (Windows and Macintosh) to Media Illusion:

1 In a bin, select the sequence you want to transfer.

2 Click the File menu and point to AvidLinks. 

The submenu shows a number of options.

3 Choose one of the following options from the AvidLinks submenu:

- Media Illusion (Composition). This option creates an OMFI 2.0 composition.

- Media Illusion (Video). This option creates a sequential file for each frame of 

video as 1:1 uncompressed in an OMF file.

For a list of the available AvidLinks, see Appendix B.
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n If you plan on performing significant effects work on a composition while in 
Media Illusion, you should transfer the composition, redigitize the media, do the 
effects work, and then transfer the OMFI media back to Symphony, Media Composer, 
Film Composer, or Avid Xpress.

The AvidLink Export to Media Illusion dialog box appears with a default file name 
in the File name text box, based on file type.

4 Check the file name, select a location for the exported file, and then click Save.

If you create an OMFI 2.0 composition file, you can import the composition 
file into Media Illusion and batch digitize it uncompressed.

You should have no difficulty transferring the following types of complex 
effects:

• Picture-in-Picture

• Push or Peel

• Conceal or L-Conceal

• Z Rotate

• Squeeze

• Superimpose

Other kinds of effects might not transfer appropriately. Media Illusion cannot 
edit or manipulate nested effects, color correction effects, Symphony Warp 
effects, or 3D effects transferred from Symphony, Media Composer, or 
Avid Xpress. 

Export ing F i les f rom Symphony Release 2.1 ,  Media Composer  
Release  9 .1 ,  or  Av id Xpress Release  3 .1  (Windows)

You can transfer compositions from Symphony Release 2.1, Media Composer 
Release 9.1, or Avid Xpress Release 3.1 (Windows) to Media Illusion, but you 
cannot transfer audio files. The best path for transfer is a network connection 
that both Media Illusion and the editing application can access. 
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To export files from Symphony Release 2.1, Media Composer Release 9.1, or 
Avid Xpress Release 3.1 (Windows) to Media Illusion:

1 In a bin, select the sequence you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following templates:

- Illusion OMF to export an OMFI Composition Version 2.0. This option creates 

an OMFI 2.0 composition.

- Illusion SGI IRIX Files to export a set of sequential files. This option creates a 

sequential file for each frame of video.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

n If you plan on performing significant effects work on a composition while in 
Media Illusion, you should transfer the composition, redigitize the media, do the 
effects work, and then transfer the OMFI media back to Symphony, Media Composer, 
Film Composer, or Avid Xpress.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

If you create an OMFI 2.0 composition file, you can import the composition 
file into Media Illusion and batch digitize it uncompressed.
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You should have no difficulty transferring the following types of complex 
effects:

• Picture-in-Picture

• Push or Peel

• Conceal or L-Conceal

• Z Rotate

• Squeeze

• Superimpose

Other kinds of effects might not transfer appropriately. Media Illusion cannot 
edit or manipulate nested effects, color correction effects, Symphony Warp 
effects, or 3D effects transferred from Symphony, Media Composer, 
Film Composer, or Avid Xpress. 

Export ing F i les f rom Media  Composer  Release  8.1  or  Avid Xpress  
Release  2 .5  (Macintosh)

You can transfer compositions from Media Composer Release 8.1 or 
Avid Xpress Release 2.5 (Macintosh) to Media Illusion, but you cannot 
transfer audio or video files. The best path for transfer is a network 
connection that both Media Illusion and the editing application can access. 

To export files from Media Composer Release 8.1 or Avid Xpress Release 2.5 
(Macintosh) to Media Illusion:

1 In a bin, select the sequence you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following templates:

- Illusion OMF to export an OMFI Composition Version 2.0. This option creates 

an OMFI 2.0 composition.
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- Illusion SGI IRIX Files to export a set of sequential files. This option creates a 

sequential file for each frame of video.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

n If you plan on performing significant effects work on a composition while in 
Media Illusion, you should transfer the composition, redigitize the media, do the 
effects work, and then transfer the OMFI media back to Media Composer or 
Avid Xpress.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

If you create an OMFI 2.0 composition file, you can import the composition 
file into Media Illusion and batch digitize it uncompressed.

You should have no difficulty transferring the following types of complex 
effects:

• Picture-in-Picture

• Push or Peel

• Conceal or L-Conceal

• Z Rotate

• Squeeze

• Superimpose

Other kinds of effects might not transfer appropriately. Media Illusion cannot 
edit or manipulate nested effects, color correction effects, Symphony Warp 
effects, or 3D effects transferred from Symphony, Media Composer, or 
Avid Xpress. 
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When you prepare a composition, sequence, or clip for transfer, select only the 
media that you need to expedite the transfer process. 

Export ing F i les f rom Symphony Release 3.x ,  Media Composer  or  
Fi lm Composer  Release 10.x  (Windows or  Macintosh) ,  or  
Avid Xpress  Release 4 .x  (Windows or  Macintosh)

You can transfer compositions with video to Matador from Symphony 
Release 3.x (Windows), Media Composer or Film Composer Release 10.x 
(Windows and Macintosh), or Avid Xpress Release 4.x (Windows and 
Macintosh), but you cannot transfer audio or compositions (except master 
clips). The supported format for transfer is sequential files and the 
recommended path is a network connection that both systems can access.

To export files from Symphony Release 3.x (Windows), Media Composer or 
Film Composer Release 10.x (Windows and Macintosh), or Avid Xpress 
Release 4.x (Windows and Macintosh) to Matador:

1 In a bin, select the sequence you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select the following template: Graphic-Targa, Use Marks, Both Fields, Odd 
Dominant, 720x486, CCIR Levels, Sequential Files.

These settings produce a set of sequential files with full-frame images that will be 
compatible with Matador. 
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4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

Export ing F i les f rom Symphony Release 2.1 ,  Media Composer  
Release  9 .1 ,  or  Av id Xpress Release  3 .1  (Windows)

You can transfer compositions with video to Matador from Symphony 
Release 2.1, Media Composer Release 9.1, or Avid Xpress Release 3.1 
(Windows), but you cannot transfer audio or compositions (except master 
clips). The supported format for transfer is sequential files and the 
recommended path is a network connection that both systems can access.

To export files from Symphony Release 2.1, Media Composer Release 9.1, or 
Avid Xpress Release 3.1 (Windows) to Matador:

1 In a bin, select the sequence you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select the Matador SGI IRIX Files template.

This template produces a set of sequential files with full-frame images that will be 

compatible with Matador. 

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.
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4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

This export creates sequential files. 

Export ing F i les f rom Media  Composer  Release  8.1  or  Avid Xpress  
Release  2 .5  (Macintosh)

You can transfer compositions with video to Matador from Media Composer 
Release 8.1 or Avid Xpress Release 2.5 (Macintosh), but you cannot transfer 
audio or compositions (except master clips). The supported format for 
transfer is sequential files and the recommended path is a network connection 
that both systems can access.

To export files from Media Composer Release 8.1 or Avid Xpress Release 2.5 
(Macintosh) to Matador:

1 In a bin, select the sequence you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select the Matador SGI IRIX Files template.

This template produces a set of sequential files with full-frame images that will be 
compatible with Matador. 

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .f o r  W i n d o w s  

You can transfer video from your editing application to Elastic Reality for 
Windows, but you cannot transfer audio or compositions (except master 
clips). The preferred path for transfer is compatible external drive storage or a 
network connection. You can transfer AVI files and OMFI media only files. 

You can perform a video mixdown or consolidation to create the master clip 
file. If you need to transfer only a segment of a sequence or a master clip, 
however, you should use the AVI process.

n You can export an AVI file only from Symphony, Media Composer Release 9.1, or 
Avid Xpress Release 3.0 or 4.x (Windows) because the AVI format is supported only 
on the Windows platform.

Export ing F i les f rom Symphony Release 3.x ,  Media Composer  or  
Fi lm Composer  Release 10.x  (Windows or  Macintosh) ,  or  
Avid Xpress  Release 4 .x  (Windows or  Macintosh)

To export files from Symphony Release 3.x (Windows), Media Composer or 
Film Composer Release 10.x (Windows and Macintosh), or Avid Xpress 
Release 4.x (Windows and Macintosh) to Elastic Reality (Windows):

n OMFI does not support 24p; use the latest QuickTime or AVI codec.

1 In a bin, select the sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following groups of settings:

- OMFI Composition, Version 1.0, Use Video Media to export an OMFI 
Composition Version 1.0.
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- Video Only, Use Marks, Both Fields, Source Compression to export a 

source-compressed file that will be compatible with Elastic Reality for 
Windows.

- Graphic-Targa, Use Marks, Both Fields, Odd Dominant, 720x486, CCIR 
Levels, Sequential Files as an alternative to AVI and OMF when the 
Elastic Reality system does not have the OMF update or the latest Avid 

codec. This export is slower than OMF or QuickTime.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

To transfer a segment of a sequence or master clip, using the OMFI graphic 
format:

n Because the graphic export format might take longer to export than exporting the 
whole sequence or master clip as an OMFI composition, make sure that you export 
only the media you need.

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 To export an OMFI media only file, select Graphic as the Export Format and 

choose OMF as the file type from the pop-up menu. 

The OMFI Parameters dialog box appears. 

4 Select the appropriate options.

5 Click OK to close the OMFI Parameters dialog box and return to the Export Format 
dialog box.

This export procedure creates an OMFI media only file or an OMFI 
composition file of a single master clip.
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Export ing F i les f rom Symphony Release 2.1 ,  Media Composer  
Release  9 .1 ,  or  Av id Xpress Release  3 .1  (Windows)

To export files from Symphony Release 2.1, Media Composer Release 9.1, or 
Avid Xpress Release 3.1 (Windows) to Elastic Reality (Windows):

n OMFI does not support 24p; use the latest QuickTime or AVI codec.

1 In a bin, select the sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following templates:

- Elastic Reality OMF to export an OMFI Composition Version 1.0.

- Elastic Reality AVI to export a source-compressed file that will be compatible 
with Elastic Reality for Windows.

- Elastic Reality Targa Files as an alternative to QuickTime and OMF when the 
Elastic Reality system does not have the OMF update or the latest Avid 

codec. This export is slower than OMF or QuickTime.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

To transfer a segment of a sequence or master clip, using the OMFI graphic 
format:

n Because the graphic export format might take longer to export than exporting the 
whole sequence or master clip as an OMFI composition, make sure that you export 
only the media you need.
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1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 To export an OMFI media only file, select Graphic as the Export Format and 
choose OMF as the file type from the pop-up menu. 

The OMFI Parameters dialog box appears. 

4 Select the appropriate options.

5 Click OK to close the OMFI Parameters dialog box and return to the Export Format 
dialog box.

This export procedure creates an OMFI media only file or an OMFI 
composition file of a single master clip.

Export ing F i les f rom Media  Composer  Release  8.1  or  Avid Xpress  
Release  2 .5  (Macintosh)

To export files from Media Composer Release 8.1 or Avid Xpress Release 2.5 
(Macintosh) to Elastic Reality (Windows):

1 In a bin, select the sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following templates:

- Elastic Reality OMF to export an OMFI Composition Version 1.0.

- Elastic Reality QuickTime to export a source-compressed file that will be 

compatible with Elastic Reality for Windows with the OMF update after using 
the QuickTime to OMF Converter.

- Elastic Reality Targa Files as an alternative to QuickTime and OMF when the 
Elastic Reality system does not have the OMF update or the latest Avid 

codec. This export is slower than OMF or QuickTime.
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n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

To transfer a segment of a sequence or master clip, using the OMFI graphic 
format:

n Because the graphic export format might take longer to export than exporting the 
whole sequence or master clip as an OMFI composition, make sure that you export 
only the media you need.

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 To export an OMFI media only file, select Graphic as the Export Format and 

choose OMF as the file type from the pop-up menu. 

The OMFI Parameters dialog box appears. 

4 Select the appropriate options.

5 Click OK to close the OMFI Parameters dialog box and return to the Export Format 
dialog box.

This export procedure creates an OMFI media only file or an OMFI 
composition file of a single master clip.
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You can transfer video from your editing application to Elastic Reality 
(SGI IRIX), but you cannot transfer audio or compositions (except master 
clips). The preferred path for transfer is a network connection or shared 
storage that both Elastic Reality and the editing application can access. You 
can transfer sequential files and ERIMovies. 

Export ing F i les f rom Symphony Release 3.x ,  Media Composer  or  
Fi lm Composer  Release 10.x  (Windows or  Macintosh) ,  or  
Avid Xpress  Release 4 .x  (Windows or  Macintosh)

To export files from Symphony Release 3.x (Windows), Media Composer or 
Film Composer Release 10.x (Windows and Macintosh), or Avid Xpress 
Release 4.x (Windows and Macintosh) to Elastic Reality (SGI IRIX):

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select the following template: Graphic-Targa, Use Marks, Both Fields, Odd 
Dominant, 720x486, CCIR Levels, Sequential Files.

Use this template as an alternative to QuickTime (which is not supported on IRIX) 
and OMFI (which is not a viable option for export because there is no HIIP update 
available for Elastic Reality running on SGI IRIX). 

This export is slower than OMF or QuickTime, and produces a sequential series of 
graphics files.

4 Click OK.

The Export As dialog box appears.
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5 Check the file name, select a location for the exported files, and then click Save.

Export ing F i les f rom Symphony Release 2.1 ,  Media Composer  
Release  9 .1 ,  or  Av id Xpress Release  3 .1  (Windows)

To export files from Symphony Release 2.1, Media Composer Release 9.1, or 
Avid Xpress Release 3.1 (Windows) to Elastic Reality (SGI IRIX):

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select the Elastic Reality Targa Files template as an alternative to QuickTime, 
which is not supported on IRIX, and OMFI, which is not a viable option for export 

because there is no HIIP update available for Elastic Reality running on SGI IRIX. 
This export is slower than OMF or QuickTime.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

This export procedure creates sequential files, one file for each frame of video. 
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Export ing F i les f rom Media  Composer  Release  8.1  or  Avid Xpress  
Release  2 .5  (Macintosh)  

You can transfer video from your editing application to Elastic Reality 
(SGI IRIX), but you cannot transfer audio or compositions (except master 
clips). The preferred path for transfer is a network connection or shared 
storage that both Elastic Reality and the editing application can access. You 
can transfer sequential files and ERIMovies. 

To export files from Media Composer Release 8.1 or Avid Xpress Release 2.5 
(Macintosh) to Elastic Reality (SGI IRIX):

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select the Elastic Reality - Targa template as an alternative to QuickTime and 

OMF, or when the Elastic Reality system does not have the latest Avid codec. This 
export is slower than OMF or QuickTime.

n Even though there is a template for Elastic Reality OMF, OMFI is not a viable option 
for export because there is no HIIP update available for Elastic Reality running on 
SGI IRIX.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

This export procedure creates sequential files, one file for each frame of video. 
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You can transfer video from your editing application to Elastic Reality 
(Macintosh), but you cannot transfer audio or compositions (except master 
clips). The preferred path for transferring AVI files is the AvidNet Transfer 
Tool, compatible external drive storage, or a network connection. 

If you are transferring AVI files from Symphony to Elastic Reality 
(Macintosh), you must have QuickTime 3.0 and the latest Media Composer 
QuickTime codec version installed on your Macintosh system. 

Export ing F i les f rom Symphony Release 3.x ,  Media Composer  or  
Fi lm Composer  Release 10.x  (Windows or  Macintosh) ,  or  
Avid Xpress  Release 4 .x  (Windows or  Macintosh)

To export files from Symphony Release 3.x (Windows), Media Composer or 
Film Composer Release 10.x (Windows and Macintosh), or Avid Xpress 
Release 4.x (Windows and Macintosh) to Elastic Reality (Macintosh):

n OMFI does not support 24p; use the latest QuickTime codec.

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following groups of settings:

- OMFI Composition, Version 1.0, Use Video Media to export an OMFI 
Composition Version 1.0.

- QuickTime-Video Only, Use Marks, Both Fields, Even Dominant, 720x486, 
Source Compression to export a source-compressed file that will be 
compatible with Elastic Reality (Macintosh).
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- Graphic-Targa, Use Marks, Both Fields, Odd Dominant, 720x486, CCIR 

Levels, Sequential Files as an alternative to QuickTime and OMF when the 
Elastic Reality system does not have the OMF update or the latest Avid 
codec. This export is slower than OMF or QuickTime and produces a 

sequential series of graphics files.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

Export ing F i les f rom Symphony Release 2.1 ,  Media Composer  
Release  9 .1 ,  or  Av id Xpress Release  3 .1  (Windows)

To export files from Symphony Release 2.1, Media Composer Release 9.1, or 
Avid Xpress Release 3.1 (Windows) to Elastic Reality (Macintosh):

n OMFI does not support 24p; use the latest QuickTime codec.

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following templates:

- Elastic Reality OMF to export an OMFI Composition Version 1.0.

- Elastic Reality QuickTime to export a source-compressed file that will be 

compatible with Elastic Reality (Macintosh).

- Elastic Reality Targa Files as an alternative to QuickTime and OMF when the 

Elastic Reality system does not have the OMF update or the latest Avid 
codec. This export is slower than OMF or QuickTime.
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n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

Export ing F i les f rom Media  Composer  Release  8.1  or  Avid Xpress  
Release  2 .5  (Macintosh)  

You can transfer video from your editing application to Elastic Reality 
(Macintosh), but you cannot transfer audio or compositions (except master 
clips). The preferred path for transferring AVI files is the AvidNet Transfer 
Tool, compatible external drive storage, or a network connection. 

To export files from Media Composer Release 8.1 or Avid Xpress Release 2.5 
(Macintosh) to Elastic Reality (Macintosh):

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following templates:

- Elastic Reality OMF to export an OMFI Composition Version 1.0.

- Elastic Reality QuickTime to export a source-compressed file that will be 
compatible with Elastic Reality (Macintosh).

- Elastic Reality Targa Files as an alternative to QuickTime and OMF when the 
Elastic Reality system does not have the OMF update or the latest Avid 
codec. This export is slower than OMF or QuickTime.
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n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.
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You can transfer video from your editing application to Marquee Release 1.0.1 
for Windows, but you cannot transfer audio or compositions (except master 
clips). The preferred path for transfer is a network connection, local storage, 
or compatible external drive storage. You can transfer AVI files, OMF graphics 
files, and OMFI with media files.

If you need to transfer only a segment of a sequence or a master clip, you 
should use the AVI process. Alternatively, you can perform a video mixdown 
or consolidation to create the master clip file.

Export ing F i les f rom Symphony Release 3.x ,  Media Composer  or  
Fi lm Composer  Release 10.x  (Windows or  Macintosh) ,  or  
Avid Xpress  Release 4 .x  (Windows or  Macintosh)

To export files from Symphony Release 3.x (Windows), Media Composer or 
Film Composer Release 10.x (Windows and Macintosh), or Avid Xpress 
Release 4.x (Windows and Macintosh) to Marquee (Windows):

n OMFI does not support 24p; use the latest QuickTime or AVI codecs.

1 In a bin, select the sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following groups of settings:

- OMFI Composition, Version 1.0, Use Video Media to export an OMFI 
Composition Version 1.0.

- Graphic-Targa, Use Marks, Both Fields, Odd Dominant, 720x486, RGB 
Levels, Sequential Files as an alternative to OMF when static files are 
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needed, or when files must be viewed before importing. This export is slower 

than OMF or QuickTime.

- Video Only, Use Marks, Both Fields, Source Compression to export a 

source-compressed file.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

To transfer a segment of a sequence or master clip, using the OMFI graphic 
format:

n Because the graphic export format might take longer to export than exporting the 
whole sequence or master clip as an OMFI composition, make sure that you export 
only the media you need.

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 To export an OMFI media only file, select Graphic as the Export Format and 

choose OMF as the file type from the pop-up menu. 

The OMFI Parameters dialog box appears. 

4 Select the appropriate options.

5 Click OK to close the OMFI Parameters dialog box and return to the Export Format 
dialog box.

This export procedure creates an OMFI media only file or an OMFI 
composition file of a single master clip. 
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Export ing F i les f rom Symphony Release 2.1 ,  Media Composer  
Release  9 .1 ,  or  Av id Xpress Release  3 .1  (Windows)

To export files from Symphony Release 2.1, Media Composer Release 9.1, or 
Avid Xpress Release 3.1 (Windows) to Marquee (Windows):

n OMFI does not support 24p; use the latest QuickTime or AVI codecs.

1 In a bin, select the sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following templates:

- Marquee OMF to export an OMFI Composition Version 1.0.

- Marquee Targa Files as an alternative to OMF when static files are needed, or 
when files must be viewed before importing. This export is slower than OMF 

or QuickTime.

- Marquee AVI to export a source-compressed file.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.
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To transfer a segment of a sequence or master clip, using the OMFI graphic 
format:

n Because the graphic export format might take longer to export than exporting the 
whole sequence or master clip as an OMFI composition, make sure that you export 
only the media you need.

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 To export an OMFI media only file, select Graphic as the Export Format and 
choose OMF as the file type from the pop-up menu. 

The OMFI Parameters dialog box appears. 

4 Select the appropriate options.

5 Click OK to close the OMFI Parameters dialog box and return to the Export Format 

dialog box.

This export procedure creates an OMFI media only file or an OMFI 
composition file of a single master clip. 

Export ing F i les f rom Media  Composer  Release  8.1  or  Avid Xpress  
Release  2 .5  (Macintosh)

To export files from Media Composer Release 8.1 or Avid Xpress Release 2.5 
(Macintosh) to Marquee (Windows):

1 In a bin, select the sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following templates:

- Marquee OMF to export an OMFI Composition Version 1.0.
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- Marquee Targa Files as an alternative to OMF when static files are needed, or 

when files must be viewed before importing. This export is slower than OMF 
or QuickTime.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

To transfer a segment of a sequence or master clip, using the OMFI graphic 
format:

n Because the graphic export format might take longer to export than exporting the 
whole sequence or master clip as an OMFI composition, make sure that you export 
only the media you need.

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 To export an OMFI media only file, select Graphic as the Export Format and 
choose OMF as the file type from the pop-up menu. 

The OMFI Parameters dialog box appears. 

4 Select the appropriate options.

5 Click OK to close the OMFI Parameters dialog box and return to the Export Format 
dialog box.

This export procedure creates an OMFI media only file or an OMFI 
composition file of a single master clip. 
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You can transfer video from your editing application to Marquee Release 1.0.1 
for SGI IRIX, but you cannot transfer audio or compositions (except master 
clips). The preferred path for transfer is a network connection or shared 
storage. You can transfer OMFI media only files and OMFI with media files 
(master clip only).

Export ing F i les f rom Symphony Release 3.x ,  Media Composer  or  
Fi lm Composer  Release 10.x  (Windows or  Macintosh) ,  or  
Avid Xpress  Release 4 .x  (Windows or  Macintosh)

To export files from Symphony Release 3.x (Windows), Media Composer or 
Film Composer Release 10.x (Windows and Macintosh), or Avid Xpress 
Release 4.x (Windows and Macintosh) to Marquee (SGI IRIX):

n OMFI does not support for 24p; use the latest QuickTime or AVI codecs.

1 In a bin, select the sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following groups of settings:

- OMFI Composition, Version 1.0, Use Video Media to export an OMFI 
Composition Version 1.0.

- Graphic-Targa, Use Marks, Both Fields, Odd Dominant, 720x486, RGB 
Levels, Sequential Files as an alternative to OMF when static files are 
needed, or when files must be viewed before importing. This export is slower 

than OMF or QuickTime and produces a sequential series of graphics files.

4 Click OK.

The Export As dialog box appears.
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5 Check the file name, select a location for the exported files, and then click Save.

To transfer a segment of a sequence or master clip, using the OMFI graphic 
format:

n Because the graphic export format might take longer to export than exporting the 
whole sequence or master clip as an OMFI composition, make sure that you export 
only the media you need.

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 To export an OMFI media only file, select Graphic as the Export Format and 
choose OMF as the file type from the pop-up menu. 

The OMFI Parameters dialog box appears. 

4 Select the appropriate options.

5 Click OK to close the OMFI Parameters dialog box and return to the Export Format 

dialog box.

This export procedure creates an OMFI media only file or an OMFI 
composition file of a single master clip. 
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Export ing F i les f rom Symphony Release 2.1 ,  Media Composer  
Release  9 .1 ,  or  Av id Xpress Release  3 .1  (Windows)

To export files from Symphony Release 2.1, Media Composer Release 9.1, or 
Avid Xpress Release 3.1 (Windows) to Marquee (SGI IRIX):

n OMFI does not support 24p; use the latest QuickTime or AVI codecs.

1 In a bin, select the sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following templates:

- Marquee OMF to export an OMFI Composition Version 1.0.

- Marquee Targa Files as an alternative to OMF when static files are needed, or 
when files must be viewed before importing. This export is slower than OMF 

or QuickTime.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.

For a list of the available templates, see Appendix B.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

To transfer a segment of a sequence or master clip, using the OMFI graphic 
format:

n Because the graphic export format might take longer to export than exporting the 
whole sequence or master clip as an OMFI composition, make sure that you export 
only the media you need.
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1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 To export an OMFI media only file, select Graphic as the Export Format and 
choose OMF as the file type from the pop-up menu. 

The OMFI Parameters dialog box appears. 

4 Select the appropriate options.

5 Click OK to close the OMFI Parameters dialog box and return to the Export Format 
dialog box.

This export procedure creates an OMFI media only file or an OMFI 
composition file of a single master clip. 

Export ing F i les f rom Media  Composer  Release  8.1  or  Avid Xpress  
Release  2 .5  (Macintosh)  

To export files from Media Composer Release 8.1 or Avid Xpress Release 2.5 
(Macintosh) to Marquee (SGI IRIX):

1 In a bin, select the sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 Select one of the following templates:

- Marquee OMF to export an OMFI Composition Version 1.0.

- Marquee Targa Files as an alternative to OMF when static files are needed, or 

when files must be viewed before importing. This export is slower than OMF 
or QuickTime.

n If you select a template and then select Customize, any changes you make in the 
Export Settings dialog box will create a new template.



. .
 . 

. .

Collaboration Guide 3-51

E X P O R T I N G  T O  M A R Q U E E  R E L E A S E  1 . 0 . 1  F O R  S G I  I R I X

For a list of the available templates, see Appendix B.

4 Click OK.

The Export As dialog box appears.

5 Check the file name, select a location for the exported files, and then click Save.

To transfer a segment of a sequence or master clip, using the OMFI graphic 
format:

n Because the graphic export format might take longer to export than exporting the 
whole sequence or master clip as an OMFI composition, make sure that you export 
only the media you need.

1 In a bin, select the segment of a sequence or master clip you want to transfer.

2 Choose Export from the File menu. 

The Export Format dialog box appears.

3 To export an OMFI media only file, select Graphic as the Export Format and 
choose OMF as the file type from the pop-up menu. 

The OMFI Parameters dialog box appears. 

4 Select the appropriate options.

5 Click OK to close the OMFI Parameters dialog box and return to the Export Format 

dialog box.

This export procedure creates an OMFI media only file or an OMFI 
composition file of a single master clip. 
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After you have exported the files, you need to move them to the system where 
your graphics or effects application resides. For options on moving the files, 
see Appendix A. For details on importing files once you have moved them, 
see the appropriate documentation for the receiving application.

M o v i n g  G r a p h i c s  F i l e s  w i t h  A v i d  X p r e s s  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .D V  R e l e a s e  1 . 0 ,  1 . 5 ,  o r  2 . 0  f o r  W i n d o w s

The following sections include the procedures for modifying frame sizes 
when you transfer files by using Avid Xpress DV Release 1.0, 1.5, or 2.0 
(Windows).

Padding the  DV Frame Size

The frame size of an NTSC DV file is 720 x 480. The NTSC D1 standard frame 
size is 720 x 486. An exported graphic might need to be padded from 480 to 
486, depending on the application you’re exporting to. The Avid Xpress DV 
system has a Pad option to adjust the 480 frame size to 486. This option adds 
six lines to the 480 frame size during export.

In Avid Xpress DV, the Pad option is most useful when you are exporting files 
to a non-DV standard application. In this situation, four black lines are added 
to the top of the frame and two black lines are added to the bottom of the 
frame. The Pad option never scales or resizes frames.
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To pad the DV frame size for exporting files from Avid Xpress DV Release 1.0, 
1.5, or 2.0 (Windows):

1 Select the material you want to export.

2 Choose Export from the File menu. 

The Pick Export Settings dialog box appears.

3 Choose the Export settings.

4 Click the Customize button. 

The Export Settings dialog box appears.

5 Choose a file you want to export from the Export As pop-up menu.

6 In the Width and Height option, choose the size 720 x 486.

7 Choose Crop/Pad.

8 Set the remaining options.

9 Name the setting by typing a name of your choice in the text box at the top of the 

Export Settings dialog box, and click OK to return to the Pick Export Settings 
dialog box.

10 Click OK in the Pick Export Settings dialog box.

The Export As dialog box appears with the default QuickTime file name extension 

in the File Name text box.

11 (Optional) Change the file name. In most cases, keep the default file name 

extension.

12 Select the destination folder for the file, and then click Save.

The file is exported and appears at the chosen destination.
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Cropping the  DV Frame Size

An imported graphic might need to be cropped from 486 to 480, depending on 
the application from which you are importing. The Avid Xpress DV system 
has a Crop option to adjust the 486 frame size to 480. This option removes six 
lines from the 486 frame size for importing.

In Avid Xpress DV, the Crop option might be most useful when you use 
material that has been created for non-DV products with a standard NTSC 
size of 720 x 486. In this situation, the top four lines and the bottom two lines 
of the frame are cropped. Maintain, non-square never scales or resizes frames.

To crop the DV frame size for importing files into Avid Xpress DV Release 1.0, 
1.5, or 2.0 (Windows), adjust the Import setting as follows:

1 Click the Settings button in the Project window.

The Settings scroll list appears.

2 Double-click an Import setting. 

The Import Settings dialog box appears. 

3 Select the Maintain, non-square option.

Select this option for an image that was created in a non-square pixel 

environment, but does not match exact DV NTSC or DV PAL dimensions. 
Maintain, non-square preserves up to 480 (NTSC) or 576 (PAL) lines, and 
removes additional lines.

4 Click OK.
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When you are moving projects between Avid applications running on 
different platforms, the process will be easier and more successful if you use 
the guidelines in the the following sections.

Fi le  Names

To make it easier to move files between products and across platforms, use the 
following guidelines when naming files: 

• Do not use the following characters in project, bin, or other file names:

/\:*?”<>|

Windows does not recognize these characters in names and will substitute 
other characters, possibly making the file name unrecognizable.

• Do not add spaces at the beginning or end of a file name. Windows will 
display such files but may be unable to open them.

• Do not use a period at the end of a file name. Windows will display such 
files but may be unable to open them.

• In Media Composer Releases 7.1v2, 7.2, and 8.0 (Macintosh), and 
Avid Xpress Release 2.5 (Macintosh), you can enable a new setting that 
prevents you from using restricted characters in file names and 
automatically adds the correct file name extensions to files for your 
project. The Use Windows Compatible File Names setting in the General 
Settings dialog box is disabled by default. When you enable the setting, 
the file name extension .avp is added to project files and .avb to bin files 
when they are saved. These file name extensions are attached to existing 
files, also.

• UNIX names are case-sensitive.
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Fonts

If the project includes titles and you are moving between Macintosh and 
Windows systems, make sure you have the same font with exactly the same 
name (preferably from the same manufacturer) on both the Macintosh and 
Windows systems. Check the font carefully because the same font can have 
slightly different names. For example, Times New Roman on the Macintosh 
system is named Times New Roman Regular on the Windows system.

If you open a title that does not have a matching font, a dialog box appears 
that allows you to substitute the font in the title with a font that exists on your 
system. 

For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.
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This section describes the options and methods you can use to transfer project 
files and media between Windows, Macintosh, and SGI IRIX systems.

There are different options for transferring files, depending on the source and 
destination systems. Tables A-1 to A-5 provide options for every combination 
of systems between which you may be moving files. All of these tables list the 
various ways to transfer data, the prerequisite hardware or software, and any 
restrictions.

Transferr ing F i les Between Macintosh Systems

Table A-1 shows for available transfer methods for transferring data between 
Macintosh systems.

Table A-1 Options for Transferring Files Between Macintosh 
Systems

Method Requirements Restrictions

Avid Unity 
TransferManager 
(server)

An Avid Unity 
workgroup 
environment

Transfer is supported between Macintosh clients in an 
Avid Unity environment. Peer-to-peer transfer is not 
supported at this time.

AvidNet Transfer 
Tool

A network or 
crossover cable

See “Transferring Files with the AvidNet Transfer Tool” 
on page  A-13 and the AvidNet Transfer Tool 
documentation.

Server-based 
network

None None.

External SCSI 
drives

None None — Disk Mounter is installed in all 
Media Composer and Avid Xpress systems.
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Floppy disk Macintosh 
formatted disk

Holds 1.4 MB. 

Zip® or Jaz® disk Macintosh 
formatted disk

Size of the disk.

CD-ROM None Do not use hybrid or ISO 9660 format, which truncates 
the file names.

E-mail E-mail software 
that supports 
attachments

See documentation for the e-mail software.

Fetch Fetch installed on 
both systems, 
and network 
access for both 
systems

One system must be set to “Server” mode. This method 
can be very slow.

AppleShare® Network access 
on both systems

Activate AppleShare on the sending system to allow a 
guest or registered user to log in.

Table A-1 Options for Transferring Files Between Macintosh 
Systems (Continued)

Method Requirements Restrictions
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Transferr ing F i les Between Windows Systems

Table A-2 shows the available transfer methods for transferring data between 
Windows systems.

Table A-2 Options for Transferring Files Between Windows
Systems

Method Requirements Restrictions

Avid Unity 
TransferManager 
(server)

An Avid Unity 
workgroup 
environment

Transfer is supported between Windows clients in an 
Avid Unity environment as well as peer-to-peer 
transfer.

Avid Unity 
TransferManager 
(local)

A network or 
crossover cable

Transfer is supported between Windows clients in a 
peer-to-peer configuration.

AvidNet Transfer 
Tool

A network or 
crossover cable

See “Transferring Files with the AvidNet Transfer 
Tool” on page  A-13 and the AvidNet Transfer Tool for 
the Windows NT Operating System documentation.

Server-based 
network

None None.

External SCSI 
drives

Disk Mounter None — Disk Mounter is installed in all Symphony, 
Media Composer, Film Composer, and Avid Xpress 
(Windows NT) systems. See the Avid MediaDrive 
Utilities manual. DiskMounter is not required on 
Windows 2000 systems.

Floppy disk PC-formatted disk Holds 1.4 MB. 

Zip or Jaz disk PC-formatted disk Size of the disk.

CD-ROM None Do not use hybrid or ISO 9660 format, which truncates 
the file names. Files copied from a CD-ROM to a 
Windows system retain the read-only attribute. To 
change this attribute, see the Windows 
documentation.



. .
 . 

. .

Collaboration Guide A-7

O P T I O N S  F O R  F I L E  TR A N S F E R S

Transferr ing F i les Between Macintosh and Windows Systems

Use Table A-3 as a guide for choosing a method of transferring files between 
Macintosh and Windows systems.

 

E-mail E-mail software that 
supports 
attachments

See the documentation for the e-mail software.

FTP Network access and 
FTP software on 
both systems

See the FTP software documentation.

Table A-2 Options for Transferring Files Between Windows
Systems (Continued)

Method Requirements Restrictions

Table A-3 Options for Transferring Files Between Macintosh and 
Windows Systems

Method Requirements Restrictions

Avid Unity 
TransferManager

An Avid Unity 
workgroup 
environment or
a network or 
crossover cable

Transfer is supported between Macintosh and Windows 
clients in an Avid Unity environment. Peer-to-peer 
transfer is supported for Windows systems only.

AvidNet Transfer 
Tool

A network or 
crossover cable

See “Transferring Files with the AvidNet Transfer Tool” 
on page  A-13 and the AvidNet Transfer Tool 
documentation.

Floppy disk PC-formatted disk Disk holds 1.4 MB. You need PC Exchange 2.2 on 
Macintosh OS 8.1 to write and read file names longer 
than eight characters plus a three-letter file name 
extension.
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Zip or Jaz disk PC-formatted disk Macintosh versions require an additional driver from 
the manufacturer to format the PCs. See the following 
manufacturer Web site: 
www.iomega.com
You need PC Exchange 2.2 on Macintosh OS 8.1 to write 
and read file names longer than eight characters plus a 
three-letter file name extension.

Macintosh 
external hard 
drive

MacDrive™ 
CrossStripe 
Edition for Avid 
Systems to read 
the Macintosh file 
names

The MacDrive CrossStripe Edition for Avid Systems 
allows you to access striped and nonstriped HFS-
formatted volumes on a Windows system. You cannot 
use a drive formatted for a Macintosh system to play 
media on Symphony, Media Composer, Film Composer 
and Avid Xpress running on a Windows system.
The MacDrive CrossStripe Edition for Avid Systems is 
available from Mediafour Corporation 
(www.mediafour.com).
If you already use MacOpener 2000 from DataViz for 
transferring files on a Windows NT system, you can 
continue to use it. However, MacOpener is not 
supported for Symphony Release 3.x, Media Composer 
and Film Composer Release 10.x, and Avid Xpress 
Release 4.x.

CD-ROM MacDrive 
CrossStripe 
Edition for Avid 
Systems on 
Windows system 
to read the 
Macintosh file 
names

Do not use hybrid or ISO 9660 format, which truncates 
the file names. Files copied from a CD-ROM to a 
Windows system retain the read-only attribute. To 
change this attribute, see the Windows documentation.

Server-based 
network

Macintosh and 
Windows 
integration

Rename files to avoid problems with illegal characters.

Table A-3 Options for Transferring Files Between Macintosh and 
Windows Systems (Continued)

Method Requirements Restrictions

http://www.iomega.com
http://www.mediafour.com
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E-mail E-mail software 
that supports 
attachments

See documentation for the e-mail software.

Fetch Fetch on the 
Macintosh system
Software that 
supports FTP on 
the Windows 
system

See the following web site for more information on 
using Fetch:
www.fetchsoftworks.com

Table A-3 Options for Transferring Files Between Macintosh and 
Windows Systems (Continued)

Method Requirements Restrictions

http://www.fetchsoftworks.com
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Transferr ing F i les Between Macintosh and SGI  IR IX Systems

Currently, Avid recommends making a transfer between Macintosh and SGI 
IRIX systems through a network connection. There is a third-party product 
installed on the SGI IRIX side, Xinet’s K-AShare®, which lets Macintosh users 
mount an SGI IRIX volume on their desktop through the Chooser. For more 
information on Xinet, see the following web site:

www.Xinet.com

Table A-4 lists all available transfer methods.

Table A-4 Options for Transferring Files Between Macintosh and 
SGI IRIX Systems

Method Requirements Restrictions

Server-based 
network

K-AShare on the 
SGI IRIX system

Rename files to avoid problems with illegal characters.

CD-ROM None Do not use hybrid or ISO 9660 format, which truncates 
the file names. Do not use any special characters in file 
names.

Zip or Jaz disk Macintosh 
formatted disk

See the manufacturer’s Web site for further information:
www.iomega.com

E-mail E-mail software 
that supports 
attachments

See the documentation for the e-mail software.

Fetch Network access 
for both systems 
and FTP software 
on the SGI IRIX 
system

See the following web site for more information on using 
Fetch:
www.fetchsoftworks.com

http://www.xinet.com
http://www.fetchsoftworks.com
http://www.iomega.com/
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Transferr ing F i les Between Windows and SGI  IRIX Systems

Currently, Avid recommends making a transfer between Windows and SGI 
IRIX systems through a network connection. This type of transfer requires 
freeware called Samba, which you can download from the Internet 
(http://samba.gorski.net). You install Samba on the SGI IRIX system, and 
then access the Avid application files via Network Neighborhood (on your 
Windows desktop). Table A-5 lists the available transfer methods.

n You can download the executable files for Samba, which is easier than downloading 
and compiling the original source code. The Web site provides detailed documentation 
on how to download Samba.

Table A-5 Options for Transferring Files Between Windows and 
SGI IRIX Systems

Method Requirements Restrictions

Server-based 
network

Samba on the 
SGI IRIX system

Rename files to avoid problems with illegal characters.

CD-ROM None Do not use hybrid or ISO 9660 format, which truncates 
the file names. Files copied from a CD-ROM to a 
Windows system retain the read-only attribute. To 
change this attribute, see the Windows documentation. 
Do not use any special characters in 
file names.

Zip or Jaz disk PC-formatted 
disk

See the manufacturer’s Web site for further information:
www.iomega.com

E-mail E-mail software 
that supports 
attachments

See the the documentation for the e-mail software.

 FTP Network access 
and FTP software 
on both systems

See the FTP software documentation.

http://www.iomega.com/
http://samba.gorski.net
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Avid Unity TransferManager (server version) is a Web-browser-based transfer 
utility available with:

• Avid Unity MediaNet

• Avid Symphony Release 3.1 and later

• Avid Media Composer Release 10.1 and later

• Avid Film Composer Release 10.1 and later

• Avid Xpress Release 4.1 and later

• Avid NewsCutter Release 2.0 and later

• Avid NewsCutter XP Release 2.0 and later

n Avid Unity TransferManager is an option that you may have to purchase separately. 

The Avid Unity TransferManager allows you to quickly and easily move 
projects, compositions, or bins between Avid applications. TransferManager 
can be used either standalone for peer-to-peer transfer (Windows systems 
only) or in an Avid Unity workgroup environment (Windows and Macintosh 
clients). 

For information on specific procedures for transferring files with Avid Unity 
TransferManager, see the TransferManager documentation.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .T r a n s f e r  T o o l

The AvidNet Transfer Tool is a standard application on all Symphony 
Release 2.1 and earlier systems, as well as Media Composer 9000 systems. It is 
an option on all other platforms except Symphony Release 3.x, 
Media Composer or Film Composer Release 10.x, and Avid Xpress Release 4.x 
for the Macintosh. The Transfer Tool allows you to quickly and easily move 
projects, compositions, or bins between Avid applications on the Macintosh 
operating system and the Windows NT operating system.

This section provides specific instructions for transferring compositions and 
bins between Media Composer and Symphony. If you want to transfer work 
between Avid Xpress (Macintosh) and Symphony or between Avid Xpress 
(Windows) and Media Composer, use the standalone version of the AvidNet 
Transfer Tool. For additional information on using the Transfer Tool, see the 
appropriate AvidNet documentation.

n If you use the AvidNet Transfer Tool to move your sequence from Media Composer 
Release 7.2 or 8.1 (Macintosh), or from Avid Xpress Release 2.5 (Macintosh), 
AvidNet will convert some audio formats for you. It will convert AIFF-C to 
Sound Designer II if you are moving to AudioVision, and Sound Designer II to 
AIFF-C if you are moving to Media Composer, Symphony, or Avid Xpress running 
on Windows NT.

c The AvidNet Transfer Tool is not supported on Symphony Release 3.x, 
Media Composer or Film Composer Release 10.x, and Avid Xpress 
Release 4.x for the Macintosh.
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Table A-6 lists the AvidNet releases and the products with which they work.

n AvidNet Release 3.3 for SGI IRIX does not interoperate with AvidNet Release 3.5 for 
Windows NT.

Table A-6 AvidNet Transfer Tool Releases and Video-Editing Applications 
Compatibility

AvidNet Transfer Tool 
Release Number Supported Applications

Release 3.5 (Windows NT) Symphony Release 2.1
Media Composer Release 9.1 (Windows)
Avid Xpress Release 3.1 (Windows)

Release 3.4 (Windows NT) NewsCutter and Textronix® Profile 
PDR400 Release 1.0 Fibre Channel 
Connection

Release 3.3 (Macintosh) Media Composer Release 8.1 (Macintosh)
Avid Xpress Release 2.5 (Macintosh)

Release 3.3 (SGI IRIX) Media Illusion Release 5.0
Elastic Reality Release 3.1
Marquee Release 2.0

Release 3.2 (Macintosh) Media Composer Release 7.2 
Avid Xpress Release 2.1 (Macintosh)
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Moving from Media Composer  Release  8 .1  (Macintosh)  to  
Symphony Release 2 .1 ,  or  Media Composer  Release 9 .1  (Windows)

Using AvidNet Release 3.3 (Macintosh), you can move compositions from 
Media Composer Release 8.1 (Macintosh) to Symphony Release 2.1, or 
Media Composer Release 9.1 (Windows).

To transfer a composition from Media Composer Release 8.1 (Macintosh) to 
Symphony Release 2.1 or Media Composer Release 9.1 (Windows):

1 In Media Composer (Macintosh), activate the bin and highlight the clips you want 
to send.

2 Choose Send Selected Clips from the Bin menu. 

The Send dialog box appears.

3 Select a destination from the To list. 

The destination should be defined as Media Composer Release 8.1, even though 
you are moving to Release 9.1.

4 Click Send.

Moving from Media Composer  Release  7 .2  or  Avid Xpress  
Release 2 .1  for  Macintosh to an Edi t ing  Appl icat ion Running on 
Windows NT

Using AvidNet Release 3.1 (Macintosh), you can move compositions from 
Media Composer Release 7.1v2 or Avid Xpress Release 2.1 (Macintosh) to any 
of the Avid editing applications running on Windows NT. If you use AvidNet 
Release 3.2, you also can send audio media.
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To transfer a composition from Media Composer Release 7.2 or Avid Xpress 
Release 2.1 (Macintosh) to an editing application running on Windows NT:

1 In AvidNet, choose Send Compositions Only from the Options menu.

2 In Media Composer, activate the bin that contains the compositions you want to 

send and highlight the compositions.

3 Choose Send Selected Clips from the Bin menu. 

The Send dialog box appears.

4 Select a destination from the To list. 

The destination should be defined as Media Composer Release 7.x.

5 Click Send.

To transfer a composition and audio media from Media Composer Release 7.2 or 
Avid Xpress Release 2.1 (Macintosh), do one of the following:

• Use AvidNet Release 3.2 and follow the procedure for “Moving from 
Media Composer Release 7.2 (Macintosh) to an Editing Application 
Running on Windows NT” on page  A-16.

• Export the composition to OMF, using the procedure in “Moving 
Sequences with Audio Media from Media Composer Release 7.2 for 
Macintosh” on page  2-63.

Moving from Media Composer  Release  7 .2  (Macintosh)  to  an 
Edi t ing Appl icat ion Running on Windows NT

Using AvidNet Release 3.2 (Macintosh), you can move compositions and 
audio media from Media Composer Release 7.2 (Macintosh) to an editing 
application running on Windows NT.
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To transfer a composition from Media Composer Release 7. 2 (Macintosh) to an 
editing application running on Windows NT:

1 In Media Composer, activate the bin that contains the compositions you want to 
send and highlight the compositions.

2 Choose Send Selected Clips from the Bin menu. 

The Send dialog box appears.

3 Select a destination from the To list. 

The destination should be defined as Media Composer Release 8.0.

4 Select No Media.

5 Click Send.

To transfer a composition and audio media from Media Composer Release 7. 2 
(Macintosh) to an editing application running on Windows NT using AvidNet 
Release 3.2:

1 In Media Composer, activate the bin that contains the compositions you want to 

send and highlight the compositions.

2 Choose Send Selected Clips from the Bin menu. 

The Send dialog box appears.

3 Select a destination from the To list. 

The destination should be defined as Media Composer Release 8.0.

4 Select Audio Only.

5 Click Send.
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Moving Bins f rom Media  Composer (Macintosh)  to an  Edi t ing  
Appl icat ion Running on Windows NT

To transfer a bin from Media Composer (Macintosh) to an editing application 
running on Windows NT:

1 In AvidNet, choose Select and Send File from the File menu.

The File Selection dialog box appears.

2 Locate and highlight the bin you want to transfer, and click Add All.

The files move to the right column.

3 To delete files from the local system after they have been transferred, select the 
“Delete file after send” option. Do not mark open files or applications for deletion.

4 Click Done.

The Send dialog box appears.

5 Select a destination from the To list.

6 Click Send.

Alternatively, to transfer a bin from Media Composer (Macintosh) to an 
editing application running on Windows NT, do one of the following:

• Use AvidNet Release 3.1 and follow the procedure for “Moving from 
Media Composer Release 7.2 or Avid Xpress Release 2.1 for Macintosh to 
an Editing Application Running on Windows NT” on page  A-15.

• Use AvidNet Release 3.2 and follow the procedure for “Moving from 
Media Composer Release 7.2 (Macintosh) to an Editing Application 
Running on Windows NT” on page  A-16.
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Moving from Symphony Release 2.1 ,  or  Media Composer  Release  
9 .1  (Windows)  to  Media Composer  Release 7 .2  or  8 .1  (Macintosh)

n In Symphony Release 2.1 or Media Composer Release 9.1 (Windows NT), the 
automatic importing of compositions into a project requires specific selections in the 
AvidNet Release 3.5 Settings window. Click the Enable Notification check box and 
select Prompt or Automatic.

To transfer a composition from Symphony Release 2.1 or Media Composer 
Release 9.1 (Windows) to Media Composer Release 7.2 or 8.1 (Macintosh):

1 In Symphony, Media Composer, or Film Composer, activate the bin that contains 
the compositions you want to send to Media Composer.

2 Select the compositions you want to transfer.

3 Choose Send Selected Clips from the Bin menu. Do not use Send Consolidated 

from the Send menu if you are transferring to a Macintosh based Avid editing 
system.

The New Transfer dialog box appears.

4 Choose or add a destination in the Destination pop-up menu.

5 Choose the priority of the transfer.

6 Choose Without Media from the Transfer Type menu to send compositions only, or 
Full to also send media. (Video from your Avid editing system for Windows NT will 
not work on Media Composer Release 7.2.)

7 Click OK.
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To transfer a bin from Symphony Release 2.1 or Media Composer Release 9.1 
(Windows) to Media Composer Release 8.1 (Macintosh):

1 In Symphony, Media Composer, or Film Composer choose File from the Send 
menu.

The Select File dialog box appears.

2 Select the bin you want to send, and click OK.

The New Transfer dialog box appears.

3 Choose or add a destination in the Destination pop-up menu.

4 Choose the priority of the transfer.

5 Choose As Bin File from the Transfer Type menu.

6 Click OK.

To transfer a bin from Symphony Release 2.1 or Media Composer Release 9.1 
(Windows) to Media Composer Release 7.2 (Macintosh): 

n This procedure gives you a new bin with the same contents as the original bin because 
the bins are not compatible across operating systems.

1 In Symphony, Media Composer, or Film Composer activate the bin that you want 
to send to Media Composer.

2 Select all the clips in the bin.

3 Choose Send Selected Clips from the Bin menu. Do not use Send Consolidated 
from the Send menu if you are transferring to a Avid editing system for Macintosh.

The New Transfer dialog box appears.

4 Choose or add a destination in the Destination pop-up menu.

5 Choose the priority of the transfer.

6 Choose Without Media from the Transfer Type menu.

7 Click OK.
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Using the AvidNet  Transfer  Tool  in  Standalone Mode

You can use the AvidNet Transfer Tool (Windows NT or Macintosh) as a 
standalone application by running it from the desktop or by accessing it 
directly when it is running with an Avid application. In standalone mode, you 
can use it to transfer any files between systems. 

U s i n g  t h e  A v i d N e t  T r a n s f e r  T o o l  f o r  
W i n d o w s N T

In standalone mode, you can send files in two ways:

• Selecting and sending files — Clicking the New button opens a File 
Selection dialog box, which allows you to browse your system’s disks and 
select files to transfer.

• Dropping files or directories — This method allows you to drop files or 
directories into the Main window or the File Selection dialog box, and 
then transfer them.
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U s i n g  t h e  A v i d N e t  T r a n s f e r  T o o l  f o r  M a c i n t o s h

To select and send files in standalone mode:

1 In AvidNet, choose Select and Send File from the File menu. 

The File Selection dialog box appears.

2 Locate and highlight the files you want to transfer, and click Add or Add All.

The files move to the right column.

3 To delete files from the local system after they have been transferred, select the 
“Delete file after send” option. Do not mark open files or applications for deletion.

4 Click Done.

The Send dialog box appears.

5 Select a destination from the To list.

6 Click Send.
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If you are using Media Composer Release 7.2 or 8.1 (Macintosh) or 
Avid Xpress Release 2.5 (Macintosh), you can use Avid Unity MediaNet for 
shared storage. If you want to move projects between systems, you can use 
the shared drives to move the projects. To make sure your projects are 
compatible before you attempt to move them, see Chapter 1. For more 
information on using Avid Unity MediaNet, see the Avid Unity MediaNet for 
Macintosh Clients Quick Start Card.
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T r a n s f e r r i n g  F i l e s  w i t h  O p e n  M e d i a  
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Open Media Management™ (OMM™) is a collaborative effort between Avid 
and leading asset management companies. OMM allows you to exchange 
video and audio clips with an asset management application. You can move 
projects between systems that use the same asset management application.

For more information about using OMM, see the Avid Symphony Input and 
Output Guide, the Avid Media Composer and Film Composer Input and Output 
Guide, or the Avid Xpress User’s Guide. 

If you are using the Avid Unity TransferManager asset management 
application, see the Avid Unity MediaManager User’s Guide and the Avid Unity 
MediaManager Administration Guide for additional information. 



. .
 . 

. .

Collaboration Guide A-25

TR A N S F E R R I N G  F I L E S  A C R O S S  A  N E T W O R K

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .T r a n s f e r r i n g  F i l e s  A c r o s s  a  N e t w o r k

n This section describes the process of transferring project and user files across a 
network. For information on accessing media files over a network or from a removable 
storage device, see “Nonshared Storage Issues for Cross-Platform Collaboration” on 
page  A-27.

Ethernet networks usually require a hub and host adapters to provide 
connections for all systems. If you want to connect only two systems, 
however, a crossover cable is sufficient to provide network connection. 

To connect a Windows or Macintosh system to another system, you will have 
to plug the RJ-45 connector into the system board because of slot limitations. 
To connect three or more systems, you must make direct connections between 
the individual systems and the hub with standard Category 5 twisted-pair 
cables with modular RJ-45 connectors. 

If you require simultaneous transfers, an Ethernet switch will allow 
simultaneous transfers at the full-rated bandwidth. A hub requires the 
bandwidth to be shared.

Using a Network Server  or  Disk to  Transfer  F i les

To transfer a project, using a network server or disk:

1 On the system from which you are moving files, select the project folder or user 

folder you want to copy. It is a good idea to move a copy of the source project and 
back up the original so that you will always have access to the original.

On the Macintosh:

- Project folders are located in the Composer Projects folder at the top level of 

the Avid drive.

- User folders are located in the Avid Users folder, which is located in the 

Project folder.
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On Windows:

- Project folders are located in the Avid Projects folder on your internal drive.

- User folders are located in the Avid Users folder, which is located in the 
Project folder.

You do not need to copy the Statistics folder, which is located in the Project folder. 
This folder can be large and is not used by Symphony, Media Composer, 
Film Composer, or Avid Xpress.

2 Copy the files to an appropriately formatted disk or a location on a server.

3 On the system to which you are transferring, copy the Project folder to the Avid 
Projects folder. Then copy the User Settings folder to the Avid Users folder.

Ignore any Resource folders or files that appear.

n The location of the Avid Projects and Avid Users folders can vary, depending on how 
the application was installed on your system.

The next time you open the Open Project dialog box, the new project will 
appear in the Projects scroll list. New user settings will appear in the Users 
scroll list. 
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You can share video and audio media files across platforms, using the 
following Avid video-editing applications:

• Symphony Release 2.1 or 3.x

• Media Composer Release 9.1 or 10.x

• Film Composer Release 10.x

• Avid Xpress Release 2.5 (Macintosh)

• Avid Xpress Release 3.1 or 4.x (Windows)

You can share media files directly in a shared storage environment, such as an 
Avid Unity workgroup. However, when you attempt to share media files by 
using a nonshared storage device — either peer-to-peer, over a network, or 
using removable storage — the following restrictions apply:

• Nonstriped HFS-formatted drives on the Macintosh system can only be 
read on a Windows system by using a utility such as the MacDrive 
CrossStripe Edition for Avid Systems from Mediafour Corporation 
(www.mediafour.com) or MacOpener 2000 available from DataViz 
(www.dataviz.com).

n MacOpener is not supported on Symphony Release 3.x, Media Composer 
Release 10.x, Film Composer Release 10.x, or Avid Xpress Release 4.x. Use the 
MacDrive CrossStripe Edition for Avid Systems.

• In general, striped HFS-formatted volumes on the Macintosh system 
cannot be read on a Windows system. You can, however, use the 
MacDrive CrossStripe Edition for Avid Systems to access striped 
HFS-formatted volumes on a Windows system.

• NTFS-formatted drives on the Windows system cannot be read on a 
Macintosh system.

http://www.mediafour.com
http://www.dataviz.com
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For successful sharing of media files in a cross-platform, nonshared storage 
environment, Avid recommends that you use the MacDrive CrossStripe 
Edition for Avid Systems to access striped and nonstriped HFS volumes on a 
Windows system. Some restrictions apply. See the release notes for your Avid 
product.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .I n t r o d u c t i o n

Symphony Release 3.x, Media Composer and Film Composer Release 10.x 
(Windows and Macintosh), and Avid Xpress Release 4.x (Windows and 
Macintosh) include a set of options called AvidLinks which are available from 
the File menu. These export options allow you to perform several common 
export procedures in one step for collaborating with other Avid applications 
such as AudioVision and Avid Media Illusion. Use the AvidLink first, when 
appropriate, for the fastest possible export.

In addition, a set of customizable export templates for many common export 
settings appears in the following:

• Symphony Release 2.1 and 3.x

• Media Composer and Film Composer Release 10.x (Windows and 
Macintosh)

• Media Composer Release 9.1 (Windows)

• Media Composer Release 8.1 (Macintosh)

• Avid Xpress Release 2.5 (Macintosh)

• Avid Xpress Release 3.1 (Windows)

• Avid Xpress Release 4.x (Windows and Macintosh)

• Avid Xpress DV Release 1.0 (Windows)

The templates are listed in the Settings scroll list. When you open the Export 
dialog box, you will see a pop-up menu listing all the export templates, and 
you can choose the one you want to use. You can also customize the templates 
and create new templates.

Some templates (Elastic Reality AVI, Marquee AVI, and After Effects AVI) 
apply only to certain versions of Windows applications, and other templates 
(Pro Tools SD2 External and AudioVision SD2 External) apply only to 
Macintosh applications.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .A d o b e  A f t e r  E f f e c t s  E x p o r t  T e m p l a t e s

There are five Adobe After Effects templates: 

• Export with Source

• After Effects QuickTime

• After Effects QuickTime (Avid Xpress DV only)

• After Effects Targa

• After Effects AVI (Windows only)

The following sections describe their settings and use.

Export  wi th  Source

Available in: Symphony Release 3.x, Media Composer and Film Composer 
Release 10.x (Windows and Macintosh), Avid Xpress Release 4.x (Windows 
and Macintosh), and Avid Xpress DV Release 1.5 and 2.0 (Windows)

Settings: QuickTime-Video and Audio, Use Marks, Both Fields, Even 
Dominant, 720x486, Source Compression

For delivery to: After Effects Release 4.0 (Macintosh) or Elastic Reality 
Release 3.1 (Windows) using QuickTime 3.0 for Windows and the Avid Codec 
for AVI. The Windows system reads the QuickTime file by using the Avid 
Codec for AVI. The QuickTime file is source compressed (using the native 
Media Composer compression). Avid Codec for AVI Version 8.0 is necessary 
on the After Effects for Macintosh system.
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After  Ef fects  QuickTime

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)

Settings: QuickTime-Video and Audio, Use Marks, Both Fields, Even 
Dominant, 720x486, Source Compression

For delivery to: After Effects Release 4.0 (Macintosh) or Elastic Reality 
Release 3.1 (Windows) by using QuickTime 3.0 for Windows and the Avid 
Codec for AVI. The Windows system reads the QuickTime file by using the 
Avid Codec for AVI. The QuickTime file is source compressed (using the 
native Media Composer compression). Avid Codec for AVI Version 8.0 is 
necessary on the After Effects for the Macintosh system.

After  Ef fects  QuickTime (Avid  Xpress DV Only)

Available in: Avid Xpress DV Release 1.0 (Windows)

Settings: QuickTime Movie, Video and Audio, Use Marks, Same as Source

For delivery to: After Effects Release 4.0 (Macintosh) or After Effects 
Release 3.0 (Windows) by using QuickTime 4.0 for Windows. The QuickTime 
file is source compressed (using the native DV compression).

After  Ef fects  Targa

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)
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Settings: Graphic-Targa, Use Marks, Both Fields, Odd Dominant, 720x486, 
RGB Levels, Sequential Files

For delivery to: After Effects (Windows or Macintosh). This export option is 
an alternative to QuickTime when static files are needed, or when only a 
portion of the export will be worked on. This export is slower than 
QuickTime.

After  Ef fects  AVI  (Windows Only)

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Avid Xpress Release 3.1 (Windows), and Avid Xpress DV 
Release 1.0 (Windows)

Settings: Video and Audio, Use Marks, Both Fields, Source Compression

For delivery to: After Effects Release 4.0 (Windows). Using the native 
compression, this export option creates a source-compressed file that is 
compatible with any After Effects Release 4.0 (Windows) system by using the 
Avid Codec for AVI Version 2.0.
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There are two Adobe Photoshop templates:

• Photoshop Targa

• Photoshop Targa (Avid Xpress DV Only)

The following sections describe their settings and use.

Photoshop Targa

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)

Settings: Graphic-Targa, Use Marks, Both Fields, Odd Dominant, 720x486, 
RGB Levels

For delivery to: Photoshop Versions 3.0 to 5.0 (Macintosh or Windows). This 
export option produces a full-frame image that is compatible with Photoshop.

Photoshop Targa (Avid Xpress  DV Only)

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)

Settings: Graphic-Targa, Use Marks, Even Field, 720x480, Scale to Fit, RGB 
Levels

For delivery to: Photoshop Versions 3.0 to 5.0 (Macintosh or Windows). This 
export option produces a full-frame image that is compatible with Photoshop.
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There is one ASF/Netshow template: Microsoft ASF. The following section 
describes its settings and use.

Microsoft  ASF (Avid Xpress  DV Only)

Available in: Avid Xpress DV Release 1.0 (Windows)

Settings: Microsoft ASF, Video and Audio, Use Marks, Even Field, RGB

For delivery to: ASF/NetShow compression. The export is a two-step process, 
and most of the settings are available in the ASF/NetShow setup after the 
initial intermediate movie creation. These settings must be configured 
manually for each export.
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There is one AudioVision AvidLink: AudioVision - Embedded Audio. The 
following section describes its settings and use.

AudioVision -  Embedded Audio

Available in: Symphony Release 3.x, Media Composer and Film Composer 
Release 10.x (Windows and Macintosh), Avid Xpress Release 4.x (Windows 
and Macintosh), and Avid Xpress DV Release 1.5 and 2.0 (Windows)

Settings: OMFI Composition, Version 1.0, Use Audio Media-AIFF-C, 
AudioVision Compatibility

For use with: Sound Designer II, AIFF-C, or WAVE source files. All audio 
media is embedded in the OMFI file, resulting in one large OMFI file after 
export. All audio media will be converted to AIFF-C when embedded in the 
OMFI file.

Works best with: Source WAVE, Sound Designer II, AIFF-C, or a mix of 
formats when you want to embed separate audio media files into one large 
OMFI file. Used primarily for small Timelines or clips, or for network transfer.
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There are two AudioVision export templates:

• AudioVision SD2 External (Macintosh Only)

• AudioVision AIFF-C Embedded

The following sections describe their settings and use.

AudioVision SD2 Externa l  (Macintosh Only)

Available in: Media Composer Release 8.1 (Macintosh) and Avid Xpress 
Release 2.5 (Macintosh)

Settings: OMFI Composition, Version 1.0, Use Audio Media-SD2, 
AudioVision Compatibility

For use with: Sound Designer II, AIFF-C, or WAVE source files. All audio 
media remains separate from the OMFI file, and will not be embedded. 
AIFF-C and WAVE source audio will be copied to a separate folder called 
Exported Audio Media, and when copied, will be converted to Sound 
Designer II format audio. Sound Designer II source files already in the project 
will not be affected, and will remain in the original media directory. 

Works best with: Source AIFF-C, WAVE, Sound Designer II audio, or a mix of 
formats when you want to keep the audio separate from the OMFI file.

AudioVision AIFF-C Embedded

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)
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Settings: OMFI Composition, Version 1.0, Use Audio Media-AIFF-C, 
AudioVision Compatibility

For use with: Sound Designer II, AIFF-C, or WAVE source files. All audio 
media is embedded in the OMFI file, resulting in one large OMFI file after 
export. All audio media will be converted to AIFF-C when embedded in the 
OMFI file.

Works best with: Source WAVE, Sound Designer II, AIFF-C, or a mix of 
formats when you want to embed separate audio media files into one large 
OMFI file. Used primarily for small Timelines or clips, or for network transfer.
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There is one Commotion QuickTime template: Commotion QuickTime 
(Avid Xpress DV only). The following section describes its settings and use.

Commot ion QuickTime (Avid  Xpress DV Only)

Available in: Avid Xpress DV Release 1.0 (Windows)

Settings: QuickTime Movie, Video and Audio, Use Marks, Same as Source

For delivery to: Commotion Windows or Macintosh by using QuickTime 4.0. 
The QuickTime file is source compressed (using the native DV compression). 
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There are five Elastic Reality templates: 

• Fast Export QuickTime

• Elastic Reality OMF

• Elastic Reality QuickTime

• Elastic Reality Targa Files

• Elastic Reality AVI

The following sections describe their settings and use.

Fast  Expor t  QuickTime

Available in: Symphony Release 3.x, Media Composer and Film Composer 
Release 10.x (Windows and Macintosh) Avid Xpress Release 4.x (Windows 
and Macintosh), and Avid Xpress DV Release 1.5 and 2.0 (Windows)

Settings: QuickTime-Video and Audio, Use Marks, Both Fields, Even 
Dominant, 720x486, Source Compression

For delivery to: After Effects Release 4.0 (Macintosh) or Elastic Reality 
Release 3.1 (Windows) by using QuickTime 3.0 for Windows and the Avid 
Codec for AVI. The Windows system reads the QuickTime file by using the 
Avid Codec for AVI. The QuickTime file is source compressed (using the 
native Media Composer compression). Avid Codec for AVI Version 8.0 is 
necessary on the Macintosh system.

Elast ic  Real i ty  OMF

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
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Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)

Settings: OMFI Composition, Version 1.0, Use Video Media

For delivery to: Elastic Reality Release 3.0 (SGI IRIX), Elastic Reality 
Release 3.1 (Windows NT and Windows 95), or Elastic Reality Release 3.1 
(Macintosh) with OMFI update. For use with master clip export only, not 
sequence. This export option creates one OMFI file that is compatible for 
import to Elastic Reality. 

Elast ic  Real i ty  QuickTime

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)

Settings: QuickTime-Video Only, Use Marks, Both Fields, Even Dominant, 
720x486, Source Compression

For delivery to: Elastic Reality Release 3.1 (Macintosh) or Elastic Reality 
Release 3.1 (Windows NT and Windows 95) by using the QuickTime to OMFI 
Converter utility. This export option creates a source-compressed file (using 
the native Media Composer compression) that will be compatible with any 
Elastic Reality Release 3.1 (Macintosh) system by using the Avid Codec for 
AVI Version 8.0, or any Elastic Reality Release 3.1 (Windows NT and 
Windows 95) system with OMFI update after using the QuickTime to OMFI 
Converter utility. 

Elast ic  Real i ty  Targa  F i les

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)
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Settings: Graphic-Targa, Use Marks, Both Fields, Odd Dominant, 720x486, 
CCIR Levels, Sequential Files

For delivery to: Elastic Reality Release 3.1 (Macintosh), Elastic Reality 
Release 3.1 (Windows NT and Windows 95), or Elastic Reality Release 3.0 (SGI 
IRIX). This export option is an alternative to QuickTime and OMF, or is used 
when the Elastic Reality system does not have the latest Avid codec. This 
export is slower than OMFI or QuickTime.

Elast ic  Real i ty  AVI

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Avid Xpress Release 3.1 (Windows), and Avid Xpress DV 
Release 1.0 (Windows)

Settings: Video Only, Use Marks, Both Fields, Source Compression

For delivery to: Elastic Reality Release 3.1 (Windows). Using the native 
compression, this export option creates a source-compressed file that is 
compatible with any Elastic Reality 3.1 (Windows) system using the Avid 
Codec for AVI Version 2.0.



. .
 . 

. .

Collaboration Guide B-15

M A C I N T O S H  I M A G E  E X P O R T  TE M P L A T E S

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .M a c i n t o s h  I m a g e  E x p o r t  T e m p l a t e s

There is one Macintosh Image template: Macintosh Image. The following 
section describes its settings and use.

Macintosh Image

Available in: Symphony Release 3.x, Media Composer and Film Composer 
Release 10.x (Windows and Macintosh), Avid Xpress Release 4.x (Windows 
and Macintosh), and Avid Xpress DV Releases 1.0, 1.5, and 2.0 (Windows)

Settings: Graphic-PICT, Use Marks, Even Field, 720x486, Scale to Fit, RGB 
Levels

For delivery to: Macintosh graphic applications. An alternate format is 
TARGA.
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There are three Marquee templates: 

• Marquee OMF

• Marquee Targa Files

• Marquee AVI

The following sections describe their settings and use.

Marquee OMF

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Avid Xpress Release 3.1 (Windows), and Avid Xpress DV 
Release 1.0 (Windows)

Settings: OMFI Composition, Version 1.0, Use Video Media

For delivery to: Marquee Release 1.0.1 (Windows) and Marquee Release 1.0.1 
(SGI IRIX). For use with master clip export only, not sequence. This export 
option creates one OMFI file compatible for import to Marquee 
Release 1.0.1.

Marquee Targa F i les

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Avid Xpress Release 3.1 (Windows), and Avid Xpress DV 
Release 1.0 (Windows)

Settings: Graphic-Targa, Use Marks, Both Fields, Odd Dominant, 720x486, 
RGB Levels, Sequential Files

For delivery to: Marquee Release 1.0.1 (Windows) or Marquee Release 1.0.1 
(SGI IRIX). This export option is an alternative to OMFI when static files are 
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needed or when files must be viewed before importing. This export is slower 
than OMF.

Marquee AVI

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Avid Xpress Release 3.1 (Windows), and Avid Xpress DV 
Release 1.0 (Windows)

Settings: Video Only, Use Marks, Both Fields, Source Compression

For delivery to: Marquee Release 1.0.1 (Windows). Using the native 
compression, this export option creates a source-compressed file that is 
compatible with any Marquee Release 1.0 (Windows) system by using the 
Avid Codec for AVI Version 2.0.
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There is one Matador template: Matador SGI IRIX Files. The following section 
describes its settings and use.

Matador  SGI  IRIX F i les

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)

Settings: Graphic-SGI, Use Marks, Both Fields, Odd Dominant, 720x486, RGB 
Levels, Sequential Files

For delivery to: Matador (SGI IRIX). This export option produces a set of 
full-frame images that are compatible with Matador.
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There are two Media Illusion AvidLinks: 

• Media Illusion - Composition Only

• Media Illusion- Graphic OMF

The following sections describe their settings and use.

Media I l lus ion -  Composi t ion Only

Available in: Symphony Release 3.x, Media Composer and Film Composer 
Release 10.x (Windows and Macintosh), Avid Xpress Release 4.x (Windows 
and Macintosh), and Avid Xpress DV Releases 1.5 and 2.0 (Windows)

Settings: OMFI Composition, Version 2.0

For delivery to: Media Illusion Release 5.0v.1 with Composition Link. This 
export option produces an OMFI composition only file with no media 
embedded, for redigitizing on the Media Illusion system. 

Media I l lus ion-  Graphic  OMF

Available in: Symphony Release 3.x, Media Composer and Film Composer 
Release 10.x (Windows and Macintosh), Avid Xpress Release 4.x (Windows 
and Macintosh), and Avid Xpress DV Releases 1.5 and 2.0 (Windows)

Settings: Graphic-OMF, Use Marks, Both Fields, Odd Dominant, 720x486, 
CCIR Levels, Sequential Files

For delivery to: Media Illusion Releases 5.0 and 5.0v.1. This export option 
produces a set of sequential files with the proper size, format, and color space 
to show correctly in the Media Illusion system. 
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There are two Media Illusion templates: 

• Illusion OMFI

• Illusion SGI IRIX Files

The following sections describe their settings and use.

I l lus ion OMFI

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)

Settings: OMFI Composition, Version 2.0

For delivery to: Media Illusion Release 5.0v.1 with Composition Link. This 
export option produces an OMFI composition only file with no media 
embedded, for redigitizing in the Media Illusion system. 

I l lus ion SGI  IRIX Fi les

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)

Settings: Graphic-Targa, Use Marks, Both Fields, Odd Dominant, 720x486, 
CCIR Levels, Sequential Files

For delivery to: Media Illusion Releases 5.0 and 5.0v.1. This export option 
produces a set of sequential files with the proper size, format, and color space 
to show correctly in the Media Illusion system. 
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There is one Pro Tools AvidLink: Digidesign Pro Tools. The following section 
describes its settings and use.

Digidesign Pro  Tools

Available in: Symphony Release 3.x, Media Composer and Film Composer 
Release 10.x (Windows and Macintosh), Avid Xpress Release 4.x (Windows 
and Macintosh), and Avid Xpress DV Releases 1.5 and 2.0 (Windows)

Settings: OMFI Composition, Version 2.0, Use Audio Media-AIFF-C

For use with: Sound Designer II, AIFF-C, or WAVE source files for Pro Tools 
Releases 4.1 to 5.1 (Macintosh). All audio media is embedded in the OMFI file, 
resulting in one large OMFI file after export. All audio media will be 
converted to AIFF-C when embedded in the OMFI file. 

Works best with: Source WAVE, Sound Designer II, AIFF-C, or a mix of 
formats when you want to embed separate audio media files into one large 
OMFI file. Used primarily for small Timelines or clips, or for network transfer.
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There are four Pro Tools templates: 

• Pro Tools AIFF-C External

• Pro Tools SD2 External (Macintosh Only)

• Pro Tools AIFF-C Embedded

• Pro Tools Audio (Avid Xpress DV Only)

The following sections describe their settings and use.

Pro Tools  AIFF-C Externa l

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)

Settings: OMFI Composition, Version 2.0

For use with: Source files for Pro Tools Releases 4.1 to 5.1 (Macintosh). The 
audio media remains separate from the OMFI file, and will not be embedded, 
converted, or copied. All media stays in the original media directory, and 
links are added to the OMFI file to locate the files once conversion to Session 
has been done in the OMFI Tool. This method cannot be used with source 
WAVE audio.

Works best with:

• (Macintosh only) Source Sound Designer II audio when you want to keep 
audio separate from the OMFI file

• Source AIFF-C audio being delivered to a Pro Tools Releases 4.3 to 5.1 
systems when you want to keep audio separate from the OMFI file
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Pro Tools  SD2 Externa l  (Macintosh Only)

Available in: Media Composer Release 8.1 (Macintosh) and Avid Xpress 
Release 2.5 (Macintosh)

Settings: OMFI Composition, Version 2.0, Use Audio Media-SD2

For use with: Sound Designer II, AIFF-C, or WAVE source files for Pro Tools 
Releases 4.1 to 5.1 (Macintosh). All audio media remains separate from the 
OMFI file, and will not be embedded. AIFF-C and WAVE source audio is 
copied to a separate folder called Exported Audio Media, and when copied 
will be converted to Sound Designer II format audio. Sound Designer II 
source files already in the project will not be affected, and will remain in the 
original media directory. 

Works best with:

• Source WAVE audio when you want to keep audio separate from the 
OMFI file

• Source AIFF-C audio being delivered to a Pro Tools Release 4.1 to 5.1 
system when you want to keep audio separate from the OMFI file.

• A mix of source WAVE and AIFF-C or Sound Designer II audio when you 
want to keep audio separate from the OMFI file

Pro Tools  AIFF-C Embedded

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)

Settings: OMFI Composition, Version 2.0, Use Audio Media-AIFF-C

For use with: Sound Designer II, AIFF-C, or WAVE source files for Pro Tools 
Releases 4.1 to 5.1 (Macintosh). All audio media is embedded in the OMFI file, 
resulting in one large OMFI file after export. All audio media will be 
converted to AIFF-C when embedded in the OMFI file. 
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Works best with: Source WAVE, Sound Designer II, AIFF-C, or a mix of 
formats when you want to embed separate audio media files into one large 
OMFI file. Used primarily for small Timelines or clips, or for network transfer.

Pro Tools  Audio  (Avid  Xpress  DV Only)

Available in: Avid Xpress DV Release 1.0 (Windows)

Settings: OMFI, OMFI Version 2.0, Embed Audio Media, AIFF-C

For use with: AIFF-C or WAVE source files for Pro Tools Releases 4.1 to 5.1. 
All audio media is embedded in the OMFI file, resulting in one large OMFI 
file after export. All audio media is converted to AIFF-C when embedded in 
the OMFI file.
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There are two QuickTime Sorenson templates: 

• QuickTime Sorenson (Avid Xpress DV Only)

• QuickTime Sorenson Streaming (Avid Xpress DV Only)

The following sections describe their settings and use.

QuickTime Sorenson (Avid  Xpress DV Only)

Available in: Avid Xpress DV Release 1.0 (Windows)

Settings: QuickTime Movie, Use Marks, Video and Audio, 160 x 120 Pixels, 
Even Field, RGB Levels Quality Low, Frame Rate 15 fps, QDesign Music at 
22 kHz, 16-bit Mono

Used to: Produce excellent Web video suitable for playback on any Pentium® 
or Power Mac™ system. Sorenson Video™ achieves higher image quality at a 
fraction of the data rate of many other codecs. This codec requires a fast 
computer for playback.

QuickTime Sorenson Streaming (Avid Xpress  DV Only)

Available in: Avid Xpress DV Release 1.0 (Windows)

Settings: QuickTime Movie, Use Marks, Video and Audio, 160 x 120 Pixels, 
Even Field, RGB Levels Quality Low, Frame Rate 15 fps, QDesign Music at 
22 kHz, 16-bit Mono, Hinted Streaming

Used to: Produce excellent Web video suitable for playback on any Pentium 
or Power Mac system. In addition, Apple QuickTime servers allow this file 
type to stream in real time to the end user. Sorenson Video achieves higher 
image quality at a fraction of the data rate of many other codecs. This codec 
requires a fast computer for playback.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .R e a l M e d i a  G 2  E x p o r t  T e m p l a t e

There is one RealMedia™ G2 template: RealMedia G2. The following section 
describes its settings and use.

RealMedia  G2 (Avid  Xpress DV Only)

Available in: Avid Xpress DV Release 1.0 (Windows)

Settings: RealMedia G2, Use Marks, Video and Audio, Even Field, RGB 
Levels

For delivery to: RealMedia G2 compression. The export is a two-step process, 
and most of the settings are available in the RealMedia setup after the initial 
intermediate movie creation. These settings must be configured manually for 
each export.
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There is one Softimage|DS AvidLink: Softimage|DS (composition). The 
following section describes its settings and use.

Sof t image|DS (composit ion)

Available in: Symphony Release 3.x, Media Composer and Film Composer 
Release 10.x (Windows and Macintosh), Avid Xpress Release 4.x (Windows 
and Macintosh), and Avid Xpress DV Releases 1.5 and 2.0 (Windows)

Settings: OMFI Composition, Version 2.0

For delivery to: Softimage|DS Release 2.1, SoftImage|DS Release 3.0.1, and 
Avid|DS Release 4.0 (Windows). This export option creates an OMFI 
composition only file with no media embedded, for redigitizing on the 
Softimage|DS or Avid|DS system. 
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There is one Softimage|DS template: Softimage|DS OMF. The following 
section describes its settings and use.

Soft image|DS OMF

Available in: Symphony Release 2.1, Media Composer Release 9.1 
(Windows), Media Composer Release 8.1 (Macintosh), Avid Xpress 
Release 3.1 (Windows), Avid Xpress Release 2.5 (Macintosh), and 
Avid Xpress DV Release 1.0 (Windows)

Settings: OMFI Composition, Version 2.0

For delivery to: Softimage|DS Release 2.1 (Windows). This export option 
creates an OMFI composition only file with no media embedded, for 
redigitizing on the Softimage|DS system. 
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There is one Windows Image template: Windows Image. The following 
section describes its settings and use.

Windows Image

Available in: Symphony Release 3.x, Media Composer and Film Composer 
Release 10.x (Windows and Macintosh), Avid Xpress Release 4.x (Windows 
and Macintosh), and Avid Xpress DV Releases 1.5 and 2.0 (Windows)

Settings: Graphic-BMP, Use Marks, Even Field, 720x486, Scale to Fit, RGB 
Levels

For delivery to: Windows graphic applications. An alternate format is 
TARGA.
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25-fps Film project compatibility with

Media Composer 10.x Macintosh 1-39
Media Composer 10.x Windows 1-24
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Avid Xpress 2.1 Macintosh 1-125
Avid Xpress 2.5 Macintosh 1-110
Avid Xpress 3.1 or 4.x Windows 1-81
Avid Xpress 4.x Macintosh 1-95
Avid Xpress DV 1.0 1-145
Avid Xpress DV 1.5 or 2.0 1-135
Media Composer 7.2 Macintosh 1-69
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Media Composer 9.1 Windows 1-23
NewsCutter 1.x or 2.x 1-163
NewsCutter DV 1.1 1-163
NewsCutter XP 1.5 or 2.0 1-154
Symphony Release 2.1 1-7

A
Adobe After Effects export templates B-3
Adobe Photoshop export templates B-6
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ASF/Netshow export template B-7
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Avid Xpress 2.1 Macintosh 2-110
Avid Xpress 2.5 Macintosh 2-101
Avid Xpress 3.1 Windows 2-93
Avid Xpress 4.x Macintosh 2-83

Avid Xpress 4.x Windows 2-73
Avid Xpress DV 1.0, 1.5, or 2.0 Windows

2-120
Film Composer 10.x Windows 2-25
Media Composer 10.x Macintosh 2-34
Media Composer 10.x Windows 2-25
Media Composer 7.2 2-63
Media Composer 8.1 Macintosh 2-52
Media Composer 9.1 Windows 2-43
Symphony 2.1 2-16
Symphony 3.x 2-7

Audio formats
defined 2-3
supported 2-4

Audio sample rates 2-3
AudioVision

AvidLink B-8
export templates B-9
exporting audio from 2-125
supported audio formats 2-5

Automation gain and clip gain compatibility 
with

Avid Xpress 2.1 Macintosh 1-123
Avid Xpress 2.5 Macintosh 1-108
Avid Xpress 3.1 or 4.x Windows 1-80
Media Composer 7.2 Macintosh 1-70
Media Composer 8.1 Macintosh 1-54
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NewsCutter XP 1.5 or 2.0 1-154
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Symphony Release 2.1 1-8
Avid Unity MediaNet, transferring files with

A-23
Avid Unity TransferManager, transferring files 

with A-12
Avid Xpress 2.1 Macintosh

audio compatibility with 2-110
video compatibility with 1-123

Avid Xpress 2.5 Macintosh
audio compatibility with 2-101
exporting from, to Elastic Reality 

Macintosh 3-40
exporting from, to Elastic Reality SGI 

IRIX 3-37
exporting from, to Elastic Reality 

Windows 3-33
exporting from, to Marquee SGI IRIX 3-50
exporting from, to Marquee Windows 3-45
exporting from, to Matador 3-29
exporting from, to Media Illusion 3-25
turning off DSK 1-121
video compatibility with 1-110

Avid Xpress 2.5 or 4.x Macintosh
importing graphics and effects files into

3-20
Avid Xpress 3.0 Windows

importing graphics and effects files into
3-18

Avid Xpress 3.1 or 4.x
video compatibility with 1-79

Avid Xpress 3.1 or 4.x Windows
turning off DSK 1-92

Avid Xpress 3.1 Windows
audio compatibility with 2-93
exporting from, to Elastic Reality 

Macintosh 3-39
exporting from, to Elastic Reality SGI 

IRIX 3-36
exporting from, to Elastic Reality 

Windows 3-32
exporting from, to Marquee SGI IRIX 3-49

exporting from, to Marquee Windows 3-44
exporting from, to Matador 3-28
exporting from, to Media Illusion 3-23

Avid Xpress 4.x Macintosh
audio compatibility with 2-83
turning off DSK 1-106
video compatibility with 1-94

Avid Xpress 4.x Windows
audio compatibility with 2-73
exporting from, to Elastic Reality 

Macintosh 3-38
exporting from, to Elastic Reality SGI 

IRIX 3-35
exporting from, to Elastic Reality 

Windows 3-30
exporting from, to Marquee SGI IRIX 3-47
exporting from, to Marquee Windows 3-42
exporting from, to Matador 3-27
exporting from, to Media Illusion 3-22
importing graphics and effects files into

3-18
Avid Xpress DV 1.0 Windows

video compatibility with 1-144
Avid Xpress DV 1.0, 1.5, or 2.0 Windows

audio compatibility with 2-120
Crop option 3-54
exporting audio files 2-121
Pad option 3-52

Avid Xpress DV 1.5 or 2.0 Windows
video compatibility with 1-134

Avid|DS
AvidLink B-27
video compatibility with 1-171

AvidLinks
AudioVision B-8
Avid|DS B-27
Media Illusion B-19
Pro Tools B-21
Softimage|DS B-27

AvidNet Transfer Tool, transferring files 
with A-13 to A-20
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C
Clip gain and automation gain compatibility 

with
Avid Xpress 2.1 Macintosh 1-123
Avid Xpress 2.5 Macintosh 1-108
Avid Xpress 3.1 or 4.x Windows 1-80
Media Composer 7.2 Macintosh 1-70
Media Composer 8.1 Macintosh 1-54
Media Composer 9.1 or 10.x 1-23
NewsCutter 1.x or 2.x 1-163
NewsCutter DV 1.1 1-163
NewsCutter XP 1.5 or 2.0 1-154
Symphony Release 2.1 1-8

Color correction compatibility with
Avid Xpress 2.1 Macintosh 1-124
Avid Xpress 2.5 Macintosh 1-109
Avid Xpress 3.1 or 4.x Windows 1-80
Avid Xpress 4.x Macintosh 1-94
Avid Xpress DV 1.0 1-145
Avid Xpress DV 1.5 or 2.0 1-135
Media Composer 10.x Macintosh 1-38
Media Composer 7.2 Macintosh 1-68
Media Composer 8.1 Macintosh 1-53
Media Composer 9.1 or 10.x 1-23
NewsCutter 1.x or 2.x 1-162
NewsCutter DV 1.1 1-162
NewsCutter XP 1.5 or 2.0 1-154
Symphony Release 2.1 1-6

Compatibility
of audio formats with

Avid Xpress 2.1 Macintosh 2-110
Avid Xpress 2.5 Macintosh 2-101
Avid Xpress 3.1 Windows 2-93
Avid Xpress 4.x Macintosh 2-83
Avid Xpress 4.x Windows 2-73
Avid Xpress DV 1.0, 1.5, or

2.0 Windows 2-120
Film Composer 10.x Windows 2-25
Media Composer 10.x Macintosh 2-34
Media Composer 10.x Windows 2-25
Media Composer 7.2 2-63

Media Composer 8.1 Macintosh 2-52
Media Composer 9.1 Windows 2-43
Symphony 2.1 2-16
Symphony 3.x 2-7

of video formats with
Avid Xpress 2.5 Macintosh 1-110
Avid Xpress 3.1 or 4.x 1-79
Avid Xpress 4.x Macintosh 1-94
Avid Xpress DV 1.0 Windows 1-144
Avid Xpress DV 1.5 or 2.0 Windows

1-134
Avid|DS 4.0 1-171
Film Composer 10.x Windows 1-22
Media Composer 10.x Macintosh 1-38
Media Composer 7.2 1-68
Media Composer 8.1 Macintosh 1-53
Media Composer 9.1 or 10.x

Windows 1-22
NewsCutter 1.x or 2.x 1-164
NewsCutter DV 1.1 1-164
Softimage|DS 3.0.1 1-171
Symphony 2.1 or 3.x 1-6

Compositions, about 1-3

D
Defocus parameter compatibility with

Avid Xpress 2.1 Macintosh 1-125
Avid Xpress 2.5 Macintosh 1-110
Avid Xpress 3.1 or 4.x Windows 1-81
Avid Xpress DV 1.0 1-145
Avid Xpress DV 1.5 or 2.0 1-134
Media Composer 7.2 Macintosh 1-69
Media Composer 8.1 Macintosh 1-54
Media Composer 9.1 and 10.x Windows

1-22
NewsCutter 1.x or 2.x 1-163
NewsCutter DV 1.1 1-163
NewsCutter XP 1.5 or 2.0 1-153
Symphony Release 2.1 1-7
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DSK, turning off
moving to Avid Xpress 2.5 Macintosh 1-121
moving to Avid Xpress 3.1 or 4.x 

Windows 1-92
moving to Avid Xpress 4.x Macintosh 1-106
moving to Film Composer 10.x Windows

1-36
moving to Media Composer 10.x 

Macintosh 1-51
moving to Media Composer 8.1 

Macintosh 1-66
moving to Media Composer 9.1 or 10.x 

Windows 1-36
moving to Symphony 2.1 or 3.x 1-20

E
Elastic Reality export templates B-12
Elastic Reality Macintosh

exporting from 3-10
exporting from Avid Xpress 2.5 Macintosh 

to 3-40
exporting from Avid Xpress 3.1 Windows 

to 3-39
exporting from Avid Xpress 4.x Windows 

to 3-38
exporting from Film Composer 10.x 

Windows to 3-38
exporting from Media Composer 10.x 

Windows to 3-38
exporting from Media Composer 8.1 

Macintosh to 3-40
exporting from Media Composer 9.1 

Windows to 3-39
exporting from Symphony 2.1 to 3-39
exporting from Symphony 3.x to 3-38

Elastic Reality SGI IRIX
exporting from 3-9
exporting from Avid Xpress 2.5 Macintosh 

to 3-37
exporting from Avid Xpress 3.1 Windows 

to 3-36
exporting from Avid Xpress 4.x Windows 

to 3-35
exporting from Film Composer 10.x 

Windows to 3-35
exporting from Media Composer 10.x 

Windows to 3-35
exporting from Media Composer 8.1 

Macintosh to 3-37
exporting from Media Composer 9.1 

Windows to 3-36
exporting from Symphony 2.1 Windows 

to 3-36
exporting from Symphony 3.x Windows 

to 3-35
Elastic Reality Windows

exporting from 3-7
exporting from Avid Xpress 2.5 Macintosh 

to 3-33
exporting from Avid Xpress 3.1 Windows 

to 3-32
exporting from Avid Xpress 4.x Windows 

to 3-30
exporting from Film Composer 10.x 

Windows to 3-30
exporting from Media Composer 10.x 

Windows to 3-30
exporting from Media Composer 8.1 

Macintosh to 3-33
exporting from Media Composer 9.1 

Windows to 3-32
exporting from Symphony 2.1 to 3-32
exporting from Symphony 3.x to 3-30

Export templates
Adobe After Effects B-3
Adobe Photoshop B-6
AudioVision B-9
Commotion QuickTime B-11
Elastic Reality B-12
Macintosh Image B-15, B-29
Marquee B-16
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Matador B-18
Media Illusion B-20
Microsoft ASF B-7
Pro Tools B-22
QuickTime Sorenson B-25
RealMedia G2 B-26
Softimage|DS B-28

Exporting audio files from
AudioVision 2-125
Avid Xpress DV 1.0, 1.5, or 2.0 Windows

2-121
Pro Tools 2-125

Exporting from
Avid Xpress 2.5 Macintosh to Elastic Reality 

Macintosh 3-40
Avid Xpress 2.5 Macintosh to Elastic Reality 

SGI IRIX 3-37
Avid Xpress 2.5 Macintosh to Elastic Reality 

Windows 3-33
Avid Xpress 2.5 Macintosh to Marquee SGI 

IRIX 3-50
Avid Xpress 2.5 Macintosh to Marquee 

Windows 3-45
Avid Xpress 2.5 Macintosh to Matador 3-29
Avid Xpress 2.5 Macintosh to 

Media Illusion 3-25
Avid Xpress 3.1 Windows to Elastic Reality 

Macintosh 3-39
Avid Xpress 3.1 Windows to Elastic Reality 

SGI IRIX 3-36
Avid Xpress 3.1 Windows to Elastic Reality 

Windows 3-32
Avid Xpress 3.1 Windows to Marquee SGI 

IRIX 3-49
Avid Xpress 3.1 Windows to Marquee 

Windows 3-44
Avid Xpress 3.1 Windows to Matador 3-28
Avid Xpress 3.1 Windows to 

Media Illusion 3-23
Avid Xpress 4.x Windows to Elastic Reality 

Macintosh 3-38

Avid Xpress 4.x Windows to Elastic Reality 
SGI IRIX 3-35

Avid Xpress 4.x Windows to Elastic Reality 
Windows 3-30

Avid Xpress 4.x Windows to Marquee SGI 
IRIX 3-47

Avid Xpress 4.x Windows to Marquee 
Windows 3-42

Avid Xpress 4.x Windows to Matador 3-27
Avid Xpress 4.x Windows to 

Media Illusion 3-22
Avid Xpress DV 1.0, 1.5, or 2.0 Windows

3-52
Elastic Reality Macintosh 3-10
Elastic Reality SGI IRIX 3-9
Elastic Reality Windows 3-7
Film Composer 10.x Windows to 

Elastic Reality Macintosh 3-38
Film Composer 10.x Windows to 

Elastic Reality SGI IRIX 3-35
Film Composer 10.x Windows to 

Elastic Reality Windows 3-30
Film Composer 10.x Windows to Marquee 

SGI IRIX 3-47
Film Composer 10.x Windows to Marquee 

Windows 3-42
Film Composer 10.x Windows to 

Matador 3-27
Film Composer 10.x Windows to 

Media Illusion 3-22
Marquee SGI IRIX 3-15
Marquee Windows 3-11
Matador 3-6
Media Composer 10.x Windows to 

Elastic Reality Macintosh 3-38
Media Composer 10.x Windows to 

Elastic Reality SGI IRIX 3-35
Media Composer 10.x Windows to 

Elastic Reality Windows 3-30
Media Composer 10.x Windows to Marquee 

SGI IRIX 3-47
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Media Composer 10.x Windows to Marquee 
Windows 3-42

Media Composer 10.x Windows to 
Matador 3-27

Media Composer 10.x Windows to 
Media Illusion 3-22

Media Composer 8.1 Macintosh to 
Elastic Reality Macintosh 3-40

Media Composer 8.1 Macintosh to 
Elastic Reality SGI IRIX 3-37

Media Composer 8.1 Macintosh to 
Elastic Reality Windows 3-33

Media Composer 8.1 Macintosh to Marquee 
SGI IRIX 3-50

Media Composer 8.1 Macintosh to Marquee 
Windows 3-45

Media Composer 8.1 Macintosh to 
Matador 3-29

Media Composer 8.1 Macintosh to 
Media Illusion 3-25

Media Composer 9.1 Windows to 
Elastic Reality Macintosh 3-39

Media Composer 9.1 Windows to 
Elastic Reality SGI IRIX 3-36

Media Composer 9.1 Windows to 
Elastic Reality Windows 3-32

Media Composer 9.1 Windows to Marquee 
SGI IRIX 3-49

Media Composer 9.1 Windows to Marquee 
Windows 3-44

Media Composer 9.1 Windows to 
Matador 3-28

Media Composer 9.1 Windows to 
Media Illusion 3-23, 3-24

Media Illusion 3-5
Symphony 2.1 to Elastic Reality 

Macintosh 3-39
Symphony 2.1 to Elastic Reality SGI IRIX

3-36
Symphony 2.1 to Elastic Reality Windows

3-32

Symphony 2.1 to Marquee SGI IRIX 3-49
Symphony 2.1 to Marquee Windows 3-44
Symphony 2.1 to Matador 3-28
Symphony 2.1 to Media Illusion 3-23
Symphony 3.x to Elastic Reality 

Macintosh 3-38
Symphony 3.x to Elastic Reality SGI IRIX

3-35
Symphony 3.x to Elastic Reality 

Windows 3-30
Symphony 3.x to Marquee SGI IRIX 3-47
Symphony 3.x to Marquee Windows 3-42
Symphony 3.x to Matador 3-27
Symphony to Media Illusion 3-22

F
File names

guidelines for 3-4, A-2
Windows restrictions for 3-4

File transfers
across a network A-25
between Macintosh and SGI IRIX A-10
between Macintosh and Windows A-7
between SGI IRIX and Windows A-11
Macintosh to Macintosh A-4
using Avid Unity MediaNet A-23
using Avid Unity TransferManager A-12
using AvidNet A-13 to A-20
using OMM A-24
Windows to Windows A-6

Files
guidelines for moving 1-4

Film Composer 10.x Windows
audio compatibility with 2-25
exporting from, to Elastic Reality 

Macintosh 3-38
exporting from, to Elastic Reality SGI 

IRIX 3-35
exporting from, to Elastic Reality 

Windows 3-30
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exporting from, to Marquee SGI IRIX 3-47
exporting from, to Marquee Windows 3-42
exporting from, to Matador 3-27
exporting from, to Media Illusion 3-22
turning off DSK 1-36
video compatibility with 1-22

film project PAL method 1 compatibility with
Media Composer 10.x Macintosh 1-39
Media Composer 9.1 or 10.x 1-24
Symphony Release 2.1 or 3.x 1-8

Fonts
guidelines for A-3
replacing title fonts 1-19

G
Graphics and effects applications

about 3-3
Guidelines for

file names A-2
fonts A-3
moving files 1-4

I
Importing graphics and effects files into

Avid Xpress 2.5 or 4.x Macintosh 3-20
Avid Xpress 3.1 or 4.x Windows 3-18
Avid Xpress DV 1.0, 1.5, or 2.0 Windows

3-54
Media Composer 8.1 or 10.x Macintosh 3-20
Media Composer 9.1, or 10.x Windows 3-18
Symphony 2.1 or 3.x 3-18

M
Macintosh Image export template B-15, B-29
Macintosh to Macintosh file transfers A-4
Macintosh to SGI IRIX file transfers A-10
Macintosh to Windows file transfers A-7
Marquee export templates B-16

Marquee SGI IRIX
exporting from 3-15
exporting from Avid Xpress 2.5 Macintosh 

to 3-50
exporting from Avid Xpress 3.1 Windows 

to 3-49
exporting from Avid Xpress 4.x Windows 

to 3-47
exporting from Film Composer 10.x 

Windows to 3-47
exporting from Media Composer 10.x 

Windows to 3-47
exporting from Media Composer 8.1 

Macintosh to 3-50
exporting from Media Composer 9.1 

Windows to 3-49
exporting from Symphony 2.1 to 3-49
exporting from Symphony 3.x to 3-47

Marquee Windows
exporting from 3-11
exporting from Avid Xpress 2.5 Macintosh 

to 3-45
exporting from Avid Xpress 3.1 Windows 

to 3-44
exporting from Avid Xpress 4.x Windows 

to 3-42
exporting from Film Composer 10.x 

Windows to 3-42
exporting from Media Composer 10.x 

Windows to 3-42
exporting from Media Composer 8.1 

Macintosh to 3-45
exporting from Media Composer 9.1 

Windows to 3-44
exporting from Symphony 2.1 to 3-44
exporting from Symphony 3.x to 3-42

Matador
export templates B-18
exporting from 3-6
exporting from Avid Xpress 2.5 Macintosh 

to 3-29
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exporting from Avid Xpress 3.1 Windows 
to 3-28

exporting from Avid Xpress 4.x Windows 
to 3-27

exporting from Film Composer 10.x 
Windows to 3-27

exporting from Media Composer 10.x 
Windows to 3-27

exporting from Media Composer 8.1 
Macintosh to 3-29

exporting from Media Composer 9.1 
Windows to 3-28

exporting from Symphony 2.1 to 3-28
exporting from Symphony 3.x to 3-27

Media Composer 10.x Macintosh
audio compatibility with 2-34
turning off DSK 1-51
video compatibility with 1-38

Media Composer 10.x Windows
audio compatibility with 2-25
exporting from, to Elastic Reality 

Macintosh 3-38
exporting from, to Elastic Reality SGI 

IRIX 3-35
exporting from, to Elastic Reality 

Windows 3-30
exporting from, to Marquee SGI IRIX 3-47
exporting from, to Marquee Windows 3-42
exporting from, to Matador 3-27
exporting from, to Media Illusion 3-22
importing graphics and effects files into

3-18
Media Composer 7.2

audio compatibility with 2-63
video compatibility with 1-68

Media Composer 8.1 Macintosh
audio compatibility with 2-52
exporting from, to Elastic Reality 

Macintosh 3-40
exporting from, to Elastic Reality SGI 

IRIX 3-37

exporting from, to Elastic Reality 
Windows 3-33

exporting from, to Marquee SGI IRIX 3-50
exporting from, to Marquee Windows 3-45
exporting from, to Matador 3-29
exporting from, to Media llusion 3-25
turning off DSK 1-66
video compatibility with 1-53

Media Composer 8.1 or 10.x Macintosh
importing graphics and effects files into

3-20
Media Composer 9.1 or 10.x Windows

turning off DSK 1-36
video compatibility with 1-22

Media Composer 9.1 Windows
audio compatibility with 2-43
exporting from, to Elastic Reality 

Macintosh 3-39
exporting from, to Elastic Reality SGI 

IRIX 3-36
exporting from, to Elastic Reality 

Windows 3-32
exporting from, to Marquee SGI IRIX 3-49
exporting from, to Marquee Windows 3-44
exporting from, to Matador 3-28
exporting from, to Media Illusion 3-23, 3-24
importing graphics and effects files into

3-18
Media Illusion

AvidLinks B-19
export templates B-20
exporting from 3-5
exporting from Avid Xpress 2.5 Macintosh 

to 3-25
exporting from Avid Xpress 3.1 Windows 

to 3-23
exporting from Avid Xpress 4.x Windows 

to 3-22
exporting from Film Composer 10.x 

Windows to 3-22
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exporting from Media Composer 10.x 
Windows to 3-22

exporting from Media Composer 8.1 
Macintosh to 3-25

exporting from Media Composer 9.1 
Windows to 3-23, 3-24

exporting from Symphony 2.1 to 3-23
exporting from Symphony to 3-22

Media Station Release 7.2 1-68
Mixed audio sample rates compatibility with

Avid Xpress 2.1 Macintosh 1-123
Avid Xpress 2.5 Macintosh 1-108
Avid Xpress 3.1 or 4.x Windows 1-79
Media Composer 7.2 Macintosh 1-69
Media Composer 8.1 Macintosh 1-54
Media Composer 9.1 or 10.x 1-23
Symphony Release 2.1 1-8

Motion Tracking compatibility with
Avid Xpress 2.1 Macintosh 1-124
Avid Xpress 2.5 Macintosh 1-109
Avid Xpress 3.1 or 4.x Windows 1-80
Avid Xpress 4.x Macintosh 1-95
Avid Xpress DV 1.0 1-145
Avid Xpress DV 1.5 or 2.0 1-135
Media Composer 10.x Macintosh 1-38
Media Composer 7.2 Macintosh 1-69
Media Composer 8.1 Macintosh 1-53
Media Composer 9.1 or 10.x 1-24
NewsCutter 1.x or 2.x 1-163
NewsCutter DV 1.1 1-163
NewsCutter XP 1.5 or 2.0 1-154
Symphony Release 2.1 1-7

Moving files
from audio to video editing application

2-124
guidelines for 1-4

Moving mattes compatibility with
Avid Xpress 2.1 Macintosh 1-123
Avid Xpress 2.5 Macintosh 1-108
Avid Xpress 3.1 or 4.x Windows 1-79
Avid Xpress DV 1.5 or 2.0 1-135

Media Composer 7.2 Macintosh 1-69
Media Composer 8.1 Macintosh 1-54
Media Composer 9.1 or 10.x 1-22
NewsCutter 1.x or 2.x 1-163
NewsCutter DV 1.1 1-163
NewsCutter XP 1.5 or 2.0 1-154
Symphony Release 2.1 1-7

MultiCamera editing compatibility with
Avid Xpress 2.1 Macintosh 1-125
Avid Xpress 2.5 Macintosh 1-110
Avid Xpress 3.1 or 4.x Windows 1-81
Avid Xpress DV 1.0 1-145
Avid Xpress DV 1.5 or 2.0 1-135
Media Composer 8.1 Macintosh 1-54
Media Composer 9.1 or 10.x 1-23
NewsCutter 1.x or 2.x 1-163
NewsCutter DV 1.1 1-163
NewsCutter XP 1.5 or 2.0 1-154
Symphony Release 2.1 1-7

N
NewsCutter 1.x or 2.x

video compatibility with 1-164
NewsCutter DV 1.1

video compatibility with 1-164

O
OMFI compositions, about 1-3
OMM, transferring files with A-24
Options for file transfers A-4 to A-11

P
Pan and scan compatibility with

Avid Xpress 2.1 Macintosh 1-125
Avid Xpress 2.5 Macintosh 1-110
Avid Xpress 3.1 or 4.x Windows 1-81
Avid Xpress 4.x Macintosh 1-95

Pro Tools
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AvidLink B-21
export templates B-22
exporting audio from 2-125
supported audio formats 2-5

Project files
about 1-3

Q
QuickTime export templates B-11, B-25

R
RealMedia G2 export template B-26
Real-time moving mattes compatibility with

Avid Xpress 2.1 Macintosh 1-123
Avid Xpress 2.5 Macintosh 1-108
Avid Xpress 3.1 or 4.x Windows 1-79
Avid Xpress DV 1.5 or 2.0 1-135
Media Composer 7.2 Macintosh 1-69
Media Composer 8.1 Macintosh 1-54
Media Composer 9.1 or 10.x 1-22
NewsCutter 1.x or 2.x 1-163
NewsCutter DV 1.1 1-163
NewsCutter XP 1.5 or 2.0 1-154
Symphony Release 2.1 1-7

Reformat effects compatibility with
Avid Xpress 2.1 Macintosh 1-125
Avid Xpress 2.5 Macintosh 1-110
Avid Xpress 3.1 or 4.x Windows 1-81
Avid Xpress 4.x Macintosh 1-95
Avid Xpress DV 1.0 1-145
Avid Xpress DV 1.5 or 2.0 1-134
Media Composer 7.2 Macintosh 1-69
Media Composer 8.1 Macintosh 1-54
Media Composer 9.1 or 10.x 1-22
NewsCutter 1.x or 2.x 1-163
NewsCutter DV 1.1 1-163
NewsCutter XP 1.5 or 2.0 1-153
Symphony Release 2.1 1-7

Release compatibility

Avid Xpress 2.1 Macintosh 1-123
Avid Xpress 2.5 Macintosh 1-110
Avid Xpress 3.1 or 4.x 1-79
Avid Xpress 4.x Macintosh 1-94
Avid Xpress DV 1.0 Windows 1-144
Avid Xpress DV 1.5 or 2.0 Windows 1-134
Avid|DS 4.0 1-171
Film Composer 10.x Windows 1-22
Media Composer 10.x Macintosh 1-38
Media Composer 7.2 1-68
Media Composer 8.1 Macintosh 1-53
Media Composer 9.1 or 10.x Windows 1-22
NewsCutter 1.x or 2.x 1-164
NewsCutter DV 1.1 1-164
Softimage|DS 3.0.1 1-171
Symphony 2.1 or 3.x 1-6

Replacing title fonts 1-19

S
SD2 See Sound Designer II
SGI IRIX to Macintosh file transfers A-10
SGI IRIX to Windows file transfers A-11
Softimage|DS

AvidLink B-27
export templates B-28

Softimage|DS 3.0.1
video compatibility with 1-171

Sound Designer II, defined 2-3
Stabilize effect compatibility with

Avid Xpress 2.1 Macintosh 1-124
Avid Xpress 2.5 Macintosh 1-109
Avid Xpress 3.1 or 4.x Windows 1-80
Avid Xpress 4.x Macintosh 1-94
Avid Xpress DV 1.0 1-145
Avid Xpress DV 1.5 or 2.0 1-135
Media Composer 10.x Macintosh 1-38
Media Composer 7.2 Macintosh 1-68
Media Composer 8.1 Macintosh 1-53
Media Composer 9.1 or 10.x 1-24
NewsCutter 1.x or 2.x 1-162
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NewsCutter DV 1.1 1-162
NewsCutter XP 1.5 or 2.0 1-154
Symphony Release 2.1 1-7

Substituting title fonts See Replacing title fonts
Supported audio formats 2-4
Symphony

exporting from, to Media Illusion 3-22
importing graphics and effects files into

3-18
Symphony 2.1

audio compatibility with 2-16
exporting from, to Elastic Reality 

Macintosh 3-39
exporting from, to Elastic Reality SGI 

IRIX 3-36
exporting from, to Elastic Reality 

Windows 3-32
exporting from, to Marquee SGI IRIX 3-49
exporting from, to Marquee Windows 3-44
exporting from, to Matador 3-28
exporting from, to Media Illusion 3-23
importing graphics and effects files into

3-18
Symphony 2.1 or 3.x

turning off DSK 1-20
video compatibility with 1-6

Symphony 3.x
audio compatibility with 2-7
exporting from, to Elastic Reality 

Macintosh 3-38
exporting from, to Elastic Reality SGI 

IRIX 3-35
exporting from, to Elastic Reality 

Windows 3-30
exporting from, to Marquee SGI IRIX 3-47
exporting from, to Marquee Windows 3-42
exporting from, to Matador 3-27

T
Transferring files

across a network A-25
audio, Avid Xpress DV 1.0, 1.5, or 2.0 

Windows 2-121
Macintosh to Macintosh A-4
Macintosh to SGI IRIX A-10
Macintosh to Windows A-7
SGI IRIX to Windows A-11
using Avid Unity MediaNet A-23
using Avid Unity TransferManager A-12
using AvidNet Transfer Tool A-13 to A-20
using OMM A-24
Windows to Windows A-6

Turning off DSK
moving to Avid Xpress 2.5 Macintosh 1-121
moving to Avid Xpress 3.1 or 4.x 

Windows 1-92
moving to Avid Xpress 4.x Macintosh 1-106
moving to Media Composer 10.x 

Macintosh 1-51
moving to Media Composer 8.1 

Macintosh 1-66
moving to Media Composer 9.1 or 10.x 

Windows 1-36
moving to Symphony 2.1 or 3.x 1-20

U
Ultimatte effect compatibility with

Avid Xpress 2.1 Macintosh 1-124
Avid Xpress 2.5 Macintosh 1-109
Avid Xpress 3.1 or 4.x Windows 1-81
Avid Xpress 4.x Macintosh 1-95
Avid Xpress DV 1.0 1-145
Avid Xpress DV 1.5 or 2.0 1-135
Media Composer 10.x Macintosh 1-39
Media Composer 7.2 Macintosh 1-69
Media Composer 8.1 Macintosh 1-54
Media Composer 9.1 or 10.x 1-24
NewsCutter 1.x or 2.x 1-163
NewsCutter DV 1.1 1-163
NewsCutter XP 1.5 or 2.0 1-154
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Symphony Release 2.1 1-7

V
Video compatibility with

Avid Xpress 2.5 Macintosh 1-110
Avid Xpress 3.1 or 4.x 1-79
Avid Xpress 4.x Macintosh 1-94
Avid Xpress DV 1.0 Windows 1-144
Avid Xpress DV 1.5 or 2.0 Windows 1-134
Avid|DS 4.0 1-171
Film Composer 10.x Windows 1-22
Media Composer 10.x Macintosh 1-38
Media Composer 7.2 1-68

Media Composer 8.1 Macintosh 1-53
Media Composer 9.1 or 10.x Windows 1-22
NewsCutter 1.x or 2.x 1-164
NewsCutter DV 1.1 1-164
Softimage|DS 3.0.1 1-171
Symphony 2.1 or 3.x 1-6

W
WAVE, defined 2-3
Windows to Macintosh file transfers A-7
Windows to SGI IRIX file transfers A-11
Windows to Windows file transfers A-6
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